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Preface

Welcome to the Oracle Marketing Implementation and Administration Guide, Release 
11i.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Marketing

If you have never used Oracle Marketing, Oracle suggests you attend one or 
more of the Oracle Applications training classes available through Oracle 
University.

■ Oracle Self-Service Web Applications

To learn more about Oracle Self-Service Web Applications, read the Oracle 
Self-Service Web Applications Implementation Manual.

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This guide contains the information you need to implement and administer Oracle 
Marketing. 

■ Chapter 1 provides an overview of the application benefits, functional areas, 
and enhancements for this release.
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■ Chapter 2 describes Oracle E-Business Suite dependencies and integration 
points.

■ Chapter 3 describes the implementation and administration of common 
components.

■ Chapter 4 describes the implementation and administration of campaign 
functionality.

■ Chapter 5 describes the implementation and administration of Campaign 
Workbench functionality.

■ Chapter 6 describes the implementation and administration of audience 
functionality.

■ Chapter 7 describes the implementation and administration of events 
functionality.

■ Chapter 8 describes the implementation and administration of marketing 
metrics functionality.

■ Chapter 9 describes the implementation and administration of data mining 
functionality.

■ Chapter 10 describes the implementation and administration of products, price 
lists, and deliverables functionality.

■ Chapter 11 describes the implementation and administration of marketing 
intelligence functionality.

■ Appendix A describes and lists Oracle Marketing profile options.

■ Appendix B describes and lists Oracle Marketing lookups.

■ Appendix C describes and lists Oracle Marketing concurrent programs.

■ Appendix D describes and lists Oracle Marketing list import fields.

■ Appendix E describes and lists Oracle Marketing seeded user statuses.

■ Appendix F describes seeded data sources and attributes.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 



 xv

markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor 
makes any representations regarding the accessibility of these Web sites. 

Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Marketing.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ PDF Documentation- See the Online Documentation CD for current PDF 
documentation for your product with each release. This Documentation CD is 
also available on OracleMetaLink and is updated frequently. 

■ Online Help - You can refer to Oracle Applications Help for current HTML 
online help for your product. Oracle provides patchable online help, which you 
can apply to your system for updated implementation and end user 
documentation. No system downtime is required to apply online help.

■ Release Content Document - See the Release Content Document for 
descriptions of new features available by release. The Release Content 
Document is available on OracleMetaLink. 
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■ About document - Refer to the About document for information about your 
release, including feature updates, installation information, and new 
documentation or documentation patches that you can download. The About 
document is available on OracleMetaLink. 

Related Guides
Oracle Marketing shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other guides when you 
set up and use Oracle Marketing.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Guides Related to This Product

Oracle Marketing User Guide
This document describes concepts and procedures that business users need to use 
Oracle Marketing to complete day-to-day tasks.

Installation and System Administration Guides

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
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also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications 
and the Oracle technology stack by automating many of the required steps. This 
guide contains instructions for using Oracle Rapid Install and lists the tasks you 
need to perform to finish your installation. You should use this guide in conjunction 
with individual product user guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 
10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 
11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.

“About” Document
For information about implementation and user documentation, instructions for 
applying patches, new and changed setup steps, and descriptions of software 
updates, refer to the ”About” document for your product. ”About” documents are 
available on OracleMetaLink for most products starting with Release 11.5.8.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.
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Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff and describes the Oracle Application Object Library components 
that are needed to implement the Oracle Applications user interface described in 
the Oracle Applications User Interface Standards for Forms-Based Products. This manual 
also provides information to help you build your custom Oracle Forms Developer 
forms so that the forms integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Applications Product Update Notes
Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.

Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.
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Oracle Workflow API Reference
This guide describes the APIs provided for developers and administrators to access 
Oracle Workflow.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Marketing implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This guide also provides 
information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetaLink.

Oracle Applications Message Manual
This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle Applications and reach full productivity quickly. Many of these courses are 
organized into functional learning paths, so you take only those courses 
appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.
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Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Marketing working for 
you. This team includes your technical representative, account manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle server, and your hardware and software 
environment.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
modules for financial management, supply chain management, manufacturing, 
project systems, human resources and customer relationship management.
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Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.

Your Feedback
Thank you for using Oracle Marketing and this Implementation and 
Administration Guide.

Oracle values your comments and feedback. In this guide is a reader’s comment 
form that you can use to explain what you like or dislike about Oracle Marketing or 
this guide. Mail your comments to the following address or call us directly at (650) 
506-7000. 

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Or, send electronic mail to appsdoc_us@oracle.com.
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1
Product Overview

This topic group provides an overview of the Oracle Marketing application for 
release 11.5.10.

Topics include: 

■ Section 1.1, "Key Benefits"

■ Section 1.2, "Functional Areas"

■ Section 1.3, "New in this Release"
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1.1 Key Benefits
Oracle Marketing provides the tools necessary to automate the planning, budgeting, 
execution, and tracking of your marketing initiatives. By automating these 
processes your marketing strategy is cost effective and intelligent. 

Oracle Marketing enables you to accomplish the following:   

■ Create and manage demand

– Establish and maintain product, service, and brand awareness

– Track and analyze leads and sales activities

– Route leads to the “best” channel

■ Improve customer profitability 

– Understand customer behavior 

– Decrease customer acquisition cost

– Reduce customer attrition

■ Automate marketing processes

– Create and maintain best practices templates

– Expedite time to market

■ Keep marketing aligned with the overall organization

– Align leads, sales, marketing efforts and objectives

– Distribute marketing information and collateral company wide 

– Provide the marketing team with relevant visibility into other parts of the 
organization

■ Measure marketing performance

– Track spending 

– Provide performance measurements for leads, responses, and revenue

■ Understand the competitive landscape

– Provide insight into competitor differentiation 

– Enable price point competition insight 
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1.2 Functional Areas
The Oracle Marketing application is composed of several functional areas. The 
implementation and use of each functional area depends on your business 
requirements. 

Core Marketing
Oracle Marketing’s “core” functionality includes Programs, Campaigns, Budgets, 
Events, Metrics and Analysis, Products, Deliverables, Price Lists, eMerchandising 
(Web marketing), Data Mining, and User Management. 

For more information about core Oracle Marketing functionality, see the Oracle 
Marketing User Guide. 

Campaign Workbench
The Campaign Workbench provides a streamlined user interface that enables you to 
create and execute campaign schedules through various marketing channels (email, 
direct mail, fax, telemarketing, advertising and Web. This UI is separate from the 
Campaign tab. Schedules, however, can be executed in both places. 

For more information about using Campaign Workbench, see the Oracle Marketing 
User Guide. 

Audience Workbench
The Audience Workbench provides you with an intuitive interface to create and 
manage lists. This workbench displays customer information that is relevant, logical 
and easy for you to use. 

For more information about using Audience Workbench see the Oracle Marketing 
User Guide.

Marketing Intelligence
The Marketing Intelligence component within Oracle Marketing provides 
comprehensive reports for the purpose of:

■ Planning

■ Performance monitoring

■  Analysis

During the planning cycle, marketing organizations should carefully study the 
results of their past activities. This provides the basis for any changes they will 
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make to the upcoming activities, as well as the benchmark on which they can 
forecast their returns in the future. During the execution stage, monitoring 
performance on a daily basis enables marketing professionals to react to their 
market needs, test their forecast assumptions and make changes if necessary. 
Throughout all business cycles, analysis needs to be conducted and analysis always 
starts with reports that contain accurate, timely data. 

eMerchandising
The eMerchandising component enables the Web marketing channel within core 
marketing. Web content, such as Web advertisements, Web offers, and product 
recommendations can be created and then displayed on Oracle iStore or any other 
Web store. 

Oracle Personalization (OP) can be integrated with eMerchandising to enable 
enhanced product recommendation. With OP, product recommendations are based 
on who the customer is, what the purchase history is, and the product that the 
customer is currently considering. Oracle Personalization is an automated 
recommendation engine that takes all relevant data into account and uses a 
statistical model to determine appropriate recommendations. 

Data Mining
Data Mining provides the ability to create predictive models of customer and 
prospective customer behavior based on historical data. Using these models, you 
can predict which segments to target for future marketing campaigns. By 
intelligently targeting only prospective customers with a high propensity to exhibit 
a desired behavior (e.g., respond to a marketing campaign), you can increase 
marketing ROI by decreasing the number of contacts and increasing the response 
rate.
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1.3 New in this Release
This section describes new functionality developed for Oracle Marketing in the 
Oracle E-Business Suite 11.5.10 release. 

See the following sections for detailed descriptions of new functionality: 

■ Section 1.3.1, "Campaign Workbench"

■ Section 1.3.2, "Integration with Oracle Personalization"

■ Section 1.3.3, "Tracking and Reporting on Personalization"

■ Section 1.3.4, "Integration with Oracle Content Manager"

■ Section 1.3.5, "Enhanced Team Access"

■ Section 1.3.6, "Fatigue Rules"

■ Section 1.3.7, "Audience Workbench"

■ Section 1.3.8, "Data Mining Enhancements"

■ Section 1.3.9, "Metrics Enhancements"

■ Section 1.3.10, "Additional Miscellaneous Enhancements"

1.3.1 Campaign Workbench
The Campaign Workbench gives you the ability to create and execute marketing 
initiatives quickly and easily. The Campaign Workbench is a new user interface for 
campaign execution. Using the Campaign Workbench, schedules are easier to create 
and more functional than ever. 

■ Schedule Dashboard: Enables you to monitor different metrics and view the 
historical trend of different metrics. 

■ Schedule Gantt Chart: Enables you to visualize the layout of promotional 
activities across time. Also allows you to enter single dimensions for the Gantt, 

Note: If you are implementing this product prior to the Oracle 
E-Business Suite release using product minipacks or family packs, 
some new functionality may be dependent on integration with 
other Oracle products. Please consult OracleMetaLink for relevant 
product patches and documentation.
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including purpose, audience, product, and channel information. This assists 
with planning and identifying conflicts or overlap in propositions. 

■ Sales Schedules: Allows sales and marketing users to create activities that cross 
sell and up sell customers in sales territories. When a sales initiative is 
launched, leads are generated for sales follow up.

■ Web Marketing Schedule: Provides a simplified version of creating Web 
postings for placing Web ads on iStore. Instead of using eMerchandising 
(11.5.9), in 11.5.10 you can simply create a Web schedule using the Campaign 
Workbench. 

■ Email Schedule: Provides email schedules that leverage Oracle Content 
Management for email template purposes. Using the Campaign Workbench 
email schedules functionality, your email schedules (because of the template 
functionality) have consistent formatting, are easier to access, and are centrally 
located. 

■ Direct Mail Schedule: Using the direct mail channel you can print PDF 
documents. 

■ Schedule Operational Reports: For supported channels (Web, direct marketing, 
sales), workbench schedules support schedule-level reports for execution 
tracking. 

■ Repeating Schedules: Repeating schedules in 11.5.9 required a trigger to be 
setup and linked to a schedule. In 11.5.10 the process of repeating a schedule is 
simplified.

■ Streamlined Lead Maturation: Campaign schedules can be easily set up to 
mature low value, low grade, and unaccepted leads from one or more 
campaigns via the new target audience natural language query builder. 

1.3.2 Integration with Oracle Personalization
Oracle Marketing can be integrated with Oracle Personalization (OP) through Web 
schedules. This integration enables enhanced product recommendations for Web 
advertisements. Oracle Personalization can also be integrated with the 
eMerchandising component (which is part of core marketing).   

With OP, product recommendations are based on who the customer is, what the 
purchase history is, and the product that the customer is currently considering. 
Oracle Personalization is an automated, real-time recommendation engine that 
takes all relevant data into account and uses a statistical model to determine 
appropriate recommendations.
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Note: This integration has the following dependencies:

■ 9.02iAS is properly setup: Because this is not part of the official Oracle 
Applications tech stack, an additional step of installing the required 
components is required. 

■ Web content is stored in Oracle Content Manager: This setup enables content 
to be associated directly to products and/or product families. In 11.5.9, all Web 
ad content was pulled either from a schedule or from Oracle iStore. However 
when using OP, recommended products could have no schedule, therefore 
requiring the content to come from a more generic source.

1.3.3 Tracking and Reporting on Personalization
Oracle Marketing has had a rule-based personalization engine since release 11.5.5. 
With release 11.5.10, Oracle Marketing can generate reports of both the 
recommendations and results (for example, responses, leads, revenue).

1.3.4 Integration with Oracle Content Manager
The Oracle Marketing and Oracle Content Manager (OCM) integration provides the 
following functionality:  

■ Collateral: A midtab exposed in the UI providing for fulfillment purposes.

■ Collaboration: A midtab exposed in the UI provides collaboration with internal 
sales team.  

Using the enhanced collateral component available in the this release, you can:

■ Create templates for emails and fax (referred to as content types).

■ Create mandatory attributes for the templates. This enables all users to have the 
same look and feel for emails and faxes. For example, all emails can contain the 
company logo and copyright text.

■ Create query templates at the content type level. This enables the 
implementation manager to create appropriate templates with queries for users 
to choose - therefore, a marketer doesn’t have to manually enter query 
information.

■ OCM folder security  and approvals
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1.3.5 Enhanced Team Access
In prior releases, if a campaign or event was marked as confidential, it would become 
non-confidential upon activation. For this release, campaigns and events will not 
automatically become non-confidential upon activation. If a campaign or event is 
confidential, it is only visible to team members, the object owner, and the 
administrator.

1.3.6 Fatigue Rules
Fatigue rules provide marketers with a tool that helps to prevent over contacting a 
customer regardless of the promotion or segmentation strategy.  

Fatigue rules provide the following business value:

■ Brand Awareness: If you can time promotions so that you don’t overexpose a 
customer, then when you do contact them, they are more receptive.

■ Marketing Strategy Decisions Support: Helps enforce marketing rules that 
dictate how often it is appropriate to contact a customer. 

■ Maximized Marketing Dollar Effectiveness: If you carefully contact your 
customer base, then every dollar spent will (in theory) get a better response 
rate. 

■ Improve Enterprise Collaboration: Helps the entire organization coordinate 
touch points.  For example, telesales, direct mail, and email all have the 
potential to ’fatigue’ the consumer.  By centralizing the rules for these 
marketing communications, you can prevent various channels from over 
contacting the consumer. 

1.3.7 Audience Workbench
The Audience Workbench provides marketers with an intuitive interface to create 
and manage lists, analyze list effectiveness, examine list trends, and directly view or 
modify their most recent lists. It also provides the administrator with a logical 
interface for setting up data sources, list templates, and configuring the 
corresponding customer profile attributes that are used by marketers to create lists. 

For more information about using the Audience workbench see the Oracle Marketing 
User Guide. 
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1.3.8 Data Mining Enhancements
Data Mining functionality provides marketers with an effective tool to predict and 
analyze customer behavior. New Data Mining features incorporated in release 
11.5.10 are as follows:

■ Predictive Model Types: Two new out-of-the-box predictive model templates 
are added to provide marketers with a richer set of customer behavior 
predictions: Product Affinity and Customer Profitability.

■ Optimal Targeting Analysis: Oracle Marketing’s predictive modeling and 
scoring functionality is enhanced to provide guidance on the optimal 
customers/prospects to target in a campaign. This analysis is based on 
customer propensity scores and expected costs and revenues per customer for a 
campaign activity. The feature enables marketer to seamlessly use the results of 
a Scoring Run from either a Campaign Response Model or a Product Affinity 
Model to determine the optimal customers to contact. 

■ Zero Implementation Steps: The objective of this functionality is to enable easy 
implementation of Oracle Marketing’s Data Mining functionality when 
customer has already implemented some of the other Oracle products. 
Significant enhancements have been made to ensure an easy implementation of 
the data mining functionality. 

■ Enhanced Predictive Model Results: Users of Oracle Marketing often need to 
import data about model performance to an excel sheet either to perform 
customized analysis or import the data into some external marketing execution 
system. In 11.5.10, the lift chart data for model performance will be available to 
the user in a table format. Users can import this data to an excel sheet. Similarly, 
users can download the performance matrix data through a download CSV 
icon for additional offline analysis.

For more information on using Data Mining see the Oracle Marketing User Guide.  

1.3.9 Metrics Enhancements
Metrics enable marketers to monitor and manage the performance of various 
marketing objects (campaigns, events, etc.) Metrics functionality has been enhanced 
in release 11.5.10 to include additional metrics and a new ‘Formula Metrics’ type. 
Additionally, the user interface has been made more intuitive to facilitate better 
usability. 

For more information on using Metrics see the Oracle Marketing User Guide.
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1.3.10 Additional Miscellaneous Enhancements
Additional minor enhancements include: 

■ Show start and end date on campaign schedule screen 

■ Show event schedule times on event screen

■ Added venue capacity and registration information to event venues

■ Cancelled schedules are no longer considered for data validations

■ Support to register B2C customers from marketing registrations screens

■ Support for event invitations
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2
Oracle E-Business Suite Dependencies

This topic group describes Oracle E-Business Suite dependencies, setups, and 
optional integrations points.

Topics include: 

■ Section 2.1, "Oracle E-Business Suite Dependency Overview"

■ Section 2.2, "Mandatory vs. Conditional Dependencies"

■ Section 2.3, "Understanding and Setting Up Mandatory Dependencies"

■ Section 2.4, "Creating the Implementation User"

■ Section 2.5, "Understanding and Setting Up Conditional Dependencies"
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2.1 Oracle E-Business Suite Dependency Overview
Oracle Marketing is a component of the integrated Oracle E-Business Suite. Because 
of this, you will need to verify that Oracle E-Business Suite dependencies are 
installed and set up properly for Oracle Marketing. The verification and setup of 
Oracle E-Business Suite prerequisites is necessary to ensure that supporting 
functionality and applications infrastructure is in place prior to beginning the 
Oracle Marketing implementation.

In addition, you can leverage other applications and modules within the Oracle 
E-Business Suite to provide additional functionality to your Oracle Marketing 
implementation. For example, if your business requirements mandate that your 
marketing campaign results be translated into leads, then you can license and 
implement Oracle Leads Management along with Oracle Marketing. This combined 
implementation would allow you to analyze and track sales leads as a follow up to 
your marketing initiatives.

2.2 Mandatory vs. Conditional Dependencies
This implementation guide categorizes Oracle E-Business Suite dependencies as 
follows:

■ Mandatory Dependencies: Oracle applications and modules that provide 
underlying infrastructure and support to Oracle Marketing. Implementing 
these dependencies is required and must be complete before beginning an 
Oracle Marketing implementation. 

For example, the Oracle Trading Community Architecture (TCA) provides a 
repository for customer and partner information. All customer and partner 
information used by Oracle Marketing is stored in the TCA tables. Because this 
information is critical for Oracle Marketing, TCA is a mandatory dependency, 
and must be setup properly. 

■ Conditional Dependencies: Oracle applications and modules that extend or 
enhance Oracle Marketing functionality via integration. Implementing these 
dependencies is conditional based on business requirements and practices, 
functionality desired, and licensing.
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2.3 Understanding and Setting Up Mandatory Dependencies
Applications and modules defined as mandatory must be setup prior to 
implementing Oracle Marketing.  The setups, however, are generally partial and 
limited to basic functions that are specifically needed for Oracle Marketing.   

For example, Oracle Inventory is a mandatory dependency for Oracle Marketing’s 
product functionality. However, to enable products for marketing purposes, you do 
not need a full Oracle Inventory implementation. 

See the following sections for more information on setting up mandatory 
dependencies:

■ Section 2.3.1, "Setting Up Oracle CRM Application Foundation"

■ Section 2.3.2, "Setting Up Oracle Territory Manager"

■ Section 2.3.3, "Setting Up Oracle One-to-One Fulfillment"

■ Section 2.3.4, "Setting Up Oracle Applications Object Library"

■ Section 2.3.5, "Setting Up Oracle General Ledger"

■ Section 2.3.6, "Defining the Marketing Calendar"

■ Section 2.3.7, "Setting Up Oracle Human Resources"

■ Section 2.3.8, "Setting Up Oracle Inventory"

■ Section 2.3.9, "Setting Up Product Lifecycle Management"

■ Section 2.3.10, "Setting Up Oracle Receivables"

2.3.1 Setting Up Oracle CRM Application Foundation
Oracle CRM Application Foundation provides a common infrastructure upon 
which all Oracle CRM applications are built. By providing a set of application 
components, CRM Application Foundation ensures that all applications interact 
with key business objects in a consistent manner. 

See the following sections for more information on CRM Application Foundation: 

■ Section 2.3.1.1, "Resource Manager"

■ Section 2.3.1.2, "Task Manager"

■ Section 2.3.1.3, "Interaction History"

■ Section 2.3.1.4, "Notes and Note Types"
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■ Section 2.3.1.5, "Assignment Manager"

2.3.1.1 Resource Manager
Resource Manager is mandatory for an Oracle Marketing implementation. This 
component enables you to use application resources regardless of where they are 
created. Acting as a central repository, Resource Manager enables the creation of 
various types of resources, groups, teams, and roles. 

You can import resources such as employees, suppliers, parties, or partners, created 
in other applications. Once imported, the resource becomes available for other 
applications to use. 

Resource Manager enables:

■ Groups

■ Roles

■ Role Types 

■ Employee Import 

2.3.1.2 Task Manager
Task Manager is mandatory for an Oracle Marketing implementation. It provides a 
mechanism for your application to respond to customer needs in a timely manner. 
Using Task Manager you can create, assign, manage, sort, and prioritize tasks.

If implementing task transition rules, after defining a rule and assigning it an 
appropriate responsibility, set the following profile: 

■ Task Manager: Default Task Status 

If no rules are assigned to a responsibility, all statuses will be displayed in the 
Status LOV. In this case, the Task Manager: Default Task Status does not need to be 
set.

2.3.1.3 Interaction History
Interaction History is mandatory for an Oracle Marketing implementation. It 
provides a common framework for capturing and accessing all interaction data 
associated with customer contact. Acting as a central repository, it provides a 
consistent API for tracking all customer interactions within the Oracle E-Business 
Suite. 

For example, if using the tracking mechanism within Web marketing, each response 
(each time a customer responds to a Web ad) is tracked in Interaction History. 
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2.3.1.4 Notes and Note Types
A complete notes implementation is optional. This module is used to create, 
maintain, and share notes related to customers, opportunities, service requests, and 
other business objects. 

Setting up note types is also optional. Although Oracle Notes comes with a set of 
predefined note types, you can create customized note types. When using Oracle 
Marketing, both the predefined set of notes and the customized notes are available.

To create customized note types, use the following procedure:

Prerequisites
None

Steps
1. Log in to Oracle Forms with CRM Administrator responsibility. 

2. Navigate to Notes Setup > Note Type Setup. 

The Application Object Library: Note Types Lookups form opens. 

3. Define the new Lookup code.

4. Define the meaning. 

Carefully describe the Note Type meaning. It is this description that will later 
be used to map the Note Type to the marketing object. 

5. Add a short description. 

6. In the tag column enter Note. 

7. Save your work. 

8. To associate the Note Type with specific marketing objects, use the following 
procedure:

a. Navigate to Notes Setups > Source and Note Type Mappings.

b. Using the Source Object LOV, select the appropriate marketing object that 
will use this Note Type. For example, Campaign Schedule. 

c. Using the Note Type LOV, select the new Note Type created. The Note 
Type LOV will display the text entered as the Note Type meaning. 

d. Select an End Date for the Note Type Mapping. 

e. Using the Application LOV, select Oracle Marketing. 
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f. Save your work. 

g. Repeat for additional marketing objects.
.

2.3.1.5 Assignment Manager
Implementing Assignment Manager is optional. The Assignment engine determines 
the best resource to be assigned to tasks based on availability and skill set. This 
engine is used by the various CRM modules to automatically assign tasks to a 
resource or a group of people. 

For more information on CRM Application Foundation components, see the Oracle 
CRM Application Foundation Implementation Guide.

2.3.2 Setting Up Oracle Territory Manager
Implementing Oracle Territory Manager is optional. It provides an infrastructure to 
define territories based on flexible criteria, such as geography, zip code, area code. 
This engine creates automatic assignment of transactions across the entire CRM 
suite. For example, leads and opportunities are routed through this engine to the 
appropriate sales professionals. 

See Oracle Territory Manager documentation for more information. 

2.3.3 Setting Up Oracle One-to-One Fulfillment
If using email, fax, print schedules, email notifications (or if using the features of 
email notifications on fulfillment rules) Oracle One-to-One Fulfillment is a 
mandatory setup. The fulfillment engine supports high volume electronic 
fulfillment of documents.  

When implementing Oracle One-to-One Fulfillment, the following conditions must 
be met: 

■ Fulfillment Server is created: A Fulfillment Server is an instance of the request 
processing software. 

■ Fulfillment Group is created:  Fulfillment group is used to group agents (users) 
together.  

Note: If a note type is not associated with a specific marketing 
object, it becomes available to all marketing objects.
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■ JFT Fulfillment Admin role is assigned to the Implementor:  This role gives 
access to the Fulfillment administration console for setting up fulfillment, 
creating master documents and viewing request history. This role and 
responsibility only needs to be assigned to a Marketing user only if he/she will 
also be administering the Fulfillment activities (for example, setting up 
Fulfillment servers, agents, etc.). Typically, only a Marketing Administrator is  
involved in these activities.

■ AMS: Enable Fulfillment is set to Yes 

Consult Oracle One-to-One Fulfillment documentation for more information.

2.3.4 Setting Up Oracle Applications Object Library
Oracle Applications Object Library (AOL) 11i enables a multiple language and 
currency setup for the Oracle Marketing implementation. After being enabled, you 
can determine the set of languages and currencies to be used. 

For more information see Oracle Applications Concepts and Oracle Applications System 
Administrator’s Guide.

2.3.5 Setting Up Oracle General Ledger
Basic accounting information for Oracle Marketing is provided by Oracle General 
Ledger (GL). Because Oracle Inventory requires at least one organization and 
associated set of books, at least one business unit must be created in GL. 

To implement GL for Oracle Marketing, you must setup the following: 

■ Accounting Calendar Types

■ Accounting Calendar

■ Currencies

■ Currency Conversion Rates

■ Currency Conversion Rate Types

■  Set of Books

For specific setup information, see the Oracle General Ledger User Guide. 
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2.3.6 Defining the Marketing Calendar
The Marketing Calendar defined by this task becomes a value in the LOVs for the 
profile AMS: Marketing Calendar. 

To define the Marketing Calendar use the following procedure:

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator responsibility.

2. Navigate to Profile > System.

3. In the Application field enter Oracle Marketing.

4. In the Profile field enter AMS: Marketing Cal%.

5. At Site Level, click the LOV to view available AMS: Marketing Calendar 
options.

6.  Select the appropriate Accounting Calendar.

7. Save your work.

For information about creating the Marketing Calendar, see Section 3.3.12, "Setting 
Up the Marketing Calendar".

2.3.7 Setting Up Oracle Human Resources
The Oracle Human Resources Management System (HRMS) stores information 
related to your organization. For detailed Oracle HRMS information, consult Using 
Oracle HRMS - The Fundamentals. 

For an Oracle Marketing implementation, see the following sections for information 
on the HRMS setups that must be performed: 

■ Section 2.3.7.1, "Determining the HRMS Navigation Path"

■ Section 2.3.7.2, "Creating Lookup Values for Organization Type" 

■ Section 2.3.7.3, "Creating Locations"

■ Section 2.3.7.4, "Creating Business Groups"

■ Section 2.3.7.5, "Creating Organizations"



Understanding and Setting Up Mandatory Dependencies

                                                                  Oracle E-Business Suite Dependencies 2-9

■ Section 2.3.7.6, "Assigning Security Profile"

■ Section 2.3.7.7, "Adding a Legal Entity, Operating Unit and HR Organization"

■ Section 2.3.7.8, "Creating A Business Unit"

■ Section 2.3.7.9, "Assigning Multi Org Responsibilities"

2.3.7.1 Determining the HRMS Navigation Path
The responsibilities and navigation paths for performing HRMS tasks is different 
depending on the terms of your lisence (shared vs. full). 

■ Shared HRMS lisence: Create employees using CRM Foundation. 

– Responsibility: CRM Administrator

– Navigation Path: CRM Foundation > Resource Manager > Maintain 
Employees > Employees

■ Full HRMS lisence: Create employees using HRMS. 

– Responsibility: HRMS Manager

– Navigation Path: People > Enter and Maintain

2.3.7.2 Creating Lookup Values for Organization Type 
In this step you are creating sub organization types. For example, if the 
organization is divided into business groups, then create an organization type 
called Business Group. 

This procedure adds values for a specific lookup “Organization Types (ORG_
TYPE)”. If the organization is divided into subsidiaries, create an organization type 
called Subsidiary. 

2.3.7.3 Creating Locations
In Oracle HRMS, you will set up each physical site where your employees work as a 
separate location. You can set up:

■ Global locations: Available in all Business Groups.

■ Business Group locations: Available in one Business Group.

Similarly, you enter the addresses of external organizations that you want to 
maintain in your system, such as employment agencies, tax authorities, and 
insurance or benefits carriers. When setting up internal or external organizations, 
you select from a list of these locations.
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2.3.7.4 Creating Business Groups
The business group is the largest organizational unit representing the enterprise. A 
Business Group may correspond to a company or corporation, or in large 
enterprises, a holding or parent company. It can be an organization with a physical 
location, or it may be an abstract representation of a legal entity that employs 
people assigned to work in organizations beneath it.

A default business organization has been set up for you, therefore this step is not 
required for Oracle Marketing to be fully operational. However, you must set up an 
organization if you plan to use any financial ERP applications in the future.

For more information see Multiple Organizations in Oracle Applications. 

2.3.7.5 Creating Organizations
The first organization to set up is the Business Group and all other organizations 
will will belong to it. Below the Business Group, you represent the groupings in 
which employees work, such as branches, departments or sections, by means of 
internal organizations. To enable the assignment of employees to an internal 
organization, you classify it as an HR Organization.

2.3.7.6 Assigning Security Profile
In this step, you will be defining the security level for specific Marketing 
Responsibilities. To do this, use the profile HR: Security Profile. This profile 
enables access (based on responsibility) to a single business group. 

To assign the security profile use the following procedure: 

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator responsibility. 

2. Navigate to Profile > System.

The Find System Profile Values form opens.

3. In the Application field enter Oracle Marketing.

4. In the Responsibility field search and select the responsibility for which the 
profile is being set. 

5. In the Profile field enter HR: Security%
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6. In the HR: Security Profile, at Site level, select an organization.

The organization selected is the business group that users will have access to. 
They will have access only to records within this business group. 

7. Save your work. 

Validate that the setting for HR: Business Group is the same organization as the 
HR: Security profile. 

2.3.7.7 Adding a Legal Entity, Operating Unit and HR Organization
To perform the HRMS task of creating a Legal Entity, Operating Unit, Organization 
follow the procedure below:

Prerequisites
None

Steps
1. Log in to Oracle Forms with the appropriate HRMS Manager responsibility. 

For more information on determining this see Section 2.3.7.1, "Determining the 
HRMS Navigation Path". 

2. Navigate to Work Structure > Organization > Description.

The Find Organization form opens. 

3. Search/and or Select your Organization.

4. Place your curser in the Organization Classification Name field. 

5. Using the LOV select GRE / Legal Entity. 

6. Select the Enabled radio button. 

7. Save your work and close this form (the Organization form will still be open in 
the background). 

8. Select Others. 

9. Select GRE / Legal Entity.

10. Select a Set of Books (defined above).

11. Click OK.

12. Save your work.
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13. Add an Operating Unit:

a. Under Organization Classifications Name, add Operating Unit.

b. Click the ellipsis to select a classification.

c. Select a Legal Entity. 

d. Click Others.

e. Select Legal Entity Accounting. 

f. Select a set of books.

g. Click OK.

h. Enable by selecting the checkbox.

i. Save your work.

14. Add an HR Organization:

a. Under Organization classifications name, add HR Organization from the 
LOV.

b. Enable by selecting the checkbox.

c. Save your work.

d. Click Others to enter additional information.

e. Save your work.

15. Close the form. 

2.3.7.8 Creating A Business Unit
To create a new Business Unit use the following procedure: 

1. Log in to Oracle with the appropriate HRMS Responsibility. 

For more information on the appropriate HRMS responsibility see 
Section 2.3.7.1, "Determining the HRMS Navigation Path". 

2. Navigate to Work Structure > Organization > Description. 

3. Select New.

4. Fill in Name of Business Unit.

5. Select Type (Business Unit).

6. Select a Location. 
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7. Select an Organization Classification. 

8. Select Internal or External.

9. Save your work.

2.3.7.9 Assigning Multi Org Responsibilities
Oracle Marketing requires the implementation of a Multiple Organization 
Structure. Please refer to Multiple Organization in Oracle Applications for additional 
information.

You will assign Multi Org responsibilities to a selected Oracle Marketing 
responsibility. This displays the appropriate Business Unit when using that 
responsibility.

2.3.8 Setting Up Oracle Inventory
Oracle Inventory serves as the repository for items that can be used in Oracle 
Marketing. Items stored in Oracle Inventory reside in the MTL_SYSTEM_ITEMS 
table. 

Oracle Inventory requires one inventory organization to be identified. Typically this 
is the Master Inventory Organization. If you need to separate products (sold from 
each operating unit) into different inventory organizations, create a separate 
inventory organization for each operating unit. 

Implement Oracle Inventory as described in the Oracle Inventory Implementation 
Guide. 

2.3.9 Setting Up Product Lifecycle Management
Oracle Marketing derives its product data using the product catalog provided by 
Product Lifecycle Management (PLM). PLM provides a product hierarchy located 
in the OLTP schemas. This hierarchy is maintained by the user in a product catalog 
and is expanded to a de-normalized table (designed for efficient traversal) by the 
Oracle Sales and Marketing applications.   

For more information about implementing PLM for Marketing see Section 10.1.1, 
"Implementing Oracle Product Lifecycle Management".
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2.3.10 Setting Up Oracle Receivables
Oracle Marketing uses Oracle Receivables to record customer information. 
Customer registration information is maintained in the Trading Community 
Architecture (TCA). TCA stores all customer, partner, prospect, and other customer 
related information in a single repository. This enables consistent message delivery 
across all channels. 

At a minimum, you need to perform the required Oracle Receivables setups, 
including tax options and address validation, as described in the Oracle Receivable’s 
User’s Guide. 

2.4 Creating the Implementation User
Each user (or type of user) has a specific collection of responsibilities. Before 
assigning responsibilities to a user, the employee must be created in the HRMS. 
After the employee has been created, you can create the user and assign 
responsibilities and a default application ID.  

To create marketing users, see the following sections: 

■ Section 2.4.1, "Creating the Employee"

■ Section 2.4.2, "Defining a User by Adding Responsibilities"

■ Section 2.4.3, "Setting the Default Application and Responsibility"

■ Section 2.4.4, "Importing the Employee"

■ Section 2.4.5, "Granting Access to Audience and Administration Tabs"

■ Section 2.4.6, "Updating Group Access"

2.4.1 Creating the Employee
The first step in creating a user is creating the employee in HRMS.  

Prerequisites
None

Steps
1. Log into Oracle Forms as HRMS Manager Responsibility. 

2. Navigate to People > Enter & Maintain.

3. In the Find Person box, select New.
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4. Enter the following information:

■ Last Name and First Name

■ Title 

■ Gender

■ Type = Employee

■ Social Security # (will be checked against existing SS#)

■ Birth Date

5. Save your work. 

A confirmation will appear in the lower left corner of the window.

6. Select Assignment and enter the following: 

■ Organization

■ Team/Group

■ Location 

■ Supervisor

If a dialog box with Update and Correction buttons displays, select Correction 
to revise existing data and Update to create a new record.

7. Save your work. 

A confirmation will appear in the lower left corner of the window.

8. Select Yes to use the new location.

9. Save your work. 

2.4.2 Defining a User by Adding Responsibilities 
After creating the employee in HRMS, you can add responsibilities to it.  

Based on your functional requirements, add one or more of the following 
responsibilities to your user. 

Prerequisites
■ Employee is created
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Steps
1. Log into Forms with System Administrator responsibility.

2. Navigate to Security > User > Define. 

The Users form opens. 

3. In the User Name field, enter a name. 

4. In the Responsibilities block, assign the appropriate responsibilities to the 
Implementation User.  

– General Ledger Super User

– HRMS Manager

– Inventory

– CRM Administrator

– Oracle Marketing Administrator

– Oracle Marketing Super User

– Oracle Marketing User

– Oracle Marketing Audience Workbench

– Oracle Marketing Campaign Workbench

– Workflow User Web Applications

– System Administrator

– Oracle Receivables 

– Oracle Payable 

– Advanced Pricing

– Receivables Manager

5. Save your work. 

For more information about creating Marketing users see:

■ Section 4.1.1, "Setting up Campaign Users"

■ Section 6.1.1, "Setting Up Audience Users"
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2.4.3 Setting the Default Application and Responsibility
Use the following procedure to assign a default application and default 
responsibility to the Implementation user: 

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator responsibility. 

1. Navigate to Security > Profile > System.

2. In the Find System Profile Values Form, at User Level, search for the user that 
will be assigned to this application and responsibility. 

3. In the Profile field enter JFT%DEFAULT%.

4. Select Find. 

5. At user level set the JTF_PROFILE_DEFAULT_APPLICATION to 690.

6. At user level set the JFT_PROFILE_DEFAULT_RESPONSIBILITY TO 21706 
(Oracle Marketing Super User). 

7. Save your work.

2.4.4 Importing the Employee
Use the following procedure to Import the employee as a Resource. 

Prerequisites
Employee exists

Steps
1. Log in to Oracle Forms with CRM Administrator responsibility.

2. Navigate to Resource Manager > Maintain Resources > Import Resources.

3. Locate the employee.

4. Enter employee’s name in the name fields

5. Select Search.

6. Select Create Resource.
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7. Click OK to accept default values.

8. Click Save Resource (record the transaction number).

2.4.5 Granting Access to Audience and Administration Tabs
Using this procedure, you will specify Roles and Groups. This step is required for 
users that need access to the Audience and the Administration tabs. 

Prerequisites
None

Steps
1. Navigate to Resource Manager.

2. Select the user as the resource.

3. Click Details.

4. On the Roles tab, select a role type of Sales and a Role of Sales Representative.

5. On the Group tab, select a group with Usages of Sales and TeleSales and Oracle 
Marketing. 

6. Make sure that the Group Member Role Sales Representative is associated to 
the above group on the resource details screen.

7. Save your work. 

2.4.6 Updating Group Access
Run the Concurrent Program AMS: Group Access Refresh to finish the process of 
creating the Implementation user. 
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2.5 Understanding and Setting Up Conditional Dependencies
Oracle Marketing’s conditional dependencies can be categorized as follows:

■ Optional Marketing and Partnering Enhancements: Additional modules that 
are implemented along with Oracle Marketing that are part of the Oracle 
Marketing and Partnering product family. 

For example, you can purchase Oracle Trade Management (which is part of the 
Oracle Marketing and Partnering family of applications) to implement along 
with Oracle Marketing. This is an optional component that enables advanced 
budgeting, claims, claims settlement, and trade planning. 

■ Optional Integrations: Applications implemented in addition to Oracle 
Marketing. Any application that is not part of the Oracle Marketing and 
Partnering product family. 

For example, Oracle iStore can be implemented along with Oracle Marketing. 
Used in conjunction with Oracle Marketing, iStore provides a Web storefront 
for online Web advertisement and execution. This functionality is optional, is 
not required for Oracle Marketing to function properly, and is therefore 
considered an optional integration.

2.5.1 Optional Marketing and Partnering Enhancements 
When implementing basic Oracle Marketing, you can optionally implement 
additional Marketing and Partnering applications.  

The following can be implemented with Oracle Marketing: 

■ Section 2.5.1.1, "Oracle Trade Management"

■ Section 2.5.1.2, "Oracle Partner Management"

■ Section 2.5.1.3, "Oracle Leads Management"

■ Section 2.5.1.4, "Oracle Content Manager"

2.5.1.1 Oracle Trade Management
Designed for the consumer goods sector, Oracle Trade Management provides 
additional B2B functionality used to: 

■ Control costs related to promotions

■ Track deals made with retailers, distributors or partners 

■ Process claims and deductions 
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■ Automate and track funds management and promotional spending

For Oracle Trade Management implementation details, see the Oracle Trade 
Management Implementation Guide.

2.5.1.2 Oracle Partner Management
Oracle Partner Management assists an organization in maintaining, tracking, 
managing, and communicating with its partners. When implemented with the rest 
of the Oracle E-Business Suite, you can manage leads, track and sharing 
opportunities with partners, forecast sales, manage partner and customer 
information, send outbound information, and calendar activities, tasks and notes.

For Oracle Partner Management implementation details, see the Oracle Partner 
Management Implementation Guide. 

2.5.1.3 Oracle Leads Management
Oracle Leads Management enables you to automate and optimize prospect-to-sales 
conversion across the enterprise. Leads Management provides a staging area for all 
prospect leads for data quality processing, prioritization and distribution, enterprise 
review, and conversion. When implemented in conjunctions with the rest of the 
Oracle E-Business Suite, Oracle Leads Management enables you to effectively 
convert prospects into sales by tracking lead activity,  aging, and closure.

For more information see the Oracle Leads Management Implementation and 
Administration Guide.

2.5.1.4 Oracle Content Manager
Oracle Content Manager (OCM) is the content management system for Oracle 
Marketing. By providing content management building blocks, Oracle Marketing 
stores the following content in OCM. 

Note: Oracle Trade Management must be purchased separately.

Note: Oracle Partner Management must be purchased separately.

Note: Oracle Leads Management must be purchased separately.
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■ Attachments: Stores all attachments for cover letters. When a user adds 
attachments to a cover letter, by default they are created in this directory. 

■ Marketing Cover Letters: Stores Fulfillment Cover Letters (also referred to as 
Templates) used in Oracle Marketing. When a user is creating a cover letter, he 
or she has an option to pick this directory as the location for his cover letter 
content item. The appropriate option in this drop-down is: OMO Directory and 
all its subdirectories excluding Requests subdirectory. 

■ Queries: Stores all the fulfillment Queries defined in Oracle Marketing. When a 
user creates a custom fulfillment query using the Oracle Marketing Admin 
screens, by default the content is stored in this directory. 

■ Deliverables: Stores all deliverable email content. When a user creates email 
content for the marketing deliverable object, by default they are created in this 
directory. 

OCM has a central repository that manages folders, versions, and translations, and 
enables an organization to work on content with associated workflows. 

For more information about using OCM in the Campaign Workbench, see 
Section 5.2.4, "Administrating Content in the Campaign Workbench".

2.5.2 Optional Integrations
Optionally, Oracle Marketing can be integrated with a variety of other applications 
to extend its functionality. The following is a list of common integration points for 
Oracle Marketing:

■ Section 2.5.2.1, "Integrating Oracle Data Mining and Oracle Marketing"

■ Section 2.5.2.2, "Integrating Oracle Marketing and Oracle Sales Online"

■ Section 2.5.2.3, "Integrating Oracle Marketing and Oracle Telesales"

■ Section 2.5.2.4, "Integrating Oracle Marketing and Oracle Interaction Center 
(Scripting)"

■ Section 2.5.2.5, "Integrating Oracle Marketing and Oracle iStore"

■ Section 2.5.2.6, "Integrating Oracle Marketing and Oracle Discoverer"

■ Section 2.5.2.7, "Integrating Oracle Personalization and Oracle Marketing"

2.5.2.1 Integrating Oracle Data Mining and Oracle Marketing
Data Mining is an analytic feature providing a complete enterprise view of the 
Oracle Marketing business flows. Using extensive analytical and reporting 
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capabilities, all personnel within and organization can monitor the status of 
marketing activities in real time. Data Mining functionality is included in an Oracle 
Marketing license. However, the decision to implement fully is optional. 

2.5.2.2 Integrating Oracle Marketing and Oracle Sales Online
Oracle Sales Online (OSO) is an application designed for field sales representatives, 
sales managers, and executives. The application provides a complete set of tools 
that enables sales teams to manage the sales cycle from beginning to end. OSO 
supports the key functions of the sales cycle, with features such as:

■  Comprehensive customer management

■  Lead and opportunity management

■  Forecasting

■  Quote generation

■  Order placement

■  Sales methodologies

When integrated with Oracle Marketing, the critical link in the Campaign to Cash 
business flow is fulfilled, providing the information to analyze the success of 
company campaigns. 

When integrated, you can also create Sales campaigns as a Sales tool to quickly 
create and execute cross sell/up sell campaigns that target existing customers. 

For more information about implementing and using Oracle Sales Online, see Oracle 
Sales Online documentation.

2.5.2.3 Integrating Oracle Marketing and Oracle Telesales
Oracle Telesales (OTS) is an application designed for inside sales professionals, 
inbound telesales agents, or outbound telemarketing agents. OTS offers a 
multi-channel selling solution that manages leads, opportunities and forecasts 
across all sales channels: over the phone, the Web or through mobile devices. It 
provides a set of tools to help the inside sales team manage the sales cycle from 
prospecting for customers to booking the order. 

When integrating Oracle Marketing and Oracle Telesales, marketers can use the 
Oracle Marketing List Import feature to assign lists to TeleSales Agents. A TeleSales 
agent can then use the Universal Work Queue to access the list of customers 
assigned to them by the marketing team. For implementation details see 
Section 6.2.8, "Implementing List Import for Universal Work Queue". 
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2.5.2.4 Integrating Oracle Marketing and Oracle Interaction Center (Scripting) 
Oracle Interaction Center is an integrated series of products designed for consistent 
and effective handling of customer interactions. It provides sophisticated routing, 
media queuing and enhanced screen pops integration. Interaction center reduces 
the cost, complexity and risk associated with deploying applications. Interaction 
Center consists of the following modules:

■ Advanced Inbound

■ Advanced Outbound

■ email Center

■ Interaction Center Intelligence

■ Scripting 

■ Universal Work Queue

Oracle Scripting is a set of tools to facilitate the process of gathering of information 
through guided decision flows, consisting of text, questions, and answers. Oracle 
Scripting is composed of several components: the Script Author, the Scripting 
Engine, the Scripting Administration console, and the Survey Administration 
console. 

2.5.2.5 Integrating Oracle Marketing and Oracle iStore
When Oracle Marketing and Oracle iStore are integrated, you can use the 
eMerchandising module of Oracle Marketing to personalize Web advertisements 
for Oracle iStore. Using this functionality, a marketer can make recommendations 
for customers. Store personalization and customer-specific recommendations are 
accomplished through specialty store Web postings from eMerchandising and store 
Event capture.

2.5.2.6 Integrating Oracle Marketing and Oracle Discoverer
Oracle Discoverer is a business intelligence/analytics application that is often 
implemented with Oracle Marketing for list management purposes.

When implemented, a Discoverer end user layer (containing Oracle Marketing 
business areas) can be launched from within the Oracle Marketing application. 
Using this interface, a list manager can create and manage workbooks and 
worksheets needed for list management purposes. 

You can create a list of person and organizational contacts -- and the organization 
information can be part of the attribute in organization contact list. When creating a 
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list from Discoverer, you will need to select a mandatory identifier, which is a 
constant key. The other fields including "include organization", "include email", etc. 
are optional depending on what kind of list you want to generate.

To implement Oracle Discoverer for Oracle Marketing purposes, use the procedures 
below. After performing these procedure, Oracle Discoverer launches with a single 
sign-on from within Oracle Marketing.

■ Section 2.5.2.6.1, "Setting Discoverer Profile Options"

■ Section 2.5.2.6.2, "Creating and Verifying Discoverer List Lookups"

■ Section 2.5.2.6.3, "Creating the Discoverer End User Layer"

■ Section 2.5.2.6.4, "Importing Discoverer EUL"

■ Section 2.5.2.6.5, "Running Concurrent Programs for Lists"

2.5.2.6.1 Setting Discoverer Profile Options   Set the following profile options.

Table 2–1 Discoverer Profile Options 

Option Required Level Setting Effect/Limitation

ICX: 
Discoverer 
End User 
Layer

Yes Site User Defined EUL prefix for Discoverer, usually 
EUL4.

ICX: 
Discoverer 
Launcher

Yes Site User Defined URL to launch Discoverer Web 
version.

ICX: 
Discoverer 
Viewer 
Launcher

Yes Site User Defined URL to launch Discoverer viewer.

ICX: 
Discoverer 
Use Viewer

Optional Site Yes/No Whether to use viewer instead Web 
Discoverer. Defaulted to No.

AMS: List 
Workbook 
B2C 
Marketing

Optional Site User Defined Workbook name convention prefix for 
B2C workbooks. The default is B2C. A 
blank convention prefix will result in 
more workbooks than you need in the 
LOV.
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2.5.2.6.2 Creating and Verifying Discoverer List Lookups   This procedure will populate 
the LOV for the List functionality.

AMS: List 
Workbook 
B2B 
Marketing 

Optional Site User Defined Workbook name convention prefix for 
B2B workbooks. The default is B2B. A 
blank convention prefix will result in 
more workbooks than you need in the 
LOV.

Table 2–2 Lookups for Lists 

Key Type Seeded Values Meanings

AMS_LIST_ ACT_TYPE User Employee List

List

Target group list selection type.

AMS_LIST_ DEDUP_ TYPE User List

Import Consumers

Import Organizations

Type of Deduplication Rules to be 
applied.

AMS_LIST_
GENERATION_ TYPE

System Incremental

Standard

Update

Update No Purge

New entries added, old entries not 
deleted, entries not updated.

All old entries deleted, new entries 
added.

New entries added, old entries not 
meeting criteria deleted, entry 
information updated.

New entries added, old entries retained, 
entry information updated

AMS_LIST_ ROW_ 
SELECT_ TYPE

System Nth Record

Random

Standard

How to select rows during list 
generation. Standard is top down 
selection.

AMS_LIST_ SEGMENT_ 
STATUS

User Archived

Available

Cancelled

Draft

Expired

Archived

Available

Cancelled

Draft

Expired

Table 2–1 Discoverer Profile Options (Cont.)

Option Required Level Setting Effect/Limitation
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AMS_LIST_ SEGMENT_ 
TYPE

System Workbook

SQL

Two types of segments supported. Based 
on a Discoverer workbook or an SQL 
statement.

AMS_LIST_ SELECTION_ 
ACTION

System Include

Exclude

Intersect

How each selection is added to the list. 
Exclude means that all entries that exist 
in the excluded list are removed from the 
current list. Intersect causes the current 
list to become a list of only those entries 
which are on the intersected list and the 
current list.

AMS_LIST_ SELECTION_ 
TYPE

System Segment

Workbook

Import List

List

SQL

Segment

Workbook

Import List

List

SQL

AMS_LIST_ STATUS System Archived

Available

Cancelled

Draft

Executed

Executing

Generating

Locked

New

Pending

Reserved

Scheduled

Validated

Validating

Archived

Available

Cancelled

Draft

Executed

Executing

Generating

Locked

New

Pending

Reserved

Scheduled

Validated

Validating

AMS_LIST_ TYPE System Manual List

Standard List

Suppression List

Target Group

List of possible list types. Note where 
these appear in the program.

Table 2–2 Lookups for Lists (Cont.)

Key Type Seeded Values Meanings
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2.5.2.6.3 Creating the Discoverer End User Layer  Use the procedures below to create a 
database user and give the appropriate Applications (APPS) grants to that user. 
After performing this procedure, the End User Layer (EUL) for Discoverer is set for 
all APPS. 

For specific information about Installing Oracle Discoverer, see Oracle iAS9i 
Installation Guide and iDS9i Installation Guide. 

To create the Oracle Marketing EUL for Discoverer use the following procedure:

Prerequisites
■ Oracle Discoverer is installed

■ Oracle Marketing is installed

Steps
1. Open a DOS prompt. 

2. Navigate to the directory where Oracle Discoverer Admin edition is installed. 
For example, if Oracle Discoverer Admin is installed in D:\orant\discvr4, type:

a) d:

b) cd \orant\discvr4

3. If the database schema has not previously been created, run the following: 

dis4adm.exe

/CREATE_EUL

/APPS_MODE

/CONNECT system/manager@tst115rw (enter in your password and TNS 
Name entry in place of “manager” and “tst115rw” respectively).

/USER eul4_us

/PASSWORD eul

/DEFAULT_TABLESPACE user_data (enter your tablespace names in 
place of “user_data”)

/TEMPORARY_TABLESPACE temp (enter your tablespace name in place 
of “temp”)

 /SET_EUL_LANGUAGE US
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/APPS_GRANT_DETAILS apps/apps (enter your Oracle Applications 
Foundation username and password for "apps" and “apps” respectively).

/SHOW PROGRESS

4. If the database schema has previously been created, run the following: 

dis4adm.exe

/CREATE_EUL

/APPS_MODE

/CONNECT eul_us/eul_us/eul@tst115rw (The “eul_us” should be the 
name of the database schema previously created.)

/APPS_GRANT_DETAILS apps/apps (username and password)

/SHOW_PROGRESS

2.5.2.6.4 Importing Discoverer EUL  Use the following procedure to import the Oracle 
Marketing End User Layer (EUL) that contains the Oracle Marketing Business 
Areas. Once imported, the Oracle Marketing Business Areas are available for List 
Management. Alternatively, you may manually import the EEX files from the 
Oracle Discoverer Admin interface.

■ For more information on functional Business Areas see Oracle Marketing User 
Guide. 

■ For more information on how to manually import see Oracle Discoverer 
Administration Guide.

To import the Discoverer EUL follow the procedure below: 

Prerequisites
■ MKS Toolkit is implemented

Steps
1. Start the Korn Shell (MKS Toolkit).

2. From the NT box where Discoverer Admin is installed map the $AU_
TOP/discover directory or copy the eex files to the NT box and specify this 
directory as 'topdir' directory when running the utility. 

3. APPS User/Responsibility must be specified for import. The imported 
workbooks will be saved under the specified APPS User. 
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4. On the new EUL make sure the APPS User does have full access privileges to 
use Discoverer Admin Edition.

5. Use the parameter file so that you don't have to specify all values on the 
command line.

      sh adupdeul.sh 
                   connect=<username/password{@<two_task>} 
                      resp=<APPS responsibility name> 
                    gwyuid=<APPS GWYUID> 
                    fndnam=<APPS FNDNAM> 
                  secgroup=<APPS responsibilty security group> 
                    topdir=<top level directory where discoverer 
                                            files are available> 
                 eulprefix=<EUL prefix (for ex EUL4 for EUL4_US)> 
                  language=<NLS language code> 
                   eultype=<OLTP|EDW>                   default OLTP 
               {   parfile=<name of parameter file>             } 
               {      mode=<COMPLETE or DRIVER> default DRIVER> } 
               {    driver=<list of driver files to be loaded 
                            separated by a "," (comma)> } 
               {   exedir=<directory where discoverer executables are 
                           located> } 
               {   logfile=<log file name, default adupdeul.log> } 

 Example
1. Copy the directory $AU_TOP/discover/US to C\bblock\import\au_

top\discover\US. 

2. With Admin Edition connect as EUL owner EUL4_US/EUL@mydb and grant 
privileges for Admin Edition to apps user SYSTEST.

3. In Korn Shell CD C\bblock\import. 

4. Specify parameter values in a parameter file, for example: 

         parfile.lst 
         eulprefix=EUL4 
         exedir=D/orant/discvr4 
         mode=COMPLETE 
         topdir=C/bblock/import/au_top/discover 
         eultype=OLTP 
         fndnam=APPS 
         gwyuid=APPLSYSPUB/PUB 
         resp="Business Views Setup" 
         secgroup="Standard" 
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5. Start the full import, all eex files in the topdir. 

         sh adupdeul.sh 
         connect    = systest/welcome98@mydb
         parfile   = parfile.lst 
         language  = US 
         logfile   = imp_010314_EUL4_US_mydb.log 

Or start the import for just the files of specified ARU copy file drivers. 

         sh adupdeul.sh 
         connect    = systest/welcome98@mydb
         parfile   = parfile.lst 
         language  = US 
         mode      = DRIVER 
         driver    = c1641981.drv 
         logfile   = imp_010314_EUL4_US_mydb.log 

6. For the first time to import, we suggest you to use mode=COMPLETE.

7. Set the following ICX profiles in Oracle Applications at the responsibility level:

■ ICX _PROFILE ICX_DISCOVERER_LAUNCHER 

URL that points to the Web Discoverer Server

Example

http://machinename.domain/diswb4/html/discolaunch.htm?Connect=[A
PPS_SECURE]

■ ICX _PROFILE ICX_DISCOVERER_VIEWER_LAUNCHER 

URL that points to the Discoverer Viewer

Example

http//machinename.domain/discoverer4i/viewer?cs=[APPS_SECURE]

■ ICX_PROFILE ICX_DEFAULT_EUL

This in combination with the language code make up the EUL owner at 
runtime. Example EUL4 (not EUL4_US)

2.5.2.6.5 Running Concurrent Programs for Lists  Run the following Concurrent 
Programs for Lists: 
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2.5.2.7 Integrating Oracle Personalization and Oracle Marketing
Implementing Oracle Personalization (OP) is an optional Oracle Marketing 
enhancement used for Web product recommendations (referred to as Web dynamic 
recommendation.) OP is an automated recommendation engine that takes in 
customer data and returns an intelligent product recommendation. Using OP, you 
can maximize transactions through intelligent product cross-selling and up-selling.  

Table 2–3 Concurrent Programs for Lists 

Concurrent Manager Required Description

AMS : Refresh Party Market 
Segments

Optional Generates a list of parties in the segment. This 
program also updates the size information for all 
segments so a history of segment sizes may be 
maintained.

AMS : Generate 
Suppression list

Optional Updates and maintains organization defined 
suppression lists. This is in addition to seeded 
suppression lists.

AMS : Purge Target Group Optional After a target group has been generated and 
used, this program lets a user purge the list 
entries. 

AMS : Purge Imported List Optional During the import process, the user may specify 
an expiration date or number of uses for a list. 
This program removes those entries whose 
expiration date has passed or number of uses 
reached.

Optional Parameter: force_purge_flag. This 
parameter indicates whether to purge a record 
regardless of the associated campaign status. 
The default value is No.

Workflow Background 
Process

Required The System Administrator must run this 
program. It populates List generation and target 
Group Generation data. 

Parameters:

Item Type: AMS List Generation Process 
Deferred: 

Yes Process Timeout : yes

Process Stuck: yes 

Ignore Minimum and Maximum Thresholds
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OP makes product recommendations based on:

■ Customer

■ Customer purchase history

■ Product customer is currently viewing 

OP is particularly relevant for companies that: 

■ Have a large customer base

■ Have a large number of products (or SKUs)

■ Have an online store that tracks customer browsing and purchase information

For more information about implementing Oracle Personalization see the 
OracleMetaLink release note Integrating Oracle Application Server Personalization with 
Oracle Marketing. 
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3
Implementing and Administrating Oracle

Marketing Common Components

This topic group describes implementation and administration procedures for  
common components within Oracle Marketing. 

Topics include:

■ Section 3.1, "Common Component Overview"

■ Section 3.2, "Implementing Common Components"

■ Section 3.3, "Administrating Common Components"
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3.1 Common Component Overview
As the Oracle Marketing implementor and/or administrator, you are responsible 
for setting up and maintaining the common components within the application. 
Common component is defined as a feature or functional behavior that applies to 
the entire application. 

3.2 Implementing Common Components
The following common component setups must be completed:

■ Section 3.2.1, "Setting Common Component Profiles"

■ Section 3.2.2, "Running Concurrent Programs for Common Components"

■ Section 3.2.3, "Implementing Marketing Users"

■ Section 3.2.4, "Implementing Fulfillment for Oracle Marketing"

3.2.1 Setting Common Component Profiles
Set the following profile options as they apply to your implementation: 
  

Table 3–1 System Profiles for Common Components 

Option Required Level Setting Effect/Limitation

AMS : 
System 
Timezone

Yes Site Select the 
timezone the 
central server 
is in.

This profile specifies the default 
timezone for the implementation. 
Timezones are defined in HZ_
TIMEZONES.

AMS : 
Admin 
Group

Yes Site Select from 
any group 
defined in JTF 
Resource 
Groups

Resources that are part of this group 
will have full access to all 
Campaigns, Events, and other 
marketing objects. Note that this 
should be a single level group.

AMS : 
Default 
Currency 

Yes Site Select from 
currencies 
defined in 
FND_ 
CURRENCIES

This becomes the default functional 
currency. All transactions will be 
converted and stored in this 
currency. This will be the default 
currency for Currency LOV.
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AMS : 
Currency 
Conversion 
Type

Yes Site

The 
User 
level 
should 
not be 
selecte
d.

Corporate, 
Spot or other 
conversion 
type defined 
in GL

If the functional currency of the 
organization and the transactional 
currency of the marketing object are 
different, this conversion will be 
used. 

AMS :  
Source 
Code Date 
Format

Yes Site Any valid 
date format

Used in the generation of source 
codes.

AMS : 
Source 
Code 
Sequence 
Length

Yes Site Maximum 
field length is 
30.

Source Code includes Geography 
code, Month code, Activity code, 
Source code digits and Suffix. See 
Source Codes.

AMS : UOM 
Area

Yes Site Depends on 
UOM Setup

Displays fields that use UOM (for 
example, area in square feet).

AMS : UOM 
Length

Yes Site Depends on 
UOM Setup

Displays fields that use UOM (for 
example, length in feet).

AMS : UOM 
Quantity

Yes Site Depends on 
UOM Setup

Displays fields that use UOM (for 
example, units in each).

AMS : UOM 
Time

Yes Site Depends on 
UOM Setup

Displays fields that use UOM (for 
example, time in minutes).

AMS : 
Profile 
Search Set 
Size

Yes User Numeric Indicates the number of rows 
displayed in selection windows.

AMS : 
Upgrade 
Complete

Optional Site Yes/No Set this profile to No if the upgrade 
has run once already.

AMS : 
Validation

Optional User 0-100 This profile option affects the 
validation severity at the database 
level. A value of 100 (Maximum 
value of 100) would cause the APIs 
to validate the passed data very 
stringently.

Table 3–1 System Profiles for Common Components (Cont.)

Option Required Level Setting Effect/Limitation
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3.2.2 Running Concurrent Programs for Common Components
Run the following concurrent programs when implementing core components for 
Oracle Marketing. 

OSO : 
Minimum 
search 
string 
length

Optional Site or 
User

User Defined The default setting is 0. This profile 
determines the number of characters 
that must be entered before 
performing a search. 

OSO : 
Search Lead 
Wildcard

Optional Any Yes/No If set to Yes, the wildcard (%) will be 
allowed as the first character in a 
search string. If set to No, and the 
wildcard is entered as the first 
character, the system will give the 
user an error message.

AMS : 
Grace 
Period in 
Days

Yes User User/Org 
determined 
number of 
days

When automatic reconciliation of 
Budgets is performed, this grace 
period is checked. If the marketing 
object is older than the ending date 
plus the grace period, any remaining 
funds associated with the marketing 
object are returned to the Budgets 
they were drawn from.

This also sets the number of days 
after the completion of a campaign 
for the concurrent manager to delete 
the target group entries from the 
AMS_LIST_ENTRIES table default is 
30 days.

JTF :  Home 
Page File 
Name

Optional Site or 
Appli
cation

User Defined. Enter a file name of the jsp file (for 
example, jtfhomepage.jsp). If no 
value is supplied, a generic 
information page is displayed. If a 
file is supplied, it will be displayed 
on the homepage.

Table 3–1 System Profiles for Common Components (Cont.)

Option Required Level Setting Effect/Limitation
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3.2.3 Implementing Marketing Users
Oracle Marketing does not ship with seeded users. It does, however, ship with 
seeded responsibilities. Based on your business requirements, you will create users 
(that contain a collection of responsibilities) to perform certain functions within the 
application. 

The following table lists several different examples of users (and their associated 
collection of responsibilities) that are relevant for an implementation. User creation 
is highly configurable; you can create any user types necessary. 

Table 3–2 Concurrent Programs for Common Components 

Concurrent 
Manager Required Responsibility Description

AMS Group 
Access 
Refresh

Yes Oracle 
Marketing 
Administrator

Updates denormalized tables with group 
information. Should be run on a periodic 
basis according the organization’s Business 
Rules. Changes made to the resource 
groups will not take effect in the 
application’s security until this program is 
run.

AMS Team 
Access 
Refresh

Yes Oracle 
Marketing 
Administrator

Updates denormalized tables with team 
information. Should be run on a periodic 
basis according to the organization’s 
Business Rules. Teams added to marketing 
objects will not gain access to the marketing 
objects until program is run.

AMS: Portal 
Cache 
Daemon

Yes Oracle 
Marketing 
Administrator

Populates the Marketing subtab on the 
Home tab.

Load 
Geographic 
Hierarchies

Yes CRM 
Administrator

This program must be run each time that 
the geographies are changed.

AMS Load 
Inventory 
Categories

Yes Inventory Loads categories from the MTL schema to 
the AMS schema denormalized tables. This 
program should be run if and when a new 
category is created in Inventory.
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Table 3–3 Oracle Marketing Suggested Users 

User Type Responsibilities Marketing Functionality

Marketing Super User Oracle Marketing Super 
User

This user has the ability to create campaigns, 
events, and programs. With access to all 
basic tabs, this user can perform most 
marketing activities, planning, and 
budgeting. 

Because this user does not have the 
Audience Workbench User Responsibility or 
the Campaign Workbench User 
Responsibility, the Audience Workbench 
and Campaign Workbench are not visible to 
this user. 

In addition to having access to all basic tabs, 
this user also has the ability to administrate 
marketing activities. This user will create 
Rules for approvals but will not have 
approval functionality.

List Manager Audience Workbench 
Super User

This user administrates data sources and 
configures  corresponding customer profile 
attributes that are used by marketers to 
create lists. 

List User Audience Workbench 
User

Uses the Audience Workbench to create and 
manage lists. 
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Campaign Manager Campaign Workbench 
Super User

This user performs administrative and setup 
activities to support the schedule creation, 
maintenance and follow up processes. They 
create and maintain Schedule Templates that 
are used by the end user to create Campaign 
Schedules. Super User functions also include 
creation and maintenance of Web 
Placements to be used for Web Schedules. 

Marketing Administrator Oracle Marketing 
Administrator

Campaign Workbench 
Super User

Audience Workbench 
Super User

Oracle Marketing Super 
User

Oracle Marketing 
System Administrator

Oracle Fulfillment Super 
User

Oracle Advanced 
Outbound 
Administrator

This user is the overall marketing 
administrator. 

This user creates metrics and metric 
templates, activity templates, custom setups, 
marketing mediums, fulfillment, locking, 
fatigue, and mandatory rules, user statuses, 
data sources, targets, etc.

Table 3–3 Oracle Marketing Suggested Users (Cont.)

User Type Responsibilities Marketing Functionality
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3.2.4 Implementing Fulfillment for Oracle Marketing
Oracle Marketing uses the following fulfillment channels for schedule execution:

■ Email: Distributes email blast campaigns to a list of customers and/or 
prospects. 

■ Fax: Distributes fax blast campaigns to a list of customers and/or prospects. 

■ Print: Provides print fulfillment capabilities for direct marketing 
campaigns. 

For events, email is the only fulfillment channel. This is established using 
fulfillment rules. For more information, see Section 3.2.4.13, "Setting Up Fulfillment 
Rules for Events".

Implementation Super User System Administrator

Campaign Workbench 
Super User

Audience Workbench 
Super User

Oracle Marketing Super 
User

System Administrator

CRM Administrator

Inventory Administrator

Oracle Content Manager

General Ledger Super 
User

HRMS Manager

Workflow User Web 
Applications

Oracle Receivables 

Oracle Payable 

Advanced Pricing

Receivables Manager

1-1 fulfillment 
Administrator.

This user is the overall implementation user 
that has the ability to perform all setup, 
implementation, and administrative tasks. 

This user has all administrative and 
implementation privileges including: user 
creation, profile settings, application 
defaults, etc. 

Table 3–3 Oracle Marketing Suggested Users (Cont.)

User Type Responsibilities Marketing Functionality
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The following sections describe setups for fulfillment in Oracle Marketing.

■ Section 3.2.4.1, "Setting Up Oracle Content Manager for Fulfillment Purposes"

■ Section 3.2.4.2, "Assigning JTF Fulfillment Admin Role to Users and Groups"

■ Section 3.2.4.3, "Setting Fulfillment Profiles"

■ Section 3.2.4.4, "Setting Up Collateral Content"

■ Section 3.2.4.5, "Understanding Fulfillment Queries for Cover Letters"

■ Section 3.2.4.6, "Seeded Campaign and Event Fulfillment Queries"

■ Section 3.2.4.7, "Associating Seeded Fulfillment Queries with Templates"

■ Section 3.2.4.8, "Creating a Custom Fulfillment Query"

■ Section 3.2.4.9, "Creating Content Types for Cover Letters"

■ Section 3.2.4.10, "Creating a New Cover Letter"

■ Section 3.2.4.11, "Creating a Click-Through Destination for a Cover Letter"

■ Section 3.2.4.12, "Adding Images to a Template"

■ Section 3.2.4.13, "Setting Up Fulfillment Rules for Events"

3.2.4.1 Setting Up Oracle Content Manager for Fulfillment Purposes
Oracle Content Manager (OCM) is the content repository for Oracle Marketing. You 
must have the appropriate permissions granted to your user in order to create 
content items in OCM folders. For more information, see the Oracle Content Manager 
Implementation Guide. 

To implement OCM for Marketing use the following guidelines: 

■ Create OCM Directories. See the Oracle Content Manager Implementation Guide 
for specific procedures. 

■ Grant Directory Privileged to Users and Groups. See the Oracle Content Manager 
Implementation Guide for specific procedures. 

■ Setup Approvals. See the Oracle Content Manager Implementation Guide for 
specific procedures.
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3.2.4.2 Assigning JTF Fulfillment Admin Role to Users and Groups
Assign the JTF Fulfillment Admin role to Fulfillment users and administrators. 
This role gives access to the Fulfillment administration console for setting up 
fulfillment, creating master documents and viewing request history. 

This role only needs to be assigned to Marketing users if they will also be 
administering Fulfillment activities (for example, setting up Fulfillment servers, 
agents, etc.). Typically, only a Marketing Administrator is involved in these 
activities. Additionally, if setting up Oracle One-to-One Fulfillment for Events and 
Campaigns, the user must have this role. 

Use the following procedure to assign this role to a user:

Prerequisites
None

Steps
1. Log in to Oracle Forms with CRM Administrator responsibility.

2. Navigate to Resource Manager > Maintain Resources > Import Resources.

3. Select the employee as the resource.

4. Select Details.

5. In the Roles tab:

If the user is to have access to the Audience and/or Administration tabs, add a 
role type of Sales and a Role of Sales Representative. For Oracle One-to-One 
Fulfillment: 

a. Add JTF_FM_ADMIN role. 

b. Assign the Fulfillment Resource Group.

c.  If the user is the default approver for marketing objects, add a Role of 
Default Marketing Approver.

d. If the user is an approver for marketing objects, a Role of Marketing 
Approver. Multiple assignments of this Role are permissible.

6. Save your work. 
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3.2.4.3 Setting Fulfillment Profiles 
To enable Oracle One-to-One Fulfillment, set AMS: Enable Fulfillment to Yes at 
site level. Without setting this profile, fulfillment activities will not execute for 
Campaigns or Events. 

3.2.4.4 Setting Up Collateral Content
Marketing campaigns and events often require that some sort of collateral content is 
sent to potential customers and event attendees. Collateral content is defined in 
Oracle Marketing as any electronic marketing material fulfilled to customers 
through an automated process. This type of content is always outbound and 
typically requires a cover letter. 

Collateral content consists of:

■ Content Types: Provides a framework or structure for the cover letter. This 
content type can be re-used for various types of cover letters. 

■ Cover Letters: Represents the actual content for the outbound activity. Contains 
various content blocks (defined by the content type). Also contains a body 
(defined by the query). 

■ Queries: SQL statements that collects data from the database - the retrieved 
data is merged into the cover letter using personalization tags (which are 
defined by the query). 

Marketers can only view cover letters that they have access to. Therefore, they must 
be given appropriate cover letter folder privileges. Folder privileges are handled 
through Oracle Content Manager’s folder security.

3.2.4.5  Understanding Fulfillment Queries for Cover Letters
A fulfillment query is a SQL statement that collects data from the database. This 
data is merged into a template by using personalization tags defined by the query. 
The Query tags enable the template to dynamically fetch data. Query tags 
ultimately become SELECT statements that enable data to be retrieved from the 
database for the cover letter (template). 

A query serves two purposes. 

1. Determines which records meet the defined criteria. 

2. Determines which fields of those records are returned. The returned data is 
merged with a template to create a customized e-mail for each recipient.
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3.2.4.6 Seeded Campaign and Event Fulfillment Queries
For Campaigns and Events, Oracle Marketing ships with seeded queries that 
contain the related mail merge tags.

The following fulfillment queries for seeded for Campaigns: 

■ Marketing Simple Query: This query is designed to retrieve basic customer 
information from the AMS tables. 

– Query retrieves: title, first name, last name, pin code, party id, customer id, 
organization, e-mail, address, fax address, customer type, and source code. 

– Data is retrieved from the following tables: ams_list_entries, ams_act_lists, 
ams_campaign_schedules. 

■ Marketing Detailed Query: This query is designed to retrieve extensive 
customer information from the AMS tables. 

– Query retrieves: title, first name, last name, pin code, campaign source 
code, offer code, party id, customer id, list header id list id, address line1, 
address line2, city, state, zip code, country, fax address, phone, e-mail 
address, customer type.

– Data is retrieved from the following tables: ams_list_entries, ams_act_lists,  
ams_campaign_schedules, ams_campaigns,  ams_act_offers.

The following fulfillment queries are seeded for Events:   

■ Invitation

■ Registration

■ Venue Change

■ Date Change

■ Cancelled

If Oracle Marketing’s seeded fulfillment queries do not meet your business 
requirements, then you can create custom queries. For more information see 
Section 3.2.4.8, "Creating a Custom Fulfillment Query".

3.2.4.7 Associating Seeded Fulfillment Queries with Templates
To create a query for a template, follow the procedure below:

Prerequisites
None
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Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > Fulfillment > Template. 

3. Select Create. 

4.  In the General Information section fill in the following:

■ Name: Provide a name for the template. 

■ Owner: Select an owner for the template. 

■ Directory: Choose cover letter. 

■ Character Set: Indicate a character set for this template. 

5. In the content creation frame choose a Query type. Select the flashlight icon to 
launch the Search and Selector. 

6. Choose either Marketing Simple Query or Marketing Detail Query. 

If a custom Query has been created, it can be selected here. 

7. Select Apply to save your work. 

3.2.4.8 Creating a Custom Fulfillment Query
To create a custom query, follow the procedure below:

Prerequisites
AMS: Enable Fulfillment is set to Yes

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > Fulfillment > Query. 

3. Select Create Query. 

4. Add a Query name. 

5. Add a Query Description.

6. Add specific SQL statements to meet your custom query business requirements.

When creating SQL statements for a custom Query it is required that you 
include the bind variables found in the Marketing Simple Query and Marketing 
Detail Query. 
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– Marketing Simple Query bind variables:  :schedule_id

– Marketing Detailed Query bind variables:  :schedule_id 

7. Select Apply to save your changes. 

The Query is not active until the status is Approved. 

3.2.4.9 Creating Content Types for Cover Letters
Oracle Marketing seeds a structure for cover letters. Being the administrator, you 
can modify the structure by defining different attributes for it. For example, you can 
modify the footer, header, images for the seeded content type. 

You can also map content types to specific channels. For example, you can map to 
email, fax, or print fulfillment channels. Based on the mapped templates, end users 
can search existing cover letters of the particular types you’ve enabled. 

Content Types can bet set as active or inactive. Inactive content types can’t be used 
for content item creation.  

The following content types are seeded for cover letters: 

■ Basic Fulfillment Cover Letter: Contains body, content block, attachments. Does 
not contain headers or footers.  

■ Fulfillment Cover Letter: Has a complete structure. Contains headers, body, 
content block, footers, and attachments. 

Figure 3–1 Administrating Cover Letters Content Types -- Setup Flow

To set up content types for cover letters, use the following procedure:
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Prerequisites
Query is created

Steps
1. Login as a user that has the Oracle Marketing Administrator responsibility. 

2. Navigate to Administration > Marketing > Fulfillment > Content Type.

3. Select Create.

4. In the Create Content Type page, enter the following details:

■ Name: Enter a logical name for this content type. For example, if creating a 
content type for fax only,  a logical name would we: Fax Only Standard. 

■ Status: If the status is active, the content type is available for use in the 
cover letter. Otherwise, you will not be able to select it when creating the 
cover letter. 

■ Content Group: Using the provided checkboxes, select the appropriate 
channel for this content type. For example, if the content type is created for 
Fax only, place a check in the Fax checkbox. 

5. In the Header region, enter the following details:

■ Display: Using this checkbox, determine if the header is part the structure 
of the content type.

■ Header Block: Using the search icon, optionally select a default header 
block. The header block typically contains the company logo, and will be 
added to the main email body. 

– Updatable: If you want the ability to update this default when creating 
the actual cover letter, select Yes in this drop-down. Otherwise, select 
No. 

– Required: If you want the header block to be a required field when 
creating the cover letter, select Yes in this drop-down. Otherwise, select 
No. 

■ Header Image: Using the search icon, optionally select a default image for 
the header block. If using the header block for the company logo, you will 
select the image content here. 

– Updatable: If you want the ability to update the image default when 
creating the actual cover letter, select Yes in this drop-down. Otherwise, 
select No. 
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– Required: If you want the header block image to be a required field 
when creating the cover letter, select Yes in this drop-down. Otherwise, 
select No. 

6. In the Body region, you will select a query to be used for mail merge fields in 
the body of the cover letter: 

■ Query: Required field for an active content type. Can create content types 
without Query when the status is inactive. Using the search icon, select the 
appropriate query tag for this content item. For example, if this content 
item is for marketing emails, then you might select Marketing Simple 
Query. 

7. In the Content Blocks section, enter the following content block details:

■ Display: Using this checkbox, determine if the content block is part the 
structure of the content type.

■ Content Block: Using the search icon, select the appropriate content block 
for this content type. Content blocks can be created in OCM or the 
Deliverables component within Oracle Marketing. 

– Updatable: If you want the ability to update this default when creating 
the actual cover letter, select Yes in this drop-down. Otherwise, select 
No. 

– Required: If you want the header block to be a required field when 
creating the cover letter, select Yes in this drop-down. Otherwise, select 
No. 

8. In the footer region, enter the following details: 

■ Footer Block: Using the search icon, optionally select a default footer block. 
This can be any static non-personalizable content. 

– Display: Using this checkbox, you will determine if the footer block will 
be part the structure of the content type.

– Updatable: If you want the ability to update this default when creating 
the actual cover letter, select Yes in this drop-down. Otherwise, select 
No. 

– Required: If you want the header block to be a required field when 
creating the cover letter, select Yes in this drop-down. Otherwise, select 
No. 

■ Footer Image: Using the search icon, optionally select a default image for 
the footer block.   
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– Display: Using this checkbox, you will determine if the footer image 
will be part the structure of the content type.

– Updatable: If you want the ability to update the image default when 
creating the actual cover letter, select Yes in this drop-down. Otherwise, 
select No. 

– Required: If you want the footer block image to be a required field 
when creating the cover letter, select Yes in this drop-down. Otherwise, 
select No.

9. In the Attachments region, enter the following details: 

■ Display: Using this checkbox, you will determine if attachments are part the 
structure of the content type.

■ Attachments: Using the search icon, you are able to see all file attachment 
items in OCM repository. You can select any of them to be the default, if 
needed. 

– Updatable: If you want the ability to update the image default when 
creating the actual cover letter, select Yes in this drop-down. Otherwise, 
select No. 

– Required: If you want the footer block image to be a required field 
when creating the cover letter, select Yes in this drop-down. Otherwise, 
select No.

10. Select Apply. 

3.2.4.10 Creating a New Cover Letter
Once you have a query and a cover letter content type, you are ready to build the 
actual cover letter. The cover letter represents the actual content, whereas the 
content type simply provides a structure or framework for it. At times, your end 
users will perform this task. 

Prerequisites
■ Query is created

■ Content Type for the cover letter is created

Steps
1. Login as a user that has the Oracle Marketing Administrator responsibility. 

2. Navigate to Administration > Marketing > Fulfillment > Cover Letter.
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The Cover Letter Summary page opens. Using these pages, you can define a 
new cover letter or update details for an existing cover letter. 

3. In the Cover Letter Summary page, fill in the following mandatory details:

■ Content Group: Select the appropriate channel for this cover letter. For 
example, if the cover letter is for fax, select fax as your channel. 

■ Content Types: Select a content type for the cover letter. The content type 
provides a predefined structure for the cover letter. 

■ Version: Select either latest version or live version. Live version is the latest 
approved version of the cover letter. You cannot make a non-live version 
(latest, for example which is not live) be available to your end users for 
pulling it up in schedule context. 

4. Select Go. 

5. Enter the following mandatory details (displayed components will depend on 
the structure of the content type selected):

■ Name: Enter a logical name for this cover letter. For example, if this cover 
letter is for faxes created in March, March Fax Standard Cover would be a 
reasonable names. 

■ Location: Enter a location for the cover letter. If the default value not your 
desired location, you can easily change it by changing the profile IBC: 
Default Home Folder. 

For example, if the default is /COMMON you could change it to /AMS. 
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Figure 3–2  Changing the Default Location for a Cover Letter

■ Header: If a header is required for this cover letter, search and select a 
content item and image for the header. 

■ Body: Using the HTML text box, enter the appropriate content using any 
personalization tags provided in the shuttle box by the query. 

If using Internet Explorer, the text box appears in HTML. If using Netscape, 
it appears as a plain text box. 

■ Content Blocks: Select the appropriate content block for this cover letter. 

■ Footer: If a footer is required for this cover letter, search and select a content 
item and image for the footer.

■ Attachments: If sending an attachment with this cover letter search and 
select it here. For example, if this cover letter uses a cover title, add it as an 
attachment. 

■ Upload Attachments: To upload a new attachment, select Browse, locate the 
new attachment, and select Add Attachment. 

■ Content Rendition: This field is required when using the print channel. 
Using the search icon, upload a PDF file for this email content. The PDF 
will be stored as a rendition which can later be used in a Print Schedule. 
This file will not be sent as part of your email. You can embed the mail 
merge tags used by the query above into the PDF document. 
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6. Select Submit for Approval. 

Depending on the defined approval process, the cover letter is sent for 
approval.  

3.2.4.11 Creating a Click-Through Destination for a Cover Letter
When using the email channel, it is likely that the cover letter will include a 
click-through destination. 

If creating your cover letters in Oracle One-to-One Fulfillment (not Oracle 
Marketing) your click-through actions are pulled from OCM. In this case, your 
actions are limited to:

■ Go to URL 

■ Go to Content Item 

Because of this, it is recommended that you create your cover letters using Oracle 
Marketing. 

3.2.4.12 Adding Images to a Template
Images can be added to templates. If an image has been added, when the template 
is displayed, an image appears within the template body. Images are added using 
the iFrame content creation box. Consequently, you must use a browser, such as 
Internet Explorer, that supports this technology. 

To add images to a template use the following procedure: 

Prerequisites
■ Profile option JFT_FM_BASE_IMAGE URL is set to the same server value as 

your applications 

■ Template is created

Steps
1. Log in to Oracle Marketing.

2. Navigate to Administration > Marketing > Fulfillment >Template.

3. Open the template. 

The Template Schedule details page opens.
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4. In the iFrame text box, select the camera icon.

If using a Netscape browser, the iFrame textbox is not available and therefore 
images can’t be added. 

5. Select the image upload location: 

■ File: Select if uploading the image from a local file folder. Use the browse 
button to search for the image. 

■ URL: Select is uploading the image from a URL. Indicate the full path name 
of the image. 

For example, if using the Australian flag image found on the Oracle Store 
landing page, you will need to “View HTML source” on the page, and 
include the image source path: /OA_MEDIA/jtfaust.gif. 

6. Select Preview to preview changes.

7. Select Apply to save your work. 

3.2.4.13 Setting Up Fulfillment Rules for Events
When creating templates for Events, you must set up fulfillment rules. These rules    
are created to link objects and actions to cover letters. When creating fulfillment 
rules, it is important to note that Event letters can only use events tokens. 
Specifically, the event_reg_id token must exist in the query. 

For Events, the following actions are seeded:

■ Send a letter on Event enrollment or registration.

■ Send a letter on Event registration cancellation.

■ Send a letter when registration status changes from waitlist to confirmed.

■ Send letters to Event roster when an Event is cancelled.

■ Send letters to Event roster when the date of the Event is changed.

■ Send letters to Event roster when the venue for the Event is changed. 
Letters will not be sent if a venue is removed from the Event.

 To implement fulfillment rules, follow this procedure:

Prerequisites
Template has been created 
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Steps
1. Navigate to Administration > Marketing > Setup > Fulfillment Rules.

2. In the Object Column LOV, choose Event Schedule. 

3. In the Action Column LOV, choose an Action. The available Actions (seeded) 
for Event Schedules are:

■ Event Cancellation

■ Event Date/Time Change

■ Registration Cancellation

■ Registration Confirmation

■ Venue Change

■ Wait List Confirmation

Custom Actions are not currently supported.

4. Enter a Subject.

5. Click the icon next to the Cover Letter and select a Cover Letter from the 
available cover letters created in Oracle Fulfillment. 

6. Click Update.

7. To preview the template, click the icon in the Preview column.

3.3 Administrating Common Components
The following administrative components are common the entire application and 
should be setup or verified before setting up related specific components.

■ Section 3.3.1, "Creating Custom Setups"

■ Section 3.3.2, "Setting Up Categories"

■ Section 3.3.3, "Setting Up Activities"

■ Section 3.3.4, "Setting Up User Statuses"

■ Section 3.3.5, "Setting Up Mandatory Rules"

■ Section 3.3.6, "Setting Up Locking Rules"

■ Section 3.3.7, "Setting Up Approval Rules"

■ Section 3.3.8, "Setting Up Geographic Areas"
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■ Section 3.3.10, "Setting Up Word Replacement Rules"

■ Section 3.3.9, "Setting Up Existence Checking"

■ Section 3.3.11, "Setting Up Marketing Source Codes"

■ Section 3.3.12, "Setting Up the Marketing Calendar"

3.3.1 Creating Custom Setups
Custom setups dictate how an organization will use marketing objects. They enable 
an organization to use marketing objects to suit the organization’s needs through 
customized, object-specific side navigation menus. 

For example, if a company decides to perform direct marketing campaigns that 
always use e-mail as the delivery mechanism, a custom setup for the marketing 
object “Campaign Schedule” can be created. This custom setup would have the 
following attributes: 

■ Custom Setup Name: Direct Marketing - Email 14

■ Associated with: Campaign Schedule (for the Campaign - Email Blast)

■ Activity Type: Direct Marketing

■ Activity: Email

You can create custom setups for the following marketing objects: 

■ Campaign

■ Campaign Schedule

■ Collection

■ Deal

■ Deliverables

■ Event

■ Event Schedule

■ Event Promotion

■ Offer

■ One-Off Event

■ Price List 

■ Trade Promotion
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Custom setup types affect all objects of that type within the application. The setup 
is restricted to newly created objects of that type. 

For example, if a Deliverable is associated with a Campaign but the Deliverable side 
navigation menu item is disabled on the custom setup, the Deliverable item for 
currently existing objects will not be visible to users. If the Deliverable item is 
enabled again, then the associated Deliverable will become available. 

To implement and understand Custom Setups see the following sections:

■ Section 3.3.1.1, "Custom Setup Functionality Overview"

■ Section 3.3.1.2, "Creating a Custom Setup"

■ Section 3.3.1.3, "Setting Up Custom Setup Details"

3.3.1.1 Custom Setup Functionality Overview
Custom setups control the following:

■ Side Navigation Menu: The vertical menu which appears on the left-hand side 
of the page once an object is created. The side panel menu does not appear until 
you create a new object.

■ Menu Items: These are the smallest components on the Side Navigation Menu. 
Menu items are the functional areas within the application where data can be 
created or where objects are viewed. Some of the menu items have functional 
implications, others are used for information purposes only. 

■ Component Groups: Each of the menu items are logically grouped into various 
sections based on functionality. Component Groups include Planning, 
Execution, Tracking, Collaboration and Approval. Within each Component 
Group is a logical collection of menu items. 

■ Seeded Menu Items: The following is a list of objects you can create Custom 
Setups to be used with.

– Main

– Messages

– Geography

– Product

– Deliverable

– Budget

– Team
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– Contact Point

– Trigger

– Schedule 

– Offer

– Tasks

– Notes

– Partners

– Cost and Revenues

– Campaign Schedule

– Metrics

– Attachments

– Theme Approval

– Budget Approval

– Market Eligibility

– Products

– Allocation

– Checkbook

3.3.1.2 Creating a Custom Setup
When creating a custom setup you will associate the custom setup with a marketing 
object. 

To create a Custom Setup use the following procedure: 

Prerequisites
None

Steps
1. Navigate to Administration > Marketing > Setup > Custom Setup. 

2. Select Create. 

3. Enter a Custom Setup name.
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4. Associate the Custom Setup with a marketing object. For a list of available 
marketing objects see Section 3.3.1.1, "Custom Setup Functionality Overview".

5. Depending on the marketing object selected, additional fields such as Activity 
Type and Activity may appear. This indicates that the Custom Setup is valid for 
the specific combination.

■ The selection of Activity Type and Activity determines the available 
Component Groups and Menu Items. For example, Direct Marketing - 
Email has a different set of Component Groups and Menu Items as 
compared to Direct Marketing – Direct Mail.

■ The available combinations of Activity Type and Activity in the Create 
Custom Setup page depend on the definition of the organization’s 
Activities, Activity Types and Categories. In the case of Deliverables, the 
combination of Activity Type and Activity is based on the parent and child 
category. Custom Setups for Campaign Schedules depend on the 
relationship of Activity Type and Activity.

6. Check Active for the Custom Setup to be available for selection during a 
marketing object create.

7. Optional. Check Allow Essential and Optional Grouping if this Custom Setup 
can be used with the Side Navigation Look profile option.

8. Optional. Enter a suffix to be used as part of the source code.

The suffix set here is reflected when an object is created. The suffix can be 
alpha, numeric or a combination. The maximum number of characters is 3.

9. Optional. Enter a brief description for this Custom Setup.

10. Select Create.

3.3.1.3 Setting Up Custom Setup Details
After the Custom Setup has been created, use the following procedure to configure 
it: 

Prerequisites
None

Steps
1. Navigate to Administration > Marketing > Setup > Custom Setup.
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2. Select the Custom Setup created previously. For more information see 
Section 3.3.1.2, "Creating a Custom Setup".

The Custom Setup Details page opens. The combination of Menu Items 
displayed is based on the marketing object, Activity, and Activity Type 
combination selected when creating the Custom Setup. 

3. Place a check in the Active checkbox. 

4. Place a check in the Allow Essential and Optional Groupings checkbox. 

5. Provide a brief description (optional). 

6. In the Components section, provide the following details: 

■ Component Group: Displays by default based on the marketing object, 
Activity, and Activity type selected for Custom Setup. 

■ Display Sequence: Use this column to control the order of the marketing 
Objects (as they appear in the side navigation menu). For example, if 
Products is to appear on the side navigation menu directly below Main, 
Product should be sequentially numbered directly after Main. Main is not 
an optional setting and must be included. In this example, Main could be 
given a value of 10, and Product could be given a value of 11. 

■ Available Attributes: Use this column to indicate if the attributes for this 
object should be made available. 

■ Essential: To control the display order of a particular marketing object, 
place a check in the Essential checkbox (be sure to select the Essential 
checkbox that aligns with the correct marketing object). Anything not 
checked in the “Essential” column is considered “Optional” and is listed in 
alphabetical order. 

■ Essential Display Sequence: Display sequence is a numeric setting used to 
order marketing objects in side navigation menus. If the Essential checkbox 
is checked, numberic values need to be provided enables the “Essential” 
marketing objects to be ordered appropriately. The Display Sequence 
column is used to determine the order when “Business Process View” 
profile value is selected.   

■ Reports: Place a check in the Reports checkbox to enable attributes to be 
shown in the portals. 

7. Click Update.
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3.3.2 Setting Up Categories
Categories are used to group objects. They can be used as selection and search 
criteria to locate objects. For some objects, categories can be used to impose a 
business rule. Categories can be used in the following marketing functional areas: 

■ Deliverables

■ Events

■ Metrics

■ Budgets 

■ Approval Rules

To understand and implement Categories see the following sections:

■ Section 3.3.2.1, "Deliverable Categories"

■ Section 3.3.2.2, "Events Categories"

■ Section 3.3.2.3, "Metrics Categories"

■ Section 3.3.2.4, "Budgets Categories"

■ Section 3.3.2.5, "Approval Rules and Categories"

■ Section 3.3.2.6, "Setting Up Deliverables Categories for Custom Setups"

3.3.2.1 Deliverable Categories
Categories are used by Deliverables to group items together. While creating a 
Deliverable it is mandatory to choose the category to which it belongs. Examples of 
Deliverable categories are: 

■ Collateral

■ Creative

■ Email 

You can create sub-categories to further define Deliverables. For example, you can 
define greetings or confirmation as sub categories under the e-mail category. Email 
is a special category of Deliverables. These will be used by Campaign Schedules to 
send as e-mail when attached through the e-mail content screen in Campaign 
Schedules. 
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3.3.2.2 Events Categories 
Categories are used with Events to group or categorize them. Examples of Event 
categories are educational Events or partnered Events.

3.3.2.3 Metrics Categories
Category is used by metrics to classify the metrics. You can have different 
categories of metrics such as cost, revenue, leads or opportunities. When you create 
a rollup or summary metrics, the system ensures that the metric rolls up or is 
summarized to the metrics of the same category.

3.3.2.4 Budgets Categories
Budgets use categories to integrate to Oracle General Ledger. Budget categories can 
also be used to verify Budget eligibility for Campaign Schedules. 

3.3.2.5 Approval Rules and Categories
Approval rules for Deliverables can be linked to Deliverable categories. Approval 
rule for Budgets can be linked to Budget categories. This means that all Budgets 
falling within that category would use that particular rule for approval when 
drawing money from those Budgets.

3.3.2.6 Setting Up Deliverables Categories for Custom Setups
Custom setups for Deliverables can be created for using Deliverable categories. 
Therefore, all deliverables using that category will use the custom setup created for 
the category attached. 

To create a Deliverable for a custom setup, use the following procedure: 

■ Section 3.3.2.7, "Create Category"

■ Section 3.3.2.8, "Verify Category"

3.3.2.7 Create Category
Use the following procedure to create a category. 

Prerequisites
None



Administrating Common Components

3-30 Oracle Marketing Implementation and Administration Guide                              

Steps
1. Log in to Oracle Marketing.

2. Navigate to Administration > Marketing > Setup > Categories. 

3. Select Create.

4. Enter a Category Name.

5. Select a Parent Category if desired.

6. Select the Enabled checkbox to make the Category available.

7. Select a marketing object from the Created For drop-down menu.

8. Enter a description.

9. In case of metrics or Deliverables make sure the parent–child relationship is 
captured correctly. 

3.3.2.8 Verify Category
Use the following procedure to verify that a category is properly implemented:

Prerequisites
Category has been set up

Steps
1. Log in to Oracle Marketing. 

2. Navigate to the Deliverable tab.

3. Select Create. 

Verify that the Category and Subcategory fields display values in the drop 
down menu.

4. Navigate to the Events tab.

5. Select Create. 

6. Create an Event. 

7. Navigate to the Categories item on the Side Navigation Menu.

Note: Oracle Marketing contains seeded categories for Deliverables 
and Events. Disable categories that are not needed.
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Verify that Category field displays values in the drop down menu.

8. Navigate to the Administration > Marketing > General > Metrics. 

Verify that the Category field displays values in the drop down menu.

3.3.3 Setting Up Activities 
An Activity manages the relationship between an object’s Activity Type and the 
Marketing Medium. 

To understand and implement Activities see the following sections:

■ Section 3.3.3.1, "Understanding Activity Types"

■ Section 3.3.3.2, "Seeded Activities and Activity Types"

■ Section 3.3.3.3, "Setting Up an Activity"

3.3.3.1 Understanding Activity Types
Available activity types are:

■ Advertising

■ Direct marketing

■ In-store

■ Press and analyst relations

The Activity page within the Administration tab manages the relationship between 
an object’s Activity Type, Activity and available Marketing Medium. Using this 
page, an organization can specify the available Activity and Marketing Mediums 
combination for a given Activity Type.

Activities can be created within the application and can be linked to an existing 
Activity Type. When an Activity Type is selected for a Object Create or Custom 
Setup, the Activities that has been created for the Activity Type will populate the 
Activity LOV.

The available Activity Types are:

■ Advertising

■ Direct Marketing

■ In-Store

■ Press and Analyst Relations
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■ Web Marketing

■ Events

3.3.3.2 Seeded Activities and Activity Types
The following is a list of seeded activities for activity types 

■ Advertising: 

– Banner Ads

– Billboard

– Brochures/Booklets

– Directories

– Display Signs

– Magazine

– Motion Pictures

– Netcast

– Newspaper

– Posters/Leaflets

– Print Ads

– Radio

– TV

■ Direct Marketing: 

– Catalog Direct Mail

– Email

– Fax

– Magazine Insert 

– Telemarketing

■ In-Store: 

– Display

– End-Aisle
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– Grounders

– Kiosk

– Menu Boards

– Package-Inserts

– Packaging-Outer

– Point-of-Purchase Displays

– Shelf

– Shop around

■ Press and Analyst Relations:

– Article

– Briefing

– Community Relations

– Company Magazine

– Crisis Communications

– Internal Communications

– Investor Relations

– Lobbying

– Press Conference

– Publications

– Release

– Tour

3.3.3.3 Setting Up an Activity 
Use the following procedure to create an activity: 

Prerequisites
None
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Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > Setup > Activity.

3. Create a Activity Name.

4. Select an Activity Type.

5. Mark Active. Only Active Activities are available within the application.

6. Associate Marketing Medium. 

7. Click Go.

a. Select a Marketing Medium from the list of active Marketing Mediums 
displayed.

b. Select Active From and Active To dates. These dates should fall within the 
Active From and Active To dates of the Marketing Medium.

c. Marketing Medium shown up on the Object details page based on the 
Association of the Marketing Medium with the various activities in the 
create Activity screen. A single Marketing Medium may be associated with 
multiple Activities.

8. Save your work. 

3.3.4 Setting Up User Statuses
System statuses drive certain behaviors of Marketing objects. User statuses, on the 
other hand, can be created on top of system statuses. User statuses do not drive 
behavior, but can be used for the purpose of classification. By setting a User Status, 
you can configure the values of the object’s “status” field. This improves usability 
and analysis of objects within the application. 

For example, a Campaign can have a system status - cancelled. The seeded user 
status for Campaign with a cancelled status is cancelled. This means that when a 
Campaign’s status moves to cancelled, the UI’s status field reflects the value 
“cancelled”.

The system status can be extended using user Status to enhance the analysis and 
reporting functionality. One such method would be to add a cancellation reason to 
the cancelled status. 
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For example: 

■ Cancelled – ROI Below Expectation 

■ Cancelled – Competitor Campaign 

■ Cancelled – Product Overlap 

■ Cancelled – Executive Rejection

To understand and set up User Status see the following sections:

■ Section 3.3.4.1, "Seeded User Statuses"

■ Section 3.3.4.2, "Creating User Statuses"

3.3.4.1 Seeded User Statuses
All enabled user statuses are available in the Campaign Status LOV. Seeded user 
status values are marked Enabled and Default. This means that the system status 
value will show up for objects as the default value. System status values cannot be 
disabled. 

New user status values can be created. Once a new user status is created for a 
combination of activity and status and marked enabled, the seeded system status 
value automatically looses its default flag. There cannot be two default user statuses 
for given combination of activity and status. 

Refer to Appendix E, "Seeded User Statuses" for a listing of seeded user statuses for 
release 11.5.10.

3.3.4.2 Creating User Statuses
Multiple Users Statuses may be created and enabled for a particular System Status. 
All functionality and rules associated with the system status will be applicable for 
the user status created for that combination.

Use the following procedure to create user statuses:

Prerequisites
None

Steps
1. Navigate to Administration > Marketing > Setup > User Status > Create.

2. Select a marketing object for the User Status For field.
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3. Select a System Status for the marketing object.

4. Enter a User Status to replace the System Status for the marketing object.

5. Select the Enabled checkbox to make the User Status available.

In order to set this User Status as a default, the Default check box needs to be 
checked in the overview screen for one of the newly created User Status, if not, 
the seeded User Status will be reflected on the Campaign. On update, the 
default value on the seeded User Status is automatically removed.

6. Save your work. 

3.3.5 Setting Up Mandatory Rules
In Oracle Marketing, most objects can use Mandatory Rules. These rules enable a 
company to control data entry by mandating that certain fields be entered on 
specific screens. In other words, rules can be created to make certain data fields 
mandatory. Certain values in the selected columns are seeded and cannot be 
changed/modified. 

For example, when creating a Campaign, on the Campaign Details page, Purpose is 
not a mandatory field by default. Seeded, it is an optional field. If your business 
requirements mandate that users must select a value for this, then you can create a 
mandatory rule to enforce this business rule. 

To create mandatory rules, follow the procedure below: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > Setup > Mandatory Rules. 

3. The Mandatory Rules Details page opens. 

4. In the Parent Object Type drop-down menu select Campaign. 

5. In the Object Attribute drop-down menu select Main (this is the side 
navigational menu for which this field appears). 

6. In the Available fields column, select Purpose. Highlight this field, shuffle it to 
the Selected Fields column. 
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7. Select Update to save your work. 

8. Navigate to Campaign > Campaigns > (open an existing Campaign).

9. Navigate to Campaign Details page. 

10. Purpose is now a mandatory field. 

3.3.6 Setting Up Locking Rules
Locking Rules are a way for companies to control data entry by disallowing 
updates to certain data at certain statuses. For example, if a marketer is not 
supposed to be able to update a Campaign’s version, this field can be locked for this 
user. In this case, when the user navigates to the Campaign Details page, version 
(usually an updatable field) will not be updatable. 

By design, locking rules are ignored for the Oracle Marketing Super User 
responsibility. In other words, when an Oracle Marketing Super User is logged in, 
the fields which are supposed to be locked are updatable. If the user is not locked in 
as the Oracle Marketing Super User, then the fields will display according to the 
locking rules defined.

To create a locking rule (for the example described above), use the following 
procedure:

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > Setup > Locking Rule. 

The Locking Rules page opens. 

3. In the Parent Object Type drop-down menu select Campaign. 

4. In the Object Attribute drop-down menu select Main (this is the side 
navigational menu for which this field appears). 

5. In the System Status LOV, choose New. 

6.  In the Available fields column, select Version. Highlight this field, shuffle it to 
the Selected Fields column. 

7. Select Update to save your work. 
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8. Navigate to Campaign > Campaigns > (open an existing Campaign).

9. Navigate to Campaign Details page. 

10. The Version field is now locked. 

3.3.7 Setting Up Approval Rules
Approvals can be used for all objects created within the Oracle Marketing 
application. It is possible to specify a business unit on an approval rule for a 
campaign schedule, however the business unit does not appear on the campaign 
schedule. Although not visible, the business unit is inherited from the campaign. In 
other words, approval rules for campaign schedules use the business unit from the 
campaign (if specified). 

For core Marketing approval rules can be created on the following marketing 
objects: 

■ Campaigns

■ Campaign Schedules

■ Events

■ Event Schedules

■ One-Off Events

■ Offers

■ Deliverables

■ Price lists

■ Claims

To understand and implement Approval Rules see the following sections:

■ Section 3.3.7.1, "Overview of Approval Rules"

■ Section 3.3.7.2, "Understanding the Approval Process"

■ Section 3.3.7.3, "Setting Up Approvals"

3.3.7.1 Overview of Approval Rules
The following is a list of terms and concepts for approval rules: 
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Concept Approval
Done prior to approving any finances for the Object. The requirement of ‘Concept’ 
approval for any Object is based on the ‘Custom Setup’ used for creating the Object.

Budget Line Approval
The method in which the money / expense associated with an ‘Object’ is approved. 
The requirement of ‘Budget Line’ approval for any Object is based on the ‘Custom 
Setup’ used for creating the Object. This approval is guided by the Budget category 
used while creating the Budget. 

Budget Approval 
The final approval for an ‘Object’. This happens after the ‘Theme’ and ‘Budget Line’ 
approvals are met. The execution of this approval depends on the Budget ‘Cutoff 
Percentage‘being met. See Profile Option, AMS Cutoff Percentage for Approval.

Budget Request Approval
Type of approval is related to the Budget Transfers. Budget transfers are used to 
transfer funds between two Budgets. This approval is guided by the Budget 
category used while creating the Budget which the funds are being sourced from. 
Note: Child Budget creation is also similar to the Budget request approval. 

Root Budget Approval
When a Budget is created in the Application, It cannot go ‘Active’ and be used by 
other objects without going through the ‘Root Budget Approval’. Any Budget 
without a parent is a ‘Root Budget’.

3.3.7.2 Understanding the Approval Process
If the Custom Setup selected for the marketing object requires both theme and 
Budget approval, the approval process will proceed in the following manner. 

1. An object goes through Concept approval when the object’s status is changed 
by the user from New to Planned.

2. Upon the next running of the concurrent process, the Concept approval is sent 
to an approver based on Approval Rules. At this time the object’s status goes to 
Pending Theme Approval.

3. Approver approves the request.

4. On approval, the object’s status goes to Planned. 
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5. When the user changes the object’s status from Planned to Active, the object 
goes through Budget Line approval.

6. Upon the next running of the concurrent process, the Budget Line approval is 
sent to an approver based on Approval Rules. At this time the object’s status 
goes to Pending Budget Approval.

7. Once the threshold limit is reached, based on the AMS Cutoff Percentage for 
Approval, the Budget approval is sent automatically. It does not require a 
concurrent process. At this time the object’s status is still at Pending Budget 
Approval.

8. The Budget approval is sent to an approver based on Approval Rules. 
Depending on the approval, the object’s status will go to Active or Rejected.

3.3.7.3 Setting Up Approvals
Use the following procedure to implement approvals. 

■ Section 3.3.7.4, "Setting Up Role Types for Approvals"

■ Section 3.3.7.5, "Setting Up Roles for Approvers"

■ Section 3.3.7.6, "Setting Profile Options for Approvals"

■ Section 3.3.7.7, "Creating Approval Rules"

■ Section 3.3.7.8, "Assigning Approvers"

■ Section 3.3.7.9, "Running Workflow Background Process for Approvals"

3.3.7.4 Setting Up Role Types for Approvals
The required role types for approvals are:

■ Default Marketing Approver: Approver of any new marketing object requiring 
approval.

■  Marketing Approver: Approvers specified by the approval rules.

Use the following procedure to set up role types for approvals: 

Prerequisites
None

Steps
1. Log in to Oracle Forms with CRM Administrator responsibility.
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2. Navigate to Setup > Role Types.

3. Use Find to check for the role type of AMSAPPR. If the role type does not exist, 
it must be created. 

4. From Menus, select New to create a new line.

5. Under the Code column, enter AMSAPPR.

6. Under Meaning, enter Default Marketing Approver.

7. Under Description, enter Default Marketing Approver.

8. Save the record.

9. If more than one person in the organization will be approving marketing 
objects, create a role type called Marketing Approver.

10. Use Find to check for the role type of MKTGAPPR. 

11. From Menus, select New to create a new line.

12. Under the Code column, enter MKTGAPPR.

13. Under Meaning, enter Marketing Approver.

14. Under Description, enter Marketing Approver.

15. Save the record.

3.3.7.5 Setting Up Roles for Approvers
The role of Default Marketing Approver must be created and assigned to a user in 
order for Oracle Marketing to function properly. The Default Marketing Approver 
receives approval notification for any marketing object not meeting the criteria 
specified in the approval rules. 

The Default Marketing Approver Role may only be assigned to one user. If more 
than one user receives this role, the approval process will fail. The system will not 
prevent you from assigning the role to more than one user.

Use the following procedure to set up approver roles:

Prerequisites
None

Steps
1. Log in to Oracle Forms with Oracle Marketing Administrator responsibility. 
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2. Navigate to Setup > Roles.

3. Query to determine whether the role AMS_DEFAULT_APPROVER exists. If 
not, create it with the following steps. 

4. From Menus, select New to create a new line.

5. Under the Code column, enter AMS_DEFAULT_APPROVER.

6. Under Name Type, enter Default Marketing Approver.

7. Under Type, use the LOV to select Default Marketing Approver or the 
description you gave the Default Marketing Approver Role Type.

8. Under Description, enter Default Marketing Approver Role.

9. Select the checkboxes Active and Manager.

10. Save your work.

11. Assign this role to a valid user. 

3.3.7.6 Setting Profile Options for Approvals
See the table below for system profiles and their values.

Table 3–4 Profile Options for Approvals 

Option Required Level Setting Effect/Limitation

AMS: 
Cutoff 
Percentage 
for 
Approval

Yes Site Enter a value 
between 0 and 
100

For a marketing object with an Initial 
Estimated Amount (IEA) value 
entered into the Budget page for that 
object to go to Active status, it must 
obtain Budget approval for this 
percentage of the IEA. During the 
initial stage, before the object status is 
Active, requests in excess of the IEA 
are not allowed. 

For example, an object with an IEA of 
$1,000 and an AMS: Cutoff Percentage 
for Approval of 60, requires approval 
of $600 in order to become Active. The 
same object in an organization with an 
AMS Threshold of 100, requires 
approval of $1,000 to become Active.
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3.3.7.7 Creating Approval Rules
The creation process involves first creating an approval rule and then assigning 
approvers to the rule. 

Use the following procedure to create approval rules:

Prerequisites
None

Steps
1. Navigate to Administration > Marketing > Setups > Approval Rules.

2. Select Create.

3. Enter a Name for the Approval Rule. 

4. Select an Approval Rule Type from the following: 

5. Object: Approval Type: Concept is for 'Concept Approval'.

■ Budget Request - Approval Type: Budget is for 'Budget Line Approval' (this 
is for funds requested from a Budget). This is when you request funds from 
a Budget. This is the rule that will apply for ‘Budget Transfers’ and Child 
Budgets. Note: Budget Requests for Transfers and Child Budgets will 
follow the above rule.

■ Budget Transfer: Used while transferring funds from one Budget to 
another.

■ Root Budget - Approval Type: Budget is for Root Budget Approval.

■ Campaign/Event - Approval Type: Budget is for Overall Object Approval 
(this is the third approval after the threshold is met). It is after this approval 
that the object’s status will go Active. 

AMS: 
Source from 
Parent

Yes Site Yes/No Determines whether Campaign 
Schedules and Event Schedules are 
sourced from their parent Campaigns 
and Events (select Yes) or from 
Budgets (select No). Campaigns and 
Events may only be sourced from 
Budgets.

Table 3–4 Profile Options for Approvals (Cont.)

Option Required Level Setting Effect/Limitation
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3.3.7.8 Assigning Approvers
Approvers can be assigned by role, user, function or a combination of all three. The 
functions in use will be functions such as 'Object Owner', 'Parent Object Owner', or 
'Budget Owner'. 

These are similar to approval roles but are different in the sense that they are 
dynamic based on each 'Object' and do not have to be assigned to a 'User'.If the 
approval needs to be sent through a chain of approvers, The approvers need to be 
set in an order. 

For example, an advertising Budget  for which there are three approvers for the 
‘Budget Line Approval’. After the rule is created, approvers need to be added to the 
rule in the order in which they are expected to approve. Approver with Order [1] 
will be the first approver followed by Approver with Order [2] and so forth.

3.3.7.9 Running Workflow Background Process for Approvals
Run the following concurrent program to perform background processes necessary 
for the approvals implementation to be complete. 

3.3.7.10 Determining/Verifying the Default Marketing Approver
Use the following SQL statement to determine who the default marketing approver 
is:

Table 3–5 Workflow Background Process for Approvals 

Concurrent Manager Required Description

Workflow Background 
Process

Yes Parameters required:

■ Set Item Type: AMS Marketing Approvals   

■ Minimum Threshold: Leave blank.

■ Maximum Threshold: Leave blank.

■ Process Deferred: Yes

■ Process Timeout: Yes

The concurrent process is required to process the 
approvals. As mentioned earlier, there are three 
approval processes to complete: Concept, 
Budget Line and Budget.

The concurrent process is required for Concept 
and Budget Line approvals. Other approvals, 
Budget Request, Root Budget and Object 
approval, occur in real time.
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SELECT emp.resource_name, rr.role_resource_id 
FROM ams_jtf_rs_emp_v emp, 
                jtf_rs_role_relations rr, 
                jtf_rs_roles_vl rl 
WHERE rr.role_id = rl.role_id 
AND rr.role_resource_id = emp.resource_id 
and  rl.role_type_code in( 'MKTGAPPR','AMSAPPR') 
AND rl.role_code  = 'AMS_DEFAULT_APPROVER' 
AND rr.ROLE_RESOURCE_TYPE = 'RS_INDIVIDUAL' 
AND delete_flag = 'N' 
AND sysdate between rr.start_date_active  
and nvl(rr.end_date_active,sysdate); 

3.3.8 Setting Up Geographic Areas
Geographies are created in two sections. First the Geographic Location Types are 
created and then Geographic Areas are created. Each Geographic Area has a 
Geographic Location Type associated with it. Run the Concurrent Manager 
Program, Load Geographic Hierarchies, any time Geography is modified.

Prerequisites
None

Steps
1. Navigate to Administration > Marketing > Geography > Location Type.

2. For each of the levels, enter a Name for the type and a Description.

■ Area 1 (top level)

■ Area 2 (second level)

■ Country

■ C Region (regions within Country)

■ State

■ S Region (regions within State)

■ City

■ Postal Code

3. Select Update.



Administrating Common Components

3-46 Oracle Marketing Implementation and Administration Guide                              

4. Navigate to Administration > Marketing > Geography > Geographic Area.

5. Select a Parent Geographic Area. 

The Geographic hierarchy should be created from the top down.

6. Select a Type for the child area.

Enter the Name, Short Name (will be used for Source Code generation), Start 
and End Dates (End Date is optional) for each child geographic area.

7. Select Update. 

3.3.9 Setting Up Existence Checking 
Existence Checking is done by using fuzzy keys and word replacement rules. List 
import programs use algorithms to create any TCA entity. For more information 
about existence checking and list import, see Section 6.2.6.2, "Performing Existence 
Checking for List Import". 

To understand and implement existing checking and word replacement rules see 
the following sections: 

■ Section 3.3.9.1, "Existence Checking Algorithm"

■ Section 3.3.9.2, "Existence Checking with the Customer Key"

■ Section 3.3.9.3, "Existence Checking for Address"

■ Section 3.3.9.4, "Existence Checking for Contacts"

■ Section 3.3.9.5, "Existence Checking for Contact Points"

3.3.9.1 Existence Checking Algorithm
The following describes existence checking algorithm logic:

If location does not exist then create a Location. If Party does not exists then create a 
Party. If Part Site does not exist for the combination of above Party and Location 
then create a Party Site. If a Contact Party does not exist then create a Contact party. 
If a Relationship of type CONTACT does not exist between Party and Contact Party 
then create Org Contact, Relationship and Contact Roles. If Contact Points do not 
exist then create Contact Points.

3.3.9.2 Existence Checking with the Customer Key 
Existence checking is done using customer_key in HZ_PARTIES. This key is 
generated by TCA APIs while creating the customer. List Import program 
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populates the AMS_IMP_SOURCE_LINES table with dedupe keys for all records to 
be imported. If it finds a match on the HZ_PARTIES, then it uses the matching 
customer, otherwise it creates a new customer using the TCA API. As mentioned 
above, if there are multiple records with the same customer key then the import 
record is created for the customer having highest party_id.

Any word replacement rules are defined in TCA then those rules will be applied to 
the customer name in the table while populating the key in AMS_IMP_SOURCE_
LINES table.

Existence checking for a B2B customer is based on Name, Address1 and Country 
columns. First, the algorithm locates the highest Party ID for the provided Name, 
Address1 and Country columns. If that fails, it looks for the highest Party ID for the 
same Name within the Country. If this also fails then it takes the name with the 
highest Party ID.

3.3.9.3 Existence Checking for Address
In the TCA customer model, the address consists of the party site in HZ_PARTY_
SITES and location in HZ_LOCATIONS. Locations is a physical address, such as 
500 Oracle Parkway, Redwood Shores, CA 94065. The Party Site is a logical name 
associated with a location. For example, the Party Site - “Head Quarters” can be 
associated with a location 500 Oracle Parkway. Multiple party sites can point to the 
same location. For example, 500 Oracle Parkway can be both “Head Quarters” and 
“Human Resources”. The List Import program check whether the location exists in 
HZ_LOCATIONS or not as well as whether the party site for the combination of 
location and customer exists in HZ_PARTY_SITES. 

To check for Address existence, the algorithm uses the Address1, City, Zip Code 
and Country columns.

If a matching record is found in HZ_LOCATIONS then it uses the matching 
location otherwise it creates a new location using TCA API. As mentioned above if 
there are multiple records with the same address key then it takes the location 
having highest location_id. 

Once the location_id is created, the program finds out whether a party site exists for 
the combination of this location_id and party_id. If such party site already exists 
then it takes that party_site_id. If not then a new party site is created using TCA 
API. 
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3.3.9.4 Existence Checking for Contacts
In TCA, the contact is stored as a party of type “PERSON” in HZ_PARTIES and a 
relationship is created between the customer and contact in HZ_RELATIONSHIPS. 
The List Import program checks whether the contact exists in HZ_PARTIES (as a 
party of type “PERSON”) as well as it checks whether a relationship of type 
“Contact” exists between the customer and contact in HZ_RELATIONSHIPS. The 
existence checking is done using customer_key in TCA table (HZ_PARTIES). Refer 
to the above section on customer.

For Contacts, existence checking first compares the First Name, Last Name, Email 
Address, and Telephone area code, number and extension fields. It first checks 
Name along with both Email Address and Telephone information. If this fails then 
it checks the Name and Email Address and if this also fails, then checks Name and 
Telephone information.

Note that if relationship of any other type exists then List import program will 
create a new relationship. If a contact with same first name and last name (thus 
same party_name in HZ_PARTIES) exists in table then list Import will not create a 
new contact in TCA tables. It will just create a new relationship if one does not 
exists and attach the list to that contact.

3.3.9.5 Existence Checking for Contact Points
List import creates Phone, Email, and WEB information. For Phone, existence 
checking is based on Name, Phone Country Code, Area Code, Phone Number and 
Extension. For Email, existence checking is based on Name and Email Address.

3.3.10 Setting Up Word Replacement Rules
Follow the steps below to add new words to TCA’s word replacement system. If 
migrating word replacement rules from a local to remote instance, after adding the 
rules (using the procedure below) you will need to run the concurrent program 
AMS Migrate Word replacement Rules for Remote List Processing.  

Prerequisites
Oracle Accounts Receivable (TCA) is implemented

Steps
1. Log in to Oracle Forms with Trading Community Manager responsibility.   

2. Navigate to Data Quality Management > Setup > Word Replacements. 
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3. In the Word List field, search for the appropriate list. For example, if looking to 
write a word replacement for Rachael, you would locate the Person Name 
Dictionary. 

4. Add new word replacements.

5. Save your work.

3.3.11 Setting Up Marketing Source Codes
Source codes are unique identifiers for the following marketing objects:

■ Campaigns

■ Campaign Schedules

■ Events

■ Event Schedules

■ Offers 

Source codes play an important role in marketing because the customer, most often, 
interacts with the application using a source code. Source codes are stored with 
orders to track the effectiveness of an Event, Campaign or Offer.

To understand and implement Marketing Source Codes see the following sections:

■ Section 3.3.11.1, "Source Code Construction"

■ Section 3.3.11.2, "Source Code Schema"

3.3.11.1 Source Code Construction
Source codes are constructed using various components. The maximum number of 
characters in a source code is 30. The Geography Code comes from the geographic 
area code entered in Geography. The Suffix comes from the source code suffix field 
in Custom Setups. The source code may contain any of the following components: 

■ Geography Code

■ Month Code

■ Activity Code

■ Source Code digits (maximum number equals 30 - total of other 
components)

■ Suffix
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3.3.11.2 Source Code Schema
Each marketing object has a column referencing the source code. This source code is 
unique throughout the application. Given a source code, it can be traced back to its 
marketing object by looking at the AMS_SOURCE_CODES table. 

The following table shows definitions for the AMS_SOURCE_CODE table: 

Table 3–6 Source Code Schema Reference 

Table Object ID Fields Source Code Fields

AMS_CAMPAIGNS_VL CAMPAIGN_ID source_code

AMS_CAMPAIGN_
SCHEDULES_VL

SCHEDULE_ID source_code

AMS_EVENT_HEADERS_
VL

EVENT_HEADER_ID source_code

AMS_EVENT_OFFERS_VL EVENT_OFFER_ID source_code

AMS_OFFERS_VL OFFER_ID

QP_LIST_HEADER_
ID

offer_code

AMS_SOURCE_CODES SOURCE_CODE_ID source_code

arc_source_code_for

source_code_for_id

related_source_code

related_source_object

related_source_id

Table 3–7 AMS_SOURCE_CODE Table Definitions 

Column Name Field Type Description

SOURCE_CODE_ID NUMBER Unique identifier for the source code 
table

SOURCE_CODE VARCHAR2(30) Unique identifier for all the 
marketing objects. Source codes are 
communicated to the customers.

SOURCE_CODE_FOR_ID NUMBER FK to the marketing object to which 
the source code points to.
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3.3.12 Setting Up the Marketing Calendar
The Marketing Calendar is a generic calendar available to all marketing users. 
Different users can have different views of the calendar, however, contents are not 
personalizable at user level. The calendar displays marketing objects based on 
statuses and time range. Procedures need to be performed to centrally setup what 
objects are shown in the calendar. 

Marketing objects supported by the Marketing Calendar:

■ Campaign Schedules

■ Event Schedules

■ One-Off Events

■ Offers

To implement the Marketing Calendar use the following procedure:

ARC_SOURCE_CODE_
FOR

VARCHAR2(30) Four letter code that points to a 
marketing object (EVEH = Event 
headers, EVEO = Event Schedules, 
EONE = One-Off Events, CAMP = 
Campaigns, CSCH = Campaign 
Schedules, OFFR = Offers)

ACTIVE_FLAG VARCHAR2(1) Flag to indicate if the source code is 
active or not.

RELATED_SOURCE_
CODE

VARCHAR2(30) Source code of the related object. 
This is used in case of Event 
promotions. The customer is 
interested in the related Event that 
the Campaign is promoting rather 
than the Campaign itself.

RELATED_SOURCE_
OBJECT

VARCHAR2(30) Four letter code that points to the 
related marketing object (EVEH = 
Event headers, EVEO = Event 
Schedules, CAMP = Campaigns, 
CSCH = Campaign Schedules, OFFR 
= Offers)

RELATED_SOURCE_ID NUMBER FK to the marketing object to which 
the related source code points to.

Table 3–7 AMS_SOURCE_CODE Table Definitions (Cont.)

Column Name Field Type Description
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■ Section 3.3.12.1, "Assigning Usage to Resource Group"

■ Section 3.3.12.2, "Selecting Calendar Display Parameters"

■ Section 3.3.12.3, "Running Concurrent Program for Calendar"

■ Section 3.3.12.4, "Configuring User Profiles"

3.3.12.1 Assigning Usage to Resource Group
Before users can view the Marketing Calendar, their group must be assigned the 
CRM Foundation Calendar Items Group Usage. Only users on groups with 
“Calendar Item” usage will be able to view marketing objects. For more 
information, see the Oracle Marketing User Guide. 

To assign usage to a resource group follow the procedures below: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Resources > Groups Summary.

3. Select a Group. 

4. Select Group Lookup. 

5. Fill in the following mandatory fields for Group Details:

■ Group Name: Name of the group by which Calendar usage privileges are 
requested.

■ Start Date: Start date for which the group will be able to access the 
Marketing Calendar. 

6. Fill in the following mandatory fields for Group Usages: 

■ Usage: To enable Calendar functionality, select CRM Foundation Calendar 
Items from the drop-down menu. 

7. Select Update to save changes. 

3.3.12.2 Selecting Calendar Display Parameters
The Marketing Administrator must decide on the parameters that will ultimately be 
displayed in the Marketing Calendar. The Administrator has 2 options: 
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■ Criteria: Displays marketing objects based on a criteria for which they qualify. 
For example, an Event Schedule may have a criteria of Status “new” and Date 
“January 1, 2003 - March 1, 2003". 

■ Object: Displays marketing objects specified. The Marketing Calendar supports 
Campaign Schedule, Event Schedule, One-off Events, and Offers. 

To specify Calendar parameters follow the procedure below: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > Setup > Calendar Criteria. 

3. Select Create. 

4. Fill in the following details: 

■ Object: Marketing object that will be displayed on the Calendar. 

■ Custom Setup: Select a custom setup for the marketing object selected. 

■ Start Date: Start date by which the marketing object selected will begin 
appearing on the Calendar. 

■ End Date: End date for which the marketing object selected will stop 
appearing on the Calendar. 

■ Priority: Priority level by which the marketing object will appear in the 
Calendar. 

■ Status: Marketing object status. For example, if the marketing object 
selected for display is “Campaign Schedule”, the status chosen may be 
Active Schedules. In this case, only Active Campaign Schedules will appear 
on the Marketing Calendar. 

5. Select Update to save your work. 

3.3.12.3 Running Concurrent Program for Calendar
Before the new object or criteria will display on the Marketing Calendar, run the 
concurrent program AMS : Interface Marketing Objects to Calendar. This 
program is a workflow background process and will update the Calendar as 
needed. 
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3.3.12.4 Configuring User Profiles
Before a user can view the Marketing Calendar they must specify in their user 
profile what marketing objects they want to view. Further, users can personalize the 
Calendar by saving preferences based on their needs. 

To configure user profiles for Calendar preferences follow the procedure below: 

1. Log in to Oracle Marketing. 

2. Select the Profile icon. 

3. Navigate to Calendar > Personalize. 

4. In the Display Items drop-down menu choose Yes. The default value for this 
drop-down menu is No. This profile turns on the Calendar feature. 

5. Select Update to save your work. 
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4
Implementing and Administrating

Campaigns

This topic group describes concepts and procedures related to Oracle Marketing 
campaign functionality.

Topics include:

■ Section 4.1, "Implementing Campaigns"

■ Section 4.2, "Administrating Campaigns"
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4.1 Implementing Campaigns
Implementing Campaigns is slightly different than administrating campaigns. 
Implementation tasks are considered one time setups. Administrative tasks, on the 
other hand, are ongoing and may require updates on a frequent basis. 

This section includes tasks for implementing Oracle Marketing Campaigns. 
Procedures listed below relate to setting up functionality existing outside the 
Campaign Workbench. For Campaign Workbench setup information, see 
Section 5.1, "Implementing the Campaign Workbench". 

To implement Campaigns, see: 

■ Section 4.1.1, "Setting up Campaign Users"

■ Section 4.1.2, "Setting Up Campaign Fulfillment"

■ Section 4.1.3, "Creating and Verifying Lookups for Campaigns"

■ Section 4.1.4, "Understanding Schedule Execution"

■ Section 4.1.5, "Running Concurrent Programs for Campaigns"

■ Section 4.1.6, "Implementing eMerchandising for the Campaign Tab"

■ Section 4.1.7, "Implementing Scripts for Campaigns"

4.1.1 Setting up Campaign Users
In Oracle Marketing, a user’s ability to perform certain functions depends on the 
associated responsibilities attached to the user. Depending on job function and 
related day-to-day tasks, assign one or both of the following responsibilities to your 
users: 

Marketing User Responsibility
This responsibility has the following visibility and privileges:

■ Ability to create campaigns, programs, budgets and budget security

■ Unable to see the Campaign Workbench

Marketing Super User Responsibility
This responsibility has the following visibility and privileges: 

■ Accesses all Marketing UI’s, including the Campaign and Audience 
Workbench. 
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■ Ability to navigate from the Oracle Marketing application to the Campaign and 
Audience Workbench.

4.1.2 Setting Up Campaign Fulfillment 
Refer to Section 3.2.4, "Implementing Fulfillment for Oracle Marketing" for 
information on setting up campaign fulfillment.

4.1.3 Creating and Verifying Lookups for Campaigns 
As mandated by your business requirements, verify or create the following 
lookups.

Table 4–1 Campaign System Lookups 

Lookup Key Value Meaning

AMS_ACCESS_TYPE Group Group

AMS_ CAMPAIGN_ 
SCHEDULE_STATUS

Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

New

On_Hold

Submitted_ BA

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

New

Active, but locked

Pending Budget Approval
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AMS_ CAMPAIGN_ 
STATUS

Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

Denied_TA

New

On_Hold

Planning

Submitted_Budget 
Approval

Submitted_Theme 
Approval

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

Denied Theme Approval

New

Active, but locked

Planned

Submitted for Budget Approval

Submitted for Theme Approval

AMS_ CAMPAIGN_
PURPOSE 

Awareness

Lead

Lead_ Maturation

Sales_ Readiness

Awareness

Lead Generation

Lead Maturation

Sales Readiness

AMS_ CONTACT_ 
POINT_TYPE

Address

Email

Fax

Inbound_ script

Outbound_ script

Phone

Website

Proposal

Address

Email

Fax

Inbound Script

Outbound Script

Phone

Website

Proposal

AMS_ MASTER_ 
OBJECT_ TYPE

Camp

CSCH

EONE

EVEH

Campaign

Campaign Schedule

One-Off Event

Event

Table 4–1 Campaign System Lookups (Cont.)

Lookup Key Value Meaning
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AMS_ MEDIA_ TYPE Broadcast

Deal

Direct_Marketing

Events

Internet

In_Store

Public_Relations

Trade_Promotion

Direct_Sales

Advertising

Deal

Direct Marketing

Events

Web Marketing

In Store

Press and Analyst Relations

Trade Promotions

Sales

AMS_ PRIORITY Fast_Track

High

Standard

Fast Track

High

Standard

AMS_ PROGRAM_ 
OBJECTIVE

User Defined

AMS_ PROGRAM_ 
STATUS

Active

Archived

Cancelled

Completed

New

On_Hold

Active

Archived

Cancelled

Completed

New

Active, but locked

AMS_ ROLLUP_ TYPE Coll

Deal

ECAM

EVCAM

Partner

RCAM

TRDP

Collection

Deal

Campaign

Event Promotions

Partner

Program

Trade Promotion

AMS_ SCHEDULE_ 
OBJECTIVE

User Defined User Defined

Table 4–1 Campaign System Lookups (Cont.)

Lookup Key Value Meaning
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4.1.4 Understanding Schedule Execution
The business events system automatically activates schedules on a specified start 
date. When the schedule is approved, the schedule execution workflow begins. This 
workflow has business events that can be used for further customizations.

4.1.5 Running Concurrent Programs for Campaigns
Run the following concurrent programs for campaigns: 

AMS_ TRIGGER_ CHK_ 
METRIC_ TYPE

Actual

Forecast

Actual Value

Forecast Value

AMS_ TRIGGER_ CHK_
TYPE

DIWB

Metric

Static_Value

Workbook

Metric

Static Value

AMS_ TRIGGER_ 
FREQUENCY_TYPE

Daily

Hourly

Monthly

None

Quarterly

Weekly

Yearly

The frequency of trigger checking

AMS_ TRIGGER_ TYPE Metric_Metric

Metric_Value

Metric_ Workbook

Metric to Metric type trigger

Metric to Value type trigger

Metric to Workbook type trigger

AMS_CAMP_ RELATED_ 
EVENT

EONE

EVEH

EVEO

One-Off Event

Event

Event Schedule

Table 4–1 Campaign System Lookups (Cont.)

Lookup Key Value Meaning
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4.1.6 Implementing eMerchandising for the Campaign Tab
eMerchandising is the Web marketing module within Oracle Marketing. When used 
with campaigns it enables Web marketing and personalization. eMerchandising can 
be implemented with Oracle iStore or any other third-party affiliate Web storefront. 

Before setting up eMerchandising the following applications need to be setup (if 
listed as mandatory). 

■ Oracle Marketing: Prior to implementing eMerchandising, Oracle Marketing 
must be properly implemented. 

■ Oracle iStore: This step is mandatory only if it is integrated with Oracle iStore. 
See the Oracle iStore Implementation Guide for details.

■ Oracle Partner Management: This implementation step is optional. See the 
Oracle Partner Management Implementation Guide for details.

■ Oracle iSupport: Implementing Oracle iSupport is optional. When 
implemented, the Oracle iSupport portal displays eMerchandising content. 

To implement eMerchandising see the following: 

■ Section 4.1.6.1, "Setting Web Posting and Placement Profiles"

Table 4–2 Campaign Concurrent Programs 

Concurrent Program Required Description

AMS: Complete 
Campaign Schedules

Optional This program accomplishes the 
following:

■ Picks up available schedules with a 
start date of today (or, a start date 
that has already passed) and 
activates them. 

■ Picks up active schedules with an 
end date of today (or, an end that 
that has passed) and completes 
them. 

Note: The eMerchandising module is an optional implementation 
step. It can only be implemented with Oracle Marketing 
Campaigns and is not designed to work with the Campaign 
Workbench.
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■ Section 4.1.6.2, "Verifying and Creating Lookups"

■ Section 4.1.6.3, "Running Concurrent Programs"

■ Section 4.1.6.4, "Setting Up the Guest User"

■ Section 4.1.6.5, "Integrating eMerchandising with Third-Party Web Storefronts"

4.1.6.1 Setting Web Posting and Placement Profiles
A Web posting is an object used to define personalized content that is dynamically 
selected and displayed at run-time in a placement. Web postings allow a particular 
content selection strategy to be executed depending on the conditions present.

There are two types of postings: 

■ Universal: Applies the same emerchandising strategy to all the visitors. 

■ Rule Based: Allows you to specify different merchandising strategies for 
different customers, using targeting conditions.

A Web placement is a logical representation for a physical space on an application 
page where some content (returned by a posting) is displayed. You can activate a 
placement once you assign to it a posting and display style. 

A Web placement is identified by: 

■ A site

■ A page

■ Page parameters 

To set system profiles for Web postings and Web placements, use the following 
procedure: 

Prerequisites
■ Oracle iStore and Oracle Partner Management are implemented, if required

Steps
1. Log in to Oracle Forms with System Administrator responsibility. 

2. Navigate to Profile > System.

3. Enter the profile name in the Profile Field and click Find.

4. Enter the appropriate value in the column corresponding to the level indicated.

5. Save your work. 
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The following table lists the system profiles and their values.

Table 4–3 eMerchandising Profile Options 

Option Required Level Setting Effect/Limitation

AMS :  Item 
Validation 
Organization

Yes Resp

Site

User 
Defined

This profile is used when validating 
the items that are used in posting 
definition and runtime. 

This will determine which items to 
be displayed when a product 
recommendation strategy is 
defined. 

AMS : 
Custom 
Condition 
Class

Optional Site Java class 
name of 
the custom 
condition

This class is invoked at runtime 
when custom conditions are 
implemented.

AMS : OA 
Media

Optional Site Physical 
file path of 
media 
directory 
where the 
image files 
are stored.

This is used in the upgrade process 
to read the files from the media 
directory and store them in the 
database.

AMS : 
Posting 
Runtime 
Shopping 
Cart 
Currency

Yes Site Select from 
a list of 
values. 
USD is the 
default.

Determines the currency in which 
shopping cart amounts are 
measured.

AMS : 
Upgrade 
iMarketing

Optional Site Yes/No Used to determine whether to 
upgrade iMarketing data from the 
previous version.

AMS: 
Merchant 
Party ID

Optional Site Choose 
from a list 
of Parties 
provided

This value determines the party ID 
of the current active merchant.

This sets the merchant ID for the 
creation of affiliate placements.

This option must be set before 
creating an affiliate site.



Implementing Campaigns

4-10 Oracle Marketing Implementation and Administration Guide                              

4.1.6.2 Verifying and Creating Lookups 
Use the following procedure to create and verify lookups:

Prerequisites
None

Steps
1. Log in to Oracle Forms as a user with the System Administrator responsibility. 

2. Navigate to Setups > Lookups. 

3. Choose View > Find to locate the individual keys. 

The following table lists the Lookups and their types, values, and meanings.

AMS: Server 
URL

Optional Site User 
Defined

This value determines the runtime 
URL path of the server. Used to 
generate API details for affiliates 
during placement definition.

This must be set before creating any 
affiliate placement definition.

For example: 
http://YourHostName:PortNum

IBE: Use Web 
Placements

Optional App Yes/No Determines whether placements are 
displayed. Required only when 
implementing iStore.

Table 4–4 Web Posting Lookups 

Key Type Values Meanings

AMS_POST_CONTENT_ 
TYPES

System Product

Schedule

Offers

Product

Web Advertisement

Web Offers

Table 4–3 eMerchandising Profile Options (Cont.)

Option Required Level Setting Effect/Limitation
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AMS_POST_ STRATEGY_ 
TYPE

System Manual_ Selection

Product_ 
Relationship

Custom

OP

Manually selected 
strategy

Strategy based on 
product relationship

Custom strategy

Used when Oracle 
Personalization is 
implemented -- only 
works with product 
content type 

AMS_POST_ PREDEF_ 
PROD_ CONTEXT

System Prod_viewed

Prod_in_cart

The product context for 
relationship based 
strategy.

AMS_PRIOR_ SORT_ 
ORDER

System Asc

Desc

Ascending

Descending

AMS_POST_ CATEGORY System Universal

Rulebased

Posting types: Universal 
or based on a rule.

AMS_POST_ STATUS System Active

Inactive

N/A

AMS_POST_ BUSPRIOR

(Business Priority)

System None

Random

Prod_list_ price

Campaign_ Start_
Date

Campaign_ End_
Date

Campaign_ Priority

None

Random (for all)

List Price (for products 
only)

Start Date, End Date, or 
Priority (for campaign 
schedules)

AMS_POST_ BUSPRIOR User Offer_Start_Date

Offer_End_Datte

Offer start and end 
dates are used by 
Web Offers

IBE_ RELATIONSHIP_
TYPES

Extensible Possible 
relationships 
between Products 
like Cross Sell, Up 
Sell. 

This is an iStore lookup 
type.

Table 4–4 Web Posting Lookups (Cont.)

Key Type Values Meanings
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AMS_POST_ 
RELATIONSHIPS

System Promoting 
Relationship types 
not covered by 
iStore

Promoting is a 
relationship not covered 
by iStore, as in 
promoting a product.

AMS_POST_ COMP_ 
OPERATOR

System EQ

GTE

LTE

Equal to

Greater than or equal to

Less than or equal to

Used to compare 
shopping cart amount.

AMS_POST_ AUDIENCE_ 
TYPE

System S

L

Segment

List

AMS_POST_ CND_DATA_ 
TYPE

System Float

String

Data Types returnable 
by Custom Condition 
Class.

AMS_PLCE_ SITE_ 
CATEGORY

System Oracle_Applications

Other_Applications

Affiliates

Oracle Applications

Other Applications

Affiliates

AMS_PLCE_ LOCATION_ 
CODE

Extensible Left1, Left2…Left7

Right1, Right2 … 
Right7

Top

Bottom

Positions for placements

Note: For Web offers to be displayed in Oracle Marketing, at the 
application level, set QP: Source System Code to Oracle Marketing.

Table 4–4 Web Posting Lookups (Cont.)

Key Type Values Meanings
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4.1.6.3 Running Concurrent Programs 
Run the following concurrent programs to update eMerchandising functionality. 
 

4.1.6.4 Setting Up the Guest User
You must create this account before you can view your online stores. If you do not 
create a guest user account, marketers will be unable to view the content created for 
eMerchandising. 

Use the following procedure to create the Oracle Marketing guest user account. 

Prerequisites
None

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Navigate to Security > User > Define.

3. In the User Name field, enter a user name, such as IBEGUEST, by which a guest 
user will be automatically logged in to Oracle Marketing.

4. In the Password field, enter a password for this user name.

Table 4–5 eMerchandising Concurrent Programs 

Concurrent 
Manager Required Description

AMS Web 
Execution: Specialty 
Store Items Refresh 
Program

Yes Refreshes the denormalized table for minisites 
periodically to capture items in the iStore minisites.

AMS Web 
Execution: 
Campaign Items 
Refresh Program

Yes Information about Campaigns is stored in multiple 
tables. To improve runtime performance, this program 
periodically collects required information on campaigns 
and places it into a single table.

AMS Web 
Execution: Refresh 
Offer Parties and 
Products

Yes Refreshes the Offer Denormalized tables. Marketing 
Online offers functionality will retrieve the Eligible 
Offers for any Products depending For Qualifying 
parties.

AMS: Refresh Party 
Market Segments

Optional Generates a list of parties in the segment. 
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5. In the Responsibilities block, choose an Oracle Marketing customer 
responsibility, such as IBE_CUSTOMER, from the Responsibility LOV.

6. Save the user record.

4.1.6.5 Integrating eMerchandising with Third-Party Web Storefronts
Integrating eMerchandising with Third-Party Web stores enables customers to 
create segments in Oracle Marketing. These segments can be re-used in rule-based 
posting conditions to personalize Web Ads. 

The Web Ads can be on sites such as the corporate Web site, or an employee portal 
built with Oracle Portal. This feature is also available even if the database storing 
the members of these sites are not in the TCA.

Web execution may be implemented by other application through jsp pages or 
HTML Pages. 

For example, suppose a campaign schedule is to be displayed on the homepage: 

■ Site = MYSITE

■ Page = HOME

■ Location(s) = TOP_CENTER and UPPER_RIGHT

Consult the following sections to integrate eMerchandising with a third-party 
storefront: 

■ Section 4.1.6.6, "Prerequisite Steps"

■ Section 4.1.6.7, "Implementing Web Execution through JSP Pages"

■ Section 4.1.6.8, "Implementing Web Execution through HTML Pages"

4.1.6.6 Prerequisite Steps
The following steps must be performed prior to implementing a Web execution 
through jsp or HTML pages. 

Steps
1. Define a Site in the Site definition screen (Marketing > Administration > 

Marketing > Execution > Sites) with a Programmatic Access Name for the site. 
In our example, the Programmatic Access Name for the site is ‘MYSITE’.

2. Define a Page for the above defined Site in the Page definition screen 
(Marketing Online > Administration > Marketing > Execution > Pages) with a 
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Programmatic Access Name for the page. In our example, the Programmatic 
Access Name for the page is ‘HOME’.

3. Define a Web placement location. The following locations are available: 

■ TOP

■ BOTTOM

■ MIDDLE 1-4

■ LEFT 1-7

■ RIGHT 1-7

4. Define posting (Marketing Online > Execution > Web Postings).

5. Define a Placement in the Placement definition screen (Marketing Online > 
Execution > Web Placements).

4.1.6.7 Implementing Web Execution through JSP Pages
In order to implement Web execution through java server pages, use the following 
steps. 

1. Set site and page attributes

a. These should be set at the top of the User Application jsp.

b. Set ‘site’ and ‘page’ attributes of page context with the corresponding 
programmatic access names 

c. In our scenario, the following would be code snippet for this step:

-------------------------------------------
<%
pageContext.setAttribute("site", “MYSITE”, PageContext.REQUEST_SCOPE);
pageContext.setAttribute("page", “HOME”, PageContext.REQUEST_SCOPE);
%>
-------------------------------------------

2. Set location and include amsWebPlacement.jsp where the recommendation is 
intended to be displayed. Repeat this step at every location where you want the 
recommendation to appear. 

Note: The jsp scope should always be ‘REQUEST’ scope, 
otherwise the recommendation will not be displayed.



Implementing Campaigns

4-16 Oracle Marketing Implementation and Administration Guide                              

a. Set Location attributes of page context.

b. Include file amsWebPlacement.jsp 

c. In our scenario, following would be code snippets for this step: 

-------------------------------------------
pageContext.setAttribute("location", “TOP_RIGHT”, PageContext.REQUEST_
SCOPE);
<jspinclude page="amsWebPlacement.jsp" flush="true" />
-------------------------------------------
-------------------------------------------
pageContext.setAttribute("location", “UPPER_RIGHT”, PageContext.REQUEST_
SCOPE);
<jspinclude page="amsWebPlacement.jsp" flush="true" />
-------------------------------------------

Notes
■ Above Step 1 should be done only once in a jsp.

■ Above Step 2 should be repeated at every location where you intend to see a 
recommendation.

■ Following are the seeded locations. New locations can be created in Location 
Lookup Types screen.

■ LEFT1, LEFT2, LEFT3, LEFT4, LEFT5, LEFT6, LEFT7

■ RIGHT1, RIGHT2, RIGHT3, RIGHT4, RIGHT5, RIGHT6, RIGHT7

■ TOP, BOTTOM

4.1.6.8 Implementing Web Execution through HTML Pages
Web execution can be implemented for HTML applications as well. For this method 
of implementation, a URL should be invoked with all required name-value 
parameters. This URL could be invoked through a java script from a HTML page. 
The invoked URL will get back the recommendations. 

Follow these steps to form the URL to be invoked.

Note: This amsWebPlacement.jsp will ultimately display a HTML 
code.
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1. http://<server name><port number>/OA_
HTML/amsWebPlacementLink.jsp?site=<Defined Programmatic Access Name 
of Site>&page=<Defined Programmatic Access Name of 
Page>&location=<Location code defined in location lookups>

2. The API that could be embedded in the HTML code would look something like 
following

-------------------------------------------
<!-- BEGIN Web Placements Tag -->
<script language="JavaScript"
src="http//www.mysite.com:8000/OA_
HTML/amsWebPlacementLink.jsp?site=MYSITE&page=HOME&location=TOP_CENTER">
</script>
<noscript>
</noscript>
<!-- END Web Placements Tag -->
-------------------------------------------

4.1.7 Implementing Scripts for Campaigns
Using the Scripting branching functionality marketing organizations can react 
differently to customer input based on a customer profile. Branching enables flow 
control logic for scripts allowing questions to be scripted based on the customer 
profile. Ultimately, this improves personalization and customer relationships. 

Using the Oracle Scripting Author scripts and surveys are created. After the Script 
is created, a marketer associates the script or survey to a Campaign Schedule. For 
more information about Scripting Author see Oracle Marketing Scripting Integration 
Guide.

To understand and implement Scripting for marketing purposes see the following 
sections:

■ Section 4.1.7.1, "Process Diagram for Creating Scripts"

■ Section 4.1.7.2, "Deploying Scripts into the Database"

■ Section 4.1.7.3, "Creating a Survey Deployment"

Note: The jsp to be used for HTML Applications is 
amsWebPlacementLink.jsp.
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■ Section 4.1.7.4, "Attaching Scripts to a Campaign Schedule"

■ Section 4.1.7.5, "Attaching Survey Deployment to a Campaign Schedule"

■ Section 4.1.7.7, "Seeded Script: Customer Authentication Building Block"

■ Section 4.1.7.8, "Seeded Script: Event Registration"

■ Section 4.1.7.9, "Seeded Script: Lead Creation"

■ Section 4.1.7.10, "Seeded Script: Customer Data Acquisition"

■ Section 4.1.7.11, "Implementing Scripting and Survey Reports"

■ Section 4.1.7.12, "Understanding Script Dashboard Reports"

4.1.7.1 Process Diagram for Creating Scripts
The following diagram depicts the  sequence of tasks and interactions for 
integrating a script into a marketing campaign. 

Figure 4–1 Process Flow Diagram: Creating Scripts

[
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4.1.7.2 Deploying Scripts into the Database
All scripts need to be deployed into the database before they can be used. If adding 
a new script or modifying an existing script, database deployment is again required. 

To deploy a script into the database (in any environment) use the following 
procedures: 

Prerequisites
None

Steps
1.  FTP the script from $AMS_TOP/scripts directory to your local machine. 

2. Launch the Script Author Applet from Scripting Administration Console. 

– For more information on the Script Author Applet refer to the following 
OracleMetaLink note: Oracle Scripting (IES) Interaction Center Family Pack P 
Readme. 

3. Log into jtflogin.jsp as a user with Scripting Administrator responsibility.

4. Select Launch Script Author.

This starts the Script Author applet. 

5.  In Script Author, open the script (open one at a time).   

6. From the Tools Menu, select Deploy Script.

This will deploy the script into the database. 

7. Repeat this process for deploying additional (or modified) scripts into the 
database. 

4.1.7.3 Creating a Survey Deployment
After deploying the scripts into the database, a Survey deployment must be created. 
Survey deployments are integrated with the Campaign Schedule in the 
Click-Through Destination (CTD) Module of Oracle Marketing. 

Use the following sequence when creating a survey deployment: 

1. Using Oracle Scripting - create a Survey Campaign.

2. Using Oracle Scripting - create a cycle for the Campaign. 

3. Using Oracle Scripting - create a Survey deployment. 
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4. Using Oracle Marketing - attach deployed survey to its appropriate CTD. 

In order to create a Survey Campaign a “survey resource” must be associated with 
it. Survey resources are HTML files or file fragments, displayed to users of the 
survey at runtime. Resources are displayed in each HTML file as a: 

■ Header section

■ Footer section

■ Error section

■ Final section

Although the resource might not contain dynamic content, it must be saved in Java 
Server Page (jsp) format. However, survey resources, like any other HTML or jsp 
page, may include images and hyperlinks.

The following jsp survey resources are seeded with the product:

■ amsScriptHeader.jsp - can be used to create the header resource 

■ amsScriptError.jsp - can be used to create error resource

■ amsScriptFooter.jsp - can be used to create footer resource

■ amsScriptThankyou.jsp - can be used to create a final page resource

If launching a Web script from Oracle iStore, generally the last page of the script 
will be  a “thank you” page. For example, the last page could be the 
amsScriptThankyou.jsp. In this case, it is recommended that you insert a link (in the 
thank you page) directing users back to a designated iStore page. 

For additional details see the Oracle Scripting Implementation Guide. 

4.1.7.4 Attaching Scripts to a Campaign Schedule
Deployed scripts are attached to a Campaign Schedule using the Campaign 
Schedule’s inbound or outbound Contact Points. The contact points are added 
under the Collaboration side navigation menu.

4.1.7.5 Attaching Survey Deployment to a Campaign Schedule
After the script has been added to the contact point, the survey deployment needs 
to be added to the content side navigation menu (within the campaign schedule). 
Because a script can contain multiple survey deployments, you must specify scripts 
at contact point level. 
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To attach a survey deployment to an existing campaign schedule use the following 
procedure: 

Prerequisites
■ Scripts are attached to the Contact Point

■ Survey Deployment is created 

Steps
1. Log in to Oracle Marketing. 

2. Navigate to the Campaign Schedule’s Click-Through-Destination Page.

3. Pick the action “Go to Web Script” in the corresponding 
Click-Through-Destination Page. 

4. Select a Web script from the Web Script LOV. 

This LOV contains only those survey deployments created for the scripts 
attached to the Campaign Schedule’s contact point. For more information see 
Section 4.2.6.3, "Understanding Click-Through Actions".    

5. Select Update to save your work. 

4.1.7.6 Implementing Seeded Scripts
Oracle Scripting contains seeded scripts focused on various marketing activities. 
These scripts can be used with minimum configuration and can be deployed as 
call-center scripts or Web surveys. In addition to simplifying processes, scripts can 
help ensure communication consistency.

Scripting Marketing Activities: 

■ Event Registration: Enables online self service registration for Marketing 
Events. 

■ Lead Creation: Captures information from customers/prospects and creates 
leads based on this information. 

■ Data Acquisition: For existing customers, this script enables the Marketing 
application to capture additional information to further enhance the customer 
profile.

Seeded Scripts: 

■ amscauth.scr   - Customer Authentication (building block)
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■ amserb2b.scr   - B2B Event registration 

■ amserb2c.scr   - B2C Event registration 

■ amserwca.scr - Event registration with customer authentication

■ amsldb2c.scr - B2C Lead creation 

■ amsldb2b.scr - B2B Lead creation 

■ amsldwca.scr – Lead creation with customer authentication

■ amsdatacq.scr - Data acquisition

The following scripts are not supported in a single sign environment:

■ amscauth.scr   - Customer Authentication (building block)

■ amserwca.scr - Event registration with customer authentication

■ amsldwca.scr – Lead creation with customer authentication

■ amsdatacq.scr - Data acquisition

To implement seeded scripts see the following:

■ Section 4.1.7.7, "Seeded Script: Customer Authentication Building Block"

■ Section 4.1.7.8, "Seeded Script: Event Registration"

■ Section 4.1.7.9, "Seeded Script: Lead Creation"

■ Section 4.1.7.10, "Seeded Script: Customer Data Acquisition"

4.1.7.7 Seeded Script: Customer Authentication Building Block 
This seeded script is a building block because it is used with the other scripts to 
provide core functionality. If you are creating new scripts, the building block script 
may need to be included. 

The Customer Authentication Building Block script provides the following 
functionality:

■ Allows the end users to login using their user id and password.

■ Allows the end users to resets their password - sends the re-set password to the 
user through e-mail. 

■ Allows users to create an Individual or Business user.
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4.1.7.8 Seeded Script: Event Registration 
The Event registration script provides a scripted flow of interactions for customer 
self-service online registration. This script is used for registering for marketing 
Events. For example, the Marketing Event “Oracle Open World” requires 
participants to register online. The registration text (questions that users fill out 
online) are part of a seeded script. This script supports registration to free Events 
only. 

Three seeded scripts are shipped for Event Registration: 

■ amserb2b.scr   - B2B Event registration

■ amserb2c.scr   - B2C Event registration 

■ amserwca.scr - Event registration with customer authentication

To implement Event Registration Scripts use the following procedure: 

Prerequisites
■ A registrable Event is available.   

■ Scripts are deployed. 

■ Survey is deployed. 

■ Script and Survey is attached to a Campaign Schedule. 

■ Oracle One-to-One Fulfillment is implemented. 

Steps
1. Log in to Oracle Marketing. 

2. Navigate to the Campaign Schedule’s Click-Through-Destination Page.

3. Pick the action “Go to Web Script” in the corresponding 
Click-Through-Destination page. 

4. Select a Web script from the Web Script LOV.   

5. Select an Event from the Event LOV. 

This step is required for Event Registration scripts. If you do not select an Event 
object from the LOV, the Event Registration Script will fail. 

6. Save your work. 
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4.1.7.9 Seeded Script: Lead Creation
The lead integration script captures information about customers. After capturing 
this information, it is passed to the lead import interface table AS_IMPORT_
INTERFACE. When the lead import process is invoked, the lead engine uses this 
information to qualify, grade, and route the lead. 

After the script has ran successfully, the lead import process should be invoked. 
This ensures that the lead engine uses this information to qualify, grade, and routes 
the lead. 

Once the customer participates in the Lead Creation Survey, the Lead Import 
Concurrent Program (Sales Import) should be started to invoke the lead import 
process. For more information see the Oracle Leads Implementation Guide. 

The following scripts are seeded for Lead Creation: 

■ amsldb2c.scr - B2C Lead creation 

■ amsldb2b.scr - B2B Lead creation 

■ amsldwca.scr – Lead creation with customer authentication

To implement a Lead creation script follow the procedure below: 

Prerequisites
■ Scripts are deployed. 

■ Survey is deployed. 

■ Script and Survey is attached to a Campaign Schedule. 

Steps
1. Log in to Oracle Marketing. 

2. Navigate to the Campaign Schedule’s Click-Through-Destination Page.

3. Pick the action “Go to Web Script” in the corresponding 
Click-Through-Destination page. 

4. Select a Web script from the Web Script LOV. 

For the Lead scripts it is not necessary to pick the Event object from the Event 
LOV.   

5.  Save your work. 
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4.1.7.10 Seeded Script: Customer Data Acquisition 
This script enhances customer profiles improving segmentation, campaign 
personalization and customer specific offers. The goal of this script (from a business 
perspective) is to acquire additional data about a customer (by way of a survey.) By 
default, this script is paired with the customer authentication building block. 

The following fields are used to capture customer information in the TCA HZ_
PERSON_PROFILES table: 

■ DATE_OF_BIRTH

■ PLACE_OF_BIRTH

■ GENDER

■ MARITAL_STATUS

■ MARITAL_STATUS_EFFECTIVE_DATE

■ PERSONAL_INCOME

■ HEAD_OF_HOUSEHOLD_FLAG

■ HOUSEHOLD_INCOME

■ HOUSEHOLD_SIZE

■ RENT_OWN_IND

To implement the data acquisition script use the following procedure:

Prerequisites
■ Scripts are deployed. 

■ Deployed Script and Survey are attached to a Campaign Schedule.

Steps
1. Log in to Oracle Marketing. 

2. Navigate to the Campaign Schedule’s Click-Through-Destination Page.

3. Choose the action “Go to Web Script” in the corresponding 
Click-Through-Destination page. 

4. Select a Web script from the Web Script LOV. 

For the data acquisition script it is not necessary to pick the Event object from 
the Event LOV.   
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5. Save your work. 

4.1.7.11 Implementing Scripting and Survey Reports
The survey data report is available for those scripts attached as inbound/outbound 
contact points of a Campaign Schedule. 

The following reports are available:

■ Number of people who have started the survey.

■ Number of people who have completed the survey.

■ Report for questions with pre-defined list of answers.

If the answers are based on a query or API, the last report will not display the data.

4.1.7.12 Understanding Script Dashboard Reports
A deployed seeded script can be evaluated using a Dashboard Report. These 
reports are intended for “Marketing Research” types of Web scripts. The list of 
values is pre-defined using Script Author. The list of values must have “Specific 
Lookup” associated with them. For more information on Specific Lookup, refer to 
Oracle Scripting User Guide. 

Reporting is possible for the following lookup types: 

■ Dropdown

■ Radio Button

■ Checkbox Group

■ Multi select List 

The following questions fall under the required criteria. Therefore, the following 
questions can be reported on. 
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Table 4–6 Scripting Reports 

Script Name Question Description Question Type

Event Registration with 
Customer Authentication

1. Select One:

2. Select One:

3. Select One: 

4. Event Registration 
Options: 

1. From Sign-In Page 
of Customer 
Authentication 
Block

2. From Sign-In Page 
of Customer 
Authentication 
Block 

3. From Sign-In Page 
of Customer 
Authentication 
Block                                                            

4. From Event 
Registration Page                                                                                                    

1. Radio Button

2. Radio Button

3. Radio Button

4. Radio Button

Lead Creation with 
Customer Authentication

1. Select One 1. From Sign-In Page 
of Customer 
Authentication 
Block

1. Radio Button

Data Acquisition 1. Gender 

2. Are you the head of 
your household? 

3. Do you rent or own 
your house? 

4. Select one: 

1. From Data 
Acquisition Page 

2. From Data 
Acquisition Page                                                          

3. From Data 
Acquisition Page                                                                 

4. From Sign-In Page 
of Customer 
Authentication 
Block                                                                

1. Radio Button

2. Radio Button

3. Radio Button

4. Radio Button

Customer Authentication 
Block

1. Select One 1. From Sign-In Page 
of Customer 
Authentication 
Block          

1. Radio Button
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4.2 Administrating Campaigns
Administrating Campaigns is slightly different than implementing campaigns. 
Administrative tasks include setups that are on-going and require updates. 

To administrate Campaigns use the following procedures: 

■ Section 4.2.1, "Setting Up Marketing Mediums for Campaigns"

■ Section 4.2.1, "Setting Up Marketing Mediums for Campaigns"

■ Section 4.2.2, "Setting Up Campaign Triggers"

■ Section 4.2.3, "Setting Up Activities for Campaigns"

■ Section 4.2.4, "Setting Up Marketing Source Codes"

■ Section 4.2.5, "Setting Up the Marketing Calendar"

■ Section 4.2.6, "Setting Up Click-Through-Destinations for Campaigns"

■ Section 4.2.7, "Setting Up Oracle Personalization for Campaigns"

■ Section 4.2.8, "Setting Up Campaign Budgets"

■ Section 4.2.9, "Setting Up Offers for Campaigns"

4.2.1 Setting Up Marketing Mediums for Campaigns
Marketing Mediums relate to a specific channel used to execute a Campaign. 
Therefore, they differ by activity. Certain execution channels, such as Oracle 
Advanced Outbound, require particular Marketing Mediums to be selected for a 
Campaign Schedule.

For example, a Valentine’s Day direct mail Campaign has a primary Campaign 
Schedule. The Campaign Schedule includes an activity type of direct marketing, an 
activity of direct mail, and a Marketing Medium of direct mail house. In this 
example, the direct mail house is the chosen execution strategy for this Campaign. 
In other words, the Valentine’s Day Campaign will be executed through the mail. 

Use the following procedure to create Marketing Mediums used in Campaign 
Schedules.

4.2.1.1 Process Flow for Creating Marketing Mediums
The following flow describes the process for creating a marketing medium. 

1. Determine Business requirements for Marketing Mediums.
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2. Create Marketing Medium. This task is performed by the Oracle Marketing 
Administrator. 

3. Attach marketing medium to the channel (activity) which will be used for 
schedule execution.

4. Create a Campaign. This task is performed by a marketer or user. 

5. Create Campaign Schedule. This task is performed by a marketer or user. 

6. Include Marketing Medium as part of the Campaign Schedule. This task is 
performed by a marketer or user. 

For example, assume that a Campaign “Valentine’s Day Direct Mail” has been 
created. To accompany this Campaign, a Campaign Schedule with the following 
attributes exists: 

■ Activity type - Direct Marketing

■ Activity - Direct Mail 

■ Marketing Medium - Direct Mail House

In this example, the Marketing Medium (Direct Mail house) is used as the execution 
channel for the Campaign (Valentine’s Direct Mail).

For more information about performing the user tasks see the Oracle Marketing User 
Guide. 

Use the following administrative procedure to create Marketing Mediums: 

Prerequisites
■ Marketing Campaign is created

■ Campaign Schedule is created

Steps
1. Log in to Oracle Marketing.

2. Navigate to Administration > Marketing > Marketing Medium.

3. Select Create.

4. Fill out the following required fields as they relate to Marketing Mediums.

■ Marketing Medium Name: This should reflect the Campaign Schedule, 
activity type, and activity it will be associated with.

■ Country: Choose the appropriate country for the Marketing Medium.
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■ Activity: Choose the appropriate activity for which this medium will 
support. For example, if the Marketing Medium is Direct Mail House, 
choose Direct Mail for the activity.

5. Select Create.

Confirmation text appear on the page indicating that changes are saved. After 
the Marketing Medium has been created by the Administrator, the Marketer 
can then use the Marketing Medium as part of the Campaign Schedule. 

4.2.2 Setting Up Campaign Triggers
Triggers enable marketers to improve marketing communications by automatically 
executing campaigns when specific customer or business situations arise. 

This functionality is particularly valuable because customers have become sensitive 
to mass and/or inappropriate marketing communications. Therefore, the trigger’s 
precise ability to execute campaigns based on timing and relevance provides a key 
marketing advantage. 

Oracle Marketing includes the following Campaign trigger functionality: 

■ Trigger for Date Based Repeating Schedules: Allows a marketer to create 
repeating campaign schedules that repeat based on a date frequency. 

■ Trigger for Single Condition Based Repeating Schedules: Enables a marketer to 
execute a “follow-up” campaign schedule based on the satisfaction of single 
condition. 

■ Trigger for Single Condition Based Notifications: Enables a notification to be 
automatically sent (to a specified resource) each time a specific criteria is met. 

■ Stop Trigger Functionality: Enables a marketer to immediately stop a trigger. 

4.2.2.1 Trigger Terms and Definitions
Prior to using, implementing, or customizing triggers review the terminology listed 
in the table below.
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Table 4–7 Trigger Terms and Definitions 

Term Definition

Trigger A mechanism that enables an action to be performed on a specific Marketing object. 
This mechanism is either date based or date and condition based. If the condition 
defined for the trigger is satisfied then an action is invoked. 

Trigger Action Once a condition is met, the trigger kicks off an action. The trigger action determines 
what happens next. 

The following actions are supported:

Seeded Marketing Actions: 

■ Sends notification to a specified resource

■ Executes associated campaign schedules

Custom Marketing Actions: 

■ Using custom logic, a non-seeded action can be created.

Trigger Condition A condition specifies what the trigger will monitor. Trigger conditions use metrics to 
measure and compare the performance of Marketing objects.   

Supported Trigger Conditions:

■ Metric to Metric Comparison

■ Metric to Value Comparison

■ Metric to Workbook Comparison

Metrics Oracle Marketing uses metrics to measure the performance of Marketing objects. 
Many metrics are seeded with the application - if not seeded, a metric can be created 
manually. 

The trigger functionality uses metrics to compare Marketing object values; the result 
of this comparison becomes the trigger condition. 

When the defined trigger condition is met an action is invoked. In other words, 
metrics (by being compared to another metric, value, or workbook) cause a trigger 
action to invoke. 

Metric to Metric Trigger 
Condition

Compares a Marketing object’s metric value to another Marketing object’s metric 
value. 

For example, campaign forecasted responses (metric) can be compared to campaign 
actual responses (metric). If the specified condition is met (forecasted responses is 
equal to actual responses) an action is invoked. 

Metric to Value Trigger 
Condition

Compares a Marketing object’s metric value to another value. 

For example, campaign responses (metric) can be compared to 20,000 (value). If the 
operator (=) is selected, once the campaign responses = 20,000 a trigger initiates an 
action. 
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Metric to Workbook 
Trigger Condition

Compares a Marketing object’s metric value to a Discoverer workbook value. When 
using this type of condition, a metric value is compared to a remote data source 
(using a workbook). 

For example, a person’s monthly spending (metric) can be compared to his/her 
average monthly spending (calculated using Discoverer workbook). 

Date Based Trigger This type of trigger is based on a predetermined date and time, it does not monitor a 
condition. In this case, the date criteria replaces the trigger condition. When the 
predetermined start date is met the trigger action begins. 

Repeating date based triggers can be created enabling a schedule to automatically 
re-run on an hourly, daily, monthly, quarterly, or yearly basis.

Repeating Schedules Repeating schedules can re-run based on a date or single condition criteria. 

When a repeating schedule re-executes, a new copy of the schedule is made - the 
original schedule is preserved. When the condition is met, the trigger picks up the 
new schedule; the schedule runs based on its defined criteria. 

The new schedules executes and the old schedule is preserved. In other words, each 
execution is a new instance of the schedule, therefore a marketer is able to separately 
track campaign responses for each schedule. 

For example, a trigger activates schedule A and it runs for a specific period of time. 
When schedule A is ready to repeat (based on the repeat unit), a copy of schedule 
A’s information is made and becomes schedule B. Schedule A’s information is 
preserved, schedule B becomes the active schedule. This cycle repeats until the 
trigger end date is reached. All schedule information is separately preserved - 
therefore, it can be individually viewed for tracking purposes. 

For more information about repeating schedules, see the following: 

■ Section 4.2.2.3, "Creating a Date Based Repeating Schedule" 

■ Section 4.2.2.4, "Execute Associated Campaign Schedule based on Single 
Condition"

Table 4–7 Trigger Terms and Definitions (Cont.)

Term Definition
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4.2.2.2 Trigger Functional Flow Diagram 
Prior to implementing or using triggers, review the functional flow diagram. 

Trigger Monitor 
Frequency

Defines the frequency in which conditions are checked for satisfaction. A trigger 
runs for a set period of time and conditions are verified only for that period. 

Trigger Monitor Frequency Determinants:   

■ Start and End Date

■ Time Zone

■ Repeat Every (for example, every 1 hour, 2 days, 1 week, etc.)

Triggers Repeat Units:

■ Hour

■ Day

■ Week

■ Month

■ Quarter

■ Year

Trigger Notification A Workflow notification sent to a specified resource. Once a trigger condition is met, 
if the action is setup to send a notification, one will be sent to the specified resource. 

Trigger Workflow The major functionality behind triggers is provided by Oracle Workflow. 

Table 4–7 Trigger Terms and Definitions (Cont.)

Term Definition
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Figure 4–2 Trigger Functional Flow

1. Create Campaign

When creating a campaign, a marketer creates one or more campaign schedule for 
it. If using a trigger, the campaign must be of type Direct Marketing: e-mail, 
telemarketing, direct mail, or fax. 

2. Create Schedule and Trigger

a. Create Campaign Schedule

A campaign schedule (of type Direct Marketing - Email, Fax, Mail, 
Telemarketing) is created for the campaign. The schedule must be marked as 
“Triggered” and can be repeating or one-time. 

b. Create Trigger

Triggers are created at the campaign level but associated at the campaign 
schedule level. Once a campaign schedule is associated with a Trigger, it 
executes depending on when the condition or date is met.   

3. Attach Schedule to Trigger

Once a campaign schedule is available it can be associated to a Trigger. When the 
Trigger condition is satisfied, the schedule is available for automatic execution. 

4. Execute Trigger Action

Execution is automatic if the condition is met. A marketer can use a seeded action or 
create a custom action. 
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4.2.2.3 Creating a Date Based Repeating Schedule 
This feature enables a marketer to create a campaign schedule that is triggered to 
repeat based on a date frequency. 

Scenario 
Amy works in the marketing department at a large retail chain. She has determined 
that online clothing sales are slow at the end of the month. As a result, Amy needs 
to create an e-mail blast that starts on June 28 and repeats monthly. Amy wants the 
e-mail blast to include only recent sign-ups - previously contacted customers must 
be excluded. 

Solution
Amy has created a campaign schedule (of type direct marketing - email) that 
repeats monthly on the 28th day. When repeating, the schedule is marked to 
“excludes previous entries from target group” therefore, the e-mail blast is sent only 
to new customers.  

Prerequisites
■ Campaign is created 

■ Campaign is activated

■ Campaign Schedule of type Direct Marketing - e-mail is created 

■ Campaign Schedule contains valid target group

Steps
1. Log in to Oracle Marketing.

2. Navigate to Campaign > Campaigns.

3. On the Campaigns landing page, select the campaign for which you are 
creating a repeating schedule. 

4. Select Trigger. 

The Campaign Details - Trigger page opens. Exact navigation path depends on 
release number and custom setup groupings. 

5. Select Create.

6. Enter the following information:

■ Trigger Name: Monthly Email Blast
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■ Type: Date Based 

■ Description: Date based repeating Schedule test    

7. Enter the following Monitor Setup information: 

■ Time Zone: Select the time zone that applies for your implementation   

■ Start Date: Today’s Date    

■ End Date: 4 months after start date 

■ Every: Use these fields to specify the repeat frequency 

■ In the blank text box enter 1. This is the numeric value for the repeat 
frequency.

■ Using the drop-down menu, select months.

8. Place a check in the Execute Associated Schedules check box.

If this check box is not checked, the campaign schedule associated to this 
Trigger will not execute.

9. Select Create.

Figure 4–3 Date Based Trigger 

10. Navigate to the Campaign Schedule for this campaign. 
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Exact navigation path depends on release number and custom setup groupings. 

11. Navigate to the Trigger Details section (lower region of the Campaign Schedule 
- Details page.) 

12. Highlight Use Trigger. 

13. In the Use Trigger drop-down menu, select Monthly Email Blast. 

14. Place a check in the Repeat check box. 

This enables the campaign schedule to repeat based on the frequency specified 
in the Trigger - details page. 

15. Place a check in the Exclude previous entries from Target Group check box. 

16. Select Update to save your work. 

17. Verify that the status of campaign schedule is Available. 

18. Save your work. 

What Happens Next?
A date based repeating campaign schedule has been created. Because the campaign 
schedule is marked to repeat and the Trigger is date based, the campaign will 
repeat on the 28th day of each month. 

When the Trigger condition (date = 28) is met, the campaign schedule re-executes 
and sends out an e-mail blast to the target group. Previously contacted customers 
will be excluded from the e-mail blast. 

4.2.2.4 Execute Associated Campaign Schedule based on Single Condition 
This functionality enables a marketer to execute a “follow-up” campaign schedule 
based on the satisfaction of a single condition. 

Scenario 
Bob is the marketing director at Willow Software Company. His group is launching 
the new release of their flagship product, Willow 9x. To determine if the planned 
messaging for the launch will be effective, Bob sets up a test email campaign 
schedule to a subset of the target audience for the launch campaign. If the response 
to this test schedule is good, Bob wants to automatically expand the email message 
to a larger target audience using a triggered campaign schedule. 
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Solution
Bob creates a campaign called Willow 9x Release with two child campaign 
schedules: "test schedule" and "primary schedule". The campaign contains a single 
condition based trigger that executes an action (execute associated schedules, in this 
case the "primary schedule") when/if actual responses for the test schedule are 
greater than the forecast responses. When the trigger condition is met, a notification 
is send to Bob and the primary schedule is activated. This trigger automatically 
expands the successful email message to a larger audience. 

Prerequisites
■ Campaign is created

■ Campaign is activated

■ Two campaign schedules (listed below) of type direct marketing - email are 
created:

– Test schedule for product launch

– Primary schedule for product launch

■  Test schedule forecasted responses count is set to 1000

■  Test schedule is activated 

Steps
1. Log in to Oracle Marketing.

2. Navigate to Campaign > Campaigns.

3. On the Campaigns landing page, select the Campaign for which you are 
creating a trigger. 

4. Select Trigger. 

The Campaign Details - Trigger page opens.Exact navigation path depends on 
release number and custom setup groupings. 

5. Select Create.

6. Enter the following general information:

■ Trigger Name: Willow_9x_Release

■ Type: Metric to Metric

In this example Actual Responses Count (metric) is being compared to 
Forecast Responses Count (metric). 
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■ Description: Optionally enter a description for the Trigger   

7. Enter the following Monitor Setup information: 

■ Time Zone: Select the time zone that applies.   

■ Start Date: Today’s Date    

■ End Date: 3 months after start date 

■ Every: Use these fields to specify the repeat frequency 

■ In the blank text box enter 1. This is the numeric value for the repeat 
frequency. 

■ Using the drop-down menu, select weeks. 

■ By setting this value to every 1 week, the trigger will check the condition 
for satisfaction once per week.

8. In the Condition section, specify the metric comparison parameters. 

Condition set 1 (metric): 

■ Object Type: Campaign Schedule

■ Object Name: Using the flashlight icon, select the campaign schedule in 
which this Trigger condition applies. In this example, select TEST CAMP 
SCHEDULE. 

■ Metric Name: Responses Count

■ If the expected seeded metric is not appearing in the metric name 
drop-down menu you might need to add the metric to the marketing 
object’s available metrics. For more information, see the Oracle Marketing 
User Guide. 

■ Metric Type: Actual Value 

■ Comparison set 2 (metric): 

■ Operator: Select (>) 

In this example, the trigger business requirements call for the primary 
campaign schedule to be executed if actual responses for the test campaign 
schedule are “greater than” forecasted responses. Therefore, the metric 
comparison uses the > operator.   

■ Object Type: Campaign Schedule
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■ Object Name: Using the flashlight icon, select the campaign schedule in 
which this Trigger condition applies. In this example, select TEST CAMP 
SCHEDULE.

■ Metric Name: Responses Count

If the expected seeded metric is not appearing in the metric name 
drop-down menu you might need to add the metric to the marketing 
object’s available metrics. For more information, see the Oracle Marketing 
User Guide. 

■ Metric Type: Forecast Value 

9. Place a check in the Send Notification check box. Select the flashlight icon to 
select the resource that will receive the notification. 

The notification will be sent when the trigger condition is met. 

10. Place a check in the Execute Associated Schedules check box. 

11. Select Create.
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Figure 4–4 Execute Associated Campaign Schedule based on Single Condition

12. Navigate to the primary campaign schedule for this campaign. 

Exact navigation path depends on release number and custom setup groupings. 
On the Campaign Schedule - Details page scroll to the Trigger Details section. 

13. Highlight Use Trigger. 

14. In the Use Trigger drop-down menu, select Willow_9x_Release. 

15. Select Update.

16. Save your work. 

What Happens Next? 
The trigger monitor has been set to re-run each week. When the trigger monitor 
runs, if the actual responses for the test schedule are greater than the forecast 
responses, the primary schedule for the product launch is activated and a 
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notification is sent to Bob. The outcome of this trigger is to expand the successful 
email message from the test schedule to a larger audience. 

4.2.2.5 Sending a Notification Based on the Satisfaction of a Single Condition
This feature enables you to setup a trigger to send a notification when a single 
condition is met. 

Scenario
Tom is creating a Mother’s Day floral campaign. Tom manages the marketing 
group therefore, he needs to monitor the marketing campaign budget. As a result, 
Tom needs to setup a trigger for this campaign to notify him if he is within $25,000 
of his total budget. Tom’s total campaign budget is $400,000. Therefore, he wants to 
be notified if the Mother’s Day floral campaign costs cause him to reach $375,000. 

Solution
Tom has created a trigger that sends him a notification when campaign costs are 
within $25,000 of his total budget. Therefore, Tom will receive an e-mail notification 
if his costs reach $375,000. 

Prerequisites
Campaign is created

Steps
1. Log in to Oracle Marketing.

2. Navigate to Campaign > Campaigns.

3. On the Campaigns landing page, select the campaign for which you are 
creating a repeating schedule. 

The Campaign Details page open. 

4. Select Trigger. 

The Campaign Details - Trigger page opens.

Exact navigation path depends on release number and custom setup groupings. 

5. Select Create.

The Trigger Create page opens.

6. Enter the following general information:
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■ Trigger Name: Floral Campaign monitor

■ Type: Metric to Value 

■ Description: Optionally enter a description for the Trigger   

7. Enter the following Monitor Setup information: 

■ Time Zone: Select the time zone that applies to your area 

■ Start Date: Select Today’s date 

■ End Date: 4 months after start date 

■ Every: Use these fields to specify the repeat frequency

■ In the blank text box, enter 1.   

■ Using the drop-down menu, select hours.   

8. In the Condition section select the metric comparison values. 

Comparison set 1 (Metric): 

■ Object Type: Campaign

■  This is the Metric object type for the first side of the comparison. 

■ Object Name: Using the flashlight icon, select the campaign in which this 
Trigger condition applies. 

■ Metric Name: Total Cost 

■ If the expected seeded metric is not appearing in the metric name 
drop-down menu you may need to add the metric to the marketing objects 
available metrics. For more information, see the Oracle Marketing User 
Guide. 

■ Metric Type: Actual Value 

Comparison set 2 (Value): 

■ Operator: Select > 

■ Value: $375,000 

■ Enter the numeric value for the operator (selected previously).

In this example, the Trigger needs to execute if the Mother’s Day floral 
Campaign costs cause the manager to come within $25,000 of the total 
budget.

Because of these requirements, the values are: 
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– Metric: Total Campaign Costs

– Operator: > 

– Value: $375,000   

9. Select Create. 

10. Navigate to the campaign schedule for this campaign. 

11. Highlight Use Trigger. 

12. In the Use Trigger drop-down menu, select Floral Campaign budget monitor. 

13. In the Send Notification to text box, select the resource in which the notification 
will be sent. 

This person must exist as a resource in the JTF_RESOURCES table. 

14. Select Update.

15. Verify that the campaign schedule status is Available. 

16. Save your work. 

What Happens Next? 
The Trigger is marked to send notifications, therefore the marketing manager will 
receive an email notification if the Mother’s Day floral campaign costs come within 
$25,000 of the total budget. In order for this to happen, the marketing manager must 
exist as a resource in the system. 

4.2.2.6 Stopping a Trigger 
This feature enables a marketer to stop a trigger at any given time. 

Scenario
John is the marketing manager for an annual Summer Khaki Shorts campaign. 
Starting in May, each Monday an email blast needs to be sent to a target group. The 
exact length of the campaign is unknown because summer duration depends on 
annual weather patterns. As a result, John needs the flexibility to immediately stop 
the campaign.

Solution
Unfortunately, this summer the weather became cool sooner than expected. John 
was able to manually terminate the trigger and immediately stop the Summer 
Khaki Shorts Campaign.
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Prerequisites
■ Campaign is created

■ Campaign Schedule is active

■ Campaign Schedule is associated to an active Trigger

Steps
1. Log in to Oracle Marketing.

2. Navigate to Campaign > Campaigns.

3. On the Campaigns landing page, select the campaign that currently contains 
the Trigger.   

4. Select Execution. 

5. Select Trigger. 

Exact navigation path will depend on your release number and custom setup 
groups.

6. Select Stop Trigger. 

What Happens Next?
Because the Trigger has been stopped, the campaign schedules it is associated with 
will no longer execute based on the conditions specified by the Trigger. In other 
words, the Trigger is immediately terminated and the schedule must execute using 
another Trigger or by using manual methods.

4.2.2.7 Customizing Triggers
Oracle Marketing ships with seeded business events that are used by the Trigger 
Workflow to launch seeded actions. The seeded Marketing Trigger process is a 
workflow process that gets initiated when a Marketing trigger’s next run time has 
reached. This could be either the original start time of the trigger, or a scheduled 
time for the trigger repetition (if the trigger repeats at a specific interval). 

To display processes in Oracle Workflow Builder, use the following procedure:

1. From the file menu, choose Open from (and connect to the database.)

2. Open item type “OMO Triggers” from the database. 

3. Expand the data source

4. Then expand the item type branch within that data source.



Administrating Campaigns

4-46 Oracle Marketing Implementation and Administration Guide                              

5. Expand the Processes branch within your item type.

6. Select the process activity to display the diagram of the process in a Process 
workflow.

If these actions do not meet your business requirements, you can subscribe to a 
seeded event and add your own custom logic. By doing so, you can define your 
own actions. To accomplish this, you will subscribe your custom logic to the seeded 
event: 

oracle.apps.ams.Trigger.TriggerCustomActionEvent

 Although this expands the seeded Workflow - it does not fundamentally change it. 

Oracle Marketing Trigger Item Type
The Trigger Workflow process is associated with an item type called OMO Triggers. 
This item type identifies all workflow processes that are needed to enable the 
Marketing Trigger functionality. 

Currently there are four different processes in the OMO Triggers item type: 

■ Trigger Process: The main process -- getting run as a subscription to the 
Workflow Business Event OMO Trigger Event 
(oracle.apps.ams.trigger.TriggerEvent). The following processes are sub flows 
of this main process flow.

– Perform All Actions 

– Execute Schedule 

– Schedule Approval 

For more information see the Oracle Marketing Release Note for Trigger Enhancement.

4.2.2.8 Running Workflow Agent Listener for Triggers
To initiate triggers, Workflow Agent Listener must be running on WF_DEFERRED. 

To properly initiate triggers, use the following guidelines: 

1. Start Fulfillment Server. 

2. Have Workflow Agent Listener running on the following agents: 

■ WF_DEFERRED

■ WF_ERROR
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For more information about trigger workflow, see the Oracle Marketing Trigger 
Enhancement release note posted on OracleMetaLink .

4.2.3 Setting Up Activities for Campaigns
An Activity manages the relationship between an object’s Activity Type and the 
Marketing Medium. 

To understand and implement Activities see the following sections:

■ Section 4.2.3.1, "Understanding Activity Types"

■ Section 4.2.3.2, "Seeded Activities and Activity Types"

■ Section 4.2.3.3, "Setting Up an Activity"

4.2.3.1 Understanding Activity Types
The Activity page within the Administration tab manages the relationship between 
an object’s Activity Type, Activity and available Marketing Medium. Using this 
page, an organization can specify the available Activity and Marketing Mediums 
combination for a given Activity Type.

Activities can be created within the application and can be linked to an existing 
Activity Type. When an Activity Type is selected for a Object Create or Custom 
Setup, the Activities that has been created for the Activity Type will populate the 
Activity LOV.

The following Activity Types are seeded:

■ Advertising

■ Web Advertising

■ Web Promotions

■ Direct Marketing

■ In-Store

■ Press and Analyst Relations

■ Web Marketing

■ Web Dynamic Recommendation  

■ Events

■ Sales
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4.2.3.2 Seeded Activities and Activity Types
The following is a list of seeded activities for activity types 

■ Advertising: 

– Banner Ads

– Billboard

– Brochures/Booklets

– Directories

– Display Signs

– Magazine

– Motion Pictures

– Netcast

– Newspaper

– Posters/Leaflets

– Print Ads

– Radio

– TV

■ Direct Marketing: 

– Catalog Direct Mail

– Email

– Fax

– Magazine Insert 

– Telemarketing

■ In-Store: 

– Display

– End-Aisle

– Grounders

– Kiosk

– Menu Boards
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– Package-Inserts

– Packaging-Outer

– Point-of-Purchase Displays

– Shelf

– Shop around

■ Press and Analyst Relations:

– Article

– Briefing

– Community Relations

– Company Magazine

– Crisis Communications

– Internal Communications

– Investor Relations

– Lobbying

– Press Conference

– Publications

– Release

– Tour

4.2.3.3 Setting Up an Activity 
Use the following procedure to create an activity: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > Setup > Activity.

3. Enter an Activity Name.

4. Select an Activity Type.
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5. Mark Active. Only Active Activities are available within the application.

6. Associate Marketing Medium. 

7. Click Go.

a. Select a Marketing Medium from the list of active Marketing Mediums 
displayed.

b. Select Active From and Active To dates. These dates should fall within the 
Active From and Active To dates of the Marketing Medium.

c. Marketing Medium shown up on the Object details page based on the 
Association of the Marketing Medium with the various activities in the 
create Activity screen. A single Marketing Medium may be associated with 
multiple Activities.

8. Save your work. 

4.2.4 Setting Up Marketing Source Codes
Source codes are unique identifiers for the following marketing objects:

■ Campaigns

■ Campaign Schedules

■ Events

■ Event Schedules

■ One-Off Events

■ Offers 

Source codes play an important role in marketing because the customer, most often, 
interacts with the application using a source code. Source codes are stored with 
orders to track the effectiveness of an Event, Campaign or Offer.

To understand and implement Marketing Source Codes see the following sections:

■ Section 4.2.4.1, "Source Code Construction"

■ Section 4.2.4.2, "Campaign Schedule Source Code Construction" 

■ Section 4.2.4.3, "Source Code Schema"
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4.2.4.1 Source Code Construction
Source codes are constructed using various components. The maximum number of 
characters in a source code is 30. The Geography Code comes from the geographic 
area code entered in Geography. The Suffix comes from the source code suffix field 
in Custom Setups. The source code may contain any of the following components: 

■ Geography Code

■ Month Code

■ Activity Code

■ Source Code digits (maximum number equals 30 - total of other 
components)

■ Suffix

4.2.4.2 Campaign Schedule Source Code Construction
Campaign Schedules can copy source code from campaigns or can have their own 
source code. If the source code is created for schedules, it will be parent campaigns 
source code and sequence number of the schedule. 

4.2.4.3 Source Code Schema
Each marketing object has a column referencing the source code. This source code is 
unique throughout the application. Given a source code, it can be traced back to its 
marketing object by looking at the AMS_SOURCE_CODES table. 

Table 4–8 Source Code Schema Reference 

Table Object ID Fields Source Code Fields

AMS_CAMPAIGNS_VL CAMPAIGN_ID source_code

AMS_CAMPAIGN_
SCHEDULES_VL

SCHEDULE_ID source_code

AMS_EVENT_HEADERS_
VL

EVENT_HEADER_ID source_code

AMS_EVENT_OFFERS_VL EVENT_OFFER_ID source_code

AMS_OFFERS_VL OFFER_ID

QP_LIST_HEADER_
ID

offer_code
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The following table shows definitions for the AMS_SOURCE_CODE table: 

AMS_SOURCE_CODES SOURCE_CODE_ID source_code

arc_source_code_for

source_code_for_id

related_source_code

related_source_object

related_source_id

Table 4–9 Table Definitions 

Column Name Field Type Description

SOURCE_CODE_ID NUMBER Unique identifier for the source code 
table

SOURCE_CODE VARCHAR2(30) Unique identifier for all the 
marketing objects. Source codes are 
communicated to the customers.

SOURCE_CODE_FOR_ID NUMBER FK to the marketing object to which 
the source code points to.

ARC_SOURCE_CODE_
FOR

VARCHAR2(30) Four letter code that points to a 
marketing object (EVEH = Event 
headers, EVEO = Event Schedules, 
EONE = One-Off Events, CAMP = 
Campaigns, CSCH = Campaign 
Schedules, OFFR = Offers)

ACTIVE_FLAG VARCHAR2(1) Flag to indicate if the source code is 
active or not.

RELATED_SOURCE_
CODE

VARCHAR2(30) Source code of the related object. 
This is used in case of Event 
promotions. The customer is 
interested in the related Event that 
the Campaign is promoting rather 
than the Campaign itself.

Table 4–8 Source Code Schema Reference (Cont.)

Table Object ID Fields Source Code Fields
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4.2.5 Setting Up the Marketing Calendar
The Marketing Calendar is a generic calendar available to all marketing users. 
Different users can have different views of the calendar (however, content is not 
personalizable at user level). The calendar displays marketing objects based on 
status and time range. 

Marketing calendar supports the following marketing objects

■ Campaign Schedules

■ Event Schedules

■ One-Off Events

■ Offers

To implement the marketing calendar use the following procedure:

■ Section 4.2.5.1, "Assigning Usage to Resource Group"

■ Section 4.2.5.2, "Selecting Calendar Display Parameters"

■ Section 4.2.5.3, "Running Concurrent Program for Calendar"

■ Section 4.2.5.4, "Configuring User Profiles"

4.2.5.1 Assigning Usage to Resource Group
Before users can view the Marketing Calendar, their group must be assigned the 
CRM Foundation Calendar Items Group Usage. Only users on groups with 
“Calendar Item” usage will be able to view marketing objects. For more information 
see the Oracle Marketing User Guide. 

To assign usage to a resource group follow the procedures below: 

RELATED_SOURCE_
OBJECT

VARCHAR2(30) Four letter code that points to the 
related marketing object (EVEH = 
Event headers, EVEO = Event 
Schedules, CAMP = Campaigns, 
CSCH = Campaign Schedules, OFFR 
= Offers)

RELATED_SOURCE_ID NUMBER FK to the marketing object to which 
the related source code points to.

Table 4–9 Table Definitions (Cont.)

Column Name Field Type Description
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Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Resources > Groups Summary.

3. Select a Group. 

4. Select Group Lookup. 

5. Fill in the following mandatory fields for Group Details:

■ Group Name: Name of the group by which Calendar usage privileges are 
requested.

■ Start Date: Start date for which the group will be able to access the 
Marketing Calendar. 

6. Fill in the following mandatory fields for Group Usages: 

■ Usage: To enable Calendar functionality, select CRM Foundation Calendar 
Items from the drop-down menu. 

7. Select Update to save changes. 

4.2.5.2 Selecting Calendar Display Parameters
The Marketing Administrator must decide on the parameters that will ultimately be 
displayed in the Marketing Calendar. The Administrator has 2 options: 

■ Criteria: Displays marketing objects based on a criteria for which they qualify. 
For example, an Event Schedule may have a criteria of Status “new” and Date 
“January 1, 2003 - March 1, 2003". 

■ Object: Displays marketing objects specified. The Marketing Calendar supports 
Campaign Schedule, Event Schedule, One-off Events, and Offers. 

To specify Calendar parameters follow the procedure below: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 
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2. Navigate to Administration > Marketing > Setup > Calendar Criteria. 

3. Select Create. 

4. Fill in the following details: 

■ Object: Marketing object that will be displayed on the Calendar. 

■ Custom Setup: Select a custom setup for the marketing object selected. 

■ Start Date: Start date by which the marketing object selected will begin 
appearing on the Calendar. 

■ End Date: End date for which the marketing object selected will stop 
appearing on the Calendar. 

■ Priority: Priority level by which the marketing object will appear in the 
Calendar. 

■ Status: Marketing object status. For example, if the marketing object 
selected for display is “Campaign Schedule”, the status chosen may be 
Active Schedules. In this case, only Active Campaign Schedules will appear 
on the Marketing Calendar. 

5. Select Update to save your work. 

4.2.5.3 Running Concurrent Program for Calendar
Before the new object or criteria will display on the Marketing Calendar, run the 
concurrent program AMS: Interface Marketing Objects to Calendar. This program 
is a workflow background process and will update the Calendar as needed. 

4.2.5.4 Configuring User Profiles
Before a user can view the Marketing Calendar they must specify in their user 
profile what marketing objects they want to view. Further, users can personalize the 
Calendar by saving preferences based on their needs. 

To configure user profiles for Calendar preferences follow the procedure below: 

1. Log in to Oracle Marketing. 

2. Select the Profile icon.

3. Navigate to Calendar > Personalize. 

The Calendar Personal Preferences Page opens.
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4. In the Display Items drop-down menu choose Yes. The default value for this 
drop-down menu is No. This profile turns on the Calendar feature. 

5. Select Update to save your work. 

4.2.6 Setting Up Click-Through-Destinations for Campaigns 
Click-Through-Destinations (CTD) allow marketers to generate URLs in the 
application. This functionality enables a marketer to create a URL for content, while 
hiding the complexity of the URL. This simplifies the process of creating a URL 
because the marketer does not have to know all parameters. 

To understand and implement Click-Though-Destinations see the following 
sections:

■ Section 4.2.6.1, "Creating URLs for Click-Through Destinations"

■ Section 4.2.6.2, "Tracking Click-Through Destinations"

■ Section 4.2.6.3, "Understanding Click-Through Actions"

■ Section 4.2.6.4, "Implementing Click-Through Destinations for Campaigns"

■ Section 4.2.6.5, "Setting the Server URL"

■ Section 4.2.6.6, "Enabling Encryption for Click-Through Destinations"

■ Section 4.2.6.7, "Setting Up Default Specialty Store"

■ Section 4.2.6.8, "Setting the Master Inventory Organization"

■ Section 4.2.6.9, "Enabling Click-Through Destination Tracking"

■ Section 4.2.6.10, "Process flow for Creating Click-Through Destinations"

■ Section 4.2.6.11, "Creating Email Click-Through Destinations"

■ Section 4.2.6.12, "Creating Web Advertisement Click-Through Destinations"

■ Section 4.2.6.13, "Creating Web Offers Click-Through-Destinations"

■ Section 4.2.6.14, "Troubleshooting a Click-Through Destination Implementation"

4.2.6.1 Creating URLs for Click-Through Destinations
There are 3 ways of creating CTD URLs: 

■ Email Content: A CTD can be created for a Campaign Schedule of type “direct 
marketing - email”. In this example, the CTD action is “Go To Web Script”. 
After selecting this action, the user selects the associated Event (in the example, 
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Event registration). Once the e-mail Campaign Schedule becomes active, a 
targeted e-mail is sent to a group of customers and or prospects. When the 
targeted group receives the e-mail and clicks the embedded e-mail link he or 
she is redirected to a Web page for Event registration. 

■ Web Advertisement Content: For example, a Web advertisement can be placed 
on the homepage of a Web store using merchandising functionality. In this case, 
a Campaign Schedule of type “Web Marketing - Advertisement” is used, and 
the associated click-through destination content is an image displayed on the 
homepage of the Web store. When a user visits the homepage of the Web store 
they will see the image, if they choose to click on the image, they will 
automatically be routed to the specified destination page.   

■ Web Offer: For example, a Web Offer can be placed on the homepage of a Web 
store using eMerchandising functionality. This Offer can be associated with an 
image containing the CTD. The associated could be “Go to iStore Shopping Cart 
with an Item”. Ultimately, the user visits the homepage of the Web store, clicks 
the image and is routed to the shopping cart page of the Web storefront. The 
Offer is applied at line level to the shopping cart total. 

4.2.6.2 Tracking Click-Through Destinations
Tracking CTDs enables businesses to gain key intelligence about customer behavior. 
For example, tracking enables marketers to know who responded to the Campaign 
Schedule (Internet Advertisement or e-mail) that the CTD is part of. Tracked 
customer and prospect information is stored in Interaction History. Later, it can 
easily be used for reporting, targeting, and intelligence purposes. To implement 
tracking for CTDs, see Section 4.2.6.9, "Enabling Click-Through Destination 
Tracking". 

4.2.6.3 Understanding Click-Through Actions
When creating a CTD you will select a specific “action” for it. For example, if 
creating a CTD for Web advertisement, the “action” for the click-though could be to 
“send the targeted user to a specific URL”. 

The following actions are seeded with the product: 

■ Go to URL: Sends the user to the defined URL. The URL for this action must be 
preceded by HTTP:// or HTTPS://. 

■ Go to iStore shopping cart: Uses iStore deep linking functionality to directly 
forward the user to the shopping cart page. This action is available only if iStore 
is implemented. 
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■ Go to Product Details page in iStore: Uses deep linking to directly forward the 
user to a specific iStore product detail page. When using this functionality, 
AMS: Item Validation Organization setting must match the IBE: Item Validation 
Organization setting. These profiles must be set to the same Master Inventory 
Organization. If they do not match, Products in iStore are not visible in Oracle 
Marketing. This action is available only if iStore is implemented. 

■ Go to Shopping Cart with Item: Uses deep linking to directly forward the user 
to the iStore shopping cart page. The shopping cart can contain an item that has 
previously been added. This action is available only if iStore is implemented.

■ Go to Section iStore: Uses deep linking to directly forward the user to a specific 
section within the iStore page hierarchy. This action is available only if iStore is 
implemented. 

■ Go to iStore Registration Page: Uses deep linking to forward the user to the 
iStore registration page. This action is available only if iStore is implemented. If 
using this action when creating an e-mail CTD be sure to set the profile IBE: 
Default Specialty Store to the name of the store that you are directing the user 
to. 

■ Go to Catalog/Minisite in iStore: Uses deep linking to route user to the 
homepage of a specific specialty store. The homepage for the user will vary on 
the preferences selected by that user. For example, if the user hasn’t registered 
in the store, and has the responsibility of IBE_GUEST, the user will be 
forwarded to the generic homepage. However, if the user has previously 
registered, and has the responsibility of IBE_CUSTOMER with a saved 
preference of “English”, the user will be forwarded to the English humped for 
that storefront. This action is available only if iStore is implemented. 

■ Go to a Web Script: Displays a list of available Web script actions. This list will 
not display all Web scripts deployed, rather, will display all Web scripts 
associated through the contact point of the Campaign Schedule. For example, 
you can create a Web script for online Event registration. In this example, a 
Campaign Schedule of type “e-mail” must exist -- it must have a contact point 
of type “inbound script”. The contact point type must be associated with the 
Event registration Web script (used as the CTD). Given this setup, the user 
receives an e-mail, clicks the hyperlink, and is re-directed to the script for online 
registration. 

4.2.6.4 Implementing Click-Through Destinations for Campaigns
The following procedures must be performed to implement CTD: 

■ Section 4.2.6.5, "Setting the Server URL"
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■ Section 4.2.6.6, "Enabling Encryption for Click-Through Destinations"

■ Section 4.2.6.7, "Setting Up Default Specialty Store"

■ Section 4.2.6.8, "Setting the Master Inventory Organization"

■ Section 4.2.6.9, "Enabling Click-Through Destination Tracking"

4.2.6.5 Setting the Server URL
To enable the application to use complete URLs for tracking java server pages, set 
AMS : Server URL at site level. This is the URL where the application is running. 
This is set to http://host server name:port number. 

4.2.6.6 Enabling Encryption for Click-Through Destinations
Because the party_id is exposed in a URL, Oracle Marketing supports encryption 
for URLs. To implement this functionality use the following procedure: 

■ Set JTF_FM_LENCRYPT_DELIM to an appropriate delimiter from the list 
provided. 

■ Set JTF_FM_RENCRYPT_DELIM to an appropriate delimiter from the list 
provided. 

■ For JTF_FM_SECURITY_KEY leave to changeme. 

Once the values for these profiles have been set you should not change them. 

4.2.6.7 Setting Up Default Specialty Store
If using this action when creating an e-mail CTD be sure to set the profile IBE : 
Default Specialty Store to the name of the store that you are directing the user to. 

4.2.6.8 Setting the Master Inventory Organization
If using the CTD action “Go to Product Details Page in iStore” then the following 
profiles must match:

■ AMS : Item Validation Organization

■ IBE : Item Validation Organization

If Oracle Marketing and Oracle iStore Products are not pointing to the same Master 
Inventory Organization then the action “Go to Product Details page in iStore” will 
not function properly. Therefore, set the profiles listed above to the same Master 
Inventory Organization. 
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For example: 

■ AMS : Item Validation Organization = Vision Operations USA

■ IBE : Item Validation Organization = Vision Operations USA

4.2.6.9 Enabling Click-Through Destination Tracking 
To enable the tracking functionality set AMS :  Interaction Logging Enabled at site 
level. Tracking is an optional setup. 

■ If set to Yes: A checkbox is displayed in the Click-Through-Destination screen 
tracking is available in the application. This features enables each click-through 
to be logged in the JTF Interaction History Tables. The logging trail tracks 
Party-id, Campaign Schedule source code, time, and date of the click-through. 

■ If set to No: The tracking checkbox is not visible in the click-through-destination 
screen. If set to No, each click-through is not logged in the JTF Interaction 
History Tables. 

4.2.6.10 Process flow for Creating Click-Through Destinations
A marketer uses the following process when creating CTDs:

1. Select Campaign Schedule: Campaign Schedules can be of type e-mail, Web 
advertisement or Web Offer. For more information see the following sections: 

2. Select Content Type. Content type must be selected either by using the Content 
side navigation menu for Web ads and Offers or by using an email authoring 
tool. 

3. Select Click-Through Action:  For a specific content type, select a specific action. 

4. Select Click-Through Parameters: Based on the action selected, a parameter 
automatically becomes available. For example, if the action selected is “go to 
URL”, the available parameter will automatically be populated. In this example, 
the parameter is a textbox for the marketer to input a destination URL. 
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Figure 4–5  Process flow for Creating Click-Through Destinations

4.2.6.11 Creating Email Click-Through Destinations 
To create a CTD for e-mail content use the following procedure:   

Prerequisites
■ AMS : Enable Fulfillment is set to Yes 

Steps
1. Navigate to Campaigns > Execution > Campaign Schedule. 

2. Select Create. 

3. In the Setup Type LOV select Direct Marketing - Email.

This selection will cause the application to automatically populate the Activity 
Type to Direct Marketing and the Activity to Email. 

4. Enter the following mandatory fields: 

■ Name: Give the Campaign Schedule an appropriate name. 

■ Language: Select a default language for the Campaign Schedule. 

■ Coordinator: Select a default coordinator for the Campaign Schedule. 

■ Currency: Select a default currency for the Campaign Schedule. 

■ Start Date: Select a default start date for the Campaign Schedule. 

■ Time Zone: Select a default time zone for the Campaign Schedule. 

5. In the Mail Preferences section enter a subject for the e-mail. 
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6. Select Update.

Once Update is selected a pencil icon appears. 

7. In the Mail Preferences section select the pencil icon. 

The Campaign Schedule Details - Email Content page opens. 

8. Scroll down to the content creation area.

9. In the Query field, click the flashlight icon. 

The Query selector will launch, this selector enables you to choose a Query. 

10. Select a Query type for the e-mail content. This step is mandatory. 
  

By default Oracle Marketing ships with 2 seeded Queries: 

■ Marketing Simple Query: For a given e-mail template, this contains simple 
query parameters for an e-mail. 

■ Marketing Detailed Query: For a given e-mail template, in addition to the 
Marketing Simple Query parameters, additional query parameters are 
included. 

A custom query can also be created. A marketer can define their own query 
parameters. If creating a custom query for an e-mail CTD, the query must 
contain the customer_id and source_code (schedule source code) fields. 

11. Create the e-mail content using the content creation box:

■ If using Internet Explorer: The content creation area is an iFrame textbox. 
Highlight the text (to be used in the link) and select the hyperlink icon. The 
Campaign Schedule Details - Click Through Destination page opens. Using 

Note: When using Internet Explorer (IE) the e-mail content creation 
box will contain iFrame functionality (and thus will contain user 
friendly text edit features). However, when using Netscape 
Navigator iFrame functionality is not available. Because of this, we 
recommend using IE.  

Note: Selecting a Query is Mandatory. If you do not select a query 
you will not be able to create the CTD. 



Administrating Campaigns

                                                                  Implementing and Administrating Campaigns 4-63

this page, select an action and related parameters. Select Apply to save your 
work. 

■ If using Netscape: The content creation area is a simple text editing box, not 
an iFrame textbox. Below the textbox, select “Define Click-Through URL”.  
The Campaign Schedule Details - Click Through Destination page opens. 
Using this page, select an action and related parameters. After applying 
changes, within the textbox, replace the text “Use Proper Anchor Text” to a 
user friendly description. For example, replace it with “Click Here” (see 
below). 

Figure 4–6 Netscape Text Replacement

12. Select Update to save your work. 

If you modify a Query after you are finished with the CTD, the CTD will need 
to be re-created.

4.2.6.12 Creating Web Advertisement Click-Through Destinations 
To create a CTD for Web advertisements follow the procedure below: 

Prerequisites
A Campaign using Web advertisements has been created

Steps

1. Navigate to Campaigns > Execution > Campaign Schedule.

2.  The Campaign Schedule details page opens. 
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3. Select Create. 

4. In the Setup Type LOV select Internet Advertisement.

This selection will cause the application to automatically populate the Activity 
Type to Web Marketing and the Activity to Advertising. 

5. Select Create to save your work. 

6. Navigate to Execution > Content (for the Campaign Schedule defined above). 

7. Select Create. 

8. In the Type drop-down choose one of the following: 

■ Web Image: Displays an image to the user. The user clicks the image and is 
routed to the destination page defined. 

■ Web Text: Display text to the user. The user click the text and is routed to 
the destination page defined. 

9. In the Subtype drop-down choose a subtype for the selected Type. 

10. In the File textbox, click the flashlight icon. 

The file selector navigation window opens. Using this navigator, search and 
select a stored image. If using an image that has not been uploaded, select 
Upload New Image. 

11. In the Click-Through-Destination section enter an action for the CTD. 

■ Based on the action selected, the application will populate available 
parameters. 

■ For example, if the action “Go to iStore Shopping Cart” is selected, the 
application will populate, next you will be prompted to select a specialty 
store. 

■ You will not be able to preview the Web advertisement in a Web storefront 
until you are in a runtime environment.   

12. Select Create to save your work. 

13. Navigate to Campaign > Execution > Content. 

14. Select the image or text (select the image or text previously selected). 

15. Select Preview. 

A Preview window opens displaying either the image or text selected for the 
Web advertisement. 
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4.2.6.13 Creating Web Offers Click-Through-Destinations
For Web Offers, action “Go to Web Script” is not available. The reason being is that 
generally you would not create a Web Offer containing a scripted flow of actions. 

Use the following procedure to create a CTD for Web Offers:

Prerequisites 
■ The Web Offer is request only

■ The Web Offer has a discount level of “line” 

■ The profile AMS : Item Validation Organization and IBE : Item Validation 
Organization are set to the same Master Inventory Organizations

Steps

1. Navigate to Campaigns > Offer > Execution > Content. 

2. Select Create. 

3. In the Type drop-down choose one of the following: 

■ Web Image: Displays an image to the user. The user clicks the image and is 
routed to the destination page defined. 

■ Web Text: Display text to the user. The user click the text and is routed to 
the destination page defined. 

4. In the Subtype drop-down choose a subtype for the Type chosen in step 8. For 
example, if Web Image was selected, the subtype could be full banner or half 
banner. 

5. In the Description textbox, enter a short description for the content. 

6. In the File textbox, click the flashlight icon. 

The file selector navigation window opens. Using this navigator, you can search 
and select a stored image. If using an image that has not previously been 
uploaded, select Upload New Image. 

7. In the Click-Through Destination section select the action “Go to Shopping Cart 
page in iStore with an item”. 

The application will populate, as a result, enter the following mandatory fields: 

■ Specialty Store: Use the flashlight icon to launch the “Choose a minisite” 
navigator. In the Minisite Column, choose the appropriate minisite. This is 
the Web storefront that is displaying the Web Offer to the user. 
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■ Section: Use the flashlight icon to launch the “Section Selector” navigator. 
In the section name column, choose the appropriate section. This is the 
section within the Web storefront that contains the item.

■ Product/Item: Use the flashlight icon to launch the “Product Selector” 
navigator. In the product name column select the appropriate column. This 
is the product within the section that is the destination for the Web Offer.

8. Select Create to save your work. 

9. Navigate to Campaign > Execution > Content. 

10. Select the content created in step 3. 

11. Select Preview. 

A Preview window opens displaying either the Web image or Web text selected 
for the Web Offer. 

4.2.6.14 Troubleshooting a Click-Through Destination Implementation
Use the following frequently asked question to assist you when troubleshooting a 
CTD implementation. 

1. Question: What if the Scripting LOV does not bring any Scripts for ‘Go To Web 
Script’ Action?

Answer: Double-check that you have associated Scripts to the Campaign 
Schedule by creating contact point of type ‘Inbound Script’. When using the 
action “Go to Web Script”, you must associate the script to the Campaign 
Schedule by creating a the contact point listed above. 

2. Question: When I click on an e-mail “Click Three Link” nothing happens, what 
am I doing wrong? 

Answer: Verify that your merge fields in the Click-Through- Destination links 
are not set up incorrectly. If you have changed the query after creating the CTD, 
this could be causing the error. If you’ve changed query parameters, you will 
need to re-create the CTD. If you don’t see customer_id and source_code  
(shown below) in your URL as merge fields that means you need to re-create 
the CTD.

■ http://ap045sun.us.oracle.com/OA_
HTML/amstracking.jsp?wcid=13891&t=Y&amsp=<<customer_
id>>&sccd={(source_code)} 

3. Question: When I click on a Click Through Link nothing happens. Why? 
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Answer: Make sure you have not changed these profile values:

■ JTF_FM_LENCRYPT_DELIM,

■ JTF_FM_RENCRYPT_DELIM and JTF_FM_SECURITY_KEY 

4. Question: The Tracking checkbox “Tracking cannot be performed” is not 
visible in the UI. Why? 

Answer: Validate that the profile AMS : Interaction Logging Enabled is set to 
Yes. 

5. Question: When I select an existing Click Through hyperlink in Email Content 
and press the Web Button in iFrame, I see a javascript prompt instead of the 
Click Through Destination Definition Page. Why? 

Answer: Existing Click-Through-Destination in Email Content (iFrame) cannot 
be updated. 

6. Question: When I try to select a product under a section, I cannot see any 
Products yet I can see them in iStore. Why? 

Answer: Check with your iStore Administrator. The Products can be in a 
sub-section under the section you are trying to select. Also, validate that the 
following profiles are pointing to the same Inventory Organization: 

■ AMS : Item Validation Organization

■ IBE : Item Validation Organization

7. Question: I cannot see all the Minisites after I have selected a Section/Product 
combination, why? 

Answer: The Minisites LOV will show all the Minisites containing the Section 
and Product combination you have selected. If you want to see all the minisites, 
deselect the Section/Section and Product you have selected.

8. Question: I cannot see all the Sections after I have selected a product. Why? 

Answer: The Sections LOV will show all the Sections containing the Product 
you have selected. If you want to see all the sections, deselect the Product you 
have selected.

9. Question: My URL parameters are not being encrypted, why? 

Answer: Verify the following profiles: 

■ JTF_FM_LENCRYPT_DELIM - must be set to an appropriate delimiter from 
the list provided. 
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■ JTF_FM_RENCRYPT_DELIM - must be set to an appropriate delimiter 
from the list provided. 

■ JTF_FM_SECURITY_KEY - must be set to changeme. 

10. Question: I cannot see an Event on the Events LOV even though the Event is 
Active. Why? 

Answer: Check the Registration End Date of the Event. The Event LOV shows 
only those Events which have the Registration End Data later or equal to the 
current date.

11. Question: When I go to the Cover Letter Details screen, I do not see the iFrame 
editor to define the CTDs. Why?

Answer: Make sure that the profile "Self Service Accessibility Features" is set to 
No.

12. Question: I don't see the actions "Go to item details" and "Go to Shopping cart" 
with an item in the actions drop down list. Why?

Answer: These actions will not be listed if you don't have any product 
associated with the schedule. Go to the Offering midtab and associate products 
to the schedule.

13. Question: I don’t see any products under the Product drop-down list. Why?

Answer: Go to Products section under the Offering midtab in the Schedule 
Details page and associate a product to the schedule. Also, make sure the 
products are Published on the Web.

14. Question: For the action "Go to Shopping cart with an item" for a Web 
Promotion Schedule, I do not see any offer under the offer dropdown. Why?

Answer: Go to the Offers section under the Offering midtab in the Schedule 
Details page and associate an offer to the schedule.

15. Question: What should I do to track a CTD?

Answer: In 11.5.10, all CTDs are tracked, by default if the profile "AMS: 
Interaction Logging Enabled" is on. Unlike release 11.5.9, there is no option of 
turning it off and on at the UI level.

4.2.7 Setting Up Oracle Personalization for Campaigns
Implementing Oracle Personalization (OP) is an optional Oracle Marketing 
enhancement used for Web product recommendations. OP is an automated 
recommendation engine that takes customer data into account and returns an 
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intelligent product recommendation. Using OP, you can maximize transactions 
through intelligent product cross-selling and up-selling. 

OP makes product recommendations based on:

■ Customer

■ Customer purchase history

■ Product customer is currently viewing 

OP is particularly relevant for companies that: 

■ Have a large customer base

■ Have a large number of products (or SKUs)

■ Have an online store that tracks customer browsing and purchase information

Oracle Personalization can be setup to make recommendations from the Campaign 
tab or from the Campaign Workbench. For more information about setting up OP 
for the Campaign Workbench, see the OracleMetaLink release note titled Integrating 
Oracle Application Server Personalization with Oracle Marketing. 

To setup Oracle Personalization to make product recommendations from the 
Campaign tab see the following:

■ Section 4.2.7.1, "Setting Personalization Profile"

■ Section 4.2.7.2, "Creating Posting Strategy for Oracle Personalization"

■ Section 4.2.7.3, "Configuring Oracle Personalization Strategy Details"

■ Section 4.2.7.4, "Creating Media Items Types"

4.2.7.1 Setting Personalization Profile
Set the following profile to enable personalization for Oracle Marketing.

Prerequisites
■ OracleAS Personalization10g Version 9.0.4 is installed. 

■ For specific details, see the OracleMetaLink release note Integrating Oracle 
Application Server Personalization with Oracle Marketing. 

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Navigate to Profile > System.
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3. In the Profile field enter AMS : Oracle Personalization Enabled.

4. Click Find.

5. Set to Yes at Site Level. 

6. Save your work.

4.2.7.2 Creating Posting Strategy for Oracle Personalization 
For OP you will need to create a posting strategy of type Product Recommendation. 
OP’s recommendation strategies looks at the posting content type to specify what 
gets shown when and in what order (if more than one content item can be shown).

The following recommendation strategies are available with this postings:

■ Manual Selection

■ Product Relationship

■ Custom

To create a posting strategy for product recommendation, see the following: 

Steps
1. Login to Oracle Marketing.

2. Select Execution.

3. Select Web Posting > Create.

4. Fill in the following mandatory fields:

■ Posting Type: Select either Universal or Rule Based. A universal posting 
applies the same strategy to all the visitors (although different content may 
be served up to each visitor). A rule-based posting consists of a set of one or 
more rules. These rules have conditions or criteria which need to be met. 
Once the conditions are met, the strategy type determines what content to 
display.  

■ Posting Name: Give the posting a relevant name. For example, Web 
product 25. 

■ Status: Select Active. 

■ Content Type: Web Product Recommendation

■ Strategy Type: Oracle Personalization

5. Select Create.
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4.2.7.3 Configuring Oracle Personalization Strategy Details
Use the following procedure to configure details for the Web product 
recommendation. 

Steps
1. Login to Oracle Marketing.

2. Navigate to Execution.

3. Select the Web posting that you need to configure. 

4. Select Strategy Details.

5. In the Strategy Details page, enter the following:

Filter Contents By:

■ Exclude Products in the current section: This enables OP to exclude 
products that are currently being viewed. 

■ Include Products in the current sections: This enables OP to include 
products that are in the current sections. 

6. Select Advanced Options.

7. In the Products Purchase History section, place a check in the Include Products 
Previously bought checkbox if you want OP to include previously purchased 
products in the recommendation. If this checkbox remains unchecked, OP will 
exclude previously purchased products from the recommendation. 

8. In the Context section configure OP to determine the context of the 
recommendation: 

■ Products in the shopping cart 

■ Products currently being browsed 

■ Users profile and history 

■ Best context available 

9. In the Base Data section, you can specify tracked data: 

■ History Only 

■ Current Session Only 

■ Both Current Session and History 
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This flexibility enables you to implicitly limit the scope of recommendations as 
appropriate. For example, a Web campaign for a video store could want to limit 
the base data to only the current session data of the renter so that the 
recommendations returned would most likely be current movies which might 
have a better margin rather than something related to movies rented a year ago.

10. Select Apply to save your work. 

4.2.7.4 Creating Media Items Types
For iStore sites, Oracle Marketing pulls images from iStore media items folder (OA_
MEDIA). The content is ultimately coming from iStore, therefore you must setup 
your media items using iStore. 

Once OP returns the product ID, Oracle Marketing:

1. Checks the style for the placement that this posting is using.

2. Determines the media item type needed from iStore. 

3. Retrieves the necessary media item type for the product ID returned by OP. 

4.2.8 Setting Up Campaign Budgets
Budgets are used in Oracle Marketing to supply funds for campaigns, events and 
other marketing objects. Approval rules determine the budget approval process and 
direct the approval workflow. Budget funds are released for marketing objects only 
after approvals are received. 

Budgets are not divided by organization. However, they are stored with the 
organization ID according to the responsibility of the user who created the budget. 

■ Section 4.2.8.1, "Setting Up Budget Security" 

■ Section 4.2.8.2, "Setting Up Budget Categories" 

■ Section 4.2.8.3, "Understanding Budget Status" 

■ Section 4.2.8.4, "Setting Up Budget Approval Rules" 

■ Section 4.2.8.5, "Setting Up Business Units for Budgets" 

■ Section 4.2.8.6, "Setting Up Multiple Currencies for Budgets" 

■ Section 4.2.8.7, "Setting Up Budget Requests"

■ Section 4.2.8.8, "Setting Up Budget Reconciliations"

■ Section 4.2.8.9, "Setting Up Budget Roll-up Views"
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4.2.8.1  Setting Up Budget Security
When a user creates a Budget it is created with: 

■ Responsibility ID of Budget creator

■ Organization ID (operating unit ID) of Budget creator

The Oracle Marketing Super User responsibility does not automatically have access 
to budgets. 

For example, John is the owner of Budget A and does not have the “Oracle 
Marketing Super User” responsibility. User Mary has “Oracle Marketing Super 
User” responsibility and is a team member with edit metrics capabilities for budget 
A. The field “category” on the Budget is locked by locking rules. John cannot 
update this field even though he is the owner, while Mary can. 

The table below explains the access security levels for Budgets. 
 

Table 4–10 Budget Security Levels 

Security Level User Name Access Control

1 AMS: Admin Group Updates all fields:

■ Excluding those locked 
by system

■ Including those locked by 
locking rules

2 Owner Updates all fields:

■ Including Owner field

■ Including adding Team 
members

■ Excluding those locked 
by system

■ Excluding those locked 
by locking rules

4 Team members without Edit 
Metrics

View Budget only

5 Everyone else No access, no view
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4.2.8.2 Setting Up Budget Categories
Budget Categories serve two purposes: 

■ Budget Classification: Configurable ways to classify a Budget. When 
classifications are used, Budgets can be divided into sales, marketing, or 
partnering purposes. For example, if a Budget classification for Partners exists, 
a category, “Partner Marketing Funds” can be created. 

■ Approval Rule Setups: These rules determine who gets to approve Budgets and 
under what conditions they can approve them. Approval rules can be either 
root Budget approval rules or Budget approval rules. 

To create Categories for Budgets follow the procedure below: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing.

2. Navigate to Administration > Marketing > Setup > Category. 

3. Select Create.

4. Select Created For = Budget. 

Wait for the page to refresh.

3 Team members with Edit 
Metrics

Updates all fields:

■ Excluding Owner field

■ Including adding Team 
members

■ Excluding those locked 
by system

■ Excluding those locked 
by locking rules

Table 4–10 Budget Security Levels (Cont.)

Security Level User Name Access Control

4 Team members without Edit 
Metrics

View Budget only

5 Everyone else No access, no view
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5. Enter a Category Name.

6. Select a Parent Category if desired.

7. Select the Enabled checkbox to make the Category available.

8. Optionally enter a description.

9. Provide the following information: 

■ Enter an appropriate prefix. These are used as a prefix for the Budget 
numbers that are generated automatically.

■ Enter valid activities. This is optional. Activities defined here will be used 
to evaluate Budget eligibility of Campaign Schedules.   

10. Select Create. 

4.2.8.3 Understanding Budget Status 
A Budget goes through the following main system statuses:

■ Draft: Budget amounts are entered but not approved.

■ Pending approval: Budget is being reviewed and needs approval before it 
becomes active. 

■ Active: The Budget is active and can be used to fund activities.

Approval rules are used to determine the route from Draft to Active. Approval 
rules are highly configurable and multiple can be created based on the Budget's 
characteristics.
 

Table 4–11 Budget Statuses 

Status Description

Draft Budgets in draft status can be updated at any time in any way.

Draft status may be updated to Pending Approval or Cancelled.

It can also be updated to Active directly in case the Budget owner 
is also the owner of the parent Budget, and the parent Budget is 
already Active.

Pending Approval The Budget has been submitted for and is awaiting approval.

After all approvers have responded positively, a Budget may 
become Active or On Hold. 

If approvers reject the Budget it will become Rejected.
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A Budget status changes once it has been updated. Approval rules determine who 
can change Budget status and under what conditions. 

4.2.8.4 Setting Up Budget Approval Rules
Approval rules determine which users can approve Budgets and under what 
circumstances their approvals are applied. Approval rules for Budgets can be 
configured using multiple parameters. For example, Budget approvals can be based 
on amount or approval organization.

Approval rules are evaluated based on the following hierarchy:

■ Business Unit = 6

■ Organization = 5

■ Approval Object Type = 4 

■ Budget Category = 3

On Hold On Hold is an interim status that is used when Budget has 
already obtained approval, and is just not completely ready to be 
made active. 

At On Hold status, a user can then manually change it to Active 
or Closed.

Rejected Budget approvers have rejected the Budget.

From Rejected, the status can be manually changed back to Draft.

Active A Budget that has been approved and is ready to fund various 
activities and promotions.

From Active, the status can be changed to Closed and Cancelled. 

Cancelled Indicates the Budget has been aborted.

From Cancelled, the status can only be changed to Archived.

Archived The Budget can no longer be used.

This cannot be changed to any other status.

Closed From On Hold or Active, Budget status can be manually changed 
to Closed. 

It indicates that the Budget has ended and is no longer available 
to fund activities and Offers.

Table 4–11 Budget Statuses (Cont.)

Status Description
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■ Custom Setup = 1

The higher the number, the more important the parameter when determining which 
approval rule applies to which particular Budget.

Approval rules are contained in the package ams_approval_pvt and the file 
containing the code is amsvappb.pls.

To set up approval rules use the following procedure: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing.

2. Navigate to Administration > Marketing > Setup > Approval Rule.

3. Select Create. 

4. Enter the following information: 

■ Approval Rule Name: Give a name for your approval rule

■ Start Date: Starting date from which the approval rule will be in use

■ Approval Rule For: Name of person to whom the rule applies. 

– Root Budget Request: Select this if defining the rule for who gets to 
approve a Budget and under what circumstances. 

– Budget Request: Select this if defining the rule for who gets to approve 
a marketing objects’ request for funding and under what circumstances. 

■ Organization: Displays a list of operating units. Select the operating unit for 
which this approval rule will apply. 

■ Budget Category: Select the Budget category that will fall into this approval 
rule.

■ Setup Type: Custom setups created for Budgets purpose.

■ Minimum Amount and Maximum Amount: Define the range of Budget 
amounts or Budget request amounts that will fall into this approval rule.

■ Description: Optionally describe your approval rule.

5. Select Create.
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The Approval Rules details page opens. It displays an Approvers table. This 
table enables you to define the people who will be approving the Budget:

6. In the Approvers section enter the following information: 

■ Order: Enter any integer in ascending order. 

■ Type: This can be Function (for customization purpose), Role (defined for 
marketing and assigned to Resources), or User (a user type). 

■ User/Role: Depending on the Type selected above, this may display a list of 
functions, roles or users

■ Start Date: The date starting from which the approver is active. Within the 
range of the approval rule, each line can also have a start date and end date.

■ End Date: The date when the approver stops being the approver.

7. Select Update to save your work. 

4.2.8.5 Setting Up Business Units for Budgets
When creating a Budget, the list of values for the Business Unit field comes from 
Organizations defined in Oracle HRMS. When defining any internal organization in 
HRMS, you have the ability to classify the organization using “Type”. One of the 
type options is “Business Unit”. This Type serves mostly for classification purposes. 

Prerequisites
None

Steps
1. Log in to Oracle Forms with Human Resources responsibility.

2. Navigate to Work Structures > Organization > Define.

3. Click New.

This enables you to define a new organization or query for a particular 
organization.

4. In the Define a new organization form, select Type = Business Unit.

5. Save your work. 

This organization will now appear in the list of values for Business Unit in 
Oracle Marketing Budgets.
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4.2.8.6 Setting Up Multiple Currencies for Budgets
Companies can create Budgets, as well as other marketing objects in multiple 
currencies. Marketing automatically does currency conversion based on the 
conversion rates defined in the profile AMS: Default Currency. 

Users can transfer Budgets and request money from Budgets in any currency. It is 
not required that the Budgets sourcing these requests is in the same currency. When 
a request for money is made in one currency, the user will see the approval 
notification and money transfer in that same currency. Similarly when Budget 
Owner receives a request, the system will automatically convert the requested 
amount into the currency of the Budget. The Budget owner will then approve the 
amount in Budgets currency. 

Although the system has a default currency, a user can specify a different default 
currency. To change the currency default use the following procedure: 

Prerequisites
The user exists in the system

Steps
1. Log in to Oracle Forms with System Administrator responsibility. 

2. Navigate to Profile > System.

3. In the Application block type Oracle Marketing.

4. In the User block type the name of the user for which the default currency is 
being selected. 

5. In the Profile block type%JTF%PROFILE%. 

6. Select Find. 

7. In the User column, change the default currency. 

8. Save your work. 

9. Log in to Oracle Marketing using the user name previosly created. 

10. Click the Profile icon.

11. Navigate to Personalization > Display Preferences. 

12. Verify that the currency preference is correct. 
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4.2.8.7 Setting Up Budget Requests
To access Budget Request screen, the proper security access level for the users must 
be enabled. For more information see Section 4.2.8.1, "Setting Up Budget Security" 

Additionally, you may need to define multiple Transfer Reasons to record the 
reasons for each request. To do so, extend the Lookup “AMS_TRANSFER_
REASON”.

4.2.8.8 Setting Up Budget Reconciliations
Budget Reconciliation enables a marketer to return the previously committed, but 
un-utilized funds, by transferring them from the Committed column to the 
Available column (“Reconcile Un-Utilized”) for marketing objects, such as 
Campaigns. This functionality should not be performed by all users. As such, this 
function needs security control. 

Budget Reconciliation Security is based on: 

■ Custom Setups: Enables or disables the Reconcile button to exists on the Budget 
side navigation menu. 

■ Responsibility: User responsibility levels enables or disables access to the 
Budget side navigation menu (regardless of Custom Setup). This can be 
controlled by including or excluding a function during responsibility setup. 

■ Including or excluding the Responsibility for Reconcile: Whether a user's 
responsibility allows him to access the Reconcile button inside the Budget side 
navigation menu (regardless of the above function) can be controlled by 
including or excluding another function just for the Reconcile portion. This is 
controlled during responsibility setup.

■ Offer Start and End Date: The Reconcile button will only appear if the Offer's 
end date has been reached and status is completed, or if Offer has no end date 
its status should be completed.

To enable Automated Reconciliation, run the concurrent program AMS-TM: 
Release Committed Budget Amount After Grace Period.

4.2.8.9 Setting Up Budget Roll-up Views
Budget roll-up view is a way for each Budget to display the amount for itself and 
also the amount summed up from its children. The roll-up summed view is its own 
Budget amount + all descendent Budget amounts. 

This features gives an organization a high level view of all Budget balances 
summed up to each level. Activities and usages can be viewed by drilling down 
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into different numbers such as committed and utilized portions of the Budget. 
When drilled down from a Rollup View, the details will show for the Budget itself 
and all of its child Budgets.

For example, a Budget called “California” has committed amounts of $10K. A 
Budget called “Oregon” has $20K. Their parent Budget “Western US” funds no 
other activities, its Rollup View committed therefore = $30K.

To enable the Budget roll-up view, set the profile option AMS: Universal Currency 
profile option at site level. This stores the one currency which is used to convert to 
all other currencies. In addition, for each user, set the JTF_PROFILE_DEFAULT_
CURRENCY. This view of the roll-up is specified by the user’s preferred currency.

Prerequisites
None 

Steps
1. Log in to Oracle Forms with System Administrator Responsibility.

2. Set the profile AMS: Universal Currency at the site level.

3. For each user, set the JTF_PROFILE_DEFAULT_CURRENCY at user level.

This determines what currency a user will see in the Budget Rollup View. 

4. Log in to Oracle Marketing.

5. Navigate to the Budget tab. 

6. Select Rollup View. 

■ Self View will show all amounts for the Budget, whereas Rollup View will 
show all amounts summed for the Budget itself and all Budgets underneath 
it.

■ The Rollup View converts all Budgets to the profile currency as set up 
above. Because the profile is set at user level, different users will see the 
Rollup View accordingly.

4.2.9 Setting Up Offers for Campaigns
Offers are generally associated with campaigns and campaign schedules. When 
Trade Management is implemented, Oracle Marketing’s offer functionality is 
enhanced to include claims that can be recorded against an offers. 

Use the following procedure to set up offers: 
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■ Section 4.2.9.1, "Setting System Profiles for Offers"

■ Section 4.2.9.2, "Creating and Verifying Lookups for Offers"

■ Section 4.2.9.3, "Running Concurrent Programs for Offers"

Prerequisites
Advanced Pricing is implemented 

4.2.9.1 Setting System Profiles for Offers
Based on your business requirements, set the following system profiles for Offers.
  

Table 4–12 System Profiles for Offers 

Option Required Level Setting Effect/Limitation

AMS: 
Relationship 
Type for 
Buying Group

Yes Site Any valid 
relationship 
type created 
in TCA

Used to establish a hierarchical 
group of customers in TCA. For 
example, if value is set to 
subsidiaries then all parties who 
share this relationship will be part of 
a buying group. These are used as 
qualification criteria for Offers.

AMS : Choose 
Date Qualifier 
Regions

Yes Site Show All

Show Header 
Dates 

Show only 
Date 
Qualifiers

This profile is used in the Trade Deal 
Offer User Interface.

Based on the setting, the user may 
either enter date qualifiers or 
Header Dates or both.

AMS :  Default 
Bucket for 
discount rules

Yes Site Values from 
Advanced 
Pricing 
Lookup 
PRICING_
GROUP_
SEQUENCE

The value set here will be used as 
the default value for buckets in the 
discount rules.

AMS : Default 
Phase for Line 
level 
discounts

Yes Site Available 
values are 
derived from 
Event phase 
setup in 
Advanced 
Pricing

This value will be used as the 
default value for phase for all 
discount rules with a discount level 
of Line.
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AMS : Default 
Phase for Line 
Group level 
discounts

Yes Site Available 
values are 
derived from 
Event phase 
setup in 
Advanced 
Pricing

This value will be used as the 
default value for phase for all 
discount rules with a discount level 
of Group of Lines.

AMS : Default 
Phase for 
Order level 
discounts

Yes Site Available 
values are 
derived from 
Event phase 
setup in 
Advanced 
Pricing

This value will be used as the 
default value for phase for all 
discount rules with a discount level 
of Order.

AMS : Default 
value for Print 
on Invoice 
Flag

Yes Site Yes/No Used as a default for all discount 
rules.

AMS : Default 
value for 
Product 
Preference

Yes Site User Defined Used as a default for all discount 
rules.

AMS : Default 
Offer Formula

Optional Site Available 
pricing 
formulas in 
Advanced 
Pricing

This option handles discount rules 
for product categories when the Unit 
of Measure is not specified.

AMS : Default 
Forecast UOM

Required Site Select from a 
defined UOM

This value is used to calculate the 
initial base sales for a Forecast. Users 
can override this default value on 
the Forecast page.

QP : Accrual 
UOM Class

Yes Site UOM Classes 
as set up in 
Inventory

Used by accrual Offers. All accrual 
units will fall under this UOM class 
(for example, frequent flyer miles).

Table 4–12 System Profiles for Offers (Cont.)

Option Required Level Setting Effect/Limitation
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4.2.9.2 Creating and Verifying Lookups for Offers
Use the following table when creating and verifying lookups for Offers:
  

QP : Item 
Validation 
Organization

Yes Resp Select from 
Inventory 
Organizations 
as set up in 
Inventory

Offers can be defined only for those 
Products which will be available in 
the specified organization. Required 
for all Offers.

Prices may be defined only for those 
Products which will be available in 
the specified organization.

QP : Source 
System Code

Yes Resp Possible 
Source 
Systems that 
can define 
Offers

Offers created using this 
relationship are tagged with this 
system source code and will be used 
to determine update privileges of 
Offers within the pricing module.

Table 4–13 Lookups for Offers 

Key Type Values Meanings

AMS_OFFER_ DEAL_ CUSTOMER_ 
TYPES

Extensible Buyer

Customer

List

Segment

Buyer Group

Customer

List

Segment

AMS_ LUMPSUM_ 
DISTRIBUTION_ TYPE

System %

Amt

Qty

Percent

Amount

Quantity

AMS_OFFER_ LUMPSUM_ 
PAYMENT

System Accrue

Check

Accrue

Issue Check

AMS_OFFER_LUMP_CUST_ TYPES System Buyer

Customer

Buyer

Customer

Table 4–12 System Profiles for Offers (Cont.)

Option Required Level Setting Effect/Limitation
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4.2.9.3 Running Concurrent Programs for Offers
Run the following concurrent programs for offers:

■ AMS-TM: Adjust Backdated Offer: This programs takes the new Offer terms 
and recalculates the parameters of the Offer retroactively to the start date.

AMS_OFFER_ STATUS System Active

Closed

Draft

Rejected

Closed

Pending

Pending_Active

Archived

Cancelled

Completed

Terminated

Onhold

Active

Closed

Draft

Budget Rejected

Closed

Pending Budget approval

Pending Active

Archived

Cancelled

Completed

Terminated

On hold

AMS_OFFER_ TYPE System OID

Lumpsum

Order

Accrual

Off_Invoice

Deal

Terms

Promotional Goods

Lump sum

Order value

Accruals

Off Invoice

Trade Deal

Terms Upgrade

AMS_QP_ ARITHMETIC _
OPERATOR

System %

Amt

Lumpsum

Newprice

Percent

Amount

Lump sum

New Price

AMS_QP_ VOLUME_ TYPE System Pricing_Attribute10

Pricing_Attribute12

Quantity

Amount

Table 4–13 Lookups for Offers (Cont.)

Key Type Values Meanings
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■ AMS-TM: Refresh of Base Sales Materialized View: This program takes data 
from Order Management and loads it into Oracle Marketing. It loads into the 
following materialized tables: 

– ams_base_sales_mv

– ams_actual_sales_mv
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5
Implementing and Administrating the

Campaign Workbench

This topic group describes concepts and procedures related to implementation and 
administration of Oracle Marketing Campaign Workbench functionality. 

Topics include:

■ Section 5.1, "Implementing the Campaign Workbench"

■ Section 5.2, "Administrating the Campaign Workbench"



Implementing the Campaign Workbench

5-2 Oracle Marketing Implementation and Administration Guide                              

5.1 Implementing the Campaign Workbench 
To implement the Campaign Workbench see the following sections: 

■ Section 5.1.1, "Setting Up Campaign Workbench Users"

■ Section 5.1.2, "Setting Campaign Workbench Profile Options"

■ Section 5.1.3, "Running Campaign Workbench Concurrent Programs"

■ Section 5.1.4, "Implementing Schedule Execution"

■ Section 5.1.5, "Disabling the Campaign Tab for Campaign Execution"

5.1.1 Setting Up Campaign Workbench Users
Depending on job function and related application visibility you will assign your 
users one or more of the following responsibilities: 

Campaign Workbench User
Assign this responsibility to the following users:

■ Marketer: Uses the Campaign Workbench to execute campaign schedules, 
creates lists, and associates target groups to campaign schedules.

■ Sales Manager: Uses the Campaign Workbench to create sales activities. A sales 
activity inherits security definitions, metrics, costs, revenues, and tracking from 
the campaign it is assigned to.

■ Sales Representative: Creates and publishes proposal templates (as part of leads 
follow up). Without this responsibility, a sales representative is unable to 
publish proposal templates.

Campaign Workbench Super User
Assign this responsibility to users who perform administrative and setup activities 
to support schedule creation, maintenance and follow up processes. Additionally, 
this user creates and maintains schedule templates used by marketers, sales 
managers, or sales representatives. This responsibility also allows you to create and 
maintain Web placements used for Web schedule. 
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5.1.2 Setting Campaign Workbench Profile Options
Set the following profile options:

Note: To remove the quick link to the Audience Administration 
dashboard, you must exclude the specific function AMS_AUD_
ADMIN_DASH_PG (for e.g., from the List Manager/Campaign 
Workbench responsibility).

To remove the quick link to the Audience Dashboard one must 
exclude the specific function AMS_AUDIENCE_DASH_PG (for e.g., 
from the Campaign Workbench responsibility).

Table 5–1 Campaign Workbench Profile Options 

Option Required Level Effect

AMS: Default 
Campaign 
Hierarchy Time 
Range 

No User 

Site (default value is 180)

Captures default time range for 
campaigns shown in the Hgrid.

The campaign hybrid enables a 
user to view the campaign 
hierarchy. To minimize the 
number of campaigns shown, 
this profile can be set at user 
level. 

For more information about the 
hybrid see the Oracle Marketing 
User Guide. 

The default value (for site) 
indicates that campaigns 
having a start date or end date 
in the last 180 days will be 
shown in the hgrid. 

When a personalized view is 
defined on hgrid (and that 
personalized view is chosen to 
be applied) the resulting 
campaigns and campaign 
schedules will be limited to 180 
days. 
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5.1.3 Running Campaign Workbench Concurrent Programs
Use the request set Metrics Background Process to populate data for:

■ Top Performing Campaigns Bin 

■ Bottom Performing Campaign Bin 

■ Trend Graph 

Schedule this request set to run daily. It has two concurrent programs: 

■ Refresh the metric: Enter “Yes” in parameter to collect history. 

■ Populate the denorm table: If “Yes” is entered in parameter the program will be 
run in incremental mode. 

The top and bottom performing bins and trend graph are found in the Campaign 
Workbench (shown below). 

AMS: My 
Recent Objects 
Time Range

No User

Site (default is 30)

Used in the My Recent 
Schedules bin on the Campaign 
Dashboard. 

Default value indicates (in 
days) that the search will be 
restricted to schedules that 
were updated within the last 30 
days. 

If the end user is a frequent 
user of campaign schedules, a 
smaller value can be selected.

Table 5–1 Campaign Workbench Profile Options (Cont.)

Option Required Level Effect
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Figure 5–1 Bottom Performing Bins -- Request Set Update

5.1.4 Implementing Schedule Execution
The following workflow business event is seeded for schedule execution:

■ oracle.apps.ams.campaign.ExecuteSchedule

This business event kicks off the execution process for schedules. 

Figure 5–2  Schedule Execution workflow

5.1.5 Disabling the Campaign Tab for Campaign Execution
Campaign Workbench functionality is packaged as a separate responsibility. If 
the business decision is made to exclusively use the Campaign Workbench for 
campaign execution you must create responsibilities to include Campaign 
Workbench functions packaged in the Campaign Workbench Super User 
Responsibility (or use default seeded responsibility). 
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You must also create user accounts that provide access to the Campaign 
Workbench and Campaign Workbench administration functions. This ensures 
that the marketing users with responsibilities to access the Campaign 
Workbench can access it for campaign execution.

To prevent the use of Campaign tab for campaign execution use the following 
procedure: 

1. Exclude the following function: 

■ User Name: OMO Campaign Schedules 

■ Function name “AMS_CAMP_CSCH”) associated with the Campaign 
Schedules functionality, from the responsibilities associated with the 
Campaign tab. 

Because Campaigns and Programs can only be created in Campaigns and 
Programs tabs respectively, for planning and budgeting purposes, some users 
must have access to these two tabs.

2. To remove Campaign Schedules from QuickFind, use the following procedure:

a. Login to the jtflogin.jsp page with sysadmin responsibility. 

b. Navigate to Settings > System > Properties > Advanced

c. Choose AMS from the Applications drop-down

d. Remove the following properties: 

– service.oracle.apps.ams.search.CschSearchFactory.categories

– service.oracle.apps.ams.search.CschSearchFactory.desc  

3. Bounce the Apache server.   

5.2 Administrating the Campaign Workbench
Using Campaign Workbench administration functionality, you will perform a 
variety of tasks that ultimately make the Campaign Workbench simple and efficient 
for your end users. 

Administrative tasks include: 

■ Section 5.2.1, "Administrating Schedule Templates"

■ Section 5.2.2, "Administrating Activity Purposes"

■ Section 5.2.3, "Administrating Fatigue Rules"
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■ Section 5.2.4, "Administrating Content in the Campaign Workbench"

■ Section 5.2.5, "Administrating Web Marketing"

■ Section 5.2.6, "Web Dynamic Recommendations using Oracle Personalization 
(OP)"

■ Section 5.2.7, "Administrating Scripts"

■ Section 5.2.8, "Frequently Asked Questions: Campaign Workbench vs. 
Campaign Tab"

5.2.1 Administrating Schedule Templates
When a marketer creates a campaign schedule a schedule template must be 
selected. This template provides a prebuilt framework for the end user that enables 
them to quickly and accurately create schedules. Oracle Marketing ships with one 
seeded schedule template for each outbound channel. 

Schedule templates include commonly used schedule attributes and details 
including: 

■ Channel: Includes one or more schedule template and collateral types.

■ Schedule Purpose: Seeded with the application and include: cross sell, up sell, 
customer retention, customer acquisition, and lead maturation. 

■ List Templates: Associated with schedule purposes and used to create target 
groups for a schedule. Audience segments are created with either the default 
list template or a specified one.

■ Schedule Planning Requirements: Attributes required for planning a schedule 
and different channels need different attributes defined. For example, outbound 
content and the target group must be defined for an e-mail schedule.

■ Approval: An attribute indicating that a campaign schedule needs approval. 
Campaign Schedules based on seeded schedule templates must be approved.

As the administrator, you can create customized schedule templates to suit your 
specific business needs. A customized schedule template is an extension of a seeded 
template. As such, a customized templates inherits the following: 

■ Channel

■ Schedule purposes

■ Default list template associations (from the seeded templates)

The following templates are seeded:
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■ Sales: Used by a sales manager to create a campaign schedule that generates 
leads that are followed up by the sales team. When your end user create a sales 
schedule, they will choose Sales Template from the template drop-down menu. 
For more information about the seeded attributes for this template, see 
Table 5–2, "Seeded Sales Schedule Templates".

■ Direct Marketing: Used by the marker to create email, fax, or print campaign 
schedules. When the end user creates a direct marketing schedule they will 
choose either r Email, Fax, or Print from the template drop-down menu. For 
more information about the seeded attributes for this template, see Table 5–3, 
"Seeded Direct Marketing Schedule Templates".

■ Web Advertisement: Used by the marketer to create campaign schedules for 
Internet advertisements. This type of template assists the marketing team in 
creating Web ads that improve product brand, company awareness, or to alert a 
customer of new and upcoming products or deals. For more information about 
the seeded attributes for this template see Table 5–4, "Seeded Web 
Advertisement Schedule Templates".

■ Telemarketing: Used by the marketing team to create campaign schedules for 
call center or telemarketing purposes. For more information about the seeded 
attributes for this template see Table 5–5, "Seeded Telemarketing Schedule 
Template".

■ Web Offer: Used by the marketer to create campaigns schedules for Internet 
promotions. For more information about the seeded attributes for this template 
see Table 5–6, "Seeded Web Offer Schedule Template".

■ Web Dynamic Recommendation: Used by the marketer to create a schedule for 
Web product recommendations. Product recommendations can be based on 
product relationships or personalized for the customers based on customer data 
captured by Oracle Personalization. For more information about the seeded 
attributes for this type of template see Table 5–7, "Seeded Web Dynamic 
Recommendation Schedule Template".

Table 5–2 Seeded Sales Schedule Templates 

Attribute Seeded Value

Outbound Channel Sales

Activity Purposes Cross-sell, Up-sell

Default List Templates 
(by activity purpose)

All list templates associated cross sell and up sell 
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Default List Template Default List templates for Sales Schedule Template: 

■ Cross-sell: Used to cross-sell to businesses based on existing 
install base. 

■ Up-sell: Used to up sell to businesses based on existing 
install base. 

The Default List Templates includes territory as the first 
mandatory data filter. If desired, the end user may choose 
another list template that is not based on Territory. 

Available Mid-tabs Required mid-tabs:

■ Offering (products and offers)

■ Target Group (segmentation rules)

Optional mid-tabs: 

■ Collateral, Scripts, Proposal Templates Collaboration: 

■ Tracking

■ Notes

Fulfillment Direct Sales

Generates leads for all the list entries. The Leads Channel 
Selection engine should channel these leads to Direct Sales 
Channel, and specific Territories if applicable.

Table 5–3 Seeded Direct Marketing Schedule Templates 

Attribute Seeded Value

Outbound Channel Email, Fax, Print

Activity Purposes Cross- Sell, Up-Sell, Customer Retention, Customer 
Acquisition, Lead Maturation

Table 5–2 Seeded Sales Schedule Templates (Cont.)

Attribute Seeded Value
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Default List Templates (by 
activity purpose)

Default List templates for Direct Marketing: 

■ Cross-sell: Used to cross-sell to businesses based on 
existing install base. 

■ Up-sell: Used to up sell to businesses based on existing 
install base.

■ Customer Retention: Includes, default based on customer 
data source. 

■ Customer Acquisition: Includes default sample third 
party data source. 

■ Lead Maturation: Mature Leads based on low grade 
Leads.

Available Mid-tabs Required Mid-tabs:

■ Offering

■ Target Group

■ Outbound Collateral

Optional Mid-tabs:

■ Supporting Collateral, and Scripts, for Collaboration

■ Tracking (Includes Costs, Revenues and Metrics)

■ Notes 

Fulfillment Associated Outbound Channel (email, fax, print)

Table 5–4 Seeded Web Advertisement Schedule Templates 

Attribute Seeded Value

Outbound Channel Indirect Marketing Channel, Web

Activity Purposes Customer Retention, Customer Acquisition

Default List Templates (by 
activity purpose)

For all Advertising channels, the user can choose marketing 
mediums at the Template level.

Default List Template N/A

Table 5–3 Seeded Direct Marketing Schedule Templates (Cont.)

Attribute Seeded Value
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Available Mid-tabs Required Mid-tabs

■ Offering

■ Collateral

Optional Mid-tabs

■ Target Group: Although optional, there could be an 
intended audience for Advertisement and Web 

■ Supporting Collateral, and Scripts for Collaboration: 

■ Tracking 

■ Notes

Fulfillment Associated Indirect Marketing Channel. For Web, the 
eMerchandising Engine handles fulfillment.

Table 5–5 Seeded Telemarketing Schedule Template 

Attribute Seeded Value

Outbound Channel Direct Marketing

Activity Purposes Cross-sell, Up-sell, Customer Acquisition, Customer 
Retention, Lead Maturation

Default List Templates (by 
activity purpose)

Default List templates for Direct Marketing: 

■ Cross-sell: Used to cross-sell to businesses based on 
existing install base. 

■ Up-sell: Used to up sell to businesses based on existing 
install base.

■ Customer Retention: Includes, default based on customer 
data source. 

■ Customer Acquisition: Includes default sample third 
party data source. 

■ Lead Maturation: Mature Leads based on low grade 
Leads.

Default List Template N/A

Table 5–4 Seeded Web Advertisement Schedule Templates (Cont.)

Attribute Seeded Value
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Available Mid-tabs ■ Offering

■ Collateral

■ Target Accounts

■ Collaboration 

■ Tracking 

■ Notes

■ Additional Information

Fulfillment Associated Outbound Channel 

Table 5–6 Seeded Web Offer Schedule Template 

Attribute Seeded Value

Outbound Channel Web Marketing

Activity Purposes Cross-sell, Up-sell, Customer Acquisition, Customer 
Retention, Lead Maturation

Default List Template N/A

Available Mid-tabs ■ Offering

■ Web Planner

■ Target Accounts 

■ Tracking 

■ Notes

■ Additional Information

Fulfillment Associated Outbound Channel 

Table 5–7 Seeded Web Dynamic Recommendation Schedule Template 

Attribute Seeded Value

Outbound Channel Web Marketing

Activity Purposes Cross-sell, Up-sell, Customer Acquisition, Customer 
Retention, Lead Maturation

Default List Template N/A

Table 5–5 Seeded Telemarketing Schedule Template (Cont.)

Attribute Seeded Value
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5.2.1.1 Creating Custom Schedule Templates
If the seeded schedule templates do not meet your business requirements you can 
create your own. A custom template inherits all seeded base template associations 
including the outbound channel, sub-tabs, bins allowed, possible activity purposes 
and default list template for each activity purpose. 

To create a custom schedule template use the following procedure:

Prerequisites
None

Steps
1. Login as a user that has the Campaign Workbench Super User responsibility. 

2. Select Campaign Dashboard.

3. Using the Administration shortcut, select Schedule Templates. 

4. In the Schedule Template page, select Create.

5. Enter the following details:

■ Name: Enter a name for the schedule template. This is the name the user 
select when choosing a template, therefore it should be intuitive and 
relevant. 

■ Activity Type: Choose an activity type. The values in the Activity type 
drop-down menu are seeded, if necessary, they can be extended. 

■ Activity: Select an activity (or channel) to further describe the activity type. 

Available Mid-tabs ■ Offering

■ Web Planner

■ Target Accounts 

■ Tracking 

■ Notes

■ Additional Information

Fulfillment Associated Outbound Channel 

Table 5–7 Seeded Web Dynamic Recommendation Schedule Template (Cont.)

Attribute Seeded Value
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■ Activity Purpose: Select an activity purpose for this template. The values in 
the Activity Purpose drop-down are seeded and can be extended if 
necessary. For more information, see Section 5.2.2, "Administrating Activity 
Purposes".

■ Default List Template: If the activity type is Direct Marketing or Web 
Marketing, you will see an option to select a default list template. 

– For Direct Marketing, selecting a list template is mandatory. 

– For Web Marketing, selecting a list template is optional. 

The list templates displayed in the Default List Template drop-down are 
the templates created in the Audience Administration Dashboard. 

6. In the Components table, select the mid-tabs that will be displayed to the end 
user when creating this schedule template. 

For example, if Main, Collateral, Offering, Target Group, and Collaboration are 
checked then the end user will see these mid-tabs when creating this type of 
schedule. 

7. Select Update to save your work.

5.2.2 Administrating Activity Purposes
Campaign Schedules are created for specific reasons to achieve a specific objectives. 
To categorize marketing objectives (also referred to as objective driven marketing), 
schedules are grouped by activity purpose. 

All campaign schedules require an activity purpose. In some cases, activity purpose 
may dictate that a target group is selected. For example, campaign schedules 
created for cross-sell purposes, requires a target group (consisting of existing 
customers) to be selected. 

Every seeded schedule template contains associated seeded activity purposes. For a 
complete list of seeded purposes by schedule type see Section 5.2.1, "Administrating 
Schedule Templates". 

If the seeded activity purposes do not match your business requirements, you can 
extend them. For example, if you need to view order details for customers who 
have recently purchased products, you can create a custom activity purpose to meet 
this objective. 

To create a custom activity purpose, extend the user lookup AMS_ACTIVITY_
PURPOSES. See Appendix B, "Oracle Marketing Lookup Reference" for more 
information.
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5.2.3 Administrating Fatigue Rules
Fatigue rules provide your end users with a tool that helps prevent them from over 
contacting customers. As the administrator, you will setup up fatigue rules that 
define contact parameters.    

Fatigue rules provide the following business benefits: 

■ Promote Brand Awareness: If promotions are strategically timed, customers are 
not overexposed, therefore when they are contacted they are likely to be more 
receptive. 

■ Support Marketing Strategy decisions: Helps enforce marketing rules dictating 
customer contact boundaries.

■ Maximize Marketing Dollar Effectiveness: If strategically contacting customers, 
every marketing dollar spent receives (in theory) a better response rate, 
therefore improving effectivity.

■ Improve Collaboration: Enables you to setup enterprise wide rules. For 
example, Telesales, direct mail, and email (all communication channels having 
the potential to fatigue the consumer) - by centralizing the rules, you can 
prevent all channels from over-contacting the consumer.

5.2.3.1 Understanding Fatigue Rules and Time Periods
A fatigue rule defines maximum permissible contacts within a specified time 
period. For example, “Do not contact customers more than two times per month by 
any channel.” The defined time period adheres to a rolling period. 

Rolling Period Example 
An e-mail schedule is set to execute on February 13th and Amy is on the target list 
of customers to be contacted. The fatigue rule specifies, “Do not contact customers 
more than two times per month by any channel.” 

On 13th February (when the schedule executes) it determines how many times Amy 
has been contacted in the last one month. 

Contact count for Amy in the last 30 days: 

■ Email was sent to Amy on Jan. 15 --   one contact was counted. 

■ Another email was sent to Amy on Jan. 21 --   the count became two.

■ As of Feb. 13, Amy had already reached her threshold of “two contacts per 
month.” Therefore, she is fatigued and can’t be contacted.
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However, if the schedule executed on Feb. 14th, the total number of contacts within 
the last 30 days would have been 1. The contact on Jan. 15th would have been rolled 
out from the past 30-day period starting Feb. 14th.

Fatigue rule time periods are defined as follows:

■ Week = 7 days

■ Month = 30 days

■ Quarter = 90 days

■ Year = 365 days

5.2.3.2  Creating Global Fatigue Rules
Using this type of rule (threshold) you can set an absolute limit on the number of 
contacts for a given time period. 

■ If exclusively setting channel-specific limits -- global rules can be null 

■ For example: do not contact any customer more than 4 times per month by any 
channel 

To create a global fatigue rule, use the following procedure:

Steps
1. Login as a user that has the Audience Super User responsibility.

2. Navigate to Administration > Fatigue Rules Setup. 

3. In the Global Rules region enter the following details:

■ Global Contact Limit Field: Enter a number to set an absolute limit to the 
number of contacts that can be initiated by the Marketing department to the 
customer – for a given time period. 

For example, if you do not want to contact a customer more than 2 times 
per month, enter 2 in this field.   

■ Global Limit Drop-Down Menu: Use this drop-down menu to choose a 
time period for the numerical limit selected above. 

For example, if you do not want to contact a customer more than 2 times 
per month, select Per Month. 

4. Select Save. 
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In addition to setting global limits, you can define further restrictions by selecting a 
marketing channel. If channel-specific rules are not set, then there is no limit per 
channel (within the defined global contact limit.)

5.2.3.3 Creating Channel-Specific Rules 
Within the limits set globally, you can also establish specific rules (thresholds) for 
each outbound channel. 

■ Includes all direct marketing channels: direct mail (print), email, fax, and 
telemarketing (phone) 

■ For example: of the 4 total contacts allowed per month, do not contact customer 
by phone more than 2 times per month. 

When determining which rule to use (global vs. channel) the system will always use 
the most restrictive combination. 

For Example, if you have a global rule (do not contact more than 4 times per month) 
and a channel specific rule (do not contact more than 2 times per month by email or 
fax) -- in this example, the system will first look at the channel contact limit. If 
further restrictions are needed, then the global rules would apply. In other words, if 
both global and channel specific rules are established, the most restrictive 
combination is used.   

To create channel specific rules, use the following procedure:

Steps
1. Login as a user that has the Audience Super User responsibility.

2. Navigate to Administration > Fatigue Rules Setup. 

3. In the Restrictions by Channel region enter the following details:

■ Channel: Using the drop-down menu, select a channel for the fatigue rule. 
The channel selected here will, by default, always use the fatigue rule 
created. For example, if creating a fatigue rule for the “email” channel, 
select email. 

■ Maximum Contact: Enter a maximum contact limit for the selected channel. 
For example, if creating a rule that states you can only contact a customer 2 
times per month (by email), enter 2 in this field. 

■ Time Frame: Select a time frame (per week, month, year, quarter) for the 
fatigue rule. For example, if creating a rule that states you can only contact 
a customer 2 times per month by email, then select per month. 
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4. Select Apply. 

5.2.3.4 Running Fatigue Rule Concurrent Program
When executing a campaign schedule (containing a fatigue rule) the following 
concurrent program must be running in the background. This program must be 
scheduled and should simultaneously with schedule executions. 

■ AMS: Apply Fatigue Rules

5.2.4 Administrating Content in the Campaign Workbench 
Using the Campaign Workbench, marketers can author, manage, and fulfill content. 
To accomplish this, Oracle Marketing integrates with Oracle Content Manager 
(OCM). 

As the administrator it is important that you understand the various definitions 
associated with content. 

Table 5–8 Content in the Campaign Workbench: Definitions 

Content Name Definition

Content Group A collection of content types that have been defined in 
the system. Content Groups are a powerful tool that 
help ensure content consistency and meta-data. Content 
Groups can be used to bundle up a set of content types 
that can be used to create content items. Examples of 
content type groups are: Web marketing and sales 
initiatives.

Content Type A logical set of attributes, attachments, and associations. 
Refers to data of a certain content type. Examples of content 
types include a feature article, product information, help files, 
etc.   Content Types should not to be confused with file types 
like file, URL, PPT, etc. Instead, they are defined as types like 
images, white papers, or sales presentations. 

OCM provides some seeded content types on installation. The 
seeded content types can be modified for Collateral content 
types and content items. 

For example, if a feature article is a content type, then the 
specific article titled “selecting the right database for your 
company” is the content item.

Some Content Items are seeded. For example, stylesheets are 
seeded for Oracle Marketing. Therefore, OCM provide these 
on installation and the content items cannot be modified.
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Refer to Section 3.2.4, "Implementing Fulfillment for Oracle Marketing" for 
information on cover letters, fulfillment queries, and content in Oracle Marketing.

5.2.5 Administrating Web Marketing
Although Oracle Marketing has two different Web marketing strategies 
(eMerchandising and Web marketing), Web marketing is the only strategy available 
in the Campaign Workbench. 

As the administrator you are responsible for determining what schedule to run, in 
what order they will run, what content is rendered, and what happens when the 
rendered content is clicked.  

When administrating Web schedules you will perform the following tasks:

■ Specify Content Type: Before creating a Web placement you will select content 
types for it. Content types define what content is rendered for a specified Web 
placement. For details, see Section 5.2.5.1, "Specifying Content Types for Web 
Marketing".

■ Create Placement: Placements are areas on a Web page designated to show 
marketing content. For details see: 

–  Section 5.2.5.2, "Creating Web Placements"

– Section 5.2.5.3, "Determining Exact or Non-Exact Placement Matching"

■ Enable Target Web site: When an affiliate Web site is implemented you must 
enable the target Web site. After doing so, you are able to specify placement 
parameters specifically for that site. 

■ Create Web Schedule (Associate Placement and Content): After associating the 
content to a placement you will create a Web schedule. As the administrator, 
you will create Web schedule templates for the end user. For details see 
Section 5.2.5.4, "Creating Web Schedule Templates".

Stylesheet Stylesheets are associated with content types. Stylesheets tell 
the rendering engines how to display the content item to the 
calling application. Each content type may have many 
stylesheets associated to it. You can create many different 
stylesheets, but only one can be the default stylesheet for a 
specific content type. 

Table 5–8 Content in the Campaign Workbench: Definitions (Cont.)

Content Name Definition
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■ Create Guest User Account: If using iStore for your Web content, you will need 
to create a guest user account (with the appropriate responsibility) to view your 
placements. 

5.2.5.1 Specifying Content Types for Web Marketing
Oracle Marketing integrates with Oracle Content Manager (OCM) to provide Web 
marketing content.

Content Type
For Web marketing, content is displayed by way of a placement. Placements can 
have multiple content types associated to it. A specific stylesheet is selected for each 
content type and associated to a placement. Web Marketing groups content types 
by Web schedule activities. This acts as a template for Web marketing schedules. 

For more information about content types see Oracle Content Manager User Guide.

Seeded Content Types for Web Marketing
Oracle Marketing ships with 2 seeded Web marketing content types: 

– Web Advertisement: Used for both Web ad and Web offer. The seeded 
stylesheet for Web is ad is called Web Ad. For a schedule of type Web 
advertisement and Web offer you can create new: 

– Content Types

– Stylesheets

– Web Dynamic Recommendation: The seeded stylesheet for Web Dynamic 
Recommendation is called Web Dynamic Recommendation Stylesheet. For a 
schedule of type Web dynamic recommendation you can’t create new 
content types. However, you can create new stylesheets.   

Unlike a Web advertisement or Web offer, when using Web dynamic 
recommendations the content rendered is not static therefore cannot be 
predefined. Recommendations are situational (based on pages browsed, 
user preference, etc.) therefore, content is dynamically selected. Web 
dynamic recommendations are only executed when iStore is implemented.

Content Group for Web Marketing
Content groups are a collection of Content Types defined in the system. For 
example, a feature article, product information, or help file. Web Marketing content 
types are part of an overall content group. 
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The seeded content group for Web marketing is:

■ Content Type Group for Web Marketing 

The content types that are part of this group will appear in the content type 
drop-down in the Web planner midtab. Therefore, the user is able to create content 
items of this content type. 

Content Items for Web Marketing
Content items refer to anything a browser can render. For example an image, text 
file, etc. With the exception of stylesheets, no content items are seeded. Content 
items should not be created for Web dynamic recommendations because they are 
dynamically selected and driven by the product recommendations setup through 
iStore. 

Stylesheets used in Web Marketing
Content types are displayed using OCM stylesheets and are ultimately rendered on 
a placement. A placement can have multiple content types associated to it however, 
a specific stylesheet can be selected for each content type and associated to a 
placement. You can create your own style sheets and use with Web marketing. For 
more information see Oracle Content Manager Implementation Guide. 

The seeded stylesheets for Web marketing are: 

■ Universal Web Advertisement Stylesheet

■ Web Dynamic Recommendation Stylesheet

5.2.5.2 Creating Web Placements
Placements are areas on particular Web pages that have been designated to show 
marketing content. A placement can only be selected once within a schedule. Once 
the schedule is approved and active (start date has passed, end date has not been 
reached) the schedule automatically becomes part of the Web schedules that can 
run on the specified placement (if auto-publish is enabled for that Placement.) If 
not, the Web site manager will have to go into the placement and explicitly publish 
the schedule. For more information see Section 5.2.5.3, "Determining Exact or 
Non-Exact Placement Matching".

Logical order for Web placement:

1. Placement is picked (exact or non-exact match is determined)

2. A Schedule within the placement is executed - if no schedule is selected, default 
content (if any) is displayed
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3. Content associated to schedule is rendered

5.2.5.3 Determining Exact or Non-Exact Placement Matching
To determine where your content is displayed, you must decide if your placement 
matching is exact or non-exact. 

Exact Matching
Takes priority over non-exact matching. It uses the following matching priority: 

■ Application

■ Page

■ Location

■ Site

■ Section

Non-Exact Matching
Uses the following matching priorities: 

■ Application

■ Page

■ Location

Note: This is only true for Oracle iStore implementations because of the site and 
section requirement. Other implementations won’t see the site or section parameter 
(because it is specific to iStore) they will only see page and location. 

To create a Web placement, use the following procedure: 

Steps
1. Login as a user that has the Campaign Workbench Super User responsibility. 

2. Within the Administration region, select Web Placements.

3. Click Create Placement. 

4. In the Create Placement page, you will define parameters for the following:

■ Placement 

■ Target 
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■ Content

5. In the Create Placement region, enter the following details:

■ Name: Provide a logical name for this placement. Because a single 
placement can be used by many different schedules - you may want to give 
it a placement specific name rather than a schedule specific name. 

■ Description: Provide a short explanation of the nature and purpose of the 
given Placement. 

■ Status: To make the placement available for execution, it must be active. 

■ Selection Method: Choose either random or ordered. When the Web 
schedule executes, this value determines if the placement is displayed 
randomly on the page, or if it is ordered on the page.

– When Ordered is selected any Web schedule that subsequently chooses 
this placement will have the lowest schedule display priority in this 
placement. You will need to go into the Placement to manually change 
this priority if needed. 

– When Random is selected a schedule (assuming it is published) is 
randomly picked. 

■ Auto-Publish: Place a check in this checkbox if you want new schedules to 
automatically publish to the Web placement once the schedule is approved. 

– If checked -- a new schedule (that chooses this placement) can execute 
anytime once it has been approved through the normal schedule 
process without any further action. This assumes that the placement is 
already active. 

– If unchecked -- you will need to update the placement and explicitly 
check this for the new schedule (that picked this placement) to actually 
run in this placement.You can uncheck the checkbox in the Publish 
column (even if the schedule is already approved and running.) 

– When publish is unchecked for a schedule, the schedule remains in the 
list of that placement and is not deleted. Other Placements defined in 
that Schedule are not affected.

6. In the Target region, enter the following mandatory details:

■ Application: Select to specify what is application is running the target Web 
site. 
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– Oracle Marketing ships with seeded application values (iStore, 
iSupport, Partners). 

– To add additional applications to the drop-down, you will need to add 
them as a third party application. To do so, you will use the 
eMerchandising component.

– After adding the affiliate Web site (using eMerchandising), it will be 
available in the application drop-down. 

■ Application Seeded values: 

– iStore, iSupport, Partner Portal

– iSupport Only

■ Site: When implementing Web marketing with Oracle iStore, use this 
section to specify site level details for the placement. 

– A site refers to a specialty store within the context of iStore. 

– For more information see iStore Implementation and Administration Guide. 

■ Section: When implementing Web marketing with Oracle iStore, use this 
area to specify section level details for the placement. Within an iStore site, 
various sections exist. For example, for a given site (Vision USA) several 
sections could exist (Notebooks, PC, Desktops, etc.)

■ Page: Specifies the page within the target Web site. This is dependent on the 
application and/or site specified. 

– Seeded Choices: iStore, iSupport, Partner Portal 

– You can create additional pages for iStore or other defined applications 
that are currently provided in eMerchandising. 

■ Location: Specified the location on the tab or page. iSupport only sites use 
the location left 1 and right 1. 

Seeded values: 

– Top 

– Bottom

– Left (1-7)

– Middle (1-4)

– Right (1-4)
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7. In the Content Region, enter the following details: 

■ Content Type: Using the search icon, select an OCM content type for this 
placement. Only Web marketing content types are displayed here. The 
content type determines what content is rendered by the placement. 

– For Web Ads and Web Offers you can create custom content types. 

– For Web Dynamic Recommendations the seeded content type must be 
used. 

– All Content Types for Web Schedules must use the seeded Content 
Type group. 

■ Stylesheet:  Using the search icon, select a default stylesheet for this 
placement. The following Stylesheets are seeded:

– Universal Web Advertisement Stylesheet (used for Web ad and Web 
offer)

– Web Dynamic Recommendation Stylesheet (used for Web product 
recommendations)

■ Default Content: Use this area to select default content items. In the event 
that a scheduled is not selected, the content defined here is displayed. You 
can’t create a default click-through destination for a default content item.

■ Default Stylesheet: Use this area to select a default stylesheet for the default 
content. 

8. Select Save. 

5.2.5.4 Creating Web Schedule Templates
Web Schedules are associated to one or more placements by selecting the placement 
in the Web planner mid-tab (during the schedule creation process.) 

Although all Web schedules use the “Web” channel each type of Web schedule can 
have specific parameters (and therefore UI’s) that are unique to them. 

Oracle Marketing ships with three types of seeded Web schedule templates: 

■ Web Ad: Results in one or more contents (typically image or text) being 
displayed on a Web page. 

■ Web Offer: Similar to a Web Ad, but has an offer (in the form of a promo or 
offer code) associated with content it serves up. One or more offers can be 
linked to a Web Offer Schedule.
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■ Web Dynamic Recommendation: Results in a product or set of products 
recommended and the associated product image being rendered on the 
Web page. 

– There is a seeded content type and style sheets used when a Placement 
is used for Web Dynamic recommendations. Together, they pull 
product content from iStore and support the appropriate click through 
destination action. 

– During the schedule creation process, only Placements with this seeded 
content type will be visible if the schedule is of type Web Dynamic 
Recommendation. 

– The seeded style sheets will have layout and click through destination 
actions associated with it. 

– The two CTD actions are: Go to Item Detail Page, Go to Shopping Cart 
with Item. 

Use the following procedure to create a custom schedule for Web ad and offer. For 
Web dynamic recommendation, you must use the seeded schedule template.

Prerequisites
None

Steps
1. Login as a user that has the Campaign Workbench Super User responsibility. 

2. Select Campaign Dashboard.

3. Using the Administration region, select Schedule Templates. 

4. In the Schedule Template page, select Create.

5. Enter the following details:

■ Name: Enter a name for the schedule template. This is the name the user 
select when choosing a template, therefore it should be intuitive and 
relevant. 

■ Activity Type: Choose an activity type. The values in the Activity type 
drop-down menu are seeded, if necessary, they can be extended. 

■ Activity: Optionally, select an activity to further describe the activity type. 
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■ Activity Purpose: Select an activity purpose for this template. The values in 
the Activity Purpose drop-down are seeded, if necessary, they can be 
extended. 

■ Default List Template: For Web Marketing, selecting a list template is 
optional. 

6. In the Components table, select the mid-tabs that will be displayed to the end 
user when creating this schedule template. 

7. Select Update to save your work.

5.2.6 Web Dynamic Recommendations using Oracle Personalization (OP) 
Using Oracle Personalization intelligent/dynamic recommendations are made 
based on customer browsing, purchase history, and demographic information. 

From an administration perspective, you are responsible for:

■ Section 5.2.6.1, "Setting Oracle Personalization Profile Options"

■ Section 5.2.6.2, "Creating Web Placement for OP"

■ Section 5.2.6.3, "Create Web Schedules for OP"

5.2.6.1 Setting Oracle Personalization Profile Options
To enable OP for Marketing purposes set the following profile: 

AMS: Use Personalization = Yes

5.2.6.2 Creating Web Placement for OP
Assuming that a Web product recommendation schedule is active, you can create a 
placement for it. In this process, the placement that you create must have the 
content type “Web dynamic recommendation”. 

To create a placement for OP, use the following procedure: 

1. Login as a user that has the Campaign Workbench Super User responsibility.

2. Navigate to Administration > Placements. 

3. Select Create Placement. 

4. In the Create Placement region, enter the following details:

■ Name: Provide a logical name for the placement. 
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■ Description: Provide a short explanation of the nature and purpose of the 
given Placement. 

■ Status: To make the placement available for execution, it must be active. 

■ Selection Method: Choose either random or ordered. When the Web 
schedule executes, this value determines if the placement is displayed 
randomly on the page, or if it is ordered on the page.

– When Ordered is selected: any Web schedule that subsequently 
chooses this placement will have the lowest schedule display priority in 
this placement. You will need to go into the Placement to manually 
change this priority if needed. 

– When Manual is selected: You can specify which Web schedule in the 
list will execute always first and/or always last. 

■ Auto-Publish: Place a check in this checkbox if you want new schedules to 
automatically publish to the Web placement once the schedule is approved. 

– If checked -- a new schedule (that chooses this placement) can execute 
anytime once it has been approved through the normal schedule 
process without any further action. This assumes that the placement is 
already active. 

– If unchecked -- you will need to update the placement and explicitly 
check this for the new schedule (that picked this placement) to actually 
run in this placement.You can uncheck the checkbox in the Publish 
column (even if the schedule is already approved and running.) 

– When publish is unchecked for a schedule, the schedule remains in the 
list of that placement and is not deleted. Other Placements defined in 
that Schedule are not affected.

5. In the Target region, enter the following mandatory details:

■ Application: Select to specify what is application is running the target Web 
site. 

■ Site: When implementing Web marketing with Oracle iStore, use this 
section to specify site level details for the placement.   

■ Section: When implementing Web marketing with Oracle iStore, use this 
area to specify section level details for the placement. Within an iStore site, 
various sections exist. For example, for a given site (Vision USA) several 
sections could exist (Notebooks, PC, Desktops, etc.)



Administrating the Campaign Workbench

                                                                  Implementing and Administrating the Campaign Workbench 5-29

■ Page: Specifies the page within the target Web site. This is dependent on the 
application and/or site specified. 

■ Location: Specified the location on the tab or page. 

For more information about parameters in the target region see 
Section 5.2.5.2, "Creating Web Placements"

6. In the Content Region, enter the following details: 

■ Content Type: Choose Web Dynamic Recommendation. 

■ Stylesheet: Choose Web Dynamic Recommendation Stylesheet (used for 
Web product recommendations)

■ Default Content: Use this area to select default content items. In the event 
that the selected content can’t be rendered, this content will become the 
default. Even if the placement is associated to iStore location and not the 
schedule, the default content is displayed. 

Note: You can’t create a default click-through destination for a default 
content item.

■ Default Stylesheet: Use this area to select a default stylesheet for the default 
content. 

For more information about content region parameters see Section 5.2.5.2, 
"Creating Web Placements"

7. Select Save. 

5.2.6.3 Create Web Schedules for OP
When creating Web schedules for OP the schedule template must be of type Web 
dynamic recommendation. 

To create a schedule template for OP, use the following procedure: 

Steps
1. Login as a user that has the Campaign Workbench Super User responsibility.

2. Navigate to Administration.

3. Select Schedule Templates.

4. Select Create.

5. In the Create Schedule Template page, enter the following details:
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■ Name: Enter a logical name for the template. For example, Web schedules 
for OP. 

■ Activity Type: In the activity type drop-down menu choose Web 
Marketing. 

■ Channel: Choose Web Dynamic Recommendation. 

6. Choose an activity purpose. 

7. Select the applicable components. 

8. Select Update to save your work. 

To verify that the OP template is functioning properly:

1. Navigate to the Campaign Workbench.

2. Using the Create Schedule page enter the following mandatory details: 

■ Template: Select the template created for OP (this is the template created 
previously.)

■ Name: Enter a relevant name for the campaign. 

■ Campaign: Search and select for the campaign that this schedule is related 
to. 

■ Launch on: Enter a start date for this campaign schedule.

3. Select Continue. 

4. Select Web Planner. 

5.2.7 Administrating Scripts
To administrate scripts in the Campaign Workbench use the following procedure. 
Refer to Oracle Scripting documentation for details on Oracle Scripting 
functionality and setups.

Prerequisites
Oracle Scripting is implemented

Steps
1. Deploy scripts to the database. 

2. Create Survey Deployment. 
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3. Using the Campaign Workbench, attach the survey deployment as a 
click-through destination. 

For specific procedures see the Oracle Marketing User Guide. 

4. Execute the schedule. 

For specific procedures see the Oracle Marketing User Guide. 

5.2.8 Frequently Asked Questions: Campaign Workbench vs. Campaign Tab
■ Question: What tools are available to create and execute Campaign Schedules?

Answer: The Campaign Workbench is provided in 11.5.10 as a new tool to 
create and execute campaign schedules. The Workbench is designed to give all 
users (not just marketers) the ability to create and execute campaign schedules 
quickly and easily. The Campaign tab provides the same functionality as in 
11.5.9 to create and execute campaign schedules for sites that used Oracle 
Marketing 11.5.9. 

■ Question: What are the benefits of using Campaign Workbench? 

Answer: The enhanced usability in the Campaign workbench User interface 
increases operational efficiency for marketers. The Campaign Workbench also 
supports Sales channel for execution to provide better sales alignment. Sales 
Schedules allow sales managers to target their own territories with promotional 
activities as required. Campaign workbench has additional tracking and 
measuring capabilities for improved marketing measurement.

Campaign Workbench has simplified the Web Schedules to provide the 
marketers more control on the placements of their content.

■ Question: Which tool should be used to create and execute Campaign 
Schedules? 

Answer: With Campaign workbench, Oracle Marketing has greatly improved 
the ease-of-use and execution capabilities in the campaign schedule 
functionality. In the upcoming releases more new features will be added to this 
tool. Campaign workbench can let users create & execute campaign schedules 
very efficiently.

However, based on the planning, budgeting and execution requirements for the 
Campaign Schedules, each site must evaluate the two tools provided for 
Campaign Schedules setup and execution to choose appropriate tool.

■ Question: Once a decision is made to use for Campaign tab for Marketing 
execution, how can that decision be enforced? 
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Answer: Campaign workbench functionality is packaged as a separate 
responsibility. If the decision has been made to use Campaign tab for campaign 
execution, the administrator should not create responsibilities to include 
Campaign Workbench functions packaged in the Campaign Workbench Super 
User Responsibility. This will ensure that the marketing users have access to 
Campaign tab alone for campaign execution.

■ Question: Once a decision is made to use for Campaign Workbench for 
marketing execution, how can that decision be enforced? 

Answer: Campaign workbench functionality is packaged as a separate 
responsibility. If the decision has been made to use Campaign Workbench for 
campaign execution, the administrator must create responsibilities to include 
Campaign Workbench functions packaged in the Campaign Workbench Super 
User Responsibility (or use default seeded responsibility). The administrator 
must also create User accounts to provide access to Campaign Workbench and 
Campaign Workbench administration functions as appropriate. This will 
ensure that the marketing users with responsibilities to access Campaign 
Workbench can access it for campaign execution. 

For more information, see Section 5.1.5, "Disabling the Campaign Tab for 
Campaign Execution".

■ Question: How do I administer the Campaign Workbench?

Answer: Campaign workbench administration functions can be accessed from 
the Campaign Dashboard. An administrator with access to the two functions, 
Schedule Template and Placements, may access them via the shortcuts on the 
Campaign Dashboard.

■ Question: Do I still need perform Administration tasks in the Administration 
tab?

Answer: The Campaigns, Programs, Products, Budgets, and other existing 
Oracle Marketing functionality needs to be administered, hence it is necessary 
for the administration to use Administration tab for some setups. Since only the 
Schedule Templates and Placements administration is included in the 
Campaign Workbench, some basic Schedule setup such as Marketing Medium 
setup, Web Sites and Applications Setup, Oracle One-to-One Fulfillment setup, 
and Leads Processing setup needs to be done by accessing these functions in the 
Administration Tab. 

■ Question: If a decision is made to use Campaign tab as well as Campaign 
Workbench for marketing execution, how can that decision be implemented 
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and what are the consequences on tracking and reporting of campaign 
schedules?

Answer: 

a. Even if it is technically possible to use Campaign tab and Campaign 
Workbench both for campaign execution, and even if there is no 
consequence and no impact on execution tracking and reporting, it is 
recommended to avoid the use of these two tools for campaign execution at 
the same time due to the following reasons:

b. The Campaign tab user interface and the Campaign Workbench user 
interface for campaign schedule setup and execution has different look and 
feel. To use both at the same time means dual training efforts. If both the 
tools are used by the same set of users, the usage is error prone.

c. Due to the considerable difference in the User Interface for Campaign tab 
and Campaign Workbench, the Campaign Schedules created using 
Campaign tab can be seen, but cannot be accessed from the Campaign 
Workbench and vice versa.

d. Web Marketing Schedules usage and setup differs considerable in both 
these tools. Web Marketing Implementation in Campaign Workbench has 
improved usability and better tracking capabilities. If both the tools are 
used by the same set of users for Web Marketing, the difference is 
confusing.
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6
Implementing and Administrating Audience

This topic group describes concepts and procedures related to the implementation 
and administration of Oracle Marketing Audience Workbench functionality.

Topics include:

■ Section 6.1, "Implementing Audience"

■ Section 6.2, "Administrating Audience"
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6.1 Implementing Audience
After installation, perform the following implementation procedures: 

■ Section 6.1.1, "Setting Up Audience Users"

■ Section 6.1.2, "Setting Profiles for Lists"

■ Section 6.1.3, "Running List Concurrent Programs"

■ Section 6.1.4, "Verifying Lookups"

■ Section 6.1.5, "Implementing List Import"

6.1.1 Setting Up Audience Users
There are two seeded responsibilities for the Audience Workbench: List Manager 
and Audience Super User. Because menus, navigation and login flows depend on 
the responsibility of the logged in user, you will assign one or both of the following 
to your users: 

List Manager Responsibility
Users with this responsibility typically: 

■ Use the Audience Dashboard as their home page

■ Establish and manage the internal list selection process for marketing 
departments 

■ Manage lists from affiliates and vendors

■ Develop and manage processes for list data quality

■ Ensure data enrichment and list data integrity

■ Are primarily responsible for list creation and management

Audience Super User Responsibility
Users with this responsibility typically: 

■ Perform administrative activities to support list management   

■ Create and maintain data sources used by the end user to create lists 

■ Configure query templates   

■ Maintain suppression lists 
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6.1.2 Setting Profiles for Lists
Set the following profiles for lists. If using Oracle Discoverer for list generation, 
additional profiles are required. For more information see Section 2.5.2.6.1, "Setting 
Discoverer Profile Options".

6.1.3 Running List Concurrent Programs
Run the following concurrent programs as needed. 

Note: To remove the quick link to the Campaign Workbench you 
must exclude the specific function AMES_WB_CAMP_DASHBOARD 
(for e.g., from List Manager/Audience Super User responsibility).

Table 6–1 AMS List Profiles

Profile Name Required Level Setting Effect/Limitation

AMS: List 
Workbook 
B2C 
Marketing

Optional Site User Defined Workbook name convention 
prefix for B2C workbooks. The 
default is B2C. A blank 
convention prefix will result in 
more workbooks than you need in 
the LOV.

AMS: List 
Workbook 
B2B 
Marketing 

Optional Site User Defined Workbook name convention 
prefix for B2B workbooks. The 
default is B2B. A blank convention 
prefix will result in more 
workbooks than you need in the 
LOV.
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6.1.4 Verifying Lookups
The following lookups populate the list of values for list functionality. If 
implementing Oracle Discoverer for lists, you will need to verify additional 
lookups. For more information see Section 2.5.2.6.2, "Creating and Verifying 
Discoverer List Lookups".

Table 6–2 List Concurrent Programs 

Concurrent Program Required Description

AMS Migrate Word 
Replacement Rules for 
Remote List Processing

Yes This program migrates word replacement rules from a local 
to remote instance. 

This is a scheduled program.   

AMS Migrate Remote List Yes This program migrates a list generated in a remote instance 
to a local instance. This is a scheduled program and can be 
executed for a particular list or for all lists. 

AMS Generate Materialized 
View for Template

Yes This program executes when a query template is created 
(when the Finish button is selected on the query template 
screen.) It creates the materialized view for the template.

AMS Re-Generate 
Materialized View for All 
Template

No This program refreshes the materialized views for all 
templates. 

AMS Process to Calculate 
the List Selection Totals

Yes This program calculates the running totals for an advanced 
list. This is launched when the recalculate button is selected 
from the list generation selections page. 
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Table 6–3 List Lookups 

Key Type Seeded Values Meanings

AMS_LIST_ ACT_TYPE User List

Import List

Workbook

Segment

SQL

Target group selection type.

AMS_LIST_ DEDUP_ TYPE User Import Persons

Import Organizations

Type of Deduplication Rules to be 
applied.

AMS_LIST_
GENERATION_ TYPE

System Append New Records

Full Refresh

Update Attributes Only

New entries added, old entries not 
deleted, entries not updated.

All old entries deleted, new entries 
added.

Entries are updated

AMS_LIST_ ROW_ 
SELECT_ TYPE

System Nth Record

Random

Standard

How to select rows during list 
generation. Standard is top down 
selection.

AMS_LIST_ SEGMENT_ 
STATUS

User Archived

Available

Cancelled

Draft

Expired

Archived

Available

Cancelled

Draft

Expired

AMS_LIST_ SEGMENT_ 
TYPE

System Workbook

SQL

Two types of segments supported. 
Based on a Discoverer workbook or 
an SQL statement.

AMS_LIST_ SELECTION_ 
ACTION

System Include

Intersect

Exclude

How each selection is added to the 
list. Exclude means that all entries 
that exist in the excluded list are 
removed from the current list. 
Intersect causes the current list to 
become a list of only those entries 
which are on the intersected list and 
the current list.
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AMS_LIST_ SELECT_TYPE System Segment

Workbook

Import List

List

SQL

Components of list used in list 
selection. 

AMS_LIST_SEGMENT_ 
STATUS

User Archived

Available

Cancelled

Draft

Expired

Possible list segment statuses. 

AMS_LIST_STATUS System Archived

Available

Cancelled

Draft

Executed

Executing

Failed

Generating

Locked

Migrating

New

Pending

Reserved

List Statuses

AMS_CHART_TYPE System Pie

Bar

Column

Type of chart available

Table 6–3 List Lookups (Cont.)

Key Type Seeded Values Meanings
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AMS_QUERY_
TEMPLATE_TYPE

System Standard

Parametrized SQL

Two types of templates are 
supported: Standard and 
Parameterized SQL.

Standard templates are created using 
the NLQ (natural language query 
builder) interface. 

AMS_LIST_ TYPE System Manual List

Standard List

Suppression List

Target Group

List of possible list types. Note where 
these appear in the program.

AMS_AUDIENCE_
METRIC_TYPES

System Booked Order Amount

Booked Order Count

Invoiced Order Amount

Leads

Opportunities

Responses

Metrics that are tracked for Lists used 
in target groups. 

AMS_EXPN_BUILDER_
OPERATORS

System Average

Maximum

Minimum

Count

Sum

Sysdate

Valid operators for expression 
builder.

AMS_DATA_SOURCE_
LOCATION_TYPE

System Local

Remote

Data sources are based on 
tables/views that are located in the 
current database (local instance) or 
views/tables located in a remote 
database (remote instance). The 
remote instance is accessed using a 
database link. 

Table 6–3 List Lookups (Cont.)

Key Type Seeded Values Meanings
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6.1.5 Implementing List Import
List Import is an Oracle Marketing feature that facilitates importing lists of 
prospects and their related information from outside sources. 

The following types of lists can be imported: 

■ Rented lists

■ Purchased mailing lists 

■ Mailing lists from merged or acquired organizations

■ Mailing lists provided by internal or external sales people

Using the List Import feature lists may be added directly to TCA tables. When 
importing from a purchased list, data is stored in the TCA schema. However, when 
importing from a rented list data is not stored in the TCA schema. For more 
information see the TCA Best Practices White Paper.

To implement List Import see the following sections:

■ Section 6.1.5.1, "List Import Table Overview"

■ Section 6.1.5.2, "Creating the Bin Directory"

■ Section 6.1.5.3, "Setting System Profiles"

■ Section 6.1.5.4, "Verifying Lookups for List Import"

■ Section 6.1.5.5, "Running NFS Mount"

AMS_DATASOURCE_
TYPE

System Parent

Child

Types of data sources available.

AMS_DATASOURCE_
CATEGORY

System Organization Contacts

Persons

Category of data source.

AMS_SPLIT_MODE System Split by Attribute

Split by Percentage

Split by Number

List splitting methods

Table 6–3 List Lookups (Cont.)

Key Type Seeded Values Meanings



Implementing Audience

                                                                  Implementing and Administrating Audience 6-9

6.1.5.1 List Import Table Overview
The Oracle Marketing list import functionality supports many different business 
requirements. For example, event registration can be automatically executed from 
list import. 

When a list import is performed, B2B or B2C data is imported into the Marketing 
and TCA tables. When doing so, you can import directly into TCA or you can 
choose to preview it first.   

Marketing import tables:

■ AMS_IMP_LIST_HEADERS_ALL

■ AMS_IMP_SOURCE_LINES

■ AMS_PARTY_SOURCES

TCA import tables: 

■ HZ_PARTIES

■ HZ_LOCATIONS

■ HZ_PARTY_SITES

■ HZ_CONTACT_POINTS

■ HZ_ORG_CONTACTS

6.1.5.2 Creating the Bin Directory
Use this procedure to create a location for the SQL loader control file. This step 
enables you to import data from a file located on the server. 

Prerequisites
SQL Loader is installed

Steps
1. Launch a DOS prompt. 

2. Create the Bin Directory under PRODUCT TOP ($AMS_TOP) for the SQL 
Loader control file. 

This directory must have read, write and execute privileges. 
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6.1.5.3 Setting System Profiles
Set the following list import profile options:
 

Table 6–4 List Import Profile Options 

Option Required Level Setting Effect/Limitation

AMS : 
IMPORT 
CONTROL 
FILE PATH

Yes Site Control File 
Location

Enter the path for the bin directory: 
($AMS_TOP/bin/)

This path is relative to the mid-tier 
server that the SQL loader control file 
is written to. 

Improper setup will cause the server 
side import to fail.

AMS : 
IMPORT 
DATA FILE 
PATH

Yes Site Data File 
Location

Enter the path for the data file location: 
($AMS_TOP/bin/). 

This path is relative to the mid-tier 
server and indicates the location of the 
import data file. 

For the data file you may also set a 
different path to where the data is kept.

Improper setup will cause the server 
side import to fail.

AMS : HZ 
DEDUPE 
RULE

Optional Site Yes/No Indicates whether de-duplication rules 
are used during the TCA import 
process. 

The system may create duplicate 
records if this profile is not set to Yes.

AMS : 
Import 
Client File 
Size

Yes Site Numeric 
value

Size of file in bytes. Based on this 
profile, the import program decides 
whether to use the concurrent manager 
to upload the file. 

Default value is 1000000. For Oracle 
Marketing List Import functionality, 
this value sets the file size limit in 
terms of bytes that can be uploaded by 
client.

AMS : 
Default 
Data Source

Yes Site Data Source 
name

Data source name that is defaulted in 
the list/target group creation screens. 
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6.1.5.4 Verifying Lookups for List Import
Use the following table for Lookups, types, values, and meanings. 
 

HZ : Key 
Word Count

Optional Site Number of 
words

This number determines how many 
words in the customer name are used 
to generate the keys

HZ : 
Address 
Key Length 

Optional Site Length of 
the Address

This determines the length of Address 
key

HZ : Postal 
Code Key 
Length

Optional Site Length of 
the Postal 
Code

This determines the length of Postal 
Code key

Table 6–5 List Lookups 

Key Type Values Meanings

AMS_ IMPORT_ STATUS System New

Staged

Scheduled

Completed

Purged

Cancelled

Error

Duplicate

Incompdump

Incompdumperr

Incomperr

New Import

Entries are imported and available for 
viewing

Import is setup and ready to be completed at 
the scheduled time

Import completed

Imported entries have been purged from the 
Marketing Import Table

The List Import has been cancelled and may 
not be reactivated

An error occurred during List Import

Duplicate record found

Incomplete-Duplicate found

Incomplete-Duplicate-Error found

Incomplete-Error found

AMS_ IMPORT_ TYPE System B2B Customer

B2C Customer

Event

Lead

Organizations, Contacts, Address

Persons, Addresses

Event Registration

Leads

Table 6–4 List Import Profile Options (Cont.)

Option Required Level Setting Effect/Limitation
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6.1.5.5 Running NFS Mount
If the concurrent manager server is different from the server where your data is 
located (and you want to import data from the server) - you must run NFS Mount. 
This ensures that your data file directory is mounted to the concurrent manager 
server.

6.2 Administrating Audience 
To administrate the Audience Workbench, see the following: 

■ Section 6.2.1, "Administrating Data Sources"

■ Section 6.2.2, "Creating Remote Data Sources"

■ Section 6.2.3, "Administrating Query Templates"

■ Section 6.2.4, "Fatigue Rules and Lists"

■ Section 6.2.5, "Administrating Deduplication Rules"

■ Section 6.2.6, "Administrating List Import"

6.2.1 Administrating Data Sources
As the audience administrator, you are responsible for setting up data sources and 
their respective attributes. Data sources are a fundamental component of the list 
management process. In short, they determine the type of data retrieved for lists.  

Data source determine: 

■ Attributes available to the end user during list creation 

■ TCA information mapping (when remote lists are migrated to a local 
instance)

■ Data available in list entry 

■ Attribute available for splitting and charting

■ Deduplication rules    

Data sources map columns from a source table (or view) to the marketing list 
entries table AMS_LIST_ENTRIES. Once mapped, data from the table or view can 
be used for lists. 

Data sources can be either child or parent.   
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Parent and Child Data Sources
The parent data source determines the type of list that will be created.  

Usually, the attributes included in the parent data source are mapped to the list 
entries.  Each parent data source also includes seeded templates and de-duplication 
rules.  

A child data source provides additional information about the parent. A parent can 
have an unlimited number of child data sources associated.  

Parent and Child Data Source Example
Scenario: Amy is the list administrator for Vision Computers. Her marketing team 
wants the ability to generate a list for cross sell purposes. The end goal is to 
generate a list of customers who have recently purchased a Vision Desktop 
computer.

Solution: Based on the business requirements given to her, Amy must create the 
appropriate data sources. As such, she will create a parent data source "Persons" 
and a child data source "Order Detail." 

Parent Data Source: Persons 

■ Table: AMS_PERSON_DETAILS_V

■ Unique Identifier: PARTY_ID

■ Information of interest: Person First Name, Person Last Name, Email 
Addresses, Language

■ Note: This data source provides details about the person/customer who has 
recently purchased a Vision Desktop computer 

Child Data Source: Order Detail

■ Table: AMS_DS_ORDERS_V

■ Unique Identifier: PARTY_ID

■ Information of interest: Booked date, Creation Date, Unit Selling Price, Order ID

■ Note: This data source provides transactional information about the person 
(and customer) who has placed the order 

To administrate data sources see:

■ Section 6.2.1.1, "Seeded Data Sources"

■ Section 6.2.1.2, "Related Data Sources"
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■ Section 6.2.1.3, "Creating Parent Data Sources for Lists"

■ Section 6.2.1.4, "Creating Child Data Sources"

■ Section 6.2.1.5, "Configuring Data Source Attributes"

■ Section 6.2.1.6, "Defining the List of Values and Charts for Data Sources"

■ Section 6.2.1.7, "Linking a Parent to a Child Data Source"

■ Section 6.2.1.8, "Linking a Child to a Parent Data Source"

6.2.1.1 Seeded Data Sources
The following parent data sources are seeded: 

■ Person: Represents Business to Consumer (B2C) customer attributes such as 
first name, last name, marital status, household income, etc. 

■ Organization Contacts: Represents Business to Business (B2B) attributes such as 
first name, last name, job title, work e-mail address, etc.

■ Organization: Represents organization attributes such as company name, 
business type, revenue, etc. 

See Appendix F, "Seeded Data Source and Data Source Attribute Reference" for 
more information on seeded data sources.

6.2.1.2 Related Data Sources
Related Data Sources help define the relationship between the corresponding data 
source and its related data source. For a parent data source, it displays the 
relationship with its child data sources. For a child data source it displays the 
relationship with the parent data source.

The Related Data Sources mid tab is displayed for all data sources (parent or child). 
If a relationship is defined in the parent data source (between itself and a child data 
source), then on navigating to the child data source, you see the relationship 
between the child and the parent. This implies that creating a relationship in one 
data source, displays the inverse relationship in the “Related Data Sources” mid tab 
of the other data source. 

For example if the Parent Data Source is Organization Contacts and the child data 
source is Locations, then if a relationship is created between the Organization 
Contacts and Locations in Organization Contacts, then the Related Data Sources 
mid-tab of Locations automatically displays the relationship of Locations to 
Organization Contacts.
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The following related data sources are seeded: 

■ Person Profile 

■ Education 

■ Employment History 

■ Organization Profile

■ Account Profile 

■ Interactions  

■ Leads 

■ Order Detail

■ Install Base 

■ Sales Access 

■ Data mining Aggregates 

■ Profitability

■ System Reference 

■ Data Mining Score

6.2.1.3 Creating Parent Data Sources for Lists
If the seeded parent data sources do not meet your business requirements you can 
create your own. When doing so, you can point to the Oracle TCA or you can use 
data that resides in a remote location. For more information about creating remote 
data sources, see Section 6.2.2, "Creating Remote Data Sources".

Whether using the seeded data sources or creating your own, when creating list 
templates selecting a parent data source is mandatory. 

To create a parent data source, use the following procedure: 

Prerequisites
None

Steps
1. Login as a user that has the Audience Super User responsibility. 

2. Select Administration Dashboard.  
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3. Select Create Data Source.

4. Fill in the following required fields:

■ Data Source Name: Enter a logical name for the parent data source. The 
name must be unique. 

■ Code: This code is used as a reference for the data source when creating 
Discoverer Workbooks. For more information about creating Discoverer 
Workbooks, see Section 2.5.2.6, "Integrating Oracle Marketing and Oracle 
Discoverer".

■ Type: Choose Parent Data Source.

■ Category: Selecting a category enables you to organize the data source by 
type. Category selection is mandatory when creating parent data sources 
and optional when creating child data sources. 

Categories determine the type of list that the end user will create.  This 
distinction tells the system (for example, Fulfillment, OTS, Advance 
Outbound) using the list what types of entries is on the list.  

The following categories are seeded: 

– Organization Contacts

– Persons

– Organization

■ Table or View Name: Select the appropriate table or view that the data 
source is using. By selecting a view (given it has been created) you are able 
to narrow down the amount of data that the end user is able to retrieve 
when creating lists. 

■ Unique Identifier: All data sources require a unique identifier. It can be  any 
attribute defined in the table or view chosen above.  The unique identifier 
enables you to set a default join condition between a parent and child data 
source. A common unique identifier for the parent data source is the 
PARTY_ID. 

You can explicitly relate the parent and child during the creation phase or 
at a later time (using the related data sources mid-tab). If you know your 
parent and child relationships up front, you can specify the default join 
condition in the data. 

5. Select Apply. 

The Update Data Source page opens. 
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6. In the Attributes tab, fill in the necessary information. 

For more information about data source attributes, see Section 6.2.1.5, 
"Configuring Data Source Attributes".

7. Select Apply. 

6.2.1.4 Creating Child Data Sources
After creating parent data sources you can create children for them. This enables 
you to define additional attributes for the parent. 

Prerequisites
Table or view is created

Steps
1. Login as a user that has the Audience Administrator responsibility. 

2. Navigate to Audience Dashboard > Audience Administration. 

3. Select Create Data Source.

4. Fill in the following required fields:

■ Data Source Name: Enter a logical name for the parent data source.

■ Code: This code is used as a reference for the data source when creating 
Discoverer Workbooks.

■ Type: Choose Child Data Source.

■ Category: Categories only apply to parent data sources.   

■ Table or View Name: Select the appropriate table or view for the child. If 
your business requirements mandate that you associate this child data 
source to a parent, enter the parent table or view name here. 

■ Unique Identifier: Enables you to set a default join condition between a 
parent and child data source. Specifying the join condition here enables the 
child and parent to be explicitly joined. 

Although you can relate the parent and child at a later time (using the 
Related Data Sources mid-tab), if you know your parent/child relationships 
up front, you can join them in the data source creation phase.   

5. Select Apply. 

The Update Data Source page opens. 
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6. In the Attributes tab, fill in the required details. 

For more information about data source attributes, see Section 6.2.1.5, 
"Configuring Data Source Attributes".

7. Select Apply. 

6.2.1.5 Configuring Data Source Attributes
When creating or updating data sources you will define the attributes for it. Using 
the data source attribute pages, you can define data source attributes for list 
management as well as data mining. 
 

Table 6–6 Data Sources Attributes 

Attribute Name  Description

Attribute The attributes of the table or view that the data source references. 
The values are displayed as they exist in the table or view. 

Display Name Allows you to change the display name for the attributes pulled from 
the table or view. The values entered in this column are displayed to 
the end user during the list creation process. 

Map to List Entries Use this field to map or organize how this data source is displayed in 
the list entries screen for the end user.

This attribute is important because if you want to enable the user to 
split the list, chart distribution of data for this attribute, or use this 
attribute in a dedupe rule then you must map the attribute to list 
entries.  

For example, if you want gender to be the first column displayed to 
the end user, in this column you would enter COL1. 

Use the Search and Select flashlight to pick from the list of values. 

Display in List 
Entries

Use this checkbox to indicate that you want this data source to 
display data (by default) in the List Entries page for the end user. 

If this checkbox is left unchecked, the data source will not display by 
default and the end user will have to explicitly select it through the 
personalization option.  

Use for Split The end user has the option to split a list by attribute. Therefore, as 
the administrator, when defining data source attributes, you must 
specify that it is available for splitting. 

If you want to use for splitting you must map the attribute. 

Define LOV Chart Selecting this icon enables you to define LOV and chart ranges for 
this data source. If you are charting an attribute, you must also map 
to list entries.
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6.2.1.6 Defining the List of Values and Charts for Data Sources
When defining data source attributes, you can choose to define a list of values that 
correspond to it. This list of values can also be used to drive the chart ranges. This 
reduces the chance of error because you are limiting the data the user can select.

To define the LOV and chart attribute use the following procedure:

Prerequisites
Data Source is created

Steps
1. Login as a user that has the Audience Administrator responsibility. 

2. Navigate to Audience Dashboard > Audience Administration. 

3. Locate the Data Source you configuring. 

4. In the Attributes mid-tab, select the Define, LOV chart icon. 

5. In the Add List of Values Using drop-down select one of the following: 

■ Manual Entries: This option enables you to manually define the LOV for the 
attribute. If using this option, select “Add Another Row” and enter a value 
code and display name. 

– Value code: Exact value (as it appears in the database). For example, the 
value code for country could be CAN for Canada.

– Display name: Text box that allows you to change the code name to a 
more user-friendly display name. For example, the display name for 
CAN could be Canada. 

LOV If a list of values are defined for this attribute, then you will see a 
check in this column. 

Chart If a chart is defined for this attribute, then you will see a check in this 
column. 

Enabled Place a check in this checkbox to enable the attribute for the data 
source. If this checkbox is left unchecked, this attribute will not be 
available for use in the list template creation process. 

Table 6–6 Data Sources Attributes (Cont.)

Attribute Name  Description
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■ Another List of Values: Allows you to pick a specific list of values that have 
previously been defined for similar attribute.  This option allows you to 
re-use the LOV that has previously been defined. This will save you time.  
Using this option you essential share the LOV with other attribute, 
therefore changing the definition of the LOV will affects all attributes 
sharing this LOV.

– List of Value Name: Using the search and select window specify the 
values that you’d like this attribute to have. For example, if you’d like 
the attribute “COUNTRY” to have “United States” and “Canada” as the 
list of value options, select them here. 

– Description: Optionally enter a description for this LOV.   

■ Custom SQL: Using this option, you can define the list of values using data 
retrieved with SQL logic. Use the Custom SQL box to enter an SQL 
statement. 

6. Select Apply. 

6.2.1.7 Linking a Parent to a Child Data Source
Use the following procedure to establish a parent and child data source 
relationship.  

Prerequisites
■ Parent is created

■ Child is created

Steps
1. Login as a user that has the Audience Administrator responsibility. 

2. Navigate to Audience Dashboard > Audience Administration. 

3. Select the parent data source (this is the parent for the child that you want to 
link to). 

4. Select Related Data Source (mid-tab).

5. Select Add Another Row and enter the following:

■ Related Data Sources: Search and select the child data source. 

■ Related Data Sources Column: Search and select the unique identifier for 
the child data source. This is the child data source attribute that would 
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define the join condition between the child and the parent. If this column is 
left blank the child's unique identifier will be used as the join condition.

■ Primary Data Source Column: Search and select the unique identifier for 
the child and the parent. By selecting the same unique identifier, the child 
becomes associated to the parent. If this column is left blank the parent's 
unique identifier will be used as the join condition.

Note: If the parent data source is selected first (and the child is related after) 
the primary data source columns refers to the parent and the related data 
source column refers to the child.  

If the child data source is selected first (and parent is related after) the 
primary data source columns refers the child and the related data source 
column refers to the parent.

6. Select Apply.

6.2.1.8 Linking a Child to a Parent Data Source
To manually establish a relationship between a child and parent data source, use 
the following procedure.

Prerequisites
■ Parent is created

■ Child is created

Steps
1. Login as a user that has the Audience Administrator responsibility. 

2. Navigate to Audience Dashboard > Audience Administration. 

3. Select the child data source (this is the child for the parent that you want to link 
to). 

4. Select Related Data Source (mid-tab).

5. Select Add Another Row and enter the following:

■ Related Data Sources: Search and select the child data source. 

■ Related Data Sources Column: Search and select the unique identifier for 
the parent data source. This is the parent data source attribute that would 
define the join condition between the child and the parent. If this column is 
left blank the parent’s unique identifier will be used as the join condition.



Administrating Audience

6-22 Oracle Marketing Implementation and Administration Guide                              

■ Primary Data Source Column: Search and select the unique identifier for 
the child and the parent. By selecting the same unique identifier, the child 
becomes associated to the parent. 

Note: If the parent data source is selected first (and the child is related after) 
the primary data source columns refers to the parent and the related data 
source column refers to the child.  

If the child data source is selected first (and parent is related after) the 
primary data source columns refers the child and the related data source 
column refers to the parent.

6.  Select Apply.

6.2.2 Creating Remote Data Sources
Data sources can be local or remote. Remote data sources can be setup and used for 
list generation. Remote data sources point to objects residing in a remote instance. 
For example, an external data warehouse system. To define a remote data source, 
you will point to a remote object using a database link (db link).  

A list created by the end user using a remote data source will reside in the remote 
instance until it is migrated.

Optionally, once you have established the db link, you can migrate a single list (or 
all remote lists) to your local instance. If migrating, remote lists go through a 
migration process. For target group generation, data validation and TCA inserts are 
performed. List are generated through a package available on the remote instance. 

Use the following procedures to setup the remote data sources:

■ Section 6.2.2.1, "Running a Script to Setup Schema in a Remote Database"

■ Section 6.2.2.2, "Creating the Database Link in the Local Instance"

■ Section 6.2.2.3, "Create Remote Data Sources in the Audience Administration 
Dashboard"

6.2.2.1 Running a Script to Setup Schema in a Remote Database 
Use the following steps to create schema used for remote processing. 

Steps
1. Login to SQL*Plus in the remote database.
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2. Download the zip file amsrlpkg.zip and unzip the contents.

3. Run the script amsremot.sql on the remote database (for the same schema). This 
script creates the following tables:

■ AMS_LIST_ENTRIES

■ AMS_HZ_WORD_REPLACEMENTS

■ AMS_LIST_HEADERS_ALL

■ AMS_LIST_SELECT_ACTIONS

4. Apply the following AMS .pls files :

■ amslgrms.pls

■ amslgrmb.pls 

6.2.2.2 Creating the Database Link in the Local Instance
Use the following guidelines when creating the DB link in the local instance: 

– DBLINK_FROM_LOCAL_TO_REMOTE: Database link name

– Username: Username used to connect to remote instance

– Password: Password used to connect to remote instance

– REMOTE_DATABASE_NAME: Name of remote instance  

Steps 
1. To create the DB link in the local instance:  

CREATE PUBLIC DATABASE LINK DBLINK_FROM_LOCAL_TO_REMOTE
   CONNECT TO USERNAME IDENTIFIED BY PASSWORD
   USING REMOTE_DATABASE_NAME;

Note: As a best practice, you should create a new schema and give 
access to tables and views which will be used for remote data 
processing. Typically this would be views and tables that will store 
customer information with which you are going to create lists. By 
creating new schema, you are limiting apps user access to only the 
relevant tables and views which might be needed for list 
generation.
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6.2.2.3 Create Remote Data Sources in the Audience Administration Dashboard
After running the script and creating the remote database link you are now ready to 
create a data source using data in the remote instance. Therefore, when creating a 
new data source, the remote data will be available to you. 

To create a data source (using the remote data) use the following procedure.

Steps
1. Login as a user that has the Audience Workbench Super User responsibility.

2. Navigate to the Audience Administration Dashboard. 

3. Select Create Data Source.

4. In the Create Data Source Page, enter the following:

■ Data Source Name: Enter a logical name for the data source.

■ Code: This code is used as a reference for the data source when creating 
Discoverer Workbooks.

■ Type: Choose either parent or child. 

■ Category: If applicable, choose a category. Categories only apply to parent 
data sources.   

5. In the Table or View Information region, enter the following: 

■ Location: Choose Remote.

■ Database Link: Enter the database link information. This is the link created 
in Section 6.2.2.2, "Creating the Database Link in the Local Instance".

■ Table or View Name: Select the appropriate table or view that the data 
source points to. By selecting a view (given that a view has been created) 
you are able to narrow down the amount of data retrieved by this data 
source. 

■ Unique Identifier: Enables you to set a default join condition between a 
parent and child data source. Specifying the join condition here enables the 
child and parent to be explicitly joined. Although you can relate the parent 
and child at a later time (using the Related Data Sources mid-tab), if you 
know your parent/child relationships up front, you can join them in the 
data source creation phase. 

6. Select Apply. 

The Update Data Source page opens. 
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7. In the Attributes tab, fill in the necessary information. 

For more information about data source attributes, see Section 6.2.1.5, 
"Configuring Data Source Attributes".

8. Select Apply. 

6.2.3 Administrating Query Templates
As the audience administrator, you will create query templates. These templates 
enable your end users to quickly and easily create lists. When creating list, your end 
user has 2 different list template options to choose from: 

■ Standard List Template: Retrieve data with natural language (using the natural 
language query builder tool) instead of using SQL

■ Parameterized SQL List Template:  Retrieve data by filling in parameters which 
you specify in SQL statements 

6.2.3.1 Seeded Standard Query Templates
The ten commonly used standard query templates that are seeded with the Oracle 
Marketing application are detailed in the table below.

Table 6–7 Seeded Standard Query Templates 

Query Template Name Data Source Filter Conditions

Cross Sell to Install Base - 
B2B

Organization Contacts Current install base products, 
purchase amounts, firmographics, 
and contact profile attributes

Cross Sell/Up Sell based 
on Orders - B2B

Organization Contacts Purchase history, firmographics, 
and contact profile attributes

Customer Acquisition - 
B2B

Organization Contacts Firmographics and contact profile 
attributes

Customer Retention based 
on Orders - B2B

Organization Contacts Purchase history, firmographics, 
and contact profile attributes

Lead Maturation - B2B Organization Contacts Lead information, firmographics, 
and contact profile attributes

Interaction Follow Up - 
B2B

Organization Contacts Interaction history, 
firmographics, and contact profile 
attributes

Cross/Sell Up Sell based 
on Orders - B2C

Persons Purchase history, demographics, 
and person profile attributes
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6.2.3.2 Creating Standard Query Templates
Within the Audience Administration interface, you can create additional 
user-defined query templates to meet your business requirements. These query 
templates can be based on the out-of-box data sources (Organization Contacts, 
Persons, Organizations) or any user-defined data source (for example, an 
industry-specific data mart). You can create these templates using either the 
Standard or Parameterized SQL template options.

To create a user-defined standard query template, use the following procedure:

Prerequisites
Data Sources are created

Steps
1. Login to the Audience Administration Dashboard.

2. Select Create Query Template.

3. Enter the following mandatory fields:

■ Query Template Name: Enter a logical name for the template. For example, 
cross sell list template. 

■ Query Template Type: Choose Standard.

■ Data Source Name: Select the data source that will be used for this 
template. The data source determines the type of data retrieved. 

■ Purpose: When the end user is creating a new list, they are required to 
select a purpose. After solacing the purpose, templates (of that purpose 
type only) are displayed to them. Therefore, as the administrator, you must 

Customer Acquisition - 
B2C

Persons Demographics and  person profile 
attributes

Customer Retention based 
on Orders - B2C

Persons Purchase history, demographics, 
and person profile attributes

Interaction Follow Up - 
B2C

Persons Interaction history, 
demographics, and person profile 
attributes

Table 6–7 Seeded Standard Query Templates (Cont.)

Query Template Name Data Source Filter Conditions
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carefully organize your template purposes. Purpose types are seeded, 
however, you can extend the purpose type lookup. 

Seeded Purpose Types:

– Cross Sell: Used for creating lists for the cross selling purposes. 

– Customer Acquisition: Used for creating lists for customer acquisition 
purposes. 

– Customer Retention: Used for creating lists for customer retention 
purposes. 

– General Purpose: Used for creating general lists (not tied to a specific 
purpose). 

–  Lead Maturation: Used for creating lead maturation lists. 

–  Up Sell: Used for creating lists for up selling purposes. 

4. Select Continue.

The Create Standard Template Query page opens. 

5. In the Query Template Selections section, select Add Another Row.

6. Fill in the following details: 

■ Attributes: Using the search and select icon choose an attribute for the 
query template. For example, if the list template filters by age or gender, 
you would select age or gender as an attribute. 

■ Attribute Display Name: Enter a user-friendly display name for the 
attribute selected. 

■ Available Operators: Select an operator for the attribute. For example, if 
filtering by “people who are age 30", then the operator would be Is. 
Depending on 

■ Operator Default: Select a default operator for the attribute. 

■ Value: Enter a value for this operator. Depending on the available operator 
and default, you will choose an appropriate value mode. The following 
modes are available:

– Calculation: If the data source is being used for “comparison” 
purposes, use this type of value mode. 

– Constant: If the data source has a static value, select this value mode. 
For example, if your query template is filtering for “age is 30" then 



Administrating Audience

6-28 Oracle Marketing Implementation and Administration Guide                              

constant (as a value mode) would be selected. Once constant is selected 
in the mode drop-down menu, a text box appears. Enter the constant 
value in this text box. For example, for “age is 30", enter the value 30. 

– Attributes: If attributes have previously been defined, you can re-use 
them by selecting this value mode. 

– List of Values: Selecting this value mode enables you to define a list of 
values for the data source. 

■ Value Display: Use this text box to change the display value for the end 
user. For example, if the attribute selected is “default city”, the value 
display could simply be “city”. 

■ Default: Place a check in this checkbox to display the selection by default. 

■ Mandatory: Place a check in this checkbox to enforce this particular 
attribute -- a mandatory selection for a template cannot be deleted by the 
end-user.

7. Select Apply to save your changes.

To preview the template before saving your changes, choose Preview Template 
Selection. 

6.2.3.3 Creating  Parameterized SQL Templates
In some cases, it might be easier to create templates based on a set of parameters. 
This may be the case when the SQL statement is very complex or if you are a power 
user of SQL. In these cases, you can set up a template so that the end user only 
needs to input values for these parameters to generate the list. 

If you set up a template using parameterized SQL, then the end user simply selects 
the template and the corresponding parameters for the template are displayed. The 
end user selects the purpose and the list template in the first step of the Create List 
process. The mechanism to display either the Standard Template (based on natural 
language) or the Parameterized SQL Template depends on how you have setup the 
template.
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Figure 6–1 Logical Process of Creating Parameterized SQL Templates

1. Step 1: As the Administrator, you will create the template based on a 
pre-selected SQL statement. Once you have set this up, when creating lists, the 
user will only need to input values for these parameters. 

2. Step 2: During the create list creation process, because you have setup 
parameterized SQL templates, this is displayed in the drop-down menu 
(instead of the standard template).   

3. Step 3: Because the parameters are pre-defined, the corresponding 
parameterized SQL template parameters are displayed. 

To create a parameterized SQL template, use the following procedure: 

Steps
1. Login as a user that has the Audience Workbench Super User responsibility.

2. Navigate to the Audience Administration dashboard.

3. Select Create Query Template.

4. In the Create Query Template page enter the following details:

■ Query Template Name: Provide a logical and relevant name for the 
template.

■ Query Template Type: Select Parameterized SQL.

■ Data Source Name: Select a Parent Data Source for the template. 

■ Purpose: Select a purpose for the template. For example, if creating a list 
template for cross selling purposes, choose Cross Sell as the purpose type.
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5. Select Continue.

6. In the SQL definition region you will enter the parameterized SQL condition. 

■ Definition: Use this field to enter editable text for the SQL Description. The 
text entered here appears in the end user interface within the Selections 
section for a list that uses this template. 

■ SQL:  Use this textbox to enter a parameterized SQL condition.  For 
example,  

Select * from Table A 
where A.COLUMN_NAME1 = :Column_Name1 
and A.COLUMN_NAME2 = :Column_Name2” 

■ Validate SQL: After entering the custom SQL, you have  the option to 
validate the SQL statement by clicking this button. Clicking this button 
takes you to the standard Validate SQL page. 

There are three sections within the Validate SQL page:

– SQL Statement: read only text of the SQL Statement entered in the 
Custom SQL page

– SQL Validation: read only text that indicates if there are any errors in 
constructing the SQL, like SQL syntax, table names, column names 
within the table, etc. 

– Index Results: read only text that identifies if the SQL condition is 
based on any non-index attributes

7. Select Finish to save your work.  

6.2.3.4 Setting Up  Query Templates to Support Recalculation and List Entry 
Preview
Within the Audience Workbench, a marketer can use query templates to create lists. 
After selecting a query template, the marketer can enter values for the query 
template conditions and obtain a quick cascading count of these conditions as well 
as previewing the entries before creating the list. These counts are based on the 
values (operator, operand) provided by the marketer for the different query 
template conditions. The numbers for these cascading counts (i.e., the Projected 
Running Total column within the List Selections table) is determined using the table 
created for the corresponding query template.

The information stored in the table is a snapshot of the data available specifically 
meeting the conditions of the template at the time of template creation. The tables 
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pre-store the information therefore reducing the need to re-compute the data being 
queried when the user wants to preview the projected total and entries.  Pre-storing 
the data supports faster viewing of the results.

The table supporting the individual query template is automatically created or 
updated depending on whether you are creating a new template or updating an 
existing one. You can also create the tables using a concurrent program. 

For seeded query templates (see Section 6.2.3.1, "Seeded Standard Query Templates" 
), you must create the tables supporting the template prior to marketers using these 
templates to obtain cascading counts. Each query template should be enabled 
before creating its corresponding table. To create tables supporting each of these 
templates, simply select the appropriate template(s) and click Apply.

The section below illustrates the process of creating a table for a query template if 
you choose to use a concurrent program.

Prerequisites
■ Before you run the concurrent program to create the table(s), ensure that all the 

conditions are defined for the corresponding query template(s) and the 
template is enabled.

■ Ensure that there is sufficient disk space. The space requirement for a table is 
proportional to the customer and transactional data within the data source and 
the number of conditions within the query template definition. A large B2C 
(business to consumer) organization will typically have more customer and 
transactional data than a B2B (business to business) organization. Hence the 
table created for B2C implementations will normally require more disk space.

The conditions for seeded query templates reference data within the Oracle 
E-Business Suite schema. It is estimated that these query templates will require 
approximately 35 MB of disk space for each query template. Based on the 
Oracle E-Business Suite data within your organization, you may require 
additional disk space.

Steps
1. Determine the “query template ID” of the query template for which the table is 

to be generated. You can obtain this ID by navigating to the details page of the 
query template within the Audience Administration interface. In the query 
template details page, the token for the template ID (i.e. TemplID) is contained 
within the web browser’s URL. For example, the template ID is highlighted in 
the following URL:
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http://xyz.com/OA_HTML/OA.jsp?OAFunc=AMS_LIST_
QURYTEMPLSTD_CRE_PG&Mode=UPD&TemplId=3012&….

Note this template ID for the corresponding query template.

2. Log into Oracle Forms as a user with the Oracle Marketing Administrator 
responsibility.

3. Navigate to Setups > Concurrent Requests.

4. Within the Find Request window, click the “Submit a New Request” button.

5. In the Submit a New Request window, select “Single Request” and click OK.

6. In the Submit Request window, within the Name field, click on the LOV drop 
down (…).

7. In the new search window, within the Find field, enter “AMS Generate Table 
For Template” and click Find.

8. You will now be prompted to enter the template ID.  Enter the template ID as 
noted previously in this procedure. 

9. Click Submit to start the concurrent program request for generating the table. 
Note the Request ID. You can monitor the status of this concurrent request by 
providing the Request ID within the Find Request window.

After the table is created successfully, a marketer can use the query template within 
the Audience Workbench to determine the cascading counts and preview entries 
that meet the template conditions.

6.2.4 Fatigue Rules and Lists
Fatigue rules provide your end users with a tool that helps prevent them from over 
contacting customers. As the Campaign/Audience Administrator, you may need to 
create fatigue rules for your implementation. Refer to Section 5.2.3, "Administrating 
Fatigue Rules" for more information.

Caution: If no template ID is provided in this window, then tables 
for all enabled query templates will be generated (or regenerated).



Administrating Audience

                                                                  Implementing and Administrating Audience 6-33

6.2.5 Administrating Deduplication Rules
De-duplication rules check for list duplications, such as duplicate names, email 
addresses, first names, last names, etc.  Deduplication rules check data being sent to 
the TCA APIs. 

Because list creation requires a parent data source to be selected, when creating 
deduplication rules, you are only able to select one that is associated to a parent 
data source.

To setup deduplication rules, use the following procedure: 

Prerequisites
Data sources are created

Steps
1. Login as a user that has the Audience Workbench Super User responsibility.

2. Select the data source for which you are creating the deduplication rule.

3. Select De-duplication Rules.

4. Select Create De-duplication Rule.

5. Enter the following details:

■ De-duplication Rule Name: Provide a logical name for the rule. For 
example, if creating a rule to eliminate duplicate email addresses a logical 
name might be Email De-dupe rule. 

■ Description: Provide a logical description for the deduplication rule. For 
example, if creating a rule to eliminate duplicate email addresses, a logical 
description might be “email address deduplication rule”. 

■ Attribute: Select the attribute that the deduplication rule is being created 
for. For example, if creating a rule to eliminate duplicate email addresses, 
you could choose Contact Email Address.

■ Word Standardization Rule: Using this drop-down, optionally, select a 
standardization rule for the corresponding attribute. Word standardization 
allows words that have alias or alternate spellings to be normalize when 
going through the de-duplication process.  

For example Oracle Pkwy means the same thing as Oracle Parkway.  
Therefore, when using word standardization, the system will recognize it to 
be a duplicate when it goes through the deduplication process. 
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You can standardize words using the following criteria: 

– Address  

– First Name

– Key Modifier

– Last Name

– Organization Name

6. Select Apply.

6.2.6 Administrating List Import
To administrate list import, you will perform one or all the following procedures: 

■ Section 6.2.6.2, "Performing Existence Checking for List Import"

■ Section 6.2.6.3, "Existence Checking for Persons"

■ Section 6.2.6.4, "Existence Checking for Organization"

■ Section 6.2.6.5, "Existence Checking for Organization Contacts"

■ Section 6.2.6.6, "Existence Checking for Address"

■ Section 6.2.6.7, "Existence Checking Using Original System Reference"

6.2.6.1 Understanding Deduplication and Existence Checking for List Import
List import checks for duplicate records during the import process by using  
deduplication rules and existence checking.

Deduplication rules: Performed before the data is sent to the TCA APIs. For 
example, if you have created a deduplication rule based on email address and two 
records exist in a particular file with same email address, the second records is 
counted as a duplicate and only the first record is processed.

Existence checking:  Predefined rules and are used only when the AMS HZ 
DEDUPE RULES profile is set to "YES".

Existence checking is done for the following:

■ Organization

■ Org contacts

■ Address
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■ Person

6.2.6.2 Performing Existence Checking for List Import 
Existence checking enables pre-defined rules to be established. This is only possible 
when AMS : HZ DEDUPE RULES profile is set to YES at site level. Existence 
checking enables the process of de duplicating import records from the TCA model. 

6.2.6.3 Existence Checking for Persons
Existence checking is based on Person First Name, Person Last Name, Email 
Address, Phone Country Code, Phone Area Code, Phone Number, Address and 
Country. 

First checks are done to see if the person exists with a provided E-mail address. If it 
does not exist then it checks with First Name and Last Name with phone attributes. 
If this fails then it looks for First Name and Last Name with address attributes. If 
this does not exist, then a new Person record is created (Party of type “Person”).

6.2.6.4 Existence Checking for Organization
Organization existence checking is based on:

■ Name 

■ Address1

■ Country columns

First it checks if an organization exists with the same name if it does not exists then 
it creates a new record. If it  does exist then it checks if an organization record exists 
with this name, address1 and country. If it does not exists then it checks with name 
and country if this also does not exists then it picks up the maximum(party_id) 
record with the same name and without checking address1 and country column.  

Even if pick up records with name, address1 and country or name and country it 
always picks up the maximum party_id for the organization name.

6.2.6.5 Existence Checking for Organization Contacts
Org contact Existence checking is based on:

■ Person

■ First name 

■ Last name 
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■ Email address 

■ Phone area code

■ Phone number 

■ Phone extension 

First it checks if a person exists with the provided first name and last name if this 
exists then it checks if a records exists with first name , last name having the same 
email address and phone area code, phone number and extension. If this does not 
exist, then it checks the first name , last name with email address. If this also does 
not exist, then it checks the first name, last name with phone area code, number and 
extension.

6.2.6.6 Existence Checking for Address
Address existence checking is based on:

■ Address1

■ City

■ Postal code 

■ Country

First it checks if there is a location for the provided address1, city, postal code and 
country column. It this does not exist then it checks for address1 with country and 
pick up that location if it's available. Otherwise, it creates a new one.

6.2.6.7 Existence Checking Using Original System Reference
Original system reference is a target field that has been added to the List Import 
process. This affects the existence checking logic in the following way:

■ Organizations (B2B): If original system reference is mapped, existence checking 
will use this value along with organization name and other attributes, such as 
Address1 and Country to find the exact match. If it is unable to find matching 
record then existence checking is done without the Original System Reference 
column.

■ Organization Contacts (B2B): If original system reference is mapped then 
existence checking will use this along with Organization Name, Person First 
Name, Person Last Name and other attributes, such as E-mail Address, Phone 
Area Code, Phone Number and Phone Extension to find the exact match. If it is 
unable to find matching records then the existence checking will be done 
without the original system reference column. 
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■ Persons (B2C): If original system reference is mapped then existence checking 
will use this along with Person First Name, Person Last Name and other 
attributes like Address1, Country, Email Address, Phone Country Code, Phone 
Area Code and Phone Number to find the exact match. If it is unable to find 
matching records then the existence checking will be done without the Original 
System Reference column.   

6.2.7 Importing Lists from XML or CSV Files
Marketers have the ability to import lists from an xml or csv file into Oracle 
Marketing. Based on the type of imported list data, the Import Wizard will walk a 
marketers through the steps.

XML Import
The xml import is available for the following:

■ Organization

■ Person

■ Addresses 

■ Person addresses import

The xml import file must be in zip format. The zip must contain the following: 

■ XML File: This contains the B2B or B2C customer information, it can be in any 
format. 

■ DTD File: This file formats the xml data. For example, if the xml file contains a 
tag “address” the DTD file will format the tag into “address = city + state + zip” 
for the application. 

B2B and B2C CSV List Import
A csv import can be performed for any B2B or B2C type of import. For more 
information on how to perform a List Import, using xml or csv see the Oracle 
Marketing User Guide. 

Oracle Marketing also supports a recurring import - an import process that is 
rescheduled for a later time. This option is available for server and ftp imports. The 
user must change the data in the file otherwise import will repeat the same data 
available in the files. 
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6.2.8 Implementing List Import for Universal Work Queue
When Oracle Marketing is integrated with Oracle Telesales, the list import feature 
can be used to assign lists to TeleSales Agents. In this scenario, a TeleSales agent can 
log into Oracle TeleSales Universal Work Queue and access a list of customers 
assigned to them by the marketing team. This enables a list of prospects collected in 
marketing to be followed up on by the sales team.

To set up List Import for Universal Work Queue follow the procedures: 

■ Section 6.2.8.1, "Setting List Import and Work Queue Profiles"

■ Section 6.2.8.2, "Implementing List Import for Telesales"

■ Section 6.2.8.3, "Selecting the List in Telesales"

6.2.8.1 Setting List Import and Work Queue Profiles
To enable the list to be displayed in Universal Work Queue the following profiles 
must be set: 

■ AMS: Queue: Marketing Lists – Manual Assignment at Site or Application 
level. This profile determines if a Telesales user can work on Marketing Lists – 
Manual Assignment. 

■ AMS: Queue Order: Marketing Lists – Manual Assignment at Application or 
Site Level. Choose a display order of 1-56. This profile determines the order of 
appearance for the “Marketing List – Manual Assignment” in the work queue 
in relation to the other Queue Order Profiles. 

6.2.8.2 Implementing List Import for Telesales
To set up the List Import for Universal Work Queue use the following procedure: 

Prerequisites
■ TeleSales Agent Responsibility is assigned to the user

■ A csv file with the Sales Agent (i.e. the application login id for the sales agent) 
column is populated

■ A Telemarketing Campaign Schedule has been created in Oracle Marketing

Steps
1. Log in to Oracle Marketing.

2. Navigate to Audience > Import.
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Use this page to import data from the csv file.

3. Using the Import Mapping section, map the sales agent column from the Source 
Column to the “Sales Agent ID” target field column. 

The Sales Agent ID is the application login id for the sales agent(s.).

4. Import the data into Oracle Marketing.

5. Generate a list using the imported data.

6. Associate the generated list to the Telemarketing Schedule created within 
Oracle Marketing.

7. Generate the target group for this Telemarketing Schedule.

6.2.8.3 Selecting the List in Telesales
After the list has been created in Oracle Marketing it is available for use in Oracle 
Telesales. Use the following procedure to verify that the list has been properly 
implemented. 

Prerequisites 
User has TeleSales Agent Responsibility

Steps
1. Log in to Oracle Telesales.

2. Navigate to the Universal Work Queue tab.

3. Select the Marketing List – Manual Assignment from the Work Type drop 
down. 

4. View the lists that have been assigned to you from Oracle Marketing. 

6.2.9 Creating List Import User Hooks
List Import pre and post user hooks allow you to write custom PL/SQL that is 
invoked during the list import process prior to list generation. The purpose is to 
allow you to  cleanse the list before the list data is inserted into TCA (pre) and after 
(post) before list generation. 

The following business events are used in the list import user hook process:

List Import - Pre Business Event: oracle.apps.ams.list.ListImportPreEvent.

List Import - Post Event: oracle.apps.ams.list.ListImportPostEvent 
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7
Implementing Events

This topic group describes the implementation of Events functionality.

Topics include:

■ Section 7.1, "Events Overview"

■ Section 7.2, "Setting System Profile Options for Events"

■ Section 7.3, "Creating and Verifying Lookups for Events"

■ Section 7.4, "Running Concurrent Programs for Events"

■ Section 7.5, "Setting Up Event Fulfillment"
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7.1 Events Overview 
Events functionality in Oracle Marketing enables Event planning and execution. 
Event Schedules can be defined for various locations and times. To support rapid 
Event creation, definition, and maintenance, Events can be setup to define content, 
messaging, and planning information. 

Consult the following sections to set up Events functionality: 

■ Section 7.2, "Setting System Profile Options for Events"

■ Section 7.3, "Creating and Verifying Lookups for Events"

■ Section 7.4, "Running Concurrent Programs for Events"

■ Section 7.5, "Setting Up Event Fulfillment"

7.2 Setting System Profile Options for Events
Set the following profile options for Events: 

Table 7–1 Profile Options for Events 

Option Required Level Setting Effect/Limitation

AMS : Auto 
Register for 
Events upon 
cancellation

Yes Site Yes/No This is used to determine if the 
attendee can be moved from the 
waiting list to registered status if a 
spot is available

AMS : Copy 
Event Details to 
Event 
Schedules

Yes Site Yes/No This is used to allow details of parent 
Event to be copied to the schedule

AMS : Prefix to 
Registration 
Confirmation 
Code

Optional Site User 
Defined

Characters for the Event Registration 
Confirmation Code.

AMS : HZ 
Dedupe Rule

Optional Site Yes/No Indicates whether to use the TCA 
deduplication rules while performing 
Event registration. 

This applies only if you are importing 
list registrants using list import. 
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OSO : 
Customer 
Access 
Privilege

Required Resp Full Set this profile to Full in order to grant 
access to the Venue subtab.

OSO : Bypass 
Group 
Validation 

Required Resp Yes/No Set this profile to Yes to grant access 
to the Venue subtab.

AMS : Enable 
Fulfillment

Optional Site Yes/No Enables Oracle Marketing to be 
integrated with Oracle One-to-One 
Fulfillment. 

AMS : Should 
Call to 
Inventory 
Modules be 
Made

Yes Site Yes/No Indicates whether an Event may be 
created as an Oracle Inventory item. 
Set to Yes if wanting to store Events in 
inventory as “items”. 

AMS : Should 
Call to Pricing 
Modules be 
Made

Yes Site Yes/No Indicates whether an Event may be 
priced.

Table 7–1 Profile Options for Events (Cont.)

Option Required Level Setting Effect/Limitation
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7.3 Creating and Verifying Lookups for Events
Create or verify the following system lookups for Events. 
 

Table 7–2 Event Lookups 

Key Type Values Meanings

AMS_DELIVERY_MEDIA_
TYPE

Extensible I SEMINAR

ON_SITE

SEMINAR

WEB

I Seminar

On Site

Seminar

Web

AMS_EVENT_STATUS System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

Denied_TA

New

On_Hold

Submitted_ BA

Submitted_TA

Planning

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

Denied Concept Approval

New

Active, but locked

Pending Budget Approval

Pending Concept Approval

Planning

AMS_EVENT_AGENDA_ 
STATUS

System Confirmed

Unconfirmed

Confirmed

Unconfirmed
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AMS_EVENT_TYPE Extensible Briefing

Conference

Exhibition

Hospitality

Internal_Event

Launch

Seminar

Speaking_ 
Engagement

Sponsorship_
Event

Trade_Show

Web_Seminar

Workshop

Briefing

Conference

Exhibition

Hospitality

Internal Event

Launch

Seminar

Speaking 
Engagement

Sponsorship

Trade Show

Web Seminar

Workshop

AMS_ CONTACT_ POINT_
TYPE

Extensible Address

Email

Fax

Inbound_ script

Outbound_ script

Phone

Website

Address

Email

Fax

In bound Script

Outbound Script

Phone

Website

AMS_ MASTER_ OBJECT_ 
TYPE

System Camp

CSCH

EONE

EVEH

Campaign

Campaign Schedule

One-Off Event

Event

AMS_ PRIORITY System Fast_Track

High

Standard

Fast Track

High

Standard

Table 7–2 Event Lookups (Cont.)

Key Type Values Meanings
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AMS_EVENT_SPEAKER_ 
STATUS

System Booked

Cancelled

Confirmed

Scheduled

Booked

Cancelled

Confirmed

Scheduled

AMS_EVENT_WAITLIST_ 
ACTION

System First_Come_First First Come First Served

AMS_EVENT_
RESOURCE_ TYPE

System AMS_People People

AMS_EVENT_REG_
STATUS

System Cancelled

Enrolled

Registered

Targeted

Waitlisted

Cancelled

Enrolled

Registered

Targeted

Waitlisted

AMS_EVENT_REG_
SOURCE

System Call_Center

External

On_Site

Partner

Web

Call Center

External

On Site

Partner

Web

AMS_EVENT_REG_
CANCEL_REASON

System Agenda_Change

Cost

Personal_
Emergency

Price_Change

Sch_Conflict

Speaker_Change

Venue_Change

Work_Emergency

Agenda Change

Cost

Personal Emergency

Price Change

Scheduling Conflict

Speaker Change

Venue Change

Work Emergency

Table 7–2 Event Lookups (Cont.)

Key Type Values Meanings
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AMS_EVENT_PAYMENT_ 
STATUS

System Comp

Free

Invoiced

Paid

Refunded

Complimentary

Free

Invoiced

Paid

Refunded

AMS_EVENT_LEVEL System Main

Sub

Main

Sub

AMS_EVENT_DAY System Five

Four

Three

Two

One

5

4

3

2

1

AMS_EVENT_CERT_ 
CREDIT_ TYPE

System General

Seed

General

Seed

AMS_EVENT_CANCEL_ 
REASON

System Disaster

Insufficient_Reg

Postponed

Schedule_Conflict

Speaker_ 
Unavailable

Venue_
Unavailable

Natural Disaster

Insufficient Registration

Postponed

Schedule Conflict

Speaker not available

Venue not available

AMS_EVENT_
ATTENDANCE_FAILURE

System Agenda_Change

Disaster

Personal_
Emergency

Schedule_Conflict

Speaker_Change

Venue_Change

Work_Emergency

Agenda Change

Natural Disaster

Personal Emergency

Schedule Conflict

Speaker Change

Venue Change

Work Emergency

Table 7–2 Event Lookups (Cont.)

Key Type Values Meanings
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7.4 Running Concurrent Programs for Events
For Events, run the program Activate Event Schedules. This program accomplishes 
two things:

1. Activates Events: This program activates available event schedules and one-off 
events for which the start date has passed.

2. Completes Events: Picks up and completes event schedules and one-off events 
for which the end date has passed. 

AMS_EVEH_PURPOSE User Organization 
defined values

Purpose for the Event.

AMS_EVEO_OBJECTIVE User Organization 
defined values

Objective for the Event.

AMS_RATE_CODE User User defined 
entries

Rates for venues.

AMS_VENUE_RATING User Excellent

Good

Fair

Poor

Excellent

Good

Fair

Poor

AMS_VENUE_TYPE User Convention_
Center

Hotel

Kiosk/Booth

Convention Center

Hotel

Kiosk/Booth

AMS_EVENT_CONTENT_
ACTIVITY

User Cancelled

Date_Change

Reg_Cancel

Reg_Confirm

Reg_Waitlist

Venue_Change

Event Cancellation

Event Date/Time Change

Registration Cancellation

Registration Confirmation

Wait List Confirmation

Venue Change

Table 7–2 Event Lookups (Cont.)

Key Type Values Meanings
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7.5 Setting Up Event Fulfillment
See Section 3.2.4, "Implementing Fulfillment for Oracle Marketing" for information 
on setting up fulfillment for Events.
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8
Implementing and Administrating Marketing

Metrics

This topic group includes implementation and administration tasks for Metrics.

Topics include:

■ Section 8.1, "Metrics Concepts"

■ Section 8.2, "Implementing Metrics"

■ Section 8.3, "Administrating Metrics"

■ Section 8.4, "Seeded Metrics Reference"
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8.1 Metrics Concepts
Metrics are measurements used for tracking the effectiveness of marketing 
activities. Metrics include both forecast and actual values. These values are either 
added manually or automatically calculated by the Marketing application. Metrics 
can also be used to initiate Campaign Triggers. For example, a Responses Count 
metric greater than a desired value could be used to trigger a follow-up Campaign 
Schedule to a larger audience. 

8.1.1 Understanding the Metric Object Hierarchy
The metric hierarchy dictates how objects relate to each other and how their 
associated metric values will rollup within the hierarchy. Ultimately, the metric 
hierarchy dictates how metric values will be totalled across marketing objects. 

8.1.2 Understanding Summary Hierarchy
Within a single marketing object, metrics of similar categories (cost, revenue, 
response, etc.) are organized into summary hierarchies. For example, within a direct 
mail campaign schedule, cost-category metrics can be related hierarchically as 
follows:

Figure 8–1 Summary Hierarchy 
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In this example, postage cost, Creative Costs, and Other Costs are summarized to 
Total Direct Cost. These lower level costs are added to Total Indirect Cost (for 
example, overhead expenses) to obtain Total Cost for the Campaign Schedule.

8.1.3 Understanding Rollup Hierarchy
The Rollup Hierarchy refers to links between metrics of different objects within the 
marketing object hierarchy. A typical marketing object hierarchy is shown below:

Figure 8–2 Rollup Hierarchy

The Rollup Hierarchy enables metrics from lower-level marketing objects (e.g., 
Campaign Schedules and Event Schedules) to be rolled up to parent objects 
(Campaigns and Events) and grandparent objects (Programs).

The following represents a detailed Rollup Metric Hierarchy. In this example, Direct 
Costs, Revenues and Responses are rolled up the marketing object hierarchy from 
the Schedule level to the Campaign/Event level to the Program level.
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Figure 8–3 Marketing Rollup Metric Hierarchy

8.1.4 Understanding Metric Calculation Types
The metric calculation type determines the way in which forecast and actual values 
for a metric are entered into the system. 

Four metric calculation types are available: 

■ Manual: Receives both forecast and actual values from user input.

■ Function: Receives actual values from a custom PL/SQL function or stored 
procedure. This function or procedure contains logic for calculating the actual 
value based on information within the Oracle E-Business Suite. 
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■ Summary: Receives both forecast and actual values from lower-level metrics in 
the summary hierarchy. May have subordinate metrics of any type (summary, 
manual, rollup or function) within the same metric category (Cost, Revenue, 
Response, etc.). This metric is automatically associated with a marketing object 
when any subordinate metric is associated. 

■ Rollup: Receive both forecast and actual values from lower levels in the 
marketing object hierarchy. Only manual and function metrics within a 
lower-level object (e.g. Campaign Schedule) can be linked to a rollup metric in a 
higher-level object (e.g. Campaign). All child metrics of a rollup metric must be 
in the same metric category (Cost, Revenue, Response, etc.). 

■ Formula: Enables a marketers to measure the performance of a marketing object 
based upon a composite value. Marketers can define a formula based upon 
relevant metrics to calculate this composite value. 

8.1.5 Understanding Metric Display Types
It drives the method in which metric values are rendered on the screen.  Possible 
types are integer, percent and currency.  Integers are displayed and saved as whole 
numbers.  

8.1.6 Understanding Metric Currency Values
Metrics with the categories of Cost and Revenue have an attribute of “Currency”. 
Two currencies apply to each metric, one for the displayed (transactional) value and 
one for the internal (functional) value. 

Rollup and Summary metrics display the currency value according to the 
marketing object's currency. Manual and Function metrics are defaulted to the 
marketing object's currency but may be changed for each metric. All Cost and 
Revenue metrics are rolled up using the internal functional currency, which is the 
same system wide. Use FND_PROFILE.VALUE ('AMS_DEFAULT_CURR_CODE') 
to determine functional currency.

The transactional value is rounded to the GL 'Minimum Accountable Unit'. The 
function value is stored without rounding to maintain required precision when 
converting to the displayed (transactional) currency. 

For example if the transactional currency is Mexican Paso (MXP) and functional 
currency is US Dollar (USD), with the conversion rate of 15,000 MXP/USD then 
conversion from 10,001 MXP to 0.67 USD (rounded), converting back produces 
10,050 MXN, and removing the rounding on the functional currency produces 
0.66673333 -- USD to 10,001 MXN.
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8.2 Implementing Metrics
A number of commonly used metrics are seeded with the product and enabled at 
time of deployment. If implementing additional metrics, defined specifically for 
your organization, as the Marketing Administrator you must create and set up 
these up. The procedures in this section will demonstrate how to accomplish that.  

8.2.1 Process Flow for Creating Metrics
Metric creation will depend on the marketing object being measured. When 
creating a new metric for a marketing object, a calculation method must be selected. 
The calculation method indicates how a metric receives input values. For example, 
if the calculation method “values roll up from lower level” is selected, the metric 
values will roll up from a lower level marketing object.

When creating a new Metric, it can be simple or very complicated, depending on 
the aspect of the marketing object being measured. Regardless of the complexity, 
the process flow for creating a metric remains constant. The general flow is shown 
below. 

Figure 8–4 Process Flow Diagram: Creating Metrics 

8.2.2 Setting Metric Profile Options
To maximize metric performance, set the profile AMS : Batch Size at site level. This 
profile takes an integer that represents the maximum number of records to save in a 
batch. This helps tune the performance of the metric refresh program. By setting 
this profile, when updates or inserts are performed, they are limited to the batch 
size. This prevents the rollback segment from becoming too big and saves any 
intermediate processing. If the program fails then not all the work would be lost. 
The refresh would start from where it left off. The batch processing is written to 
prevent committing any corrupt state.

8.2.3 Implementing Summary Metrics
Summary metrics enable values to be calculated vertically in the hierarchy. Values 
are totalled at the marketing object level. Summary metrics may have subordinate 
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metrics of any type (summary, manual, or function). Summary metrics should be 
created to total the manual metrics at that marketing object level. 

Summary Metrics are assigned automatically to the marketing object when any 
subordinate metric is assigned. 

For example, you can create a summary metric called "Total Cost" that is used with 
any object type. Then create other cost metric for campaign schedules, such as 
"Venue Costs", "Postage Costs", etc. all of which summarize to "Total Cost". When 
assigning "Venue Costs" and "Postage Costs" to a campaign schedule, Total Cost 
will add these values together to give a summary value.

Summary metrics can be rolled up at same level but are not permitted to be rolled 
up to parent level. 

Use the following procedure to create a summary metric:

Prerequisites
None

Steps
1. Navigate to Administration > Marketing > General > Metric.

2. Select Create. 

3. In the Metrics Definition page enter the following: 

■ Enter a Name for the metric.

■ Navigate to the Calculation type region. 

■ Although you are not finished filling in the metric details, to simplify the 
process of choosing a "used with" object, select a calculation type up front.  

■ In the Calculation type region select Summarize. 

By selecting this type of calculation, the "used with" object is automatically 
populated with Any. 

■ Select a Category from the Seeded List. 

■ Select a Sub category if one is available. 

■ Select a Display Type. 

Display type drives how the metric values are displayed in the UI. Select 
either integer, percent or currency.  
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■ Select an Aggregation type.  

The aggregation type drives the method that calculates the summary 
metric. It can be calculated by summarization or by average. When using 
summarization, all child values are totalled. When using average, instead of 
creating a total an average is created.

Note: The accrual region only applies to manual and function metrics. 
Therefore, this region is disabled.  

4. Optionally, in the Summarize To region select Summarize at Same Level

If selecting this option, the value of the metric being created is summarized to 
this metric. However, both metrics will always be attached to the same 
marketing object.

Only rollup to parent when using manual, rollup, or calculate using PL/SQL 
metric. 

5. Select Create.

8.2.4 Implementing Rollup Metrics
A rollup metric receives its values from lower level marketing objects. A rollup 
metric must have the same category as all of its child metrics. 

Manual and Function Metrics are assigned to a Rollup Metric, therefore results can 
be propagated to parent marketing objects. Rollup Metrics may be assigned to 
themselves so that any hierarchical marketing object structure will collect all values 
from subordinate objects. Values cannot be entered. All values are totaled from the 
child level. Rollup Metrics always have a Used With field value of Any.

For example, you may want to establish a venue cost at the Event Schedule level. To 
view venue costs across multiple Event Schedules, a rollup metric called “Rolled-up 
Venue cost” can be created for the “Venue cost” manual metric. The rollup metric 
will appear at the Event and program levels totaling all 'Venue Costs' from the 
Event Schedules.

To create a Rollup Metric follow the procedure below: 

Prerequisites
None 

Steps
1. Log in to Oracle Marketing. 
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2. Navigate to the Administration > Marketing > General > Metric. 

3. Select Create.

4. Enter the Metric name. 

5. Select calculation type Rollup.

6. Select Create.

7. To have the rollup metric continue to rollup the marketing object hierarchy, set 
the “Summarize to: of the parent” to this same rollup metric.

8. Set: Summarize to: at the same level” to the desired summary metric to total at 
the same object level.

9. Select Update to save your work.

8.2.5 Implementing Manual Metrics
A manual metric receives values from user input. Manual metrics are entered by 
hand into the system. 

For example, an Oracle Marketing Administrator can create a manual metric for the 
Campaign Schedule object called “Venue Cost”. This enables a marketer who is 
using the application to manually enter costs associated with Venues.

■ Each manual metric can be assigned to an object multiple times. A transaction 
date and description distinguishes each entry.

■ Each metric is optionally assigned a summary metric, which totals values 
within the same marketing object. When the manual metric is assigned to the 
object, the summary metric is also assigned. The summary metric must have the 
same category, display type, and aggregation type as all its child metrics.

■ Each metric is optionally assigned a Rollup Metric, which totals value at the 
parent business object. When the values of a marketing object are refreshed the 
rollup metric is either created at the parent level, or if the appropriate rollup 
metric exists, a link is made so the rollup can determine which values to total. 

Note: To have a rollup metric recursively rollup to itself, you will 
need to create the rollup with "of the parent" blank then update the 
rollup metric with this field assigned to itself. During creation of 
the rollup metric it does not have an entry in the database and the 
LOV will not show this as an entry.
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The Rollup Metric must have the same category, display type, and aggregation 
type as all its child metrics.

A manual metric receives values from user input. Manual metrics are entered by 
hand into the system. 

For example, an Oracle Marketing Administrator can create a manual metric for the 
Campaign Schedule object called “Venue Cost”. This enables a marketer who is 
using the application to manually enter costs associated with Venues. 

To create a Manual Metric, follow the procedure below: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > General > Metric.

3. Select Create. 

4. In the General Information Section, enter the following details:

■ Name: Give the metric a name, for example, Venue Cost. 

■ Enabled: Select to enable the metric. 

■ In the Calculation section select Enter Values Manually (default setting.)

■ Category:  Choose a category to associate the Metric with. For example, 
Cost. 

■ Sub-Category. Choose a sub-category associated to the category selected 
above. 

■ Used With: Select the marketing object that will use this metric.   

■ Description: Enter a meaningful description for this metric. 

5. In the Summarize To section select a Parent level/and or Same Level metric.

This step is optional and only is performed if the manual metric created will be 
Rolled up to a parent or Summarized at same level. 

6. Select Create. 
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8.2.6 Implementing PL/SQL Programs for Metrics
PL/SQL Program Metrics enables the Metrics Refresh Engine to interface with 
database stored procedures and functions. This allows for the implementation of 
customized logic for calculating metric values based on business needs. Each time 
the Refresh Metric Engine is invoked, all PL/SQL Program metrics in the system 
are executed.

Two types of PL/SQL Program metrics are supported:

■ Procedure: Procedure Metrics, based on database stored procedures, are 
executed once regardless of how many times it is used in the system. For 
example, seeded procedure metrics are used to calculate the number of leads 
generated from a campaign schedule. Each lead generated is assigned a source 
code that references a marketing object. The number of leads for a campaign 
schedule is determined by counting the number of leads with the same source 
code linked to the campaign schedule.

■ Function: Function Metrics, based on database stored functions, are executed 
once for each usage. For example, if 10 Campaigns use the Function Metric, the 
function is executed 10 times.

For performance purposes, use of Procedure Metrics are highly recommended over 
Function Metrics. As the data grows the overhead of function metrics grows 
proportionally. Execution of the function is proportional to the number of instances 
of the function metric are attached to objects. Where as, procedure metrics are 
executed once per refresh no matter the size of data. The queries and other program 
logic are executed once to gather all the required data in bulk and then written in 
bulk to the activity metric table. 

8.2.7 Implementing Procedure Metrics
Procedure Metrics are intended for enabling metric value calculations to be 
performed in a batch mode. Because Procedure Metrics are expected to update 
metric values for multiple Marketing objects, the database bulk update features are 
used.

To understand and implement Procedure Metrics see the following:

■ Section 8.2.7.1, "Procedure Metric Overview"

■ Section 8.2.7.2, "Anatomy of a Procedure Metric"

■ Section 8.2.7.3, "Creating a Procedure Metric"

■ Section 8.2.7.4, "Sample Procedure Metric for Calculating Leads"
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■ Section 8.2.7.5, "Calculation Logic"

■ Section 8.2.7.6, "Using Bulk Collect and Update for Procedure Metric Queries"

8.2.7.1 Procedure Metric Overview
The first select statement represents when the procedure metric is called by the 
AMS – Metric Refresh program concurrent program. This select statement queries 
for all activity metrics system wide that are relevant to this operation. The query is 
not specific to any marketing object.

The second select statement (within “ELSIF p_arc_act_metric_used_by = ‘CSCH’ 
THEN”) is for a specific object to update. In this case a campaign schedule. The 
query adds to the where clause for the specific object from the input parameters.

The output of these queries includes a list of activity metric ids and corresponding 
actual values. Bulk Collect is used to maximize the processing of the query. These 
results are passed to ‘UPDATE_ACTMETRICS_BULK’ to do a bulk update of the 
activity metrics table. This update also includes setting the dirty flag of the parent 
activity metrics to be refreshed.

A check should be made to prevent updating the actual value if it has not changed. 
For example, if the number of leads for a campaign schedule is 20 and on refresh 
the leads are calculated to be 20 again then do not update the activity metric. The 
list of activity metric ids and actual values should not include these items. If the 
activity metric is updated then the refresh engine will attempt to recalculate the 
rollup and summary metrics, thus wasting processing.

8.2.7.2 Anatomy of a Procedure Metric
A Procedure Metric must have the following parameters: 

8.2.7.3 Creating a Procedure Metric
This metric is executed once per refresh for each metric with the same procedure 
name. All values must be computed and saved in memory for a bulk update.

Table 8–1 Procedure Metric Parameters 

Parameter Name Data Type Default Value

p_arc_act_metric_used_by VARCHAR2 Null

P_act_metric_used_by_id NUMBER Null
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Procedure metrics are not supported for Cost or Revenue metrics. Once a cost 
metric has been posted to the budget the actual value cannot be updated. Currency 
conversions are expensive to process.

 An API is used to perform the bulk update. Because of efficiency very little 
validation is performed.  

Procedure Metric Sample
PROCEDURE run_metrics(p_arc_act_metric_used_by VARCHAR2 := NULL,
p_act_metric_used_by_id NUMBER := NULL)
IS
   l_actual_values_table num_table_type;
   l_activity_metric_id_table num_table_type;
BEGIN
   IF p_arc_act_metric_used_by IS NULL THEN
      SELECT NVL(actual_value, 0), activity_metric_id
      bulk collect INTO l_actual_values_table,
                        l_activity_metric_id_table
      FROM some_table
   ELSIF p_arc_act_metric_used_by = 'CSCH' THEN
      SELECT NVL(actual_value, 0), activity_metric_id
      bulk collect INTO l_actual_values_table,
                        l_activity_metric_id_table
      FROM some_table
      WHERE object_type = 'CSCH'
   END IF;
   update_actmetrics_bulk(l_activity_metric_id_table,
                          l_actual_values_table);
END;

See AMS_ACTMETRIC_SEED_PVT.Calculate_Seed_Metrics for a detailed use of 
Procedure Metrics.

To create a Procedure Metric follow the procedure below:

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to the Administration > Marketing > General > Metric. 

3. Select Create.
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4. Enter the Metric name:

For example, choose: My Procedure Metric, Category - Response, Sub Category 
- none, Used With - Campaign Schedule, Return Value - Numeric, Description - 
optional. Select the Calculation 'Calculate Using Program', and enter the 
procedure name, 'SCHEMANAME.RUN_METRICS'. And, enter summary and 
rollup metrics at will.

5. Select Create. 

Verify metric on the Overview page.

6. Navigate to the Campaign Schedule. 

7. Assign this metric to the a Campaign Schedule. 

This procedure is executed when either the refresh button is pressed or the 
concurrent metrics engine executes. Verify results with source tables.

8.2.7.4 Sample Procedure Metric for Calculating Leads
The following is a sample procedure Metric for Leads. This is an excerpt from 
package AMS_ACTMETRICS_SEED_PVT.

PROCEDURE Calculate_Seeded_Metrics(
          p_arc_act_metric_used_by VARCHAR2 := NULL,
          p_act_metric_used_by_id NUMBER := NULL)
IS
   l_actual_values_table Ams_Actmetrics_Seed_Pvt.num_table_type;
   l_activity_metric_id_table Ams_Actmetrics_Seed_Pvt.num_table_type;
BEGIN
   -- Get all object data to update.
   IF p_arc_act_metric_used_by IS NULL THEN
      SELECT NVL(actual_value, 0), activity_metric_id
      bulk collect 
      INTO l_actual_values_table, l_activity_metric_id_table
      FROM
        (SELECT actual_value, activity_metric_id
        FROM(
           --R9 Campaign Schedule/Leads
           SELECT
           /*+ index(X AS_SALES_LEADS_N4)
               index(B ams_campaign_schedules_b_u1)
               index(ALB ams_metrics_all_b_n3)
               index(c ams_source_codes_u2)
               index(Y as_statuses_b_u1)
       index(AL AMS_ACT_METRICS_ALL_N5)*/
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   COUNT(1) actual_value, AL.activity_metric_id,
                  AL.func_actual_value
           FROM ams_campaign_schedules_b  B, ams_source_codes  C,
                as_sales_leads X, as_statuses_b  Y,
                ams_act_metrics_all AL, ams_metrics_all_b ALB
           WHERE X.status_code = Y.status_code
           AND  B.schedule_id = C.source_code_for_id
           AND  C.arc_source_code_for = ‘CSCH’
           AND  Y.lead_flag = 'Y'
           AND  Y.enabled_flag = 'Y'
           AND  B.source_code = C.source_code
           AND  X.source_promotion_id = C.source_code_id
           AND  NVL(X.DELETED_FLAG,'N') <> 'Y'
           AND  AL.arc_act_metric_used_by = ‘CSCH’
           AND  AL.act_metric_used_by_id = B.schedule_id
           AND  AL.metric_id = ALB.metric_id
           AND  ALB.metric_category = 906 -- Leads
           AND  ALB.function_name 
                = 'AMS_ACTMETRICS_SEED_PVT.CALCULATE_SEEDED_METRICS'
           AND  ALB.metric_calculation_type = 'FUNCTION'
      GROUP BY AL.activity_metric_id, AL.func_actual_value)
      WHERE NVL(actual_value,0) <> NVL(func_actual_value,-1)
    );
   ELSIF p_arc_act_metric_used_by = ‘CSCH’ THEN
      SELECT NVL(actual_value, 0), activity_metric_id
      bulk collect 
      INTO l_actual_values_table, l_activity_metric_id_table
      FROM (
        SELECT actual_value, activity_metric_id
        FROM(
            --R9 Campaign Schedule/Leads
           SELECT
   /*+ index(X AS_SALES_LEADS_N4)
               index(B ams_campaign_schedules_b_u1)
               index(ALB ams_metrics_all_b_n3)
               index(C ams_source_codes_u2)
               index(Y as_statuses_b_u1)
       index(AL AMS_ACT_METRICS_ALL_N5)*/
   COUNT(1) actual_value, AL.activity_metric_id,    
                  AL.func_actual_value
           FROM ams_campaign_schedules_b  B, ams_source_codes  C,
                as_sales_leads X, as_statuses_b  Y,
                ams_act_metrics_all AL, ams_metrics_all_b ALB
           WHERE X.status_code = Y.status_code
           AND  B.schedule_id = C.source_code_for_id
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           AND  C.arc_source_code_for = ‘CSCH’
           AND  Y.lead_flag = 'Y'
           AND  Y.enabled_flag = 'Y'
           AND  B.source_code = C.source_code
           AND  X.source_promotion_id = C.source_code_id
           AND  NVL(X.DELETED_FLAG,'N') <> 'Y'
           AND  AL.arc_act_metric_used_by = ‘CSCH’
           AND  AL.act_metric_used_by_id = B.schedule_id
           AND  AL.metric_id = ALB.metric_id
           AND  AL.ACT_METRIC_USED_BY_ID = p_act_metric_used_by_id
           AND  ALB.metric_category = 906 -- Leads
           AND  ALB.function_name = 
                'AMS_ACTMETRICS_SEED_PVT.CALCULATE_SEEDED_METRICS'
           AND  ALB.metric_calculation_type = 'FUNCTION'
      GROUP BY AL.activity_metric_id, AL.func_actual_value
         )
      WHERE NVL(actual_value,0) <> NVL(func_actual_value,-1)
         );
   END IF;
   update_actmetrics_bulk(l_activity_metric_id_table, 
                          l_actual_values_table);
END Calculate_Seeded_Metrics;

Local Variables
Two PL/SQL tables are needed to “bulk” capture the activity_metric_id and the 
calculated values corresponding to the ID’s. The two tables should be of type num_
table_type from the package ams_actmetrics_seed_pvt:

■    l_values_tab Ams_Actmetrics_Seed_Pvt.num_table_type;

■    l_ids_tab Ams_Actmetrics_Seed_Pvt.num_table_type;

8.2.7.5 Calculation Logic
The body of the procedure consists of code to select the values from a 
business-specific table. The business table needs to be able to join with a 
corresponding Marketing object table, such as Campaigns. 

The activity metric table includes the id and object type of the corresponding object. 
For a campaign, the field arc_act_metric_used_by is ‘CAMP’ and act_metric_used_
by_id is the campaign id. 
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   Within the object the specific relevant metrics can be referenced by the metric_id. 
Thus to write the select statement the where clause includes

■ WHERE Actmetric.Arc_act_metric_used_by = <object_code>

■ AND actmetric.act_metric_used_by_id = <object_id>

■ AND actmetric.metric_id = <metric_id>

Where the object_id is a join to the business table that references the marketing 
object. The metric_id needs to match the procedure metrics’ id. To find the correct 
metric id query the metric table for the matching procedure name. For example:

■ SELECT metric_id, metrics_name, arc_metric_used_for_object

■ FROM ams_p_metrics_v

■ WHERE FUNCTION_NAME = 'SCHEMANAME.RUN_METRICS' -- Use upper 
case.

8.2.7.6 Using Bulk Collect and Update for Procedure Metric Queries
Procedure metric queries must utilize ‘BULK COLLECT’ feature of PL/SQL to 
maximize performance. Bulk Collect minimizes the amount of context switching 
required by fetching values one at a time. Bulk Collect changes context to SQL to 
read in all values to PL/SQL arrays, which reduces context switching to once. After 
the data is fetched, the procedure must execute the bulk update procedure: 

Table 8–2 Object Type 

Object Type Object Code Table Column and Reference

Campaign CAMP AMS_CAMPAIGNS_ALL_B.CAMPAIGN_ID

Campaign 
Schedule

CSCH AMS_CAMPAIGN_SCHEDULES_
B.SCHEDULE_ID

Event EVEH AMS_EVENT_HEADERS_ALL_B.EVENT_
HEADER_ID

Event Schedule EVEO AMS_EVENT_OFFERS_ALL_B.EVENT_
OFFER_ID

One-Off Event EONE AMS_EVENT_OFFERS_ALL_B.EVENT_
OFFER_ID

Deliverable DELV AMS_DELIVERABLES_ALL_
B.DELIVERABLE_ID

Dialog DILG AMS_DIALOGS_ALL_B.DIALOG_ID
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Ams_Actmetrics_Seed_Pvt.update_actmetrics_bulk (

       l_activity_metric_ids_tab,
       l_actual_values_tab);

8.2.8 Implementing Function Metrics 
Function metrics execute the PL/SQL function for each instance of the activity 
metric on the system. The return value of a number is the actual value for the 
activity metric to update.

To understand and implement Function Metrics see the following:

■ Section 8.2.8.1, "Function Metric Overview"

■ Section 8.2.8.2, "Anatomy of a Function Metric"

■ Section 8.2.8.3, "Sample Activity Function Metric"

■ Section 8.2.8.4, "Creating a Function Metric"

8.2.8.1 Function Metric Overview
The stored PL/SQL function or procedure name must be the full name which 
includes the schema name, package name, and module name (if applicable). 
Function metrics are similar to a manual metric leaf level metric, data values are 
entered, however, difference forecasted (marketing is expending) values vs. actual 
(what they actually spend). 

A Function metric is executed once for each assigned metric to a marketing object. 
The parameter for the function is the activity metric id, which distinctly references 
the marketing object. 

For the marketing object specification - use the following query parameters:

■ Table: AMS_ACT_METRICS_ALL 

■ Object type: ARC_ACT_METRIC_USED_BY

■ Object id: ACT_METRIC_USED_BY_ID 

The function metric returns the actual value to be set. In the case of Cost and 
Revenue metrics the actual value must be in the 'Default Currency'. (Use Fnd_
Profile.Value ('AMS_DEFAULT_CURR_CODE') to derive the default currency). For 
Costs, once the cost is posted to a budget the actual value cannot be updated.

Because function metrics are executed once per object and the value is updated one 
at a time, this method is very slow when processing thousands of metrics.
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8.2.8.2 Anatomy of a Function Metric
The parameters include the activity metric id. Each execution of this function is for a 
single activity metric to retrieve the current actual value. The activity metric id is 
passed as the parameter. With this activity metric id the all the information about 
the activity metric can be accessed including the relevant object and current values. 
The actual value calculation may include counting a number of items, such as leads, 
or totaling values such as revenue.

8.2.8.3 Sample Activity Function Metric 
The value returned is updated in the corresponding AMS_ACT_METRICS_ALL 
record. Currency conversion is performed for Cost and Revenue metrics.

FUNCTION run_metric(p_activity_metric_id IN NUMBER)
RETURNS NUMBER
IS
   L_actual_value NUMBER;
BEGIN
   -- Query actual value
   SELECT actual_value
   INTO l_actual_value
   FROM business, ams_act_metrics_all actmetric
   WHERE actmetric.activity_metric_id = p_activity_metric_id
   AND business.id = actmetric.act_metric_used_by_id;
   RETURN l_actual_value;
END;

8.2.8.4 Creating a Function Metric
To create a Function Metric (using the example above), use the following procedure: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > General > Metric.

3. Select Create. 

4. In the General Information Section, enter the following details:

■ Name: Give the metric a name, for example, Function_Test. 
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■ Enabled: Select to enable the metric. 

■ Category: In the drop-down menu, choose a category to associate the 
Metric with. For example, Cost. 

■ Used With: Select the marketing object that will use the Metric. For 
example, Campaign. 

■ Description: Enter a meaningful description for this metric. 

5. In the Calculation section, select Calculate Using Program. Enter the schema, 
package, and function name. 

6. In the Summarize To section select a Parent level/and or Same Level object.

This step is optional and need only be performed if the manual metric being 
created is to be Rolled up to a parent or Summarized at same level. 

8.2.9 Implementing Variable Metrics
When creating a variable metric you are required to select a multiplier metric. A 
multiplier metric can be any manual or function metric with the same "Used With" 
object -  is not a cost or revenue category. 

The variable metric unit value can be  entered by the user for forecast value. 
However, the actual unit value is calculated based on the actual value divided by 
the actual value of the multiplier metric. 

When the variable metric is assigned to a marketing object the multiplier metric is 
also assigned (if not already present). When the metrics are refreshed the variable 
metric is updated.

For example, “postage costs” can be associated to a number of people in a target 
group (contacts). To contact them you have a mailer you sent out, and postage for 
this is.37/person. You have 500 people in the target contact group. The variable 
metric takes.37 and multiplies it by the # of people in your contact group.

Prerequisites
The multiplier metric must be defined before creating the variable metric 

Steps
1. Log in to Oracle Marketing. 

2. Navigate to the Administration > Marketing > General > Metric. 

3. Select Create.
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4. Select category of Cost or Revenue.

5. Set Used with to the appropriate object type.

6. Set Calculation to 'Enter value manually', and set Accrual to Variable.

7. Select the multiplier metric from the LOV next to 'Multiplier Metric'.

8. Select summarize to parent, and same level as required.

9. Select Create to save and update your changes. 

8.2.10 Implementing Formula Metrics
Using metric formulas you can measure the effectiveness of a marketing object 
based on a composite value calculated from different metrics. Using metrics in this 
way activity effectiveness is better understood by the marketing department. 

Formula metrics: 

■ Calculate composite values from other metrics defined for the same object type.

■ Can be used in the metrics side navigation menus for measuring the 
performance of various marketing objects. 

■ Will calculate as null if the dependent metrics are not assigned to the same 
object.

■ Perform basic mathematical calculations including, addition, subtraction, 
multiplication, and division, along with a parentheses for grouping.

■ Is defined by a unique name  for a particular object type so that the calculations 
are consistent throughout the system for the same formula.  

■ Formulas can also be defined generically for object type ‘Any’.  

The sources of  variables  for the formula metrics type ‘Any’ are either categories or 
rollup and summary metrics.  

For example, to define the ROI formula  of type ‘Any’ the source values can be 
defined as the categories cost and revenue, then the ROI formula can be attached to 
all supported marketing objects, because there are no object specific dependencies.  
The category variable will total all the lower level metrics (manual, function, and 
rollups) within the same category.  For a sub-category, only the metrics within the 
same subcategory are added. The variables within the formula are only from the 
metrics associated with  the same object type. When a formula is added to an object 
the relevant metrics are automatically added.
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Formula metrics calculate measures based on other metrics. This is an extension of 
the metrics calculation types. Formula metrics can be used in the metrics side 
navigation menus for measuring the performance of various marketing objects. A 
‘Formula Metrics’ can calculate composite values from other metrics defined for the 
same object type. If the dependent metrics are not assigned to the same object the 
formula will calculate null. Formulas can perform basic mathematical calculations 
including, addition, subtraction, multiplication, and division, along with a 
parentheses for grouping.

A formula is defined with a unique name  for a particular object type so that the 
calculations are consistent throughout the system for the same formula.  Formulas 
can also be defined generically for object type‘Any’.  The sources of  variables  for 
the formula metrics type ‘Any’ are either categories or rollup and summary metrics.  
For example, to define the ROI formula  of type ‘Any’ the source values can be 
defined as the categories cost and revenue, then the ROI formula can be attached to 
all supported marketing objects, because there are no object specific dependencies.  
The category variable will total all the lower level metrics (manual, function, and 
rollups) within the same category.  For a sub-category, only the metrics within the 
same subcategory are added. The variables within the formula are only from the 
metrics associated with  the same object type  .When a formula is added to an object 
the relevant metrics are automatically added.  

To create metric formulas use the following procedure:

Steps
1. Login as a user that has the Oracle Marketing Administrator responsibility. 

2. Navigate to Administration > Marketing > General > Metrics.

3. Select Create.

4. In the Metrics definition page, enter the following details:

■ Name: Enter a logical name.

■ Enabled: Place a check in this checkbox to make this metric available.

■ Display Type: Choose a display type (either currency, integer, or percent) 
for this metric. For more information on display type, see Section 8.1.5, 
"Understanding Metric Display Types".

■ Category: Defaults to Cost. The Category determines the location of the 
formula metric within the end user interface. If a formula is associated with 
a Cost or Revenue category, then this formula is displayed within the Cost 
& Revenue side navigation menu. If the formula is associated with any 



Implementing Metrics

                                                                  Implementing and Administrating Marketing Metrics 8-23

other category (Response, Lead, Opportunity, etc.), then this formula is 
displayed within the Metric side navigation menu of the end user interface.

■ Used With:  This drop down box displays the object that the formula 
metrics is associated with. Metrics sources  used for a formula should be  
within the same object type as the formula metrics. The objects with which 
users can associate the formula metrics include- campaigns, campaign 
schedule, events, event schedules, one-off events and deliverables. You can 
also select “Any” to associate the formula metric to any object type 

■ Aggregation: Defaults to Summation. You can also choose Average as the 
Aggregation type to accurately indicate the type of metric aggregation. 

 

5. In the Calculation region select Calculate Using Formula. This selection is 
required for formula metrics. 

The ‘Accural Type’ section and the ‘Summarize To’ are not relevant for formula 
metric are grayed out on selecting the ‘Calculate Using Formula’ radio button. 

6. Select Create. 

7. In the Formula table enter the following details:

■ Remove: Use this checkbox to remove a line item from the formula 
definition. 

■ Source Type: Use this drop down to select the type of source to be used for 
defining the formula .The option in this drop down include, Category, 
Metric, Number and Operator.

■ Source Name: Use the flashlight LOV to select the name of the source. This 
will display the names of all the sources of type selected in the ‘Source 
Type’ field. 

For example, if the user has selected metric from the source type drop 
down, the flashlight LOV displays all the metric. The columns within this 
LOV include Metrics Name, Calculation, Category, Used With and 
Description. This flashlight LOV would not be available for the operator 

Note: The Create page is generic for all metric types and some 
options, such as Aggregation, may not be applicable for all metric 
calculation types. For example, aggregation does not apply to 
formula metrics although it does appear in the Create page.
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and number option of the ‘Source Type’ drop down. Note: In this release, 
six operators are supported: -, +, *, /, (, and ).

■ Sequence: Use this field to reorder the sequence of entries in the formula 
through this field. You can’t reuse existing numbers within a sequence 
order.

8. Select Update to save your work and validate your formula. 

When the Update button is clicked on the formula details page, the formula is 
validated. If the formula is valid then the following  message appears. 

■ Formula is Valid.

■ Total Responses/Target Group Count

If the formula is not valid, then the following message is displayed

■ Formula is Invalid

■ Display the formula with a “^ - Error – “ that indicates the spot of the error

8.3 Administrating Metrics
See the following sections to administrate marketing metrics:

■ Section 8.3.1, "Associating Metrics to Marketing Objects"

■ Section 8.3.2, "Running the Metrics Concurrent Program"

■ Section 8.3.3, "Setting Up Metric Templates"

■ Section 8.3.4, "Creating a Metric Template"

■ Section 8.3.5, "Enabling Metric Templates"

■ Section 8.3.6, "Using Metric Templates"

8.3.1 Associating Metrics to Marketing Objects
You can create metrics for any object that exists in the Oracle Marketing application. 
After the metric has been created by the Administrator, the marketer will use the 
metric in association with the Campaign object being measured. 

For example, if a Manual Metric called “total cost” has been created for the 
Campaign Object, a marketer will simply navigate to the Campaign Details page 
and select Metric. The Manual Metric “total cost” will be available and will be 
associated to the Campaign Object by the marketer. 
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8.3.2 Running the Metrics Concurrent Program
After implementing any type of metric, the concurrent manager for metrics must be 
set up. The Metrics Refresh Engine utilizes PL/SQL features to quickly, and 
correctly roll up values. 

A check is made to see if any rollup metrics are missing. That is, a metric defined 
with a rollup parent, and the associated activity metric does not have a rollup 
parent. 

■ If so, the rollup is created and the activity metric is updated to point to the new 
rollup metric. 

■ Alternatively, if the rollup parent exists, the activity metric is update to point to 
the existing one.

■ All activity metrics marked with a dirty flag (indicates values may not be 
correctly totaled) are read into memory.

■ All parent activity metrics of the dirty metrics are also read into memory.

■ Each node in the dirty tree is calculated from the leaf level up.

■ Totals are kept in memory until the operation is completed.

■ On completion, values are bulk updated into the activity metrics table and the 
dirty flag is reset.

■ This process is broken into 2 parts: Rollups and Summaries.

■ Update History is optionally performed as indicated by an input parameter. 

The following steps are made in the refresh process:

Prerequisites
Metric is properly set up

Steps
1. Log in to Oracle Forms as Oracle Marketing Administrator.

2. Navigate to Applications > Functions > Setups > Concurrent Requests.

3. Select Submit a New Request.

4. Select the Concurrent Manager Program: AMS - Metrics refresh program.

5. Schedule the program to execute at least once daily.

6. Update History.



Administrating Metrics

8-26 Oracle Marketing Implementation and Administration Guide                              

■ Metric history records the activity metric records on a daily basis. History is 
recorded by the AMS: Metric Refresh Program only when the Update_
history flag is set to Yes. 

■ The refresh must be executed on a daily basis for the history to be recorded. 
If Update_History has been set to No, then no history will be recorded. The 
history is recorded for each metric as a single record for a given day. If the 
metric record is updated more than once in a day, only the last value of that 
day is recorded. If a metric is not updated on a given day then no history is 
recorded. 

■ The history can be shown by the history section on the Metrics and Cost & 
Revenue side navigation menus. Select the Metric Name, Start and End 
dates, Interval Value Type (cumulative or incremental), then select View 
History to show a table of values and charts. Recording history is required 
for support of Business Intelligence for Marketing (BIM). 

7. Save your work. 

8.3.3 Setting Up Metric Templates
Metric templates enable you to standardize the metrics associated with a marketing 
activity. For example, you can define a metric template that automatically associates 
specific call center costs to all new telemarketing activities. To streamline template 
setup and administration, each template is associated to a single marketing activity 
type (e.g. email, telemarketing, direct mail) or a single marketing object type (e.g. 
Campaign, Campaign Schedule, Event, Event Schedule).

To understand and implement Metric Templates see the following sections:

■ Section 8.3.4, "Creating a Metric Template"

■ Section 8.3.5, "Enabling Metric Templates"

■ Section 8.3.6, "Using Metric Templates"

8.3.4 Creating a Metric Template
To create a Metric Template use the procedure below: 

Prerequisites
Metric is defined
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Steps
1. Log in to Oracle Marketing.

2. Navigate to Administration > Marketing > Metric Templates. 

The Metric Template overview page opens, it contains a list of all metric 
templates defined on the system. On the overview page templates can be enable 
or disabled as required.

3. Select Create. 

The Metric Template Create page opens, enter the following information: 

■ Name: Enter a name for the template. The metric name value must correlate 
with the marketing object it is associated with. 

■ Enabled: Select whether to have the template enabled on creation.

■ Description: Enter a description for the template. 

■ Associated With: Select either Object Type or Custom Setup. A Metric 
Template can be associated with either a marketing object (campaigns, 
events etc.) or with a custom set-up. If the metric template is associated 
with a marketing object, all metrics added to the template would have the 
same used with.

If the metric template is associated with a custom set-up, all metric added 
to the template will have the same used with object as the custom set-up.

Existing templates, which refer more than one object type,  are to be split 
into each object type. The Metrics and Custom Setups would be distributed 
according to the same Object Types to the new templates.

■ Association Name: Use the flashlight icon to display a list of all the custom 
setups (in the case where you have selected custom setup in the Association 
Type drop down.) If you have selected used with in the association type 
drop-down, a list of all the object types (e.g. Campaign Schedules, 
Campaigns, etc.) is displayed when selecting the flashlight LOV.

4. Select Create.

5. In the Define Metrics table, select the set of metrics to include in the template. 

■ Metric Name: Using the flashlight icon search and select the metrics that 
will be part of this template. 
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■ Used With: This shows what types of object the metrics can be assigned to. 
The associations include defining which object types or custom setups these 
metrics are assigned to on creation

■ Enabled: If enabling this template place a check in the enabled checkbox. 

6. Select Update to save your work.

8.3.5 Enabling Metric Templates
Enabling occurs at each level of the metric template. The entire template is enabled 
or disabled, or with each metric individually. If the template is disabled then the 
associations and metrics within are ignored. If metrics are disabled within the 
template then those metrics are not assigned (at least because of this template, but 
another template still could assign that metric). 

8.3.6 Using Metric Templates
Usage of a metric template is transparent to the marketer creating the business 
object. When the marketing object is created the metric templates are all searched to 
generate a composite list of metrics to assign. The metrics are required to have the 
same ‘Used With’ object type as the new business object. The metrics must be 
enabled at the metric definition. The template, association type, and included metric 
all must be enabled to assign the metric. If duplicates of a metric are found across 
the templates only one metric is assigned to the object.

For more information about using Metric Templates see the Oracle Marketing User 
Guide. 

8.4 Seeded Metrics Reference
A number of commonly used marketing metrics, such as Total Cost, Total Revenue, 
Responses Count and Event Registrants, are included in with the deployment of the 
Oracle Marketing application. The following is a listing of the metrics which are 
selectable for association to specific marketing activities/objects. 
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Table 8–3 Seeded Metrics 

Metric Name
Metric 
Id

Used With 
Object

Calculation 
Type Category

Metric 
Parent 
Id

Summary 
Metric Id

Total Campaign Cost 1 Any Summary Cost - -

Total Campaign Direct Cost 2 Any Summary Cost - 1

Rolled-up Campaign 
Deliverable Cost

3 Any Rollup Cost 3 2

Rolled-up Campaign Event 
Cost

4 Any Rollup Cost 4 2

Rolled-up Campaign Cost 5 Any Rollup Cost 5 57

Total Campaign Indirect Cost 6 Any Summary Cost - 1

Total Campaign Revenue 7 Any Summary Revenue - -

Rolled-up Campaign Revenue 8 Any Rollup Revenue 8 62

Total Campaign Response 9 Any Summary Response - -

Campaign Response 10 Campaign Manual Response 11 64

Rolled-up Campaign Response 11 Any Rollup Response 11 64

Total Campaign Schedule Cost 12 Any Summary Cost - -

Total Campaign Schedule 
Direct Cost

13 Any Summary Cost - 12

Rolled-up Campaign Schedule 
Deliverable Cost

14 Any Rollup Cost 14 13

Rolled-up Campaign Schedule 
Event Cost

15 Any Rollup Cost 15 13

Direct Cost 16 Campaign 
Schedule

Manual Cost 171 57

Total Campaign Schedule 
Indirect Cost

17 Any Summary Cost - 12

Total Campaign Schedule 
Revenue

18 Any Summary Revenue - -

Revenue 19 Campaign 
Schedule

Manual Revenue 8 62

Total Campaign Schedule 
Response

20 Any Summary Response - -
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Response 21 Campaign 
Schedule

Manual Response 11 64

Total Event Cost 22 Any Summary Cost - -

Total Event Direct Cost 23 Any Summary Cost - 22

Rolled-up Event Deliverable 
Cost

24 Any Rollup Cost 24 22

Rolled-up Event Campaign 
Cost

25 Any Rollup Cost 25 23

Rolled-up Event Cost 26 Any Rollup Cost 26 57

Total Event Indirect Cost 27 Any Summary Cost - 22

Total Event Revenue 28 Any Summary Revenue - -

Rolled-up Event Revenue 29 Any Rollup Revenue 29 62

Total Event Response 30 Any Summary Response - -

Event Response 31 Event Manual Response 32 64

Rolled-up Event Response 32 Any Rollup Response 32 64

Total Event Schedule Cost 33 Any Summary Cost - -

Total Event Schedule Direct 
Cost

34 Any Summary Cost - 33

Rolled-up Event Schedule 
Deliverable Cost

35 Any Rollup Cost 35 34

Rolled-up Event Schedule 
Campaign Cost

36 Any Rollup Cost 36 34

Direct Cost 37 Event 
Schedule

Manual Cost 172 57

Total Event Schedule Indirect 
Cost

38 Any Summary Cost - 33

Total Event Schedule Revenue 39 Any Summary Revenue - -

Revenue 40 Event 
Schedule

Manual Revenue 29 62

Total Event Schedule Response 41 Any Summary Response - -

Response 42 Event 
Schedule

Manual Response 32 64

Table 8–3 Seeded Metrics (Cont.)
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Total Deliverable Cost 43 Any Summary Cost - -

Total Deliverable Direct Cost 44 Any Summary Cost - 43

Creative Cost 45 Deliverable Manual Cost - 57

Other Cost 46 Deliverable Manual Cost - 57

Postage Cost 47 Deliverable Manual Cost - 57

Total Deliverable Indirect Cost 48 Any Summary Cost - 43

Total Deliverable Revenue 49 Any Summary Revenue - -

Revenue 50 Deliverable Manual Revenue - 62

Total Deliverable Response 51 Any Summary Response - -

Response 52 Deliverable Manual Response - 64

Other Cost 53 Campaign Manual Cost 5 57

Other Cost 54 Event Manual Cost 26 57

Allocation 55 Campaign Allocation Allocation - -

Total Cost 56 Any Summary Cost - -

Total Direct Cost 57 Any Summary Cost - 56

Rolled-up Deliverable Cost 58 Any Rollup Cost 58 57

Rolled-up Event Program Cost 59 Any Rollup Cost 59 57

Rolled-up Cost 60 Any Rollup Cost 60 57

Total Indirect Cost 61 Any Summary Cost - 56

Total Revenue 62 Any Summary Revenue

Rolled-up Revenue 63 Any Rollup Revenue 63 62

Total Response 64 Any Summary Response - -

Rolled-up Response 65 Any Rollup Response 65 64

Campaign Response 66 Program Manual Response 65 64

Other Cost 67 Program Manual Cost 60 57

Allocation 68 Program Allocation Allocation - -

Total One-Off Event Cost 69 Any Summary Cost - -

Table 8–3 Seeded Metrics (Cont.)
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Total One-Off Event Direct 
Cost

70 Any Summary Cost - 69

Rolled-up One-Off Event 
Deliverable Cost

71 Any Rollup Cost 71 70

Rolled-up One-Off Event 
Campaign Cost

72 Any Rollup Cost 72 70

Direct Cost 73 One-Off 
Event

Manual Cost 173 57

Total One-Off Event Indirect 
Cost

74 Any Summary Cost - 69

Total One-Off Event Revenue 75 Any Summary Revenue - -

Revenue 76 One-Off 
Event

Manual Revenue 174 62

Total One-Off Event Response 77 Any Summary Response - -

Response 78 One-Off 
Event

Manual Response 175 64

Total Leads 81 Any Summary Leads - -

Rolled-up Campaign Leads 82 Any Rollup Leads 82 81

Leads 83 Campaign 
Schedule

Function Leads 82 81

Leads 84 Event 
Schedule

Function Leads 86 81

Leads 85 One-Off 
Event

Function Leads 87 81

Rolled-up Event Leads 86 Any Rollup Leads 86 81

Rolled-up One-Off Event 
Leads

87 Any Rollup Leads 87 81

Total Opportunities 91 Any Summary Opportunities - -

Rolled-up Campaign 
Opportunities

92 Any Rollup Opportunities 92 91

Opportunities 93 Campaign 
Schedule

Function Opportunities 92 91

Opportunities 94 Event 
Schedule

Function Opportunities 96 91

Table 8–3 Seeded Metrics (Cont.)
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Opportunities 95 One-Off 
Event

Function Opportunities 97 91

Rolled-up Event Opportunities 96 Any Rollup Opportunities 96 91

Rolled-up One-Off Event 
Opportunities

97 Any Rollup Opportunities 97 91

Total Orders Amount 101 Any Summary Orders Amount -

Rolled-up Campaign Orders 
Amount

102 Any Rollup Orders Amount 102 101

Orders Amount 103 Event 
Schedule

Function Orders Amount 106 101

Orders Amount 104 One-Off 
Event

Function Orders Amount 107 101

Orders Amount 105 Campaign 
Schedule

Function Orders Amount 102 101

Rolled-up Event Orders 
Amount

106 Any Rollup Orders Amount 106 101

Rolled-up One-Off Event 
Orders Amount

107 Any Rollup Orders Amount 107 101

Total Registrants 121 Any Summary Registrants - -

Rolled-up Event Registrants 122 Any Rollup Registrants 122 121

Registrants 123 Event 
Schedule

Function Registrants 122 121

Registrants 124 One-Off 
Event

Function Registrants 125 121

Rolled-up One-Off Event 
Registrants

125 Any Rollup Registrants 125 121

Total Attendees 131 Any Summary Attendees - -

Rolled-up Event Attendees 132 Any Rollup Attendees 132 131

Attendees 133 Event 
Schedule

Function Attendees 132 131

Attendees 134 One-Off 
Event

Function Attendees 135 131

Rolled-up One-Off Event 
Attendees

135 Any Rollup Attendees 135 131

Table 8–3 Seeded Metrics (Cont.)
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Total Cancellations 141 Any Summary Cancellations - -

Rolled-up Event Cancellations 142 Any Rollup Cancellations 142 141

Cancellations 143 Event 
Schedule

Function Cancellations 142 141

Cancellations 144 One-Off 
Event

Function Cancellations 145 141

Rolled-up One-Off Event 
Cancellations

145 Any Rollup Cancellations 145 141

Total Orders Count 151 Any Summary Orders Count - -

Rolled-up Campaign Orders 
Count

152 Any Rollup Orders Count 152 151

Rolled-up Event Orders Count 153 Any Rollup Orders Count 153 151

Rolled-up One-Off Event 
Orders Count

154 Any Rollup Orders Count 154 151

Orders Count 155 Campaign 
Schedule

Function Orders Count 152 151

Orders Count 156 Event 
Schedule

Function Orders Count 153 151

Orders Count 157 One-Off 
Event

Function Orders Count 154 151

Total Responses Count 161 Any Summary Response - -

Rolled-up Campaign 
Responses Count

162 Any Rollup Response 162 161

Rolled-up Event Responses 
Count

163 Any Rollup Response 163 161

Rolled-up One-Off Event 
Responses Count

164 Any Rollup Response 164 161

Responses Count 165 Campaign 
Schedule

Function Response 162 161

Responses Count 166 Event 
Schedule

Function Response 163 161

Responses Count 167 One-Off 
Event

Function Response 164 161

Table 8–3 Seeded Metrics (Cont.)



Seeded Metrics Reference

                                                                  Implementing and Administrating Marketing Metrics 8-35

Rolled-up Campaign Direct 
Cost

171 Any Rollup Cost 171 57

Rolled-up Event Direct Cost 172 Any Rollup Cost 172 57

Rolled-up One-Off Event 
Direct Cost

173 Any Rollup Cost 173 57

Rolled-up One-Off Event 
Revenue

174 Any Rollup Revenue 174 62

Rolled-up One-Off Event 
Response

175 Any Rollup Response 175 64

Rolled-up Campaign Indirect 
Cost

176 Any Rollup Cost 176 17

Rolled-up Event Indirect Cost 177 Any Rollup Cost 177 38

Rolled-up One-Off Event 
Indirect Cost

178 Any Rollup Cost 178 74

Table 8–3 Seeded Metrics (Cont.)



Seeded Metrics Reference

8-36 Oracle Marketing Implementation and Administration Guide                              



                                                      Implementing and Administrating Data Mining 9-1

9
Implementing and Administrating Data

Mining

This topic group includes implementation and administration tasks for 
implementing the Oracle Marketing Data Mining functionality. 

Topics include:

■ Section 9.1, "Data Mining Overview"

■ Section 9.2, "Implementing Data Mining"

■ Section 9.3, "Administrating Data Mining Functionality"
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9.1 Data Mining Overview 
Data Mining is the process of discovering patterns and relationships in large 
amounts of data. These patterns and behaviors are used to predict the behavior or 
customers and prospects. 

A marketer uses the data by building “models” which act as a set of rules  used to 
predict the value of a specific customer attribute. The prediction is based on the 
known values of other attributes. Oracle Marketing is integrated out-of-the-box 
with Oracle9i Data Mining to build predictive models of customer behavior.

After installing Oracle Marketing, several implementation and administrative tasks 
must be performed to ensure that ODM is configured to fit your business needs.

Some tasks are required and others are optional. Optional procedures need only be 
performed if the functionality provided is required by your business processes. 

9.2 Implementing Data Mining
A license for Oracle9i Data Mining is a prerequisite for using data mining 
functionality within Oracle Marketing. Upon installation of Oracle Marketing, data 
mining functionality is automatically implemented. In other words, there are no 
additional required implementation steps. 

The implementation steps listed in this section are optional and only necessary if 
additional functionality is required by specific business processes. This section 
assumes that Oracle Marketing and Oracle Data Mining are installed on the same 
database instance.  Additionally, this section assumes the following:

■ Oracle Marketing is implemented

■ Oracle9i Data Mining Release 2 (or higher) is implemented

■ The seeded data sources reference information stored within:

■ Oracle Customer Model (Trading Community Architecture or TCA)

■ Interaction History

■ Order Management

■ Customer Intelligence

To perform optional implementation steps, see the following sections: 

■ Section 9.2.1, "Registering Your ODM Password with Oracle Applications"

■ Section 9.2.2, "Activating the Data Mining Concurrent Manager"
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■ Section 9.2.3, "Starting the ODM Monitor"

■ Section 9.2.4, "Setting System Profiles"

■ Section 9.2.5, "Running Data Mining Concurrent Programs"

9.2.1 Registering Your ODM Password with Oracle Applications
Registering the Oracle Data Mining (ODM) schema with Applications Foundation 
allows ODM to programmatically fetch the ODM username and encrypted 
password, thus avoiding the security risk of maintaining this information in a 
property file.  

During the installation process the ODM schema is registered as an external schema 
with Oracle Applications and a default database username (ODM) and password is 
assigned. For security reasons, you should change this password.

To change the password:

1. Log on as a user with System Administrator responsibility.

2. Navigate to Security > ORACLE > Register.

3. Use the flashlight icon to search for the ODM database user name.

4. Place your cursor in the Password field. Enter your new password.

5. Re-enter your password.

6. Click OK.

9.2.2 Activating the Data Mining Concurrent Manager
A concurrent manager is required exclusively for running data mining concurrent 
requests in order to avoid deadlock when multiple models or scoring runs are 
generated in parallel.

To activate the data mining concurrent manager:

1. Log into Oracle Applications as a user with the System Administrator 
responsibility.

2. Navigate to Concurrent > Manager > Administer.

3. Select Marketing Data Mining Manager.

4. Select Activate.
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9.2.3 Starting the ODM Monitor
Each time the database is started, you must start the ODM Monitor that handles 
data mining requests. 

To start the ODM Monitor:

1. Using SQL *Plus, log in to the database and issue the following command:

exec odm.odm_start_monitor

2. For the ODM Monitor to start, verify that the “job_queue_processes” database 
parameter has a minimum value of 2.

3. If there is an abnormal shut down of the database, it is recommended to stop 
and re-start the ODM Monitor. To stop the ODM Monitor, log in to the database 
and issue the following command:

exec odm.odm_stop_monitor

9.2.4 Setting System Profiles
Set the following data mining system profiles as mandated by your business 
requirements. 

9.2.5 Running Data Mining Concurrent Programs
The data mining concurrent programs can be accessed by either logging into 
applications as System Administrator and navigating to Concurrent > Requests or 
by logging into Oracle Marketing as the Marketing Super User and navigating to 
Administration > Marketing > Analytics > Concurrent Requests.

Table 9–1 Data Mining System Profiles 

Option Required Level Setting Effect/Limitation

AMS : Data 
Mining ODM 
Debug 
Enabled

Optional User Default value is 
No. 

If set to Yes - 
debug is turned 
on

If set to No - 
debug is turned 
off 

Enables debugging information 
to be written in the concurrent 
request log. 

This is optional because turning 
on debug is optional. 
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Use the table below to run concurrent programs as mandated by your business 
requirements. 

For more information on BIC see Oracle Customer Intelligence Implementation Guide 
Release 11.5.6. 

9.3 Administrating Data Mining Functionality
After implementing data mining, depending on your business requirements, 
several administrative procedures  may need to be performed.  

For more information see:

■ Section 9.3.1, "Seeded Model Types"

■ Section 9.3.2, "Creating Custom Model Types"

■ Section 9.3.3, "Defining Seeded Data Source Attributes"

■ Section 9.3.4, "Creating new Data Sources for Data Mining"

Table 9–2 Data Mining Concurrent Programs 

Concurrent Manager Required Responsibility Description

Workflow Background 
Process

Yes System 
Administrator

Parameters Form: 

■ Item Type: AMS Data Mining - 
Build/Score/Preview

■ Minimum Threshold: Leave blank.

■ Maximum Threshold: Leave blank.  

■ Process Deferred: Yes

■ Process Timeout: Yes

■ Process Stuck: Yes

For the Workflow daemon to monitor data mining 
workflow requests, a frequency of 30 minutes should 
be sufficient.

AMS Expire Data 
Mining Models

Optional Oracle 
Marketing 
Administrator

Background process monitoring data mining models 
for expiration. A frequency of once a day should be 
sufficient.

AMS Update Data 
Mining Party Details

Optional Oracle 
Marketing 
Administrator

Updates detail information collected on parties. The 
frequency should be the same as the Customer 
Intelligence Model (BIC) Summary Extraction 
process. 
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■ Section 9.3.5, "Creating Targets"

■ Section 9.3.6, "Seeded Targets"

9.3.1 Seeded Model Types
Oracle Marketing ships with seeded models. However, custom models can also be 
created. See Section 9.3.2, "Creating Custom Model Types" for more information on 
custom models. For more information on using the seeded model types, see the 
Oracle Marketing User Guide. 

The following model types are seeded for data mining:

9.3.2 Creating Custom Model Types
Oracle Marketing uses “predictive models” to predict future customer behavior. 
They are built using the Naive Bayes algorithm, which can predict binary or 
multi-class outcomes. Currently in Oracle Marketing, this algorithm is used to 
predict the binary outcomes of a target field.

For example, you might want to predict which customers are likely to respond to a 
direct marketing campaign or predict which customers are likely to buy a particular 

Table 9–3 Data Mining Seeded Model Types

Seeded Model Type Purpose

Response Used to predict customers/prospects that are most likely to 
respond to your e-mail, telemarketing, or direct mail 
campaign.

Loyalty/Retention Used to predict individuals or businesses that are most likely 
to defect from your organization. This type of model assists 
you in converting them to loyal customers. 

Custom Used to predict the value of any customer attribute in TCA or 
in a user-defined data source. For example, you can set up a 
custom model that predicts financial risk based on a credit 
score attribute or a custom model to predict likelihood of high 
credit card balances vs. low balances.

Product Affinity Predicts the likelihood of purchasing a particular product. You 
can also use this model to predict propensity to buy within a 
given product category based on an analysis of all products in 
that category.

Customer Profitability Predicts the likelihood of a customer relationship being 
profitable. 
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product. The possible values for the target field would be yes or no (i.e., a binary 
outcome). 

A custom model type can be created to predict the value of any customer data 
attribute in the Oracle TCA customer data model (or in any user-defined data 
source) for customer information. This feature enables users to model any binary 
(Yes/No) customer behavior. 

For example, marketers can set up a custom model to predict financial risk (based 
on a credit score attribute or a custom model) to predict likelihood of high credit 
card balances. 

To create custom model types, use the following procedures: 

■ Section 9.3.2.1, "Add New Lookup Code" 

■ Section 9.3.2.2, "Restart HTTP Server"

■ Section 9.3.2.3, "Verify New Model Type" 

9.3.2.1 Add New Lookup Code
To create a new lookup code for the custom Model type, use the following 
procedure: 

Prerequisites
None

Steps
1. Log in to Oracle Forms with Oracle Marketing Administrator Responsibility. 

2. Navigate to Setups > Lookups. 

3. Add your new model type to the Lookup Type: AMS_DM_MODEL_TYPE. 

■ Code: Use this field to name the new model type. 

■ Meaning: This will be the display name (in the Oracle Marketing 
drop-down menu) for the custom model type. 

■ Description: Optional description of the custom model type. 

4. Save your work. 
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9.3.2.2 Restart HTTP Server
Lookup types are cached in the HTTP Server. Therefore, after creating a new 
lookup type, you must restart the HTTP server to refresh the data. The exact 
procedures for this step will vary depending on your environment. 

9.3.2.3 Verify New Model Type
In order to begin using a new model type, you will need to setup the target field 
that the new model type will be predicting. 

To verify the new model type, use the procedure below: 

Prerequisites
None

Steps
1. Log in to Oracle Marketing. 

2. Navigate to Administration > Marketing > Analytics > Targets. 

3. Select Create. 

4. Select the Model Type LOV. The custom Model Type is visible in the 
drop-down menu.

9.3.3 Defining Seeded Data Source Attributes
Oracle Marketing ships with seeded data sources that are used by both list 
generation and data mining functionality. The seeded data sources are editable. By 
default, all attributes (or columns) associated with the seeded data source are active. 
As the administrator, you must deactivate fields you wish to exclude for list 
generation and data mining analysis.

To define the data source attribute details for data mining, you should do the 
following:

■ Select the Data Mining Details view within the Attributes mid-tab of a data 
source.

■ Check the “Use for Data Mining” column to select attributes to be used for data 
mining.

See Appendix F, "Seeded Data Source and Data Source Attribute Reference" for 
more information on seeded data sources and data source attributes.
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9.3.4 Creating new Data Sources for Data Mining
Use the following procedure to create a new data source.

Prerequisites
None

Steps
1. Login as a user that has the Audience Administrator responsibility. 

2. Navigate to Audience Dashboard > Audience Administration. 

3. Select Create Data Source.

4. Fill in the following required fields:

■ Data Source Name: Enter a logical name for the parent data source.

■ Code: Enter a code, this is used as a reference for the data source when 
creating Discoverer Workbooks.

■ Type: Select Parent Data Source.

■ Category: Defines the type of data put into the list by categorizing the data 
source by type. Category selection is mandatory when creating parent data 
sources and optional when creating child data sources. 

The following categories are seeded: 

– Organization Contacts

– Persons

– Organization

■ Table or View Name: Select the appropriate table or view that this data 
source points to. By selecting a view (given that a view has been created) 
you are able to narrow down the amount of data that this source will 
retrieve. 

■ Unique Identifier: When creating data sources, if you are explicitly defining 
the relationship (between parent and child) up front, the unique identifier is 
critical. 

This field allows you to set a default join condition between a parent and 
child data source. Specifying the join condition here enables the child and 
parent to be explicitly joined. 



Administrating Data Mining Functionality

9-10 Oracle Marketing Implementation and Administration Guide                              

Although you can relate the parent and child at a later time (using the 
Related Data Sources mid-tab), if you know your parent/child relationships 
up front, you can join them in the data source creation phase. 

5. Select Apply. 

The Update Data Source page opens. 

6. In the View drop-down, choose Data Mining Details.

7. Place a check in the Use for Data Mining checkbox for every attribute you want 
to use for data mining.

8. Optionally, change the source field label.

9. If you want the application to automatically bin the data, select Auto Binning.

10. If you want to manually bin the data, uncheck the Auto Binning column. Select 
Apply and then select the Binning Details icon.

Enter the Number of Buckets to be used for the Manual Binning. You can then 
enter the bucket number and the value for each of these buckets. 

In addition, you can also create manual bins within multiple values by 
specifying the multiple values (for the same bucket) in multiple lines. For 
example, to create two buckets with multiple values for an attribute of type 
VARCHAR, you can specify the following:

Select Update after you finish defining the manual bins.

11. If generating a list from the data mining results, then map the data source 
attributes to the corresponding list entries columns within the Map to List 
Entries column.

12. To display these columns within the Entries mid-tab for a list, check the Display 
in List Entries check box.

Bucket Number Value

1 A

1 E

1 I

2 B

2 C
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13. Select Apply to save your work.

9.3.5 Creating Targets
When marketers create predictive models, they are required to choose the model 
type and the target. As the administrator, you will need to set up the data sources 
and targets for the marketer. Terms are defined as follows:

■ Data Source: A database table (or view) which is the source of data

■ Target: Associates the data source, model type, and the target field. The target 
field is a column within the data source whose value you are trying to predict. 
See Section 9.3.6, "Seeded Targets" for a list of seeded targets.

For example, you might define a target called “Laser Printer Indicator”. This target 
associates a specific model type (say, Product Affinity), a user-defined data source 
(B2B: Orders Data Mart), and a target field (a column within the corresponding data 
source). When a marketer chooses the Product Affinity model type and the “Laser 
Printer Indicator,” they can then build a predictive model to determine who is 
likely to purchase a laser printer by mining data stored within the corresponding 
data source (in this case the “B2B: Orders Data Mart”).

Oracle Marketing currently supports binary outcomes for the target field. As such, 
the possible values for a target field must either be binary or must be mapped to a 
binary outcome. For example, if you are trying to predict high-income households, 
then you will set up the “Income” target field such that values greater than 100000 
is defined as the positive target (yes) and the other values are non-positive (no).

To create a Target use the following procedure:

Prerequisites
None

Steps
1. Log in to Oracle Marketing.

2. Navigate to Administration > Marketing > Analytics > Targets.

3. Select Create.

4. In the Create Targets page, enter the following information:

■ Name: Enter a name for the target. Choose a name that logically represents 
the customer behavior being predicted. For example, if creating a target to 
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predict customers who’ll purchase a laser printer, then name the target as 
“Laser Printer Indicator”.

■ Model Type: Use the LOV to select the corresponding Model Type 
(Custom, Customer Profitability, Direct Mail Response, E-Mail Response, 
Loyalty/Retention, Product Affinity, or Telemarketing Response).

■ Parent Data Source: Use the LOV to select the parent data source.

■ Child Data Source: If the parent data source has child data sources, then 
these are displayed below the selected parent data source. Select the child 
data sources to be used for data mining analysis.

■ Target Field: Select the flashlight icon to launch the target field selector. The 
target field selector LOV displays the attributes of parent data source as 
well as any selected child data source. Choose the target field within the 
corresponding parent or child data source.

■ Description: Optionally, enter a description for the target.

5. In the Positive Target Values section specify the positive target value for this 
target field.

■ Condition: Use this column to select a condition operator for the target 
field.

■ Value: Use this column to indicate a value for the condition selected. 
Certain conditions allow certain value inputs. For example, if the condition 
“=” is selected for the target field “Response”, then an appropriate value 
could be “Yes”. The text input is case sensitive and must match the value in 
the database exactly. 

Note: In this example, if the value for “Response” in the database is “yes”, 
then the positive value of “Yes” will not match the database value.

■ Upper Value: Use this column to indicate a upper value when “BETWEEN” 
is chosen as the condition operator. Only the BETWEEN operator requires a 
value in this column. For example, if using the target “household income” 
with the operator “BETWEEN” and a Value of “100000” and an Upper 
Value of “150000”, then this would consider all household incomes between 
100,000 and 150,000 to be positive target values. All other income values are 
considered non-positive. To build a valid predictive model, the data must 
contain positive and non-positive values.

■ Value Description: Use this column to give your values a text description.

6. Select Create to create your target field.
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9.3.6 Seeded Targets
The following targets are seeded for release 11.5.10:

■ B2C: Direct Mail Responders

■ B2B: Direct Mail Responders

■ B2C: E-mail Responders

■ B2B: E-mail Responders

■ B2C: Telemarketing Responders

■ B2B: Telemarketing Responders

■ B2C: Loyalty/Retention

■ B2B: Loyalty/Retention

■ B2C: Profitability

■ B2B: Profitability

■ B2C: Product Affinity

■ B2B: Product Affinity
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10
Implementing and Administrating Products,

Price Lists, and Deliverables

This topic group describes concepts and procedures related to the implementation 
and administration of products, price lists, and deliverables in Oracle Marketing.

Topics include:

■ Section 10.1, "Implementing Products"

■ Section 10.2, "Administrating Products"

■ Section 10.3, "Implementing Price Lists"

■ Section 10.4, "Implementing Deliverables"
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10.1 Implementing Products 
Implementing products for marketing purposes provides marketer’s the ability to 
create, promote, and manage products. After you have properly implemented 
products, your end users can access products using the Campaign Workbench or 
the Campaign tab. For the purpose of marketing, products are usually associated 
with an offer, event, promotion, or deliverable.   

Oracle Marketing requires that the following applications are properly 
implemented:

■ Section 10.1.1, "Implementing Oracle Product Lifecycle Management"

■ Section 10.1.2, "Implementing Oracle Inventory for Marketing Products"

10.1.1 Implementing Oracle Product Lifecycle Management
Oracle Marketing uses Oracle Product Lifecycle Management (PLM) for product 
cataloging and management. The concept of using a single product hierarchy model 
provides an efficient and re-usable catalog and product management system.

Using catalog categories you build a structured hierarchy that contains 
characteristics (such as attributes and functions). These characteristics are inherited 
throughout the hierarchy.  

For example, you can create a catalog category phone. This category can have 
children mobile phone and land line. All children for the parent phone will  inherit all 
characteristics defined for phone.

Note: Interest Types, primary and secondary codes are no longer used for product 
categorization.

Figure 10–1 Setting Up the Product Catalog  
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Step 1: Create Product Catalog
A catalog is a collection of categories that are setup in a hierarchical format. When 
building your product catalog (and associated hierarchy), the first thing to do is 
create the catalog structure. 

To create the catalog, use the following procedure: 

Steps
1. Login to Self Service as a user that has the Catalog Manager responsibility. 

2. Navigate to Setup > Catalogs.

3. Select Create Catalog.

4. Fill in the following fields:

■ Name: Enter a name relevant to Marketing. For example, AMS Catalog. 

■ Description: Provide a relevant description for this catalog. For example, 
marketing products catalog. 

■ Controlled at:  Select if you want the product catalog to be associated at the 
item or organization level. 

■ Flex Structure:  Select the appropriate flex structure for your 
implementation. 

■ Default Category: Select the default category based on your implementation 
requirements.  

5. Place a check in the following checkboxes: 

■ Enable Hierarchy for Categories

■ Enforce a List of Valid Categories

6. Select Apply.

Step 2: Create Product Categories
To create Product Categories use the following procedure: 

Prerequisites
You must add the following responsibilities to your user.  

■ Catalog Responsibility: Enables you to access the PLM UI  also enables you to 
execute the Load Catalog Hierarchy concurrent program.
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■ Inventory responsibility: Enables you to access the Oracle Inventory UI and 
allows you to see the default category set UI.

Steps
1. Login to Self Service as a user that has the Catalog Manager responsibility. 

2. Navigate to Setup > Categories.

3. Select Create Categories.

4. In the flex structure field select Sales Categories. 

5. Fill in mandatory fields.

6. Click Apply. 

Step 3: Add Product Categories to Catalog
In this step, you will add the product categories created above to the product 
catalog. While adding the categories to the catalog, the parent-child relationships 
are preserved. After creating the category you must associate it to the catalog 
created. 

Steps
1. Login to Oracle Forms as a user that has the Catalog Manager responsibility.

2. Navigate to the Catalog created in the previous step.

3. Select Categories.

4. Choose Add Category.

5. Use the Add Sub-category action to add sub-categories to existing categories.

Step 4: Add Marketing Attributes
Product categories in the catalog have additional Sales and Marketing related 
attributes. These include:

■ Include in Forecast: All product categories that can be forecasted against should 
have this flag set. This is similar to the forecastable flag in interest types in 
11.5.9 and previous releases. 

■ Expected Purchase: All product categories that sales reps can log 
opportunity/lead lines against should have this flag set. This is similar to the 
expected purchase flag on interest types in 11.5.9 and previous releases.
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■ Exclude From User View: Some product categories may be in the catalog for 
purely reporting and collection purposes. Such product categories should have 
this flag set. The product hierarchy presented to sales reps will ignore these 
categories. These can however be used by analytical and reporting tools such as 
DBI.

To setup these attributes, use the following procedure: 

1. Switch to Catalog Manager responsibility.

2. Navigate to the Catalog previously created (you can click on the catalog name 
in the catalog search.)

3. Choose Categories.

4. Select the category name you wish to set the attributes for.

5. Choose Attributes.

6. Update the attributes as desired.

7. Attach the product reporting functional area, using the following procedure:  

a. Login to Oracle Forms as a user that has the Oracle Marketing 
Administrator responsibility.

b. Navigate to Inventory > Setup > Items > Categories > Default Category 
Sets.

c. Attach the functional area Product Reporting  to the catalog (i.e, category 
set) as created above.

8. Next, run Load Catalog Hierarchy from the Catalog Manager responsibility.

This enables the categories defined above are made visible to the Marketing 
applications. Only categories with the following parameters will be pulled into 
this view:

– FORECASTABLE_FLAG = Y 

– PURCHASE_INTEREST = Y  

9. Login to  Oracle Forms as a user that has the Catalog Manager responsibility.

10. Select View > Requests.

11. Select Submit a New Request.

12. In the Submit Request form, specify the request Load Catalog Hierarchy, 
specify the Refresh Mode and choose Submit.
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Step 5: Viewing Marketing Categories
To see a list of categories used for marketing (to manually map) you will need to 
run the following script:

■ AMSUPCMP.sql

This script is located in the Product Top directory (shown below):

■ ProductTop/patch/11.5/sql

Step 6: Mapping Marketing Categories
After viewing the list of categories for Marketing, you will map them to the catalog 
previously created. 

To access PLM UI for Mapping use the following procedure: 

1. Log to the SSWA Using Catalog manager responsibility.  

2. Navigate to Setup -> Setup Workbench 

3. Navigate to Catalog Tab.

4. Select “Catalog Category Mapping”, Use the UI for mapping the categories.

Step 7: Run Concurrent Program 
Once categories are mapped, run AMS Upgrade Product Categories to migrate 
marketing data.  

10.1.2 Implementing Oracle Inventory for Marketing Products
Oracle Product Lifecycle Management handles product cataloging and change 
management for Oracle Marketing. Oracle Inventory acts as the physical repository 
for products. 

You can create 2 different types of products using inventory:  

■ Inventory Items: These include tangible items such as books, clothing, 
appliances, and computers. 

■ Service Items: Currently, warranties, subscriptions, and contracts are supported 
as a newly created service product. 

To implement products use the following procedure:

■ Section 10.1.3, "Validating Inventory Organization for Products"

■ Section 10.1.4, "Setting System Profiles for Products"
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■ Section 10.1.5, "Validating Item Validation Organization"

■ Section 10.1.6, "Creating and Verifying lookups for Products"

■ Section 10.1.7, "Running Concurrent Programs for Products" 

■ Section 10.1.8, "Recompiling Key Flexfield Segments"

10.1.3 Validating Inventory Organization for Products
Oracle Inventory must be properly implemented before using the Product Pages in 
Oracle Marketing. The Master Inventory Organization assigned will appear by 
default in the Oracle Marketing Product Pages. When creating new Products, they 
will be placed into the default Master Inventory Organization. 

Set the profile AMS : Item Validation Master Organization to the default Master 
Inventory Organization for which Products will be selected from and created to. 

10.1.4 Setting System Profiles for Products
Set the following profile option for Products:  
 

10.1.5 Validating Item Validation Organization
This step applies only if implementing Oracle iStore with Oracle Marketing. 

Set AMS : Item Validation Master Organization and IBE: Item Validation 
Organization profiles at site and responsibility levels to the same Master Inventory 
Organization. 

Table 10–1 Product Profile Options 

Option Required Level Setting Effect/Limitation

AMS : 
Inventory 
Item Update 
Allowed

No Site Yes/No Seeded value is No. By default, a 
Marketer is able to update Products 
created within the Oracle Marketing 
application.However, if a Marketer 
wants to be able update Products from 
Oracle Inventory, set this value to Yes at 
Site level.   

AMS : Item 
Validation  
Master 
Organization 

Yes Site Indicates the default Master Inventory 
organization for which Products will be 
selected from or created to.
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For more information about how iStore uses the IBE: Item Validation Organization 
profile option to derive its product database, see the Oracle iStore Implementation 
Guide. 

If the two Item Validation Organization profile options do not match at the same 
levels, then the Create Product button will not be display in the Store 
Administration UI’s Catalog > Products menu. However, the iStore administrator 
still will have view and update privileges for Products within the inventory 
organization of the IBE: Item Validation Organization profile option at its 
lowest-level setting.

10.1.6 Creating and Verifying lookups for Products 
Use the following Lookups for Products: 



Implementing Products

Implementing and Administrating Products, Price Lists, and Deliverables 10-9

Table 10–2 Lookups for Products

Key Type Values Meanings

ITEM_TYPE Extensible AI

AOC

ATO

CONSULTING

EDU

FG

FRT

I

K

KIT

M

MEDIA

NRI

OC

OP

P

PF

PH

PL

POC

PTO

REF

RI

SA

SI

SW LIC

TRAIN

ATO Option Class

ATO item 

ATO model

Contracts - consulting

Contracts - Education

Contracts - KIT

Contracts - Media

Contracts - Software

License

Contracts - Training

Finished good

Freight

Inventory Type

Kit

Model

Non-recurring

Option Class

Outside Processing Item

PTO Option Class

PTO model

Phantom item

Planning 

Product Family

Purchased Item

Recurring

Reference Item

Subassembly supply item

INVENTORY_ ITEM_ 
STATUS_ CODE

User ACTIVE

INACTIVE

Active

Inactive
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10.1.7 Running Concurrent Programs for Products
If there has been a change in the flexfield structure, compile the Inventory System 
Items Flexfield and the Inventory Category Flexfield prior to running this 
concurrent program.

Run the concurrent program listed below to load the Oracle Inventory categories 
information into the Oracle Marketing database tables. This allows the appearance 
of current product categories data in the Oracle Marketing pages. 

You only need to run the concurrent program after you create new categories in 
Oracle Inventory.

10.1.8 Recompiling Key Flexfield Segments
In Oracle Applications, key flexfields (KFFs) are customized fields used to enter 
multi–segment values such as part numbers, account numbers, etc. 

You must recompile the key flexfield segments -- only once -- after creating them. If 
you do not perform this step, part numbers will appear as X in the Products pages.

Following are quick steps to recompile the KFF segments. For more information, see 
the Oracle Inventory User’s Guide.

1. Log in to Oracle Forms with System Administrator responsibility.

2. Navigate to Application > Flexfield > Key > Segments.

3. Query on:

■ Application: Oracle Inventory

■ Flex Title: System Items (MTL_SYSTEM_ITEMS_B_KFV)

4. Select Unfreeze.

5. Select Freeze. 

6. Recompile the key flexfield by selecting the Compile button. 

For general information on DFFs, see the Oracle Application’s User’s Guide.

Table 10–3 Profile Option for Products 

Concurrent Manager Required Description

AMS Load Inventory 
Categories

Yes Loads categories from the MTL schema to the 
AMS schema denormalized tables. This program 
should be run if and when a new category is 
created in Inventory.
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10.2 Administrating Products
See the following sections to administrate products:

■ Section 10.2.1, "Administrating Product Templates"]

■ Section 10.2.2, "Creating a New Product or Service Template"

■ Section 10.2.3, "Setting up the New Template"

■ Section 10.2.4, "Selecting Product Attributes in Seeded Product Templates"

10.2.1 Administrating  Product Templates
Product templates enable a marketing administrator to configure product attributes. 
Configurable Product Options enable the marketer to define, at time of installing 
Oracle Marketing, the list of product attributes to be displayed in the inventory 
options side navigation menu for any responsibility. 

This allows customization of a list of product attributes based on business needs 
and integration requirements. Oracle Marketing provides a default template based 
on whether you are defining a product or a service. Selecting or de-selecting the 
desired product attributes can override the template. 

You can define the list of product attributes for each responsibility and you can also 
specify if the product attributes are editable in the inventory options page. This 
feature allows you to isolate product attributes and limit their access to the 
appropriate users in accordance with business and integration requirements. This 
feature was added as an Enhancement request for Oracle iStore and Oracle Service 
Online. 

Oracle Marketing Product Templates are different from inventory templates. 
Templates created here are used only in Oracle Marketing screens, which gives the 
user an option to configure the product attributes, which are displayed in inventory 
option side navigation menu. 

Logical process of creating templates: 

1. Create Product Templates - choose Service or Product Type.

2. Associate responsibility to the template.

3. For each product attribute select whether the attribute is defaulted, editable or 
hidden.
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4. Depending on the responsibility of the user creating the product the templates 
associated to that responsibility will be implemented. If no templates are 
associated to the user, the default-seeded template is used.

10.2.2 Creating a New Product or Service Template
To create a new template use the following procedure:

1. Log in to Oracle Marketing. 

2. Navigate to Administration > Setup > Product Option. 

3. Select Create Product Template.

4. In the Create Product Template screen, enter the following:

■ Template Name: Enter a unique, descriptive name for the template.

■ Type of template: Select the radio button for either a Product or Service 
template. When selecting a type, the PRODUCT_SERVICE_FLAG flag from 
AMS_PROD_TEMPLATES_B which will have value P/S. Depending upon 
the value, meaning it is retrieved from the ak_region_items/_tl. 

■ Description: Optionally, enter a description for the template.

5. Select Apply to save your work. 

10.2.3 Setting up the New Template
Set up the new template as follows:

1. Log in to Oracle Marketing.

2. Navigate to Administration > Setup > Product Option.

3.  Select the hyperlink of the new template in the Product Templates screen.

4. In the Responsibilities block, select the flashlight icon to retrieve the Marketing 
responsibility which will link to the template. Only one product template and 
one service template can be assigned to a responsibility. 

Optionally, remove an assignment. 

5. In the Attributes block, set the following parameters for each attribute. 

■ Default: Select this to make an attribute the default when a product is 
created.
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■ Editable: Select this to make an attribute updatable in the product screens. 
This field overrides the Hide field. If you select Editable, Hide is ignored.

■ Hide: Select this to make the attribute hidden in the product screens. This is 
overridden by a selected Editable parameter. 

■ Select All: Select this flag to enable all the attributes belonging to a selection 
default and edit enabled. 

6. Select Apply to save your work. 

10.2.4 Selecting Product Attributes in Seeded Product Templates
Different Inventory attributes can be assigned to a product, depending upon the 
type of product created -- Inventory or Service. If an Inventory product has been 
created, the attributes screen will display the specific Inventory and Order 
Management attributes; if the Service option has been selected, the specific Service 
default attributes will be displayed. The tables in this section list the seeded 
attributes for each of the two seeded product templates:

■ Product (Inventory) Template 

■ Service Template 

See the Oracle Marketing User Guide for more information on seeded Templates for 
Products and Service Attributes.

10.3 Implementing Price Lists 
Price Lists are used to price Products. Products can be added to multiple price lists 
which can be in different currencies support a global pricing strategy. Price lists can 
have eligibility defined so that customers who match the criteria alone eligible for 
the price.

Events and Deliverables that are created as inventory items can be added to a price 
list. Price lists can be attached to Offers as qualifiers so that customers can get a 
discount on a specific price.

Oracle Quoting-Forms, Oracle Order Management, and Oracle Advanced Pricing 
must be implemented prior to setting up price lists. 

To implement price lists in Oracle Marketing, follow these procedures: 

■ Section 10.3.1, "Setting System Profile Options for Price Lists"

■ Section 10.3.2, "Creating and Verifying Lookups for Price Lists"
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10.3.1 Setting System Profile Options for Price Lists
Set the following profile options for price lists:  

10.3.2 Creating and Verifying Lookups for Price Lists
See the table below for Lookups and their types, values and meanings. 

Table 10–4 Price List Profile Options 

Option Required Level Setting Effect/Limitation

QP: Item 
Validation 
Organization

Yes Responsibility Select from 
Inventory 
Organizations 
set up in 
Inventory

Prices may be defined only for 
those Products which will be 
available in the specified 
organization.

AMS: Allow 
Updates to 
QP Price 
Lists in OMO

Yes Responsibility Yes/No Selecting Yes will allow Price 
lists created using Advanced 
Pricing to be edited in Oracle 
Marketing.

See also QP: Source System 
Code

AMS : Root 
Section for 
Price List 
Report

Yes Site Sections 
defined in the 
hierarchy Tab 
of iStore’s 
Merchant UI

Price list report available from 
the overview page will utilize 
the section set in this profile to 
determine the section 
hierarchy. Items can be 
grouped into sections. 
Sections in turn can be 
grouped into other sections, 
creating a hierarchical 
structure.

Table 10–5 Lookups for Price Lists 

Key Type Values Meanings

AMS_ 
PRICE 
LIST_ 
STATUS

System Active

Draft

Rejected

Pending

Cancelled

Active

Draft

Rejected

Pending Budget Approval

Cancelled
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10.4 Implementing Deliverables 
Deliverables are hard or soft, electronic collateral that is transmitted to a customer, 
prospect or an Event registrant. Deliverables may also be collected into a kit by 
defining a Deliverable as a kit and then adding other deliverables to the kit. 
Deliverables are utilized by both Campaigns and Events. Deliverables are 
integrated into Oracle Inventory. When a Deliverable is created as an inventory 
item, it is created as a collateral item. These collateral items are available to Oracle 
Telesales. Physical Deliverables created as inventory items may be priced using 
Oracle Pricing in Oracle Marketing.

To implement Deliverables in Oracle Marketing follow these procedures:

■ Section 10.4.1, "Setting System Profile Options for Deliverables"

■ Section 10.4.2, "Creating and Verifying Lookups for Deliverables"

10.4.1 Setting System Profile Options for Deliverables
Set the following profile options for Deliverables: 

10.4.2 Creating and Verifying Lookups for Deliverables
See the table below for lookups, types, values and meanings.

Table 10–6 Profile Options for Deliverables 

Option Required Level Setting Effect/Limitation

AMS: Item 
Validation 
Master 
Organization

Yes Site A valid 
Master 
Inventory 
Organization

When a Deliverable is flagged as an 
inventory item, it is created in 
Inventory under the specified 
master organization.

AMS: Should 
Call to 
Inventory 
Modules be 
Made

Yes Site Yes/No Indicates whether a Deliverable may 
be created as an Oracle Inventory 
item.

AMS: Should 
Call to Pricing 
Modules be 
Made

Yes Site Yes/No Indicates whether a Deliverable may 
be priced.
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Table 10–7 Lookups for Deliverables 

Key Type Values Meanings

AMS_DELIV_STATUS User Archived

Available

Cancelled

Denied_BA

New

Submitted_BA

Superseded

Expired

Denied_TA

Budget_Appr

Submitted_TA

Archived

Available

Cancelled

Denied - Budget Approval

New

Submitted - Budget Approval

Superseded

Expired

Denied - Concept Approval

Budget Approved

Submitted - Concept Approval

AMS_EVENT_FULFILL_
ON

System On_Cancel

On_Enroll

On_Reg

On Cancellation

On Enrollment

On Registration

AMS_CAMP_FULFILL_
ON

System On_Invite On Invite

AMS_OBJECT_USAGE_
TYPE

System Created

Used_By

Created

Used By
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11
Implementing Marketing Intelligence

This topic group includes implementation and administration tasks for 
implementing Oracle Marketing’s marketing intelligence functionality. 

Topics include: 

■ Section 11.1, "Marketing Intelligence Overview"

■ Section 11.2, "Implementing Marketing Intelligence"

■ Section 11.3, "Implementing Lead Intelligence"
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11.1 Marketing Intelligence Overview
Oracle Marketing’s marketing intelligence is displayed as homepage bins, reports, 
and charts that provide summary information about key marketing activities, along 
with links to recently accessed campaigns and events. 

Marketing intelligence displays the following: 

■ Most Recent Bins: Display links to recently accessed campaigns and events. The 
links are generated automatically when you create or edit a campaign or event. 
The links navigate you to the details page for the object type. Most Recent bins 
are available for campaign and event objects. 

■ Reporting Bins: Display trend performance information for key marketing 
activities. Some examples include campaign effectiveness, event effectiveness, 
and marketing budgets. Each reporting bin contains links to more granular 
detailed reports. 

■ Reports: Displayed directly on the homepage are drill-down reports linked 
from a reporting bin, but with a configurable date range specified by the user. 
The date aggregate for the report is inherited from the calling bin. For example, 
when drilling down on the month of September, all data for the drilldown 
reports is about September. 

■ Charts: Display trend performance information for key marketing activities. 
They illustrate information based on date ranges specified by the user. In Oracle 
Marketing, charts render the top comparisons. For example, if you are viewing 
a Campaigns by Leads chart and the number of rows to display is10, then the 
chart for Campaigns by Leads will show the Top 10 Campaigns by Leads. 

For more information on using Bins, Reports and Charts see the Oracle Marketing 
User Guide.      

11.2 Implementing Marketing Intelligence
This section describes how to implement Marketing Intelligence functionality 
displayed on the homepage of the Oracle Marketing. This includes the Bins, Charts 
and Reports. Displaying the following marketing objects is covered in this section:

■ Campaigns

■ Events

■ Budgets

■ Key performance indicators
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■ Marketing activities

■ Interaction history responses

See the following procedures to implement Marketing Intelligence: 

■ Section 11.2.1, "Setting System Profile Options for Marketing Intelligence"

■ Section 11.2.2, "Defining Marketing Calendar Periods"

■ Section 11.2.3, "Implementing Lookups for Marketing Intelligence"

■ Section 11.2.4, "Defining Exchange Rates"

■ Section 11.2.5, "Loading Marketing Facts for a First Time Build"

■ Section 11.2.6, "Creating Initial Build of Materialized Views"

■ Section 11.2.7, "Refreshing Materialized View for Campaigns, Events, and 
Budgets"

■ Section 11.2.8, "Loading Marketing Facts From a Previous Refresh Date"

11.2.1 Setting System Profile Options for Marketing Intelligence
Set the following system profiles for Marketing Intelligence.

11.2.2 Defining Marketing Calendar Periods
The calendar periods must be defined for the Marketing Calendar for the fiscal year 
containing the date one year prior to the start date. The Start Date is the first date 
for which data in the Bins, Charts and Reports should be displayed. Also define the 
periods: Month, Quarter and Year.

Identify the Calendar associated with the profile AMS : Marketing Calendar and 
define Periods on this calendar for the Fiscal Year, which contains the date one year 

Table 11–1 Marketing Intelligence Profile Options 

Option Required Level Setting

BIM Month Period 
Type

Yes System Select the month period type corresponding 
to the Marketing Calendar.

BIM Quarter 
Period Type

Yes System Select the quarter period type corresponding 
to the Marketing Calendar.

BIM Year Period 
Type

Yes System Select the year period type corresponding to 
the Marketing Calendar.
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prior to the start date of the first time facts load, to the current Fiscal Year. It is 
required that periods of type Month, Quarter, and Year should be defined. 

For example, the Fiscal Year starts from 1st June of every year. To load the facts 
from 01-SEP-00, it is required to define the periods for the Marketing Calendar 
starting with the Fiscal Year containing the date 01-SEP-99 to the current Fiscal 
Year.

Prerequisites
None

Steps
1. Log into Forms with System Administrator responsibility.

2. Navigate to Profile > System.

3. Use Find to locate the profile AMS: Marketing Calendar.

Note the calendar entered in this profile.

4. Switch responsibility to General Ledger Super User.

5. Navigate to Setup > Financials > Calendars > Accounting.

6. Locate the Calendar noted above and verify the required periods of Month, 
Quarter and Year are defined.

11.2.3 Implementing Lookups for Marketing Intelligence
This procedure is only necessary if using the Web response interface public APIs: 
AMS_RESP_REJECT_REASON and AMS_RESP_GRADE. 

See the table below for lookups, types, values, and meanings: 

Table 11–2 Lookups for Marketing Intelligence - Web Responses 

Key Type Values Meanings

AMS_RESP_
REJECT_REASON

User User Defined Organization defined 
rejection reasons.

AMS_RESP_
GRADE

User User Defined Organization defined 
response grades.
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11.2.4 Defining Exchange Rates
Exchange rates need to be defined between the transaction currency and the default 
currency code associated to the profile AMS Default Currency. The rates must be 
defined between the currencies, from the date the transactions will be loaded. 

For example, if loading all the campaigns which started on or after 01/SEP/00 
where the minimum approval date is 01/Mar/00, the currency exchange rates need 
to be defined from 01/Mar/00.

All the transactions amounts will be converted to the default currency code 
associated to the profile AMS : Default Currency. All currencies used in 
transactions must have a conversion rate defined with the conversion rate type 
specified in the profile AMS : Currency Conversion Type.

Prerequisites
None

Steps
1. Log into Forms for General Ledger Super User responsibility.

2. Navigate to Setup > Currencies > Rates > Daily.

3. Click Enter by Date Range to enter a range of dates the rate is applicable.

4. Select the From and To currencies.

5. Enter a From date and a To date.

6. Set the type equal to the type specified in the profile AMS : Currency 
Conversion Type.

7. Save your work.

11.2.5 Loading Marketing Facts for a First Time Build
Execute this Request Set only for the first time load. The Request for a first time 
build consists of 8 concurrent programs.

Use the following procedure to run a request set:

Prerequisites
None
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Steps
1. Log in to Oracle Marketing as Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Choose BIM: Load Marketing facts for the first time from the LOV. The 
Program block will list the concurrent programs in this request set. When 
programs are first listed, the Parameters column is blank for all programs.

5. Click on the Parameter column of the first row.

6. The system displays a Parameter window, where all the parameters are 
defaulted automatically.

7. Change the dates as desired and click OK. 

The Start and End dates are defaulted to the sysdate. The Start Date should be 
the first date for which data should be shown.

8. Click on the Parameter column of the second row.

9. The system displays a Parameter window with all the parameters defaulted 
automatically to the values entered in the first row.

10. Click on the Parameter column of the third row.

11. The system displays a Parameter window with all the parameters defaulted 
automatically to the values entered in the previous row.

12. Click Submit. 

The Request set will run and execute all the above concurrent programs 
sequentially. 

Table 11–3 Request Set: Loading Marketing Facts for a First Time Build 

Sequence
Concurrent 
Program Parameters

Est 
Time Comments

0 BIM: Truncate 
all facts

Objects (select from: All, 
Campaigns, Events, 
Budgets, Leads, Lead 
Import, Response)

This program 
removes all 
previously loaded 
facts. It should be 
used only when the 
data should be 
removed in its 
entirety
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11.2.6 Creating Initial Build of Materialized Views
Execute this Request Set only for the first time. This prepares the pre-built tables for 
all materialized views.  This program has to be run only once and should not be run 
during subsequent loads.

1 BIM: Load 
Marketing 
Facts for the  
First Time

Object to Load: 
Campaign

Start Date: 01-SEP-00

End Dates: (SYSDATE)

2 Hrs., 

15 
Mins

Loads all Campaign 
Facts 

2 BIM: Load 
Marketing 
Facts for the 
First Time

Object to Load: Event

Start Date: 01-SEP-00

End Dates: (SYSDATE)

6 Mins Loads all Event Facts

3 BIM:Load 
Marketing 
Facts for the  
First Time

Object to Load: Budget

Start Date: 01-SEP-00

End Dates: (SYSDATE)

20 
Mins

Loads all Budgets 
Facts

4 BIM:Load Key 
Performance 
Indicator Facts

1 Min Loads KPI facts

5 BIM: Load 
Marketing 
Facts for the  
First Time

Object to Load: Leads

Start Date: 01-SEP-00

End Dates: (SYSDATE)

30 
Mins

Loads Lead Facts

6 BIM: Load 
Marketing 
Facts for the 
First Time

Object to Load: Lead_
Import

Start Date: 01-SEP-00

End Dates: (SYSDATE)

7 Mins Loads Lead Import 
Facts

7 BIM:Load 
Marketing 
Facts for the  
First Time

Object to Load: 
Response

Start Date: 01-SEP-00

End Dates: (SYSDATE)

5 Mins Loads Web Response 
Facts

Table 11–3 Request Set: Loading Marketing Facts for a First Time Build (Cont.)

Sequence
Concurrent 
Program Parameters

Est 
Time Comments
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If for any reason, a user intends to re-run this request set again, execute the 
Concurrent Program, BIM: Truncate all facts, before running the Concurrent 
Manager Program, BIM: Load Marketing facts for the first time.

Prerequisites
None

Steps
1. Log in to Oracle Forms as Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Choose BIM: Initial build of Materialized Views from the LOV. The Program 
block will list the concurrent programs listed below. The Parameters column is 
blank for all the programs.

5. Click on the Parameter column of the first row.

6. The system displays a Parameter window, where the parameter, Number of 
Parallel Processors, is defaulted automatically to 8. Change the value for this 
parameter to 4 and click OK. 

Four processors is sufficient to run this Request Set.

7. Click on the Parameter column of the second row. The system displays a 
Parameter window with the parameter, Number of Parallel Processors, 
defaulted automatically to 4.

8. Repeat the steps 5 and 6 for the third and fourth rows.

9. After verifying all the parameters, click Submit. 

The Request set will run and execute all the above concurrent programs 
sequentially:  
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11.2.7 Refreshing Materialized View for Campaigns, Events, and Budgets
The Request set: BIM: Refresh Materialized Views, builds the materialized views for 
Campaigns, Events, Budgets, Key Performance Indicators and Marketing Activities. 

This Request Set should be run only after the facts are loaded, either by the Request 
Set: BIM: Load Marketing facts for the first time or by Request Set: BIM: Load 
Marketing facts from the previous refresh date.

This program has to be run each time after facts are loaded or refreshed. 

Prerequisites
None

Steps
1. Log in to Oracle Forms as Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Select BIM: Refresh Materialized Views from the LOV. 

Table 11–4 Request Set: BIM: Initial Build of Materialized Views 

Seq Concurrent Program Parameters Est Time Comments

1 BIM: Initial build of 
Campaigns Materialized 
Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Campaigns Materialized views

2 BIM: Initial build of Events 
Materialized Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Events Materialized views

3 BIM: Initial build of 
Budgets Materialized 
Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Budgets Materialized views

4 BIM: Initial build of Key 
Performance Indicators 
Materialized Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for Key 
Performance Indicators 
Materialized views

5 BIM: Initial Build of 
Interaction History 
Response Materialized 
Views

-- 1 Min Prepares pre-built tables for 
Interaction History Response 
Materialized views
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The Program block will display the concurrent programs listed in the table 
below. Note that the Parameters column is blank for all the programs.

5. Click on the Parameter column of the first row.

6. The system displays a Parameter window, where the parameter Number of 
Parallel Processors is defaulted automatically to 8.

7. Change the value for this parameter to 4 and click OK. 

8. Click on the Parameter column of the second row. The system displays a 
Parameter window with the parameter, Number of Parallel Processors, 
defaulted automatically to 4.

9. Repeat steps 8 and 9 for third, fourth, and fifth rows.

10. After verifying all the parameters, click Submit. 

The Request set will run and execute all the above concurrent programs 
sequentially.

11.2.8 Loading Marketing Facts From a Previous Refresh Date
This request set will load all the marketing facts from the previous refresh date. 
Execute this Request Set on a daily basis.This program has to be run each time facts 
are loaded or refreshed. 

Prerequisites
Marketing facts are properly implemented

Steps
1. Log in to Oracle Forms as Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Select BIM: Load Marketing facts from previous refresh date from the LOV. The 
Program block will display the concurrent programs listed below. 

5. Click on the Parameter column of the first row.

6. The system displays a Parameter window, where all the parameters are 
defaulted automatically.

7. Note that the End date is defaulted to the sysdate. Change the date as desired 
and click OK.
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8. Click on the Parameter column of the second row.

9. The system displays a Parameter window with all the parameters defaulted 
automatically. Note that the end date is defaulted to the value entered in the 
first row. Change the date as desired and click OK.

10. Click on the Parameter column of the third row.

11. The system displays a Parameter window with all the parameters defaulted 
automatically.

12. After verifying all the parameters, click Submit. The Request Set will run and 
execute all the above concurrent programs sequentially. 

13. Note: that this program has to be run on a daily basis.

14. Run the Request Set: BIM: Refresh Materialized Views, above, to build the 
materialized views following the steps instructions listed above.

Note: The end date is defaulted from the value entered in the first 
row. Change the date as desired and click OK.

Table 11–5 Request Set: BIM Load Marketing Facts from a Previous Refresh Date 

Seq Concurrent Program Parameters Est Time Comments

1 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: 
Campaign

End Date: 
(SYSDATE)

5 Mins Loads all Campaign Facts

2 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: Event

End Date: 
(SYSDATE)

5 Mins Loads all Events Facts

3 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: 
Budget

End Date: 
(SYSDATE)

5 Mins Loads all Budget Facts

4 BIM: Load Key 
Performance Indicator facts 
from previous refresh date

5 Mins Loads all KPI Facts
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11.3 Implementing Lead Intelligence
This section describes how to implement Lead Intelligence functionality that is 
displayed on the homepage of the Oracle Marketing. This section covers how to 
display the following marketing objects on the homepage: 

■ Leads 

■ Lead Import

■ Web Surveys

See the following procedures to implement Lead Intelligence: 

■ Section 11.3.1, "Creating Initial Build of Materialized View for Lead Intelligence" 

■ Section 11.3.2, "Refreshing Materialized Views for Lead Intelligence"

■ Section 11.3.3, "Loading Marketing Facts from Previous Refresh Date"

11.3.1 Creating Initial Build of Materialized View for Lead Intelligence
Execute this Request Set only for the first time. This prepares the pre-built tables for 
all materialized views for Lead Intelligence. This program has to be run only once 
and should not be run during subsequent loads.

Prerequisites
None

5 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: Leads

End Date (SYSDATE)

5 Mins Loads Lead Facts

6 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: Lead_
Import

End Date (SYSDATE)

5 Mins Loads Lead Import Facts

7 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: 
Response

End Date (SYSDATE)

5 Mins Loads Web Response Facts

Table 11–5 Request Set: BIM Load Marketing Facts from a Previous Refresh Date (Cont.)

Seq Concurrent Program Parameters Est Time Comments
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Steps
1. Log in to Oracle Forms as Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Choose BIM: Initial build of Materialized Views from the LOV. 

The Program block will display the concurrent programs listed in the table 
below. Note that the Parameters column is blank for all the programs.

5. Click on the Parameter column of the first row.

6. The system displays a Parameter window, where the parameter, Number of 
Parallel Processors, is defaulted automatically to 8. Change the value for this 
parameter to 4 and click OK. 

Four processors is sufficient to run this Request Set.

7. Click on the Parameter column of the second row. The system displays a 
Parameter window with the parameter, Number of Parallel Processors, 
defaulted automatically to 4.

8. Repeat the steps 5 and 6 for the third and fourth rows.

9. After verifying all the parameters, click Submit. 

The Request set will run and execute all the above concurrent programs 
sequentially.

Table 11–6 Request Set BIM: Initial Build of Materialized Views for Lead Intelligence 

Seq Concurrent Program Parameters Est Time Comments

1 BIM: Initial build of Lead 
KPI Materialized Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Lead KPI Materialized views

2 BIM: Initial build of Lead 
Quality Materialized Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Lead Quality Materialized views

3 BIM: Initial build of Lead 
Sources Materialized Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Lead Sources Materialized views

4 BIM: Initial build of Lead 
Import Materialized Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Lead Import Materialized views

5 BIM: Initial Build of 
Responses Materialized 
Views

Number of Parallel 
Processors: 4

1 Min Prepares pre-built tables for 
Responses Materialized views
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11.3.2 Refreshing Materialized Views for Lead Intelligence
Builds the Materialized views for Leads, Lead Import and Web Responses. This 
Request Set should be run only after the facts are loaded, either by the Request Set: 
BIM: Load Marketing facts for the first time or by Request Set: BIM: Load Marketing 
facts from the previous refresh date. This program has to be run each time facts are 
loaded or refreshed.

Prerequisites
None

Steps
1. Log in to Oracle Forms as Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Select BIM: Refresh Materialized Views from the LOV. 

The Program block will display the concurrent programs listed below. 

5. Click on the Parameter column of the first row.

Table 11–7 Request Set: BIM: Refresh Materialized View 

Seq Concurrent Program Parameters Est Time Comments

1 BIM: Refresh of Campaign 
Materialized views

Number of Parallel 
Processors: 4

10 Mins Builds Campaign Materialized 
views

2 BIM: Refresh of Events 
Materialized views

Number of Parallel 
Processors: 4

5 Mins Builds Events Materialized 
views

3 BIM: Refresh of Budgets 
Materialized views

Number of Parallel 
Processors: 4

20 Mins Builds Budgets Materialized 
views

4 BIM: Refresh of Key 
Performance Indicator 
Materialized views

Number of Parallel 
Processors: 4

5 Mins Builds Key Performance 
Indicators Materialized views

5 BIM: Refresh of Marketing 
Activities Materialized 
views

Number of Parallel 
Processors: 4

5 Mins Builds Marketing Activities 
Materialized views

6 BIM: Refresh of Interaction 
History Response 
Materialized views

Number of Parallel 
Processors: 4

5 Min Builds Interaction History 
Response Materialized views
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6. The system displays a Parameter window, where the parameter Number of 
Parallel Processors is defaulted automatically to 8.

7. Change the value for this parameter to 4 and click OK. 

8. Click on the Parameter column of the second row. The system displays a 
Parameter window with the parameter, Number of Parallel Processors, 
defaulted automatically to 4.

9. Repeat steps 8 and 9 for third, fourth, and fifth rows.

10. After verifying all the parameters, click Submit. 

The Request set will run and execute all the above concurrent programs 
sequentially.  

11.3.3  Loading Marketing Facts from Previous Refresh Date
This request set will load all the marketing facts from the previous refresh date. 
Execute this Request Set on a daily basis.This program has to be run each time facts 
are loaded or refreshed.

Table 11–8 Request Set: BIM Refresh of Materialized Views for Lead Intelligence 

Seq Concurrent Program Parameters Est Time Comments

1 BIM: Refresh of Summary 
by Group Hierarchy

Number of Parallel 
Processors: 4

10 Mins Prepares summarized tables 
based on group hierarchy. This 
has to be run first before 
running any other lead 
intelligence refresh materialized 
view program.

2 BIM: Refresh of Lead KPI 
Materialized Views

Number of Parallel 
Processors: 4

45 Mins Builds Lead KPI Materialized 
Views

3 BIM: Refresh of Lead 
Quality Materialized Views

Number of Parallel 
Processors: 4

60 Mins Builds Lead Quality 
Materialized Views

4 BIM: Refresh of Lead 
Sources Materialized Views

Number of Parallel 
Processors: 4

60 Mins Builds Lead Sources 
Materialized Views

5 BIM: Refresh of Lead 
Import Materialized Views

Number of Parallel 
Processors: 4

5 Mins Builds Lead Import Materialized 
Views

6 BIM: Refresh of Responses 
Materialized Views

Number of Parallel 
Processors: 4

5 Min Builds Responses Materialized 
Views
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Prerequisites
None

Steps
1. Log in to Oracle Forms as Marketing Intelligence Collection Manager.

2. Navigate to Requests > Run.

3. Select the Request Set Radio button and click OK.

4. Select BIM: Load Marketing facts from previous refresh date from the LOV. The 
Program block will display the concurrent programs listed below. 

5. Click on the Parameter column of the first row.

6. The system displays a Parameter window, where all the parameters are 
defaulted automatically.

7. Note that the End date is defaulted to the sysdate. Change the date as desired 
and click OK.

8. Click on the Parameter column of the second row.

9. The system displays a Parameter window with all the parameters defaulted 
automatically. Note that the end date is defaulted to the value entered in the 
first row. Change the date as desired and click OK.

10. Click on the Parameter column of the third row.

11. The system displays a Parameter window with all the parameters defaulted 
automatically.

12. After verifying all the parameters, click Submit. The Request Set will run and 
execute all the above concurrent programs sequentially. 

13. Note: that this program has to be run on a daily basis.

14. Run the Request Set: BIM: Refresh Materialized Views, above, to build the 
materialized views following the steps instructions listed above.

Note: The end date is defaulted from the value entered in the first 
row. Change the date as desired and click OK.
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Table 11–9 Request Set: BIM Load Marketing Facts from Previous Refresh Date 

Seq Concurrent Program Parameters Est Time Comments

1 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: 
Campaign

End Date: 
(SYSDATE)

5 Mins Loads all Campaign Facts

2 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: Event

End Date: 
(SYSDATE)

5 Mins Loads all Events Facts

3 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: 
Budget

End Date: 
(SYSDATE)

5 Mins Loads all Budget Facts

4 BIM: Load Key 
Performance Indicator facts 
from previous refresh date

5 Mins Loads all KPI Facts

5 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: Leads

End Date (SYSDATE)

5 Mins Loads Lead Facts

6 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: Lead_
Import

End Date (SYSDATE)

5 Mins Loads Lead Import Facts

7 BIM: Load Marketing Facts 
from previous refresh date

Object to Load: 
Response

End Date (SYSDATE)

5 Mins Loads Web Response Facts
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A
Oracle Marketing Profile Option Reference

This appendix describes Oracle Marketing related profile options and settings. 

Topics include: 

■ Section A.1, "Before You Begin"

■ Section A.2, "Setting Profile Options"

■ Section A.3, "Oracle Marketing Profile Option Reference"
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A.1 Before You Begin
Before making Oracle Forms settings, ensure that all Oracle Applications server 
processes are up and running. In particular, if you stopped concurrent managers 
before applying Oracle Applications patchsets, restart them now by changing to 
$COMMON_TOP/admin/scripts, and executing adcmctl.sh <APPS 
username/APPS password> start.

A.2 Setting Profile Options
Most profile options ship with a seeded value. Setting or changing profile option 
values is one way to change the default behavior of the application. You may or 
may not want to change profile option values depending on business requirements.

Profile options can be set at four levels:

■ Site: Settings at this level affect the entire Oracle E-Business Suite.

■ Application: Setting profiles at this level overrides the site level setting for the 
particular application. This level enables the setting to be applied to the specific 
application you are working with. 

■ Responsibility: Setting profiles at this level affects users of a given 
responsibility. At this level it overrides the application level setting for users of 
the particular responsibility.

■ User: Setting profiles at the user level affect the individual user only. At this 
level it overrides the responsibility level setting for an individual user.

Use the following procedure to set any profile option.

Steps
1. Log in to Oracle Forms with the System Administrator responsibility.

2. Navigate to Profile > System.

3. Check the level(s) at which you want to set the profile option. The available 
levels are listed below:

■ Site

Note: When setting profile options it may be necessary to log out 
and back in (and stop/restart the Web server) for changes to take 
effect.
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■ Application—If you select this level, choose the application from the 
Application LOV for which you want to set the profile option.

■ Responsibility—If you select this level, choose the responsibility from the 
Responsibility LOV for which you want to set the profile option.

■ User—If you select this level, choose the user from the User LOV for whom 
you want to set the profile option.

4. In the Profile field, enter the profile name, such as AMS: Default Percent 
Formula, or a wildcard search criterion such as AMS%.

5. Click Find.

The System Profile Values form opens with the results of your search.

6. Verify or set the profile option(s) at the levels that you selected.

7. Field and Variable Values window, choose APPLICATION_ID from the Field 
LOV. 

The Value field in the Examine Field and Variable Values window is populated 
with the value of APPLICATION_ID.

8. In the Examine Field and Variable Values window, choose RESPONSIBILITY_
ID from the Field LOV. 

The Value field in the Examine Field and Variable Values window is populated 
with the value of RESPONSIBILITY_ID.

A.3 Oracle Marketing Profile Option Reference 
The following table displays profile options used by Oracle Marketing.



Oracle Marketing Profile Option Reference

A-4 Oracle Marketing Implementation and Administration Guide                              

Table A–1 Oracle Marketing Profile Options

Option
Required/
Optional Level Setting Effect/Limitation

AMS : Admin Group Required Site Select from 
any group 
defined in JTF 
Resource 
Groups

Resources that are part of this group will 
have full access to all campaigns, Events, 
and other marketing objects. Note that this 
should be a single level group.

AMS : Allow 
committed budget to 
exceed total budget

Required Site

Appl

Resp

User

Yes/No If set to Yes, the committed amount for a 
budget can exceed its total budget amount. 

If set to No, the committed amount may 
not exceed the total budget amount. Set to 
no if you intend to use budget not just for 
sourcing but also for imposing financial 
control over budgetary usage.

AMS : Allow 
Recalculation of 
Committed Budget

Optional Site Yes/No Re-Calculated Committed is an option to 
re-calculate the necessary funding level 
based on the actual sales performance of a 
promotion (i.e. offer). Funds can be 
increased or decreased. If the promotion 
performs well, funding can be 
automatically increased, and vice versa. 

If set to Yes the concurrent process( for 
recalculate commit) will perform 
re-calculation of offers’ committed 
amounts. 

If set to No re-calculation will not be 
performed. Users are still able to see the 
Re-Calculated Committed budget column, 
it will simply be equal the Committed 
column.

AMS : Allow updates 
to Price Lists created in 
Advanced Pricing from 
Oracle Marketing

Required Resp Yes/No Selecting Yes will allow Price lists created 
using Advanced Pricing can be edited in 
Oracle Marketing.

AMS : Allow 
Un-Related ShipTo On 
Claims

Optional Site Yes/No This profile determines whether the ship to 
site can be un-related to the bill to site. In 
both Order Management and in AR this is 
possible. For example, the bill-to and 
ship-to may have absolutely no 
relationship set up. Since TM integrates 
closely with these two, a similar profile is 
provided.
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AMS : Auto Register 
for Events upon 
cancellation

Required Site Yes/No This is used to determine if the attendee 
can be moved from the waiting list to 
registered status if a spot is available

AMS : AR Credit 
Method For Rule

Required Site

Resp

Credit 
method 
values from 
AR

Determines who revenue and transaction 
line balances will impact when TM creates 
an invoice credit to settle a deduction. The 
selections are passed to AR.

AMS : AR Credit 
Method For Installment

Required Site 

Resp

Credit 
method 
values from 
AR

Determines who revenue and transaction 
line balances will impact when TM creates 
an invoice credit to settle a deduction. The 
selections are passed to AR.

AMS: Budget has Grace 
Period

Optional Site

Appl

Resp

User

Yes/No Yes indicates that budgets can have grace 
periods.

AMS : Budget 
Adjustment Grace 
Period in Days

Optional Site

Appl

Resp

User

Enter any 
integer (for 
number of 
days)

Budget reconciliation may be performed 
manually or automatically.

■ If automatic: The "AMS-TM: Release 
Committed Budget Amount After 
Grace Period concurrent program is 
used to reconcile budgets. This 
program waits before reconciling the 
sourced budgets of an object after the 
closing date of the object. 

■ If manual: The offer is evaluated on a 
case by case basis. Use automatic if 
you would like to systematically 
reconcile the budgets. 

AMS : Choose Date 
Qualifier Regions

Required Site Show All

Show Header 
Dates 

Show only 
Date 
Qualifiers

This profile is used in the Trade Deal Offer 
User Interface.

Based on the setting, the user may either 
enter date qualifiers or Header Dates or 
both.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Claim Write Off 
Threshold

Optional Site

Appl

Resp

User

This write-off threshold is defined as the 
difference between the total and the 
settlement value returned from AR. For an 
invoice related deduction, if the difference 
amount (Claim amount less the AR credit 
memo amount) is less than this write-off 
threshold amount, Trade Management will 
automatically create a write-off claim line 
and create a negative adjustment to the 
invoice.

AMS : Confirmation 
URL

Required Site URL Contact preferences can be updated by the 
user using self service pages which are 
invoked by updating the contact 
preferences link in an e-mail text body.

Once the user updates the contact 
preferences he or she is redirected to the 
page specified in this profile. 

AMS : Copy Event 
Details to Event 
Schedules 

Required Site Yes/No This is used to allow details of parent 
Event to be copied to the schedule

AMS: Cut Off 
Percentage for 
Approval

Optional Site Enter any 
number (for 
percentage)

This determines what percentage of the 
estimated budget amount an object must 
secure in actual funding before the object 
can go active. 

For example, if you enter 100, it means 
100%. An offer’s estimated budget amount 
is $10K, meaning that it is estimated that 
this offer must get budget approved for 
$10K before the offer can go active.

This applies only to a Trade Management 
implementation. 

AMS : Implement 
Contra Charge 
Payment Method

Required Site Yes/No If set to Yes, “Contra Charge” is a 
settlement option available when settling 
claims. Contra charges are used to track 
offsetting balances for creditors who are 
also debtors.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Currency 
Conversion Type

Required Site Select from 
conversions 
defined in GL, 
such as 
Corporate or 
Spot.

This is the exchange rate used for 
converting transactional amounts into the 
default currency.

AMS : Custom 
Condition Class

Optional Site Java class 
name of the 
custom 
condition

This class is invoked in the runtime when 
custom conditions are implemented.

AMS : Cut off 
percentage for 
Approvals 

Required Site Enter a value 
between 0 
and 100

For a marketing object with an Initial 
Estimated Amount (IEA) value entered 
into the Budget page for that object to go to 
Active status, it must obtain budget 
approval for this percentage of the IEA. 
During the initial stage, before the object 
status is Active, requests in excess of the 
IEA are not allowed. 

AMS : Data Mining 
Across Database Link

Optional Site Yes or No Profile to determine if  data mining uses a 
DB Link. 

Determines if the installation is a single or 
dual installation  

No (or no value) for this profile means single 
installation scenario. 

Yes means a dual installation scenario.

AMS : Data Mining 
Engine Output Schema

Required Site Free form 
text 
correspondin
g to the 
scoring 
output 
schema. 

The scoring run result processing program 
will use the scheme specified to fetch the 
results.

AMS : Data Mining 
Debug  Enabled

Optional User Default value 
is No. When 
set to Yes, 
debug is 
turned on, 
when set to 
No, debug is 
turned off.  

Enables debugging information to be 
written in the concurrent request log. 

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Data Mining 
Server JDBC URL

Required 
for a dual 
installation

Site This site level 
profile option 
is required if 
the customer 
is 
implementing 
a dual 
installation 
system, where 
Apps is in one 
instance and 
ODM is in 
another.  

The JDBC connect string for the ODM server.  

Only required for a dual installation data 
mining scenario.

AMS : Default Amount 
Formula 

Required Site Supported 
Formulas

Used to set the default formula for 
discount rule. For example, if the value is 
set to “handling”, then when changing the 
discount type to “amount”, the value of the 
formula is set to “handling”. 

AMS : Default Bucket 
for discount rules

Required Site Values from 
Advanced 
Pricing 
Lookup 
PRICING_
GROUP_
SEQUENCE

The value set here will be used as the 
default value for buckets in the discount 
rules.

AMS : Default Budget 
for a Person

Required Site

Appl

Resp

User

Choose a 
budget name 
from the list 
of available 
budgets 

During budget request for all objects, users 
may decide to source from a Budget or 
from a Person. When sourcing is made to a 
person, the system will automatically 
default the budget name specified on this 
profile on to the budget request. Users will 
be able to change it on screen.

AMS : Default 
Currency Code

Required Site Select from 
currencies 
defined in 
FND_ 
CURRENCIE
S

This becomes the default functional 
currency. All transactions will be converted 
and stored in this currency. This will be the 
default currency for Currency LOV.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Default Cust 
View

Optional Site

Appl

Resp

User

Yes/No Default value is No. 

If set to Yes, a user can see the Budget 
Customer View from the Budget summary 
page. 

AMS : Default Offer 
Formula

Optional Site Available 
pricing 
formulas in 
Advanced 
Pricing

This option handles discount rules for 
product categories when the Unit of 
Measure is not specified.

AMS : Default Partner 
Budget

Optional Site

Appl

Resp

User

Choose a 
budget name 
from the list 
of available 
budgets

Default budget for a partner

AMS : Default Period 
in Days for 
recalculating 
committed budget

Optional Site

Appl

Resp

User

Enter any 
integer (for 
number of 
days)

This profile determines how often updates 
to Re-Calculated Committed are 
performed. Enter any number greater than 
or equal to one.  

For example: 

■ If set to 1, Re-Calculated Committed 
change after 1 day. 

■ If set to 2, Re-Calculated Committed 
change after 2 days.

AMS : Default Percent 
Formula

Required Site Formulas 
Supported in 
Advanced 
Pricing

Used to set the default formula for a 
Discount Rule having Discount Type  
“Percent”. For example, if the Value is set 
to “Handling” then when changing the 
Discount Type to “Percent” the value of 
Formula is set to “Handling”.

AMS : Default Phase 
for Line level discounts 

Required Site Available 
values are 
derived from 
Event phase 
setup in 
Advanced 
Pricing

This value will be used as the default value 
for phase for all discount rules with a 
discount level of Line.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Default Phase for 
Line Group level 
discounts 

Required Site Available 
values are 
derived from 
Event phase 
setup in 
Advanced 
Pricing

This value will be used as the default value 
for phase for all discount rules with a 
discount level of Group of Lines.

AMS : Default Phase 
for Order level 
discounts

Required Site Available 
values are 
derived from 
Event phase 
setup in 
Advanced 
Pricing

This value will be used as the default value 
for phase for all discount rules with a 
discount level of Order.

AMS : Default Product 
Stylesheet

Required Site User defined Determines the default stylesheet file for 
Products.

AMS : Default 
Schedule Stylesheet

Required Site User Defined Determines the default stylesheet file for 
Schedules.

AMS : Default Task 
Status for creating Task 
Templates

Optional Site Depends on 
JTF Task 
Statuses

If nothing is entered here, tasks will default 
to ’unassigned’.

AMS : Default value for 
Print on Invoice Flag

Required Site Yes/No Used as a default for all discount rules.

AMS : Default value for 
Product precedence

Required Site User Defined Used as a default for all discount rules.

AMS : Default value for 
incompatibility group

Optional Site

Appl

Resp

User

Choose an 
incompatibili
ty group 
from a list of 
available 
incompatibili
ty groups set 
up in 
Advanced 
Pricing.

This profile only applies to fully accrued 
budget. 

Incompatibility Group is setup Advanced 
Pricing, it determines how promotions will 
be grouped together and which ones will 
be applied together with other promotions. 

Being that a fully accrued budget creates 
an offer in the background, and being that 
the offer will by default have this 
incompatibility group, this concerns a fully 
accrued budget. 

Users can change this defaulted value 
while setting up the fully accrued budget.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Email Footer 
Banner

Optional User Image File 
and Path

Image for the email footer of an email blast. 

AMS : Email Header 
Banner

Optional User Image File 
and Path

Image for the email header of an email 
blast.

AMS Enable 
Fulfillment

Optional Site Yes/No Enables Oracle One-to-One Fulfillment 
Service Integration.

AMS : Enable Tip Text Optional User Yes/No Tip text will be displayed in the UI.

AMS  : HZ Dedupe 
Rule

Optional Site Yes/No Indicates whether deduplication rules are 
in effect for records placed into TCA. 

AMS : Implement 
Contra Charge 
payment method

Required Site Yes/No If set to Yes, “Contra Charge” is a 
settlement option available when settling 
claims. Contra charges are used to track 
offsetting balances for creditors who are 
also debtors.

AMS : Implement Client 
File Size

Required Site Numeric 
value

Default value is 1000000. For Oracle 
Marketing List Import functionality, this 
value sets the file size limit in terms of bytes 
that can be uploaded by client.

AMS : Implement 
Payables  

Required Site Yes/No If get to Yes, “Check” is a settlement option 
available when settling claims.

AMS : Implement 
Payables Integrations

Optional Site

Appl

Resp

User

Yes/No This profile value will determine the 
availability of the “check”’ settlement 
method in Trade Management. A setting of 
Yes means that settlement by Check is 
available.

AMS : Import Control 
File Path

Required Site Control File 
Location

Path for the bin directory ($AMS_
TOP/bin)

Improper setup will cause the server side 
import to fail.

AMS : Import Date File 
Path

Required Site Data File 
Location

Path for the data file location 

Improper setup will cause the server side 
import to fail.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Interaction 
Logging Enabled

Optional Site To enable click-through destination 
logging in Interaction History, each time a 
customer/prospect clicks the URL, set 
AMS :  Interaction Logging Enabled at site 
level. 

If set to Yes, each click-through is logged in 
Interaction History, in the JTF Interaction 
History Tables.

If set to No, each click-through is not 
logged. This logging trail tracks the 
following information from the click 
through:

■ Party-id

■ Campaign Schedule source code

■ Time and Date of the click-through

AMS : Item Validation 
Master Organization

Required Site A Valid 
Master 
Inventory 
Organization

When a deliverable is flagged as an 
inventory item, it is created in Inventory 
under the specified master organization.

AMS : Inventory Item 
Update Allows

Optional Site Yes/No Default value is no. a Marketer is able to 
update products created within the Oracle 
Marketing application.However, if a 
Marketer wants to be able update products 
from Oracle Inventory, set this value to Yes 
at Site level.   

AMS : List Workbook 
B2B Marketing 

Optional Site User Defined Workbook name convention prefix for B2B 
workbooks. The default is B2B. No 
convention prefix will result in more 
workbooks than you need in the LOV.

AMS : List Workbook 
B2C Prefix

Optional Site User Defined Workbook name convention prefix for B2C 
workbooks. The default is B2C. No 
convention prefix will result in more 
workbooks than you need in the LOV.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Marketing 
Calendar

Required Site Accounting 
Setting

Seeded value for this profile is Null. he 
Calendar needs to be created and associated 
to this profile. For Oracle Marketing objects, 
the time periods  come from the marketing 
calendar. The Marketing Calendar setups are 
performed prior to implementing Oracle 
Marketing.

AMS : Marketing to 
ODM Database Link

Required Site All database 
links in the 
database.

This profile is only necessary if 
implementing ODM in a dual instance 
environment. 

The value of this profile options should be 
the name of the database link from the 
Oracle Marketing database instance to the 
ODM database instance. It allows Oracle 
Marketing to read scoring run results from 
the ODM results tables.

AMS: Merchant Party ID Optional Site Choose from 
a list of 
Parties 
provided

This value determines the party ID of the 
current active merchant.

This sets the merchant ID for the creation 
of affiliate placements.

This option must be set before creating an 
affiliate site.

AMS : OA_Media Path Optional Site Physical file 
path of media 
directory 
where the 
image files 
are stored.

This is used in the upgrade process to read 
the files from the media directory and store 
them in the database.

AMS : ODM to 
Marketing Database 
Link

Optional Site Name of 
database link 

Profile to determine the DB Link from ODM 
to APPS database. It is only required for a 
dual installation data mining scenario.

AMS : Offer 
Confidential Flag

Optional Site Yes/No Used to set default value for Confidential 
flag in Offer Creation form. For example, if 
setting to Yes, then every time an offer is 
created, it will default to confidential (which 
can be overridden). 

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Offer Discount 
Level

Required Site Used to set default value for Offer discount 
level. For example if setting to Line, and 
minimum volume is 5, then each order line 
will have a minimum quantity of five to get a 
discount. 

AMS : Posting Runtime 
Shopping Cart 
Currency

Required Site Select from a 
list of values. 
USD is the 
default.

Determines the currency in which 
shopping cart amounts are measured.

AMS : Queue : 
Marketing Lists - 
Manual Assignments

Optional All Yes/No This profile determines if a user can work 
on Marketing Lists - Manual Assignments. 
This profile assigns the user a universal 
work queue. In UWQ you can enable or 
disable a note that is exposed by telesales. 

AMS : Queue Order : 
Marketing Lists - 
Manual Assignments

Optional All Yes/No This profile is only applicable when Oracle 
Marketing is integrated with Oracle 
Telesales. Determines the order of 
appearance for the Universal Work Queue. 
This is only applicable if the profile AMS : 
Queue : Marketing Lists  - Manual 
Assignment is enabled. 

AMS : Prefix to 
Registration 
Confirmation Code

Optional Site User Defined Characters for the Event Registration 
Confirmation Code.

AMS : Pricelist Header 
Name for Events

Required Site User defined 
entry

Enter the name of the default price list for 
Events.

AMS : Price Different 
Budget

Optional Site

Appl

Resp

User

Choose a 
budget from 
a list of 
available 
budgets

This is used for accruals created by the 
AMS-TM: Charge back Accruals 
concurrent process (which do not have any 
budgets assigned).

The program imports sell-through sales 
data into TM, often for the purpose of 
forecasting or creating promotional 
accruals for indirect customers. 

AMS : Profile Search Set 
Size  

Required User Numeric Indicates the number of rows displayed in 
selection windows.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Relationship 
Type for Buying Group

Required Site Any valid 
relationship 
type created 
in TCA

Used to establish a hierarchical group of 
customers in TCA. For example, if value is 
set to subsidiaries then all parties who 
share this relationship will be part of a 
buying group. These are used as 
qualification criteria for offers.

AMS : Root Section for 
Price List Report

Required Site Sections 
defined in the 
hierarchy Tab 
of iStore’s 
Merchant UI

Price list report available from the 
overview page will utilize the section set in 
this profile to determine the section 
hierarchy. Items can be grouped into 
sections. Sections in turn can be grouped 
into other sections, creating a hierarchical 
structure.

AMS: Server URL Optional Site User Defined This value determines the runtime URL 
path of the server. Used to generate API 
details for affiliates during placement 
definition.

This must be set before creating any 
affiliate placement definition.

For example: http://YourHostName:PortNum

AMS : Scan Data UOM Required Site All possible 
UOM values

Used to set the default value for UOM in 
the Discount rules for Scan Data Offers. For 
example if you choose “Each” then each 
empty Discount Rule in Scan Data Offers 
will appear with UOM as “Each”.

AMS : Should Call to 
Inventory Modules be 
Made?

Required Site Yes/No Indicates whether a deliverable or an Event 
may be created as an Oracle Inventory 
item.

AMS : Should call to 
Pricing Modules be 
Made?

Required Site Yes/No Indicates whether a deliverable or an Event 
may be priced.

AMS : Show GL 
Accounts On Screen

Required User Yes/No Default is Yes. If Yes is selected the Sales/ 
Expense Account field and the Accrual 
Liability Account field appear in the Create 
Budget page.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : Source Code 
Date Format

Required Site Less than 6 
characters

Used in the generation of source codes. The 
value has to be less than 6  characters (ex. 
"MMDDYY"). 

Apache Server needs to be bounced after 
setting the profile options.

AMS : Source Code 
sequence length

Required Site Value must 
be between 1 
and 10

Source Code includes Geography code, 
Month code, Activity code, Source code 
digits and Suffix. 2. 

The value can be anything between 1 to 10 
(4 or 5 is recommended).

Apache Server needs to be bounced after 
setting the profile options. 

AMS : Source From 
Parent Object

Required Site Yes/No Determines whether campaign schedules 
and Event Schedules are sourced from their 
parent campaigns and Events (Yes) or from 
budgets (No). Campaigns and Events, 
themselves, may only be sourced from 
budgets.

AMS : Store Date in 
Qualifiers

Required Site Yes/No Used to specify the location to store date 
qualifiers in the offers. If this is set to Yes, 
the date qualifier (for example, shipping 
date) is stored in the qualifier. If the value 
is set to No, the date qualifier is stored in 
the header. 

AMS : Universal 
Currency

Required Site Choose any 
valid 
currency 
from a list of 
available 
currencies 

This profile determines the currency for the 
rollup view. It allows the rollup view of a 
budget to display correctly by converting 
all entries to a single currency. 

Different users will, however, be able to see 
the Rollup View in different currencies 
based on the user level profile option JTF_
PROFILE_DEFAULT_CURRENCY. (In 
other words, the universal currency profile 
is simply for storage in the background).

Once set the profile should not be changed. 

AMS :  Update Claim 
Access

Optional Site

User

Yes/No This profile controls whether non-claim 
owners AND non-claim team members get 
update or view access to the claims.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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AMS : UOM Area Required Site Depends on 
UOM Setup

If not set correctly, will not be displayed 
for fields that use UOM (for example, area 
in square feet).

AMS : UOM Length Required Site Depends on 
UOM Setup

If not set correctly, will not be displayed 
for fields that use UOM (for example, 
length in feet).

AMS : UOM Quantity Required Site Depends on 
UOM Setup

If not set correctly, will not be displayed 
for fields that use UOM (for example, units 
in each).

AMS : UOM Time Required Site Depends on 
UOM Setup

If not set correctly, will not be displayed 
for fields that use UOM (for example, time 
in minutes).

AMS : Upgrade 
Complete Flag

Optional Site Yes/No Yes means no upgrade and No means will 
upgrade data.

AMS : Upgrade 
iMarketing

Optional Site Yes/No Used to determine whether to upgrade 
iMarketing data from the previous version.

AMS : User Country Required User Select from 
valid 
countries

Defaults new objects to this country when 
created.

AMS : Validate Market 
and Product Eligibility 
Between Object and 
Budget

Required Site Yes/No Default value is No. 

If set to Yes, the product and marketing 
eligibility of an offer must fall within the 
targets of the budget. The eligibilities of a 
budget must include those of an offer. Even 
if different parameters are used for 
defining these eligibilities (e.g. budget uses 
Territories, but offer uses Customer), the 
validation procedure can still decide 
whether the offer falls within budget (e.g. 
budget says “US West” territory, offer says 
“Business World”, the procedure will 
figure out, based on the definition of the 
US West territory, whether it includes the 
customer Business World in it).

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation



Oracle Marketing Profile Option Reference

A-18 Oracle Marketing Implementation and Administration Guide                              

AMS : Validation Level Optional User 0-100 This profile option affects the validation 
severity at the database level. A value of 
100 (Maximum value of 100) would cause 
the APIs to validate the passed data very 
stringently.

HZ: Address Key 
Length 

Optional Site Length of the 
Address

This determines the length of Address key.

BIM Month Period 
Type

Required Syst Select the month period type defined on 
the Marketing Calendar.

BIM Quarter Period 
Type

Required Syst Select the quarter period type defined on 
the Marketing Calendar.

BIM Year Period Type Required Syst Select the year period type defined on the 
Marketing Calendar.

Client Timezone Required User Select from a 
List of 
Timezone 
Values

This profile is used by the Marketing APIs 
for converting user entered date and time 
to server specific date and time.

This profiles replaces AMS : CLIENT_
TIME_ZONE_ID. 

HZ: Key Word Count Optional Site Number of 
words

This number determines how many words 
in the customer name are used to generate 
the keys.

HZ: Postal Code Key 
Length

Optional Site Length of the 
Postal Code

This determines the length of Postal Code 
key.

IBE: Use Web 
Placements

Required App Yes/No Determines whether placements are 
displayed. Required only when 
implementing iStore.

ICX: Discoverer End 
User Layer

Required Site User Defined EUL prefix for Discoverer, Usually EUL4

ICX: Discoverer 
Launcher

Required Site User Defined URL to launch Discoverer Web version

ICX: Discoverer Use 
Viewer

Optional Site Yes/No Whether to use viewer instead Web 
Discoverer. Defaulted to No.

ICX: Discoverer Viewer 
Launcher

Required Site User Defined URL to launch Discoverer viewer

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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JTF Home Page File 
Name

Optional Site or 
App

User Defined. Enter a file name of the jsp file (for example, 
jtfhomepage.jsp). If no value is supplied, a 
generic information page is displayed. If a 
file is supplied it will be displayed on the 
homepage.

JTF_FM_BASE_
IMAGE_URL

Optional Site Host and port 
name of 
application 
installation 
instance

If adding images to templates this profile 
must be set at site level. When uploading 
images to be stored in the database, the 
application must be enabled to retrieve 
files from the database. This profile enables 
this retrieval. The value of this profile must 
be set to the same value as your application 
installation. For example: 

http://<host_name>:<port_
number>/OA_HTML/

JTF_FM_
UNSUBSCRIBE_TEXT

Optional Site Replace host 
and port with 
your host 
name and 
port number.  

Use this profile to enable users to 
unsubscribe from email blasts. 

@ Click <a href="http://host:port/OA_
HTML/amsContactPreferencesMain.jsp?P
AGE. 

OBJ.requestId=&PAGE.OBJ.objId="here</
a>to unsubscribe. 

OSO: Minimum search 
string length

Optional Site or 
User

User Defined The default setting is 0. This profile 
determines the number of characters that 
must be entered before performing a 
search. 

OSO: Search Lead 
Wildcard

Optional Any Yes/No If Yes, the wildcard (%) will be allowed as 
the first character in a search string. If No, 
and the wildcard is entered as the first 
character, the system will give the user an 
error message.

OSO : Customer Access 
Privilege 

Required Resp Full Set this profile to Full in order to grant 
access the Venue subtab.

QP: Accrual UOM Class Required Site UOM Classes 
as set up in 
Inventory

Used by accrual offers. All accrual units 
will fall under this UOM class. For 
example, frequent flyer miles.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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QP: Item Validation 
Organization

Required Resp Select from 
Inventory 
Organizations 
as set up in 
Inventory

Offers can be defined only for those 
products which will be available in the 
specified organization. Required for all 
offers.

Prices may be defined only for those 
products which will be available in the 
specified organization.

Server Timezone Required Site Select from a 
List of 
Timezone 
Values

This profile is used by the Marketing APIs 
for converting user entered date and time 
to server specific date and time. 

Note: AMS : SERVER_TIMEZONE_ID is 
obsolete and Server Timezone should be 
used instead. 

QP: Source System Code Required Resp Possible 
Source 
Systems that 
can define 
offers

Offers created using this relationship are 
tagged with this system source code and 
will be used to determine update privileges 
of offers within the pricing module.

Task Manager: Default 
assignee status

Optional App User Defined Specifies the default assignee status when 
creating or assigning a task. 

Task Manager: Default 
Priority

Optional App User Defined Specifies the default task priority when 
creating a task.

Task Manager: Default 
Task Status

Optional App User Defined Required for implementing a task 
transition rule. This profile option must be 
set to the initial status of the rule.

Task Manager: Owner 
type for a task

Optional App User Defined Specifies the default task type when 
creating a task.

Table A–1 Oracle Marketing Profile Options(Cont.)

Option
Required/
Optional Level Setting Effect/Limitation
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B
Oracle Marketing Lookup Reference

This appendix describes concepts and procedures related to lookups that are used 
by Oracle Marketing. 

Topics include: 

■ Section B.1, "Understanding Lookups"

■ Section B.2, "Creating New Lookup Types"

■ Section B.3, "Oracle Marketing Lookup Reference"
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B.1 Understanding Lookups
Lookups provide the list of values (LOVs) that appear in Oracle Marketing user 
interface drop-down lists. Lookup values make choosing information quick and 
easy, they ensure that users enter only valid data into Oracle Marketing.

Most Lookups are predefined (seeded in the application), the seeded value can be 
left as is, or they can be customized to fit your business needs. Lookups are stored 
in the FND_LOOKUPS table which is part of the Application Object Library (AOL). 

You can add new Lookups Values at any time. You can set the Enable Flag for a 
Value to No, so that it will no longer appear in the list of values, or you can use the 
Start and End Dates to control when a value will appear in a list. 

When implementing Oracle Marketing you will be setting three types of Lookups:

■ System: System Lookups may not be modified or deleted, and may not have 
additional values added.

■ Extensible: Extensible Lookups may have additional values added to the list. 
Seeded extensible Lookups may not be deleted.

■ User: User Lookups are completely modifiable. They may be modified and/or 
added to. Seeded user Lookups, if any, may be modified or deleted.

B.2 Creating New Lookup Types
To create a new lookup type, add values to an existing lookup type, or prevent 
existing values from appearing in a lookup type, use the Application Utilities 
Lookups window.You must log out and log in again to see the effect of your 
changes. 

To define a new Lookup type and Lookup value use the following procedure: 

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator Responsibility.

2. Navigate to Application > Lookups. 

Note: All levels of Lookups may have their visible values modified.
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3. Choose the access level for the lookup type.

4. Enter the lookup type.

5. Enter the user name of the lookup. This is the name that users will see from 
within the application.

6. Select the application in which the lookup will be used.

7. Optionally, add a description of the lookup type.

8. If you want to add lookup values specific to the security group/business group 
linked to your current responsibility, un–check the Global Security Group check 
box. Existing lookup values are available to all business groups.

9. Enter the code, meaning and optionally a description for each value. Leave the 
Tag column blank.

10. If you do not enter a start date, the new lookup is valid immediately. If you do 
not enter an end date, the new lookup is valid indefinitely.

11. Save your work.

B.2.1 Adding Values to an Existing Lookup
To add a new value to an existing Lookup use the following procedure:

Prerequisites
None

Steps
1. Query the lookup type to which you want to add a value.

You cannot add values if the access level is System.

2. If you want to add lookup values specific to the security group/business group 
linked to your current responsibility, un–check the Global Security Group check 
box. Existing lookup values are available to all business groups.

3. Enter the code, meaning and optionally a description for each value. Leave the 
Tag column blank.

4. If you do not enter a start date, the new lookup is valid immediately. If you do 
not enter an end date, the new lookup is valid indefinitely.

5. Save your work. 
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B.3 Oracle Marketing Lookup Reference
The following table lists the Lookup settings used by Oracle Marketing. 

Table B–1 Oracle Marketing Lookup Values 

Key Type Values Meanings

AGGREGATE_BY System YEAR

MONTH

QTR

INCREMENT

Year

Month

Quarter

Increment

AMS_ ACCESS_ TYPE System Group

User

Group

User

AMS_ ACCRUAL_ BASIS System Customer

Sales

Customer

Sales

AMS_ ADJUSTMENT_
TYPE

Extensible Decrease_ 
Committed

Decrease_ 
Comm_ Earned

Decrease_ Earned

Standard

Decrease Committed Amount

Decrease Committed and Earned Amounts

Decrease Earned Amount

Increase Earned Amount

AMS_ BUDGET_ 
SOURCE_ STATUS

System Approved

Closed

New

Pending

Rejected

Approved

Closed

Planning

Pending

Rejected

AMS_ BUDGET_ TRANS_
TYPE

User Credit

Debit

Credit

Debit

AMS_CAMP_FULFILL_
ON

System On_Invite On Invite

AMS_CAMP_ RELATED_ 
EVENT

System EONE

EVEH

EVEO

One-Off Event

Event

Event Schedule
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AMS_ CAMPAIGN_
PURPOSE 

Extensible Awareness

Lead

Lead_ Maturation

Sales_ Readiness

Awareness

Lead Generation (?)

Lead Maturation

Sales Readiness

AMS_ CAMPAIGN_ 
SCHEDULE_STATUS

System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

New

On_Hold

Submitted_ BA

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

New

Active, but locked

Pending Budget Approval

AMS_ CAMPAIGN_ 
STATUS

System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

Denied_TA

New

On_Hold

Planning

Submitted_
Budget Approval

Submitted_
Theme Approval

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

Denied Theme Approval

New

Active, but locked

Planned

Submitted for Budget Approval

Submitted for Theme Approval

AMS_CLAIM_ CLASS System Claim

Deduction

Claim

Deduction

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_CLAIM_ HISTORY_ 
EVENT

System Changes

Line

New

Split

Changes

Line

New

Split

AMS_CLAIM_ 
PAYMENT_ METHOD

System Check

Credit_Memo

Debit_Memo

Check

Credit Memo

Debit Memo

AMS_CLAIM_STATUS System Approved

Cancelled

Closed

Complete

Duplicate

New

Open

Pending

Pending_
Approval

Pending_Close

Rejected

Approved

Cancelled

Closed

Complete

Duplicate

New

Open

Pending

Pending Approval

Pending Close

Rejected

AMS_ CONTACT_ 
POINT_TYPE

Extensible Address

Email

Fax

Inbound_ script

Outbound_ script

Phone

Website

Proposal

Address

Email

Fax

Inbound Script

Outbound Script

Phone

Website

Proposal

AMS_ CONTENT_ TYPE Extensible HTML

Text

HTML

Text

Used for email schedules

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_ CREATION_ SIGN System +

-

Positive

Negative

AMS_ DEDUCTION_ 
PAYMENT_ METHOD

System Adjustment

Chargeback

Contra_Charge

Credit_Memo

Debit_Memo

Reg_Credit_
Memo

Write_Off

Adjustment

Chargeback

Contra Charge

On Account Credit

Debit Memo

Invoice Credit

Write Off

AMS_DELIV_STATUS User Archived

Available

Cancelled

Denied_BA

New

Submitted_BA

Superceded

Expired

Denied_TA

Budget_Appr

Submitted_TA

Archived

Available

Cancelled

Denied - Budget Approval

New

Submitted - Budget Approval

Superceded

Expired

Denied - Concept Approval

Budget Approved

Submitted - Concept Approval

AMS_DELIVERY_
MEDIA_TYPE

Extensible I SEMINAR

ON_SITE

SEMINAR

WEB

I Seminar

On Site

Seminar

Web

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_DM_ MODEL_ 
STATUS

System Available

Draft

Building

Scheduled

Scoring

Archived

Expired

Custom

Preview

Queued

Available

Draft

Building

Scheduled

Scoring

Archived

Expired

Custom

Preview

Queued

AMS_DM_ MODEL_ 
TYPE

System Email

Telemarketing

DirectMail

Loyalty

Custom

Email Response

Telemarketing Response

Direct Mail Response

Loyalty

Custom

AMS_DM_ SCORE_ 
STATUS

System Draft

Scheduled

Scoring

Completed

Archived

Preview

Queued

Draft

Scheduled

Scoring

Completed

Archived

Preview

Queued

AMS_DM_ SOURCE_ 
TYPE

System Standard

Cell

CSCH

DIWB

Generated List

Segment

Campaign Schedule

Discoverer Workbook

AMS_DM_ TARGET_ 
GROUP_ TYPE

System Business

Consumer

Organization Contacts

Persons

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_DM_ TARGET_ 
VALUE_ TYPE

System Binary

Categorical

Continuous

Binary

Categorical

Continuous

AMS_EVENT_AGENDA_ 
STATUS

System Confirmed

Unconfirmed

Confirmed

Unconfirmed

AMS_EVENT_
ATTENDANCE_
FAILURE

System Agenda_Change

Disaster

Personal_
Emergency

Schedule_Conflict

Speaker_Change

Venue_Change

Work_Emergency

Agenda Change

Natural Disaster

Personal Emergency

Schedule Conflict

Speaker Change

Venue Change

Work Emergency

AMS_EVENT_CANCEL_ 
REASON

System Disaster

Insufficient_Reg

Postponed

Schedule_Conflict

Speaker_ 
Unavailable

Venue_
Unavailable

Natural Disaster

Insufficient Registration

Postponed

Schedule Conflict

Speaker not available

Venue not avaialble

AMS_EVENT_CERT_ 
CREDIT_ TYPE

System General

Seed

General

Seed

AMS_EVENT_DAY System Five

Four

Three

Two

One

5

4

3

2

1

AMS_EVENT_FULFILL_
ON

System On_Cancel

On_Enroll

On_Reg

On Cancellation

On Enrollment

On Registration

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings



Oracle Marketing Lookup Reference

B-10 Oracle Marketing Implementation and Administration Guide                              

AMS_EVENT_FULFILL_
ON

System On_Cancel

On_Enroll

On_Reg

On Cancellation

On Enrollment

On Registration

AMS_EVENT_LEVEL System Main

Sub

Main

Sub

AMS_EVENT_
PAYMENT_ STATUS

System Comp

Free

Invoiced

Paid

Refunded

Complimentary

Free

Invoiced

Paid

Refunded

AMS_EVENT_PURPOSE N/A N/A (Obsolete)

AMS_EVEH_PURPOSE User Organization 
defined values

Purpose for the Event.

AMS_EVENT_REG_
CANCEL_REASON

System Agenda_Change

Cost

Personal_
Emergency

Price_Change

Sch_Conflict

Speaker_Change

Venue_Change

Work_Emergency

Agenda Change

Cost

Personal Emergency

Price Change

Scheduling Conflict

Speaker Change

Venue Change

Work Emergency

AMS_EVENT_REG_
SOURCE

System Call_Center

External

On_Site

Partner

Web

Call Center

External

On Site

Partner

Web

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_EVENT_REG_
STATUS

System Cancelled

Enrolled

Registered

Targeted

Waitlisted

Cancelled

Enrolled

Registered

Targeted

Waitlisted

AMS_EVENT_
RESOURCE_ TYPE

System AMS_People People

AMS_EVENT_ 
SCHEDULE_OBJECTIVE

N/A N/A (Obsolete)

AMS_EVEO_OBJECTIVE User Organization 
defined values

Objective for the Event.

AMS_EVENT_SPEAKER_ 
STATUS

System Booked

Cancelled

Confirmed

Scheduled

Booked

Cancelled

Confirmed

Scheduled

AMS_EVENT_STATUS System Active

Archived

Available

Cancelled

Closed

Completed

Denied_BA

Denied_TA

New

On_Hold

Submitted_ BA

Submitted_TA

Planning

Active

Archived

Available

Cancelled

Closed

Completed

Denied Budget Approval

Denied Concept Approval

New

Active, but locked

Pending Budget Approval

Pending Concept Approval

Planning

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_EVENT_STREAM_ 
TYPE

System A

B

C

D

A

B

C

D

AMS_EVENT_TYPE

(Event Activities)

System Briefing

Conference

Exhibition

Hospitality

Internal_Event

Launch

Seminar

Speaking_ 
Engagement

Sponsorship_
Event

Trade_Show

Web_Seminar

Workshop

Briefing

Conference

Exhibition

Hospitality

Internal Event

Launch

Seminar

Speaking 
Engagement

Sponsorship

Trade Show

Web Seminar

Workshop

AMS_EVENT_WAITLIST_ 
ACTION

System First_Come_First First Come First Served

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_FUND_ SOURCE System CAMP

EVEH

EVEO

FUND

CSCH

DELV

EONE

OFFR

PTNR

OPTN

VEND

USER

Campaign

Event

Event Schedule

Budget

Campaign Schedule

Deliverable

One Off Event

Offer

Partner

Other Partner

Vendor

Person

AMS_FUND_ STATUS System Active

Archived

Cancelled

Closed

Draft

On_Hold

Pending

Rejected

Active

Archived

Cancelled

Closed

Draft

On Hold

Pending Approval

Rejected

AMS_FUND_ TYPE System Fixed

Fully_ Accrued

Fixed

Fully Accrued

AMS_GL_ DATE_TYPE System Claim_Date

Due_Date

System_Date

Claim Date

Due Date

System Date

AMS_GL_ EVENT_ LINE_
TYPE

System Accrual_Liability

Expense_Account

Rec_Clearing

Ven_Clearing

Accrual Liability

Expense Account

Receivable Clearing Acct.

Vendor Clearing Account

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_GL_ EVENT_ 
STATUS

System Accounted

Accounted_With_
Error

Created

Accounted

Accounted with Error

Created a New Transaction

AMS_GL_ EVENT_TYPE System Accrual

Accrual_
Adjustment

Contra_Charge

Settle_By_Credit

Settle_By_WO 

Settle_By_Check

Accrual Liability

Accrual Adjustment

Settle by Contra Charge

Settle by Credit Memo

Settle to Writing Off 

Settle by Payment Voucher

AMS_ HISTORY_ RULES_ 
OBJECT

System Claim Claim

AMS_ IMPORT_ STATUS System New

Staged

Scheduled

Completed

Purged

Cancelled

Error

New Import

Entries are imported and available for 
viewing

Import is setup and ready to be completed 
at the scheduled time.

Import completed.

Imported entries have been purged from 
the Marketing Import Table.

The list import has been cancelled and may 
not be reactivated.

An error occurred during list import.

AMS_ IMPORT_ TYPE System Customer

Event

Lead

Organizations, Persons and TCA data.

Event registration data. 

Leads data.

AMS_LIST_ ACT_TYPE User Employee List

List

Target group list selection type

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_LIST_ DEDUP_ 
TYPE

User List

Import 
Consumers

Import 
Organizations

Type of Deduplication Rules to be applied.

AMS_LIST_
GENERATION_ TYPE

System Incremental

Standard

Update

Update No Purge

New entries added, old entries not deleted, 
entries not updated

All old entries deleted, new entries added

New entries added, old entries not meeting 
criteria deleted, entry information updated

New entries added, old entries retained, 
entry information updated

AMS_LIST_ ROW_ 
SELECT_ TYPE

System Nth Record

Random

Standard

How to select rows during list generation. 
Standard is top down selection.

AMS_LIST_ SEGMENT_ 
STATUS

User Archived

Available

Cancelled

Draft

Expired

Archived

Available

Cancelled

Draft

Expired

AMS_LIST_ SEGMENT_ 
TYPE

System Workbook

SQL

Two types of segments supported. Based on 
a Discoverer workbook or an SQL 
statement.

AMS_LIST_ SELECTION_ 
ACTION

System Include

Exclude

Intersect

How each selection is added to the list. 
Exclude means that all entries that exist in 
the excluded list are removed from the 
current list. Intersect causes the current list 
to become a list of only those entries which 
are on the intersected list and the current 
list.

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_LIST_ SELECTION_ 
TYPE

System Segment

Workbook

Import List

List

SQL

Segment

Workbook

Import List

List

SQL

AMS_LIST_ STATUS System Archived

Available

Cancelled

Draft

Executed

Executing

Generating

Locked

New

Pending

Reserved

Scheduled

Validated

Validating

Archived

Available

Cancelled

Draft

Executed

Executing

Generating

Locked

New

Pending

Reserved

Scheduled

Validated

Validating

AMS_LIST_ TYPE System Manual List

Standard List

Suppression List

Target Group

List of possible list types. Note where these 
appear in the program.

AMS_ LUMPSUM_ 
DISTRIBUTION_ TYPE

System %

Amt

Qty

Percent

Amount

Quantity

AMS_ MASTER_ 
OBJECT_ TYPE

System Camp

CSCH

EONE

EVEH

Campaign

Campaign Schedule

One-Off Event

Event

Table B–1 Oracle Marketing Lookup Values (Cont.)
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AMS_ MEDIA_ TYPE System Broadcast

Deal

Direct_Marketing

Events

Internet

In_Store

Public_Relations

Trade_Promotion

Advertising

Deal

Direct Marketing

Events

Web Marketing

In Store

Press and Analyst Relations

Trade Promotions

AMS_ OBJECT_ CLASS System Invoice

Order

Order_line

PCHO

Invoice

Order

Order Line

Purchase Order

AMS_OBJECT_USAGE_
TYPE

System Created

Used_By

Created

Used By

AMS_OFFER_ DEAL_ 
CUSTOMER_ TYPES

Extensible Buyer

Customer

List

Segment

Buyer Group

Customer

List

Segment

AMS_OFFER_ 
LUMPSUM_ PAYMENT

System Accrue

Check

Accrue

Issue Check

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_OFFER_ STATUS System Active

Closed

Draft

Rejected

Closed

Pending

Pending_Active

Archived

Cancelled

Completed

Terminated

Onhold

Active

Closed

Draft

Budget Rejected

Closed

Pending budget approval

Pending Active

Archived

Cancelled

Completed

Terminated

On hold

AMS_OFFER_ TYPE System OID

Lumpsum

Order

Accrual

Off_Invoice

Deal

Terms

Promotional Goods

Lump sum

Order value

Accruals

Off Invoice

Trade Deal

Terms Upgrade

AMS_OFFER_LUMP_
CUST_ TYPES

System Buyer

Customer

Buyer

Customer

AMS_ PARTNER_ 
HOLDING_ TYPE

(Holding Owner)

System PTNR

VEND

Partner

Vendor

Only used when Partners Online is 
implemented.

AMS_ PAYMENT_ 
STATUS

System Incomplete

Interfaced

Paid

Pending

Incomplete

Interfaced

Paid

Pending

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_PLCE_ 
LOCATION_ CODE

Extensible Left1, 
Left2…Left7

Right1, Right2 … 
Right7

Top

Bottom

Positions for placements

AMS_PLCE_ SITE_ 
CATEGORY

System Oracle_
Applications

Other_
Applications

Affiliates

Oracle Applications

Other Applications

Affiliates

AMS_POST_ AUDIENCE_ 
TYPE

System S

L

Segment

List

AMS_POST_ BUSPRIOR

(Business Priority)

System None

Random

Prod_list_ price

Campaign_ Start_
Date

Campaign_ End_
Date

Campaign_ 
Priority

None

Random (for all)

List Price (for products only)

Start Date, End Date, or Priority (for 
campaign schedules).

AMS_POST_ CATEGORY System Universal

Rulebased

Posting types: Universal or based on a rule.

AMS_POST_ CND_
DATA_ TYPE

System Float

String

Data Types returnable by Custom 
Condition Class.

AMS_POST_ COMP_ 
OPERATOR

System EQ

GTE

LTE

Equal to

Greater than or equal to

Less than or equal to

Used to compare shopping cart amount.

Table B–1 Oracle Marketing Lookup Values (Cont.)
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AMS_POST_ CONTENT_ 
TYPES

System Product

Offer

Schedule

Product

Web Offer

Web Advertisement

AMS_POST_ PREDEF_ 
PROD_ CONTEXT

System Prod_viewed

Prod_in_cart

The product context for relationship based 
strategy.

AMS_POST_ 
RELATIONSHIPS

System Promoting 
Relationship 
types not covered 
by iStore

Promoting is a relationship not covered by 
iStore, as in promoting a product.

AMS_POST_ STATUS System Active

Inactive

-

AMS_POST_ STRATEGY_ 
TYPE

System Manual_ 
Selection

Product_ 
Relationship

Inferred_OP

Custom

Manually selected strategy

Strategy based on product relationship

Inferred based on Personalization

Custom strategy

AMS_ PRICE LIST_ 
STATUS

System Active

Draft

Rejected

Pending

Cancelled

Active

Draft

Rejected

Pending Budget Approval

Cancelled

AMS_PRIOR_ SORT_ 
ORDER

System Asc

Desc

Ascending

Descending

AMS_ PRIORITY System Fast_Track

High

Standard

Fast Track

High

Standard

AMS_ PRODUCT_ LEVEL System Product

Family

Product

Product Family

AMS_ PROGRAM_ 
OBJECTIVE

User User Defined -

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_ PROGRAM_ 
STATUS

System Active

Archived

Cancelled

Completed

New

On_Hold

Active

Archived

Cancelled

Completed

New

Active, but locked

AMS_QP_ ARITHMETIC 
_OPERATOR

System %

Amt

Lumpsum

Newprice

Percent

Amount

Lump sum

New Price

AMS_QP_ VOLUME_ 
TYPE

System Pricing_
Attribute10

Pricing_
Attribute12

Quantity

Amount

AMS_QUARTERS System Q1

Q2

Q3

Q4

Q1

Q2

Q3

Q4

AMS_ REASON_ CODE_
TYPE

User Adjust_Reason

Invoicing_Reason

Adjustment Reason

Invoicing Reason

AMS_ ROLLUP_ TYPE Extensible Coll

Deal

ECAM

EVCAM

Partner

RCAM

TRDP

Collection

Deal

Campaign

Event Promotions

Partner

Program

Trade Promotion

AMS_ SCHEDULE_ 
OBJECTIVE

User User Defined -

AMS_ TRANSFER_ 
REASON

User Sourcing Initial Sourcing

Table B–1 Oracle Marketing Lookup Values (Cont.)
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AMS_ TRANSFER_ TYPE Extensible Release

Reserve

Transfer

Request

Utilized

Release

Reserve

Transfer

Request

Utilized

AMS_ TRIGGER_ CHK_ 
METRIC_ TYPE

System Actual

Forecast

Actual Value

Forecast Value

AMS_ TRIGGER_ CHK_
TYPE

System DIWB

Metric

Static_Value

Workbook

Metric

Static Value

AMS_ TRIGGER_ 
FREQUENCY_TYPE

System Daily

Hourly

Monthly

None

Quarterly

Weekly

Yearly

The frequency of trigger checking

AMS_ TRIGGER_ TYPE System Metric_Metric

Metric_Value

Metric_ 
Workbook

Metric to Metric type trigger

Metric to Value type trigger

Metric to Workbook type trigger

AMS_ UTILIZATION_ 
TYPE

System Accrual

Adjustment

Sales_ Accrual

Utilized

Accrual

Adjustment

Sales Accrual (refers to the salesperson)

Utilized

AMS_VALUE_ LIMIT Extensible Balance

Committed

Paid

Planned

Utilized

Balance

Committed

Paid

Planned

Utilized

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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AMS_YEARS System 1995

1996

1997

1998

1999

2000

2001

2002

1995

1996

1997

1998

1999

2000

2001

2002

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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IBE_ RELATIONSHIP_
TYPES

Extensible Possible 
relationships 
between Products 
like Cross Sell, Up 
Sell. 

This is an iStore lookup type.

INVENTORY_ ITEM_ 
STATUS_ CODE

User ACTIVE

INACTIVE

Active

Inactive

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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ITEM_TYPE Extensible AI

AOC

ATO

CONSULTING

EDU

FG

FRT

I

K

KIT

M

MEDIA

NRI

OC

OP

P

PF

PH

PL

POC

PTO

REF

RI

SA

SI

SW LIC

TRAIN

ATO Option Class

ATO item 

ATO model

Contracts - consulting

Contracts - Education

Contracts - KIT

Contracts - Media

Contracts - Software

License

Contracts - Training

Finished good

Freight

Inventory Type

Kit

Model

Non-recurring

Option Class

Outside Processing Item

PTO Option Class

PTO model

Phantom item

Planning 

Product Family

Purchased Item

Recurring

Reference Item

Subassembly supply item

Table B–1 Oracle Marketing Lookup Values (Cont.)

Key Type Values Meanings
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C
Oracle Marketing Request Set and

Concurrent Program Reference

This appendix provides a table of the Request Sets and Concurrent Manager 
Programs used by Oracle Marketing.

Topics include: 

■ Section C.1, "Running Concurrent Programs"

■ Section C.2, "Checking Concurrent Program Status"

■ Section C.3, "Oracle Marketing Request Sets"

■ Section C.4, "Oracle Marketing Concurrent Program Reference"
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C.1 Running Concurrent Programs
Many operational processes for Oracle Marketing require Concurrent Programs to 
run. They can run on a scheduled basis or on an as required basis. Use the following 
instructions for running any Oracle Applications concurrent program or program 
set. 

See the Oracle Applications System Administrator’s Guide for complete details on 
Oracle Applications concurrent programs.

Prerequisites
None

Steps
1. Log in to Oracle Forms with appropriate responsibility. The Submit a New 

Request Form automatically opens. 

For Oracle applications concurrent programs, the responsibility varies by 
module.

2. Choose Single Request (if running a single concurrent program) or Request Set 
(if running a set of concurrent programs). 

3. Select OK. The Submit Request form opens. 

4. Query for the appropriate concurrent program, if necessary. 

5. Enter run immediately or select Schedule to schedule batch jobs. 

6. If scheduling, select the time frame: 

– As soon as Possible: Select this option if running the program 
immediately. 

– Once: Select this option to run the program(s) one at a time.

– Periodically or On Specific Days: Select this option to run the program 
on a schedule that you will later specify. 

7. Select Submit to submit the request. 
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C.2 Checking Concurrent Program Status
Use the following procedure to check the status of a concurrent program. 

Prerequisites
None

Steps
1. Log in to Oracle Forms with System Administrator Responsibility. 

2. Choose Concurrent > Request. 

The Find Request window (defaulted to “All My Requests”) opens. 

3. In the Find Request window, search for your concurrent program request. 

– If the server is not busy, then selecting Find may be the fastest way to find 
your request. 

– If the server is busy, it may be better to enter search criteria and look for 
Specific Requests. 

4. The Request window displays a list of submitted requests. The Oracle 
Marketing concurrent programs should be listed. 

5. Select Refresh Data occasionally to check the completion status. 

6. Once in the “red” state or Phase = “completed” the “View Output” and “View 
Log” buttons will become active (if the log output files have been setup 
correctly). 

C.3 Oracle Marketing Request Sets
Request sets are sets of concurrent manager programs which may be executed as a 
group. If desired, any concurrent manager program which is part of a request set 
may be executed individually.
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Table C–1 Oracle Marketing Request Sets 

Request Set Name Concurrent Manager Programs

BIM: Load Marketing 
Facts for the First Time

BIM: Load Marketing Facts for the First Time, Object to Load: Campaign

BIM: Load Marketing Facts for the First Time, Object to Load: Event

BIM: Load Marketing Facts for the First Time, Object to Load: Budget

BIM: Load Marketing Facts for the First Time, Object to Load: Leads

BIM: Load Marketing Facts for the First Time, Object to Load: Lead_Import

BIM: Load Marketing Facts for the First Time, Object to Load: Response

BIM: Load Key Performance Indicator Facts

BIM: Initial Build of 
Materialized Views

BIM: Initial Build of Campaign Materialized Views

BIM: Initial Build of Event Materialized Views

BIM: Initial Build of Budget Materialized Views

BIM: Initial Build of Key Performance Indicators Materialized Views

BIM: Initial Build of Interaction History Responses Materialized Views
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C.4 Oracle Marketing Concurrent Program Reference
The table below indicates the Concurrent Manager programs for Oracle Marketing. 

BIM: Refresh 
Materialized Views

BIM: Refresh Campaign Materialized Views

BIM: Refresh Event Materialized Views

BIM: Refresh Budget Materialized Views

BIM: Refresh Key Performance Indicators Materialized Views

BIM: Refresh Marketing Activities Materialized Views

BIM: Refresh of Interaction History Responses Materialized Views

BIM: Refresh 
Materialized Views - 
Lead Intelligence

BIM: Refresh Summary by Group Hierarchy Materialized Views

BIM: Refresh of Lead KPI Materialized Views

BIM: Refresh of Lead Quality Materialized Views

BIM: Refresh of Lead Sources Materialized Views

BIM: Refresh of Lead Import Materialized Views

BIM: Refresh of Responses Materialized Views

BIM: Load Marketing 
Facts from Previous 
Refresh Date

BIM: Load Marketing Facts from Previous Refresh Date, Object to Load: Campaign

BIM: Load Marketing Facts from Previous Refresh Date, Object to Load: Event

BIM: Load Marketing Facts from Previous Refresh Date, Object to Load: Budget

BIM: Load Marketing Facts from Previous Refresh Date, Object to Load: Leads

BIM: Load Marketing Facts from Previous Refresh Date, Object to Load: Lead_
Import

BIM: Load Marketing Facts from Previous Refresh Date, Object to Load: Response

BIM: Load Key Performance Indicator Facts from Previous Refresh Date

Table C–1 Oracle Marketing Request Sets (Cont.)

Request Set Name Concurrent Manager Programs
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Table C–2 Oracle Marketing Concurrent Manager Programs 

Concurrent 
Manager Required Description

Activate 
Event 
Schedules

Yes This will pick up all the Event Schedules which are in Available status and for 
which the start date has passed and its Event is active and make the Schedule 
Active. For Events, run the program Activate Event Schedules. This program 
accomplishes two things:

■ Activates Events: This program activates available event schedules and 
one-off events for which the start date has passed.

■ Completes Events: Picks up and completes event schedules and one-off 
events for which the end date has passed.  

AMS Activate 
Schedule

Optional This will pick up all the Campaign Schedules which are in Available status and 
for which the start date has passed and its Campaign is active and make the 
Schedule Active.

AMS: 
Complete 
Campaign 
Schedules

Optional This program accomplishes the following:

■ Picks up available schedules with a start date of today (or, a start date that 
has already passed) and activates them. 

■ Picks up active schedules with an end date of today (or, an end that that has 
passed) and completes them.  

AMS Expire 
Data Mining 
Models

Yes Background process that monitors data mining models to see if they have expired. 
A frequency of once a day should be sufficient.

AMS: 
Generate 
Suppression 
list

Optional Updates and maintains organization defined suppression lists. This is in addition 
to seeded suppression lists.

AMS Group 
Access 
Refresh

Yes Updates denormalized tables with group information. Should be run on a 
periodic basis according the organization’s Business Rules.

AMS Web 
Execution: 
Specialty 
Store Items 
Refresh 
Program

Yes Refreshes the denormalized table for minisites periodically to capture items in the 
iStore minisites.

AMS Web 
Execution: 
Campaign 
Items Refresh 
Program

Yes Information about Campaigns is stored in multiple tables. To improve runtime 
performance, this program periodically collects required information on 
campaigns and places it into a single table.
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OZF - TM: 
Trade 
Management 
Activities 
(Offers and 
Schedules)

Required 
if using 
Offers 
and Web 
Posting

Refreshes the Offer Denormalized tables. Marketing Online offers functionality 
will retrieve the Eligible Offers for any Products depending For Qualifying 
parties.

AMS Load 
Inventory 
Categories

Yes Loads categories from the MTL schema to the AMS schema denormalized tables. 
This program should be run if and when a new category is created in Inventory.

 AMS : 
Interface 
Marketing 
Objects to 
Calendar

Yes Before the new object or criteria will display on the Marketing Calendar, you must 
run the concurrent program  This program is a workflow background process and 
will update the Calendar as needed. 

Load Catalog 
Hierarchy

Yes Next, run Load Catalog Hierarchy from the Catalog Manager responsibility.

This enables categories defined for Products to be visible to the Marketing 
applications. Only categories with the following parameters will be pulled into 
this view:

■ FORECASTABLE_FLAG = Y 

■ PURCHASE_INTEREST = Y  

AMS - Metrics 
refresh 
program

Optional Refreshes Metrics. There is an optional parameter to record metrics history. 
Update History.

Metric history records the activity metric records on a daily basis. History is 
recorded by the AMS: Metric Refresh Program only when the Update_history flag 
is set to Yes. 

The refresh must be executed on a daily basis for the history to be recorded. If 
Update_History has been set to No, then no history will be recorded. The history 
is recorded for each metric as a single record for a given day. If the metric record 
is updated more than once in a day, only the last value of that day is recorded. If a 
metric is not updated on a given day then no history is recorded. 

The history can be shown by the history section on the Metrics and Cost & 
Revenue side navigation menus. Select the Metric Name, Start and End dates, 
Interval Value Type (cumulative or incremental), then select View History to 
show a table of values and charts. Recording history is required for support of 
Business Intelligence for Marketing (BIM). 

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)

Concurrent 
Manager Required Description
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Metrics 
Background 
Process

- Use this request set to populate data for updating bin and graph data in the 
Campaign Workbench:

■ Top Performing Campaigns Bin 

■ Bottom Performing Campaign Bin 

■ Trend Graph 

It is recommended that you schedule this request set to run daily -- it has two 
concurrent programs:  

■ Refresh the metric: Enter "Yes" in parameter to collect history. 

■ Populate the denorm table: If "Yes" is entered in parameter , the program 
will be run in incremental mode. For example, just update mvs for the data 
updated since last time.

The Top and Bottom performing bins/Trend graph are found in the Campaign 
Workbench (shown below). 

AMS Portal 
Cache 
Daemon

Yes Populates the Marketing subtab on the Home tab.

AMS: Purge 
Imported List

Optional During the import process, the user may specify an expiration date or number of 
uses for a list. This program removes those entries whose expiration date has 
passed or number of uses reached.

Optional Parameter: force_purge_flag. This parameter indicates whether to purge 
a record regardless of the associated campaign status. The default value is No.

AMS: Purge 
Target Group

Optional After a target group has been generated and used, this program lets a user purge 
the list entries. 

AMS: Refresh 
Party Market 
Segments

Optional Generates a list of parties in the segment. This program also updates the size 
information for all segments so a history of segment sizes may be maintained.

AMS Team 
Access 
Refresh

Yes Updates denormalized tables with team information. Should be run on a periodic 
basis according to the organization’s Business Rules.

AMS-TM: 
Adjust 
Backdated 
Offer

Yes Concurrent program to adjust backdated offers. This should be run after running 
the AMS-TM: Funds Accrual Engine concurrent program.

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)

Concurrent 
Manager Required Description
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AMS-TM: 
Funds 
Accrual 
Engine

Yes Ability to calculate budget utilization and earnings based on ship confirmed 
orders (provided the offer’s phase is set to ‘Ship’, else the accruals will be 
calculated at the phase the offer is applied). 

In case of Fully Accrued type of Budgets with accrue to is  ‘customer’, Budget, 
Committed and Earned columns are to be updated with the accrued amount. But 
in case of budgets with accrue to ‘Sales’, only Budget column will have to be 
updated. Committed and Earned should not be populated. This allows users to 
transfer money from Fully accrued budget to any other Fixed Budgets. If max cap 
is specified against the Fully accrued budget, the budget can be accumulated only 
to the level of max cap. 

Parameters: p_run_exception. Set to Y to run Order Management Except Queue.

AMS-TM: 
Import 
Territory 
Hierarchy

Yes This concurrent program uploads the hierarchy data from jtf_territories to AMS 
schema to be able to perform budget allocation to that territory hierarchy. The 
concurrent program expects a hierarchy id meaning which particular hierarchy 
the user wants to import.

Parameters: Hierarchy Id

AMS-TM: 
Release 
Committed 
Budget 
Amount After 
Grace Period

Yes A budget has been committed for an offer or any other activity. The Activity or 
offer date has ended or the offer is going to be closed or canceled. There might be 
a situation that the budget has not been utilized completely. This feature can be 
implemented through a concurrent process would return back the unused 
committed amount back to the sourcing budget. If there is a grace period, release 
of committed amount from a fixed type fund would take place whenever a offer is 
closed or canceled after the attainment of the grace period. 

Parameters: p_object_type (Object Type, for example, CAMP, OFFR, EVEH)

AMS-TM: 
Validate 
Budget 
Thresholds

Yes Threshold Alert provides the feature to monitor over spending or under spending 
from time to time. The concurrent program performs the automatic process of 
verification and notifies the owner of the budget on over & under utilization.

Parameters: None

AMS-TM 
Utilize 
Lumpsum 
Offers

Yes A user initiated background process that will account budget utilizations against 
lumpsum offer whenever the offer start date arrives rather than on offer approved 
or created date. 

In case when the Offer is active on the date when Offer was created, then the 
budget utilization will be updated immediately.

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)

Concurrent 
Manager Required Description
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AMS-TM: 
Claims Aging 
Population 

Yes Claims aging program populates the summary table for the claims aged by 
customer for an aging bucket. Aging will be run based on the system date. This 
program has to be run on a daily basis to get the daily aging analysis for the 
customers. 

Claims may be aged using a future type. This type will display claims that will 
become due, based on the Due Date, the specified number of days in the future.

Parameter: Aging bucket defined in Oracle Receivables

AMS-TM: 
Claims 
Autopay

Yes Autopay program is used to pay accruals on a regular basis to customers. 
Autopay can be set up to pay accruals based on a customer, budget, campaign or 
offer.

Parameters:

■ Customer

■ Budget

■ Offer

■ Campaign

AMS-TM: 
Claims 
Settlement 
Fetcher 

Yes Settlement fetcher gets the settlement data created in receivables and payables 
after settling a claim. Claim settlement on a manual claims gets created through 
autoinvoice or payables invoice import. These are programs which run on a batch 
mode and after the actual payment gets created in receivables or payables, 
settlement fetcher has to be run to get the settlement data to be shown in claims.

Parameters: None

AMS-TM: 
Import Claims 

Yes Import Claims imports the data from interface tables into claims. This program 
runs through the standard validations for claims creation and rejects the claims 
that are not successful for import.

Parameters: None

AMS-TM: 
Perform 
Recalculated 
Commitment 
for Offers

Optional Performs recalculation of committed budget for offers.

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)

Concurrent 
Manager Required Description
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AMS-TM: 
Transfer to 
General 
Ledger 

Yes Transfer to General Ledger is run to transfer the sub-ledger accounting entries 
created by claims/accruals into General Ledger accounting tables. 

Parameters:

■ Selection Type (1-Batch Transfer)

■ Set Of Books - Primary set of books 

■ Transfer Reporting Books - Yes/No

■ Batch Name - Name of batch for transfer

AMS Update 
Data Mining 
Models

Optional Updates detail information collected on parties. The frequency should be the same 
as the BIC Summary Extraction process.

AMS Web 
Execution: 
Specialty 
Store Items 
Refresh 
Program

Yes This refreshes the denormalized table for minisites periodically to capture items in 
the iStore minisites.

AMS Web 
Execution: 
Campaign 
Items Refresh 
Program

Yes Information about Campaigns is stored in multiple tables. To improve runtime 
performance, this program periodically collects required information on 
campaigns and places it into a single table.

AMS Web 
Execution: 
Refresh Offer 
Parties and 
Products

Yes This program loads offer party and product information into denormalized tables. 
This information will be used in validating budget eligibility and Web offer 
recommen- dations.

AutoInvoice - 
Oracle 
Receivables

Yes AutoInvoice is an Oracle Receivables concurrent program used to create credit 
memos/debit memos in receivables. It is used for creating credit memos on 
settling manual claims. Claims settled with receivables payment method gets 
created with the batch source defined in system parameters. For more information 
on parameters and options see the Oracle Receivables Implementation Guide.

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)

Concurrent 
Manager Required Description
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BIM: Load 
Marketing 
Facts for the 
First Time

Optional Loads all Facts for the first time. Repeat for each object: Campaign, Event, Budget, 
Leads, Lead Import and Response.

Parameters:

Start Date

End Date

Part of the Request Set:  BIM: Load Marketing Facts for the First Time

BIM: Load 
Marketing 
Facts from the 
Previous 
Refresh Date

Optional Loads all Facts from the Previous Refresh Date. Repeat for each object: Campaign, 
Event, Budget, Leads, Lead Import and Response.

Parameters:

Start Date

End Date

Part of the Request Set: BIM: Load Marketing Facts from the Previous Refresh 
Date

BIM: Load 
Key 
Performance 
Indicator 
Facts

Optional Loads KPI Facts.

Part of the Request Set:  BIM: Load Marketing Facts for the First Time

BIM: Initial 
build of 
Campaigns 
Materialized 
Views

Optional Prepares pre-built tables for Campaign Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Initial build of Materialized Views

BIM: Initial 
build of 
Events 
Materialized 
Views

Optional Prepares pre-built tables for Events Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Initial build of Materialized Views

BIM: Initial 
build of 
Budgets 
Materialized 
Views

Optional Prepares pre-built tables for Budgets Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Initial build of Materialized Views

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)
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BIM: Initial 
build of 
Interaction 
History 
Materialized 
Views

Optional Prepares pre-built tables for Interaction History Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Initial build of Materialized Views

BIM: Initial 
build of Key 
Performance 
Indicators 
Materialized 
Views

Optional Prepares pre-built tables for Key Performance Indicators Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set:  BIM: Initial build of Materialized Views

BIM: Initial 
build of Leads 
Quality 
Materialized 
Views

Optional Prepares pre-built tables for Leads Quality Materialized Views

Part of the Request Set: BIM: Initial build of Materialized Views - Lead Intelligence

BIM: Initial 
build of Leads 
Sources 
Materialized 
Views

Optional Prepares pre-built tables for Leads Sources Materialized Views

Part of the Request Set: BIM: Initial build of Materialized Views - Lead Intelligence

BIM: Initial 
build of Lead 
Import 
Materialized 
Views

Optional Prepares pre-built tables for Lead Import Materialized Views

Part of the Request Set: BIM: Initial build of Materialized Views - Lead Intelligence

BIM: Initial 
build of 
Responses 
Materialized 
Views

Optional Prepares pre-built tables for Responses Materialized Views

Part of the Request Set: BIM: Initial build of Materialized Views - Lead Intelligence

BIM: Refresh 
Campaign 
Materialized 
Views

Optional Builds Campaigns Materialized views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set: BIM: Refresh of Materialized Views

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)
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BIM: Refresh 
Events 
Materialized 
Views

Optional Builds Events Materialized views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set: BIM: Refresh of Materialized Views

BIM: Refresh 
Budgets 
Materialized 
Views

Optional Builds Budgets Materialized views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set: BIM: Refresh of Materialized Views

BIM: Refresh 
of Interaction 
History 
Materialized 
Views

Optional Builds Interaction History Materialized views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set: BIM: Refresh of Materialized Views

BIM: Refresh 
Key 
Performance 
Indicators 
Materialized 
Views

Optional Builds Key Performance Indicators Materialized views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set: BIM: Refresh of Materialized Views

BIM: Refresh 
Marketing 
Activities 
Materialized 
Views

Optional Builds Marketing Activities Materialized Views

Parameters:

Number of Parallel Processors: 4

Part of the Request Set: BIM: Refresh of Materialized Views

BIM: Refresh 
of Summary 
by Group 
Hierarchy

Optional Builds summarized tables based on group hierarchy.

Part of the Request Set: BIM: Refresh of Materialized Views - Lead Intelligence

BIM: Refresh 
of Leads KPI 
Materialized 
Views

Optional Builds Leads KPI Materialized Views.

Part of the Request Set: BIM: Refresh of Materialized Views - Lead Intelligence

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)
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BIM: Refresh 
of Leads 
Quality 
Materialized 
Views

Optional Builds Leads Quality Materialized Views.

Part of the Request Set: BIM: Refresh of Materialized Views - Lead Intelligence

BIM: Refresh 
of Leads 
Sources 
Materialized 
Views

Optional Builds Leads Sources Materialized Views.

Part of the Request Set: BIM: Refresh of Materialized Views - Lead Intelligence

BIM: Refresh 
of Lead 
Import 
Materialized 
Views

Optional Builds Lead Import Materialized Views.

Part of the Request Set: BIM: Refresh of Materialized Views - Lead Intelligence

BIM: Refresh 
of Responses 
Materialized 
Views

Optional Builds Responses Materialized Views.

Part of the Request Set: BIM: Refresh of Materialized Views - Lead Intelligence

BIM: Load 
Marketing 
Facts from 
previous 
refresh date

Optional Loads all facts from the previous refresh date. Repeat for each object: Campaign, 
Event, Budget.

Parameters:

Object to Load: Campaign

End Date

Number of Parallel Processors: 4

Part of the Request Set: Load Marketing Facts from previous refresh date

BIM: Load 
Key 
Performance 
Indicator facts 
from previous 
refresh date

Optional Loads all KPI facts from the previous refresh Date.

Initial Build of 
Campaigns 
mvs 

- Obsolete in Release 7.

Replaced by BIM: Initial Build of Campaigns Materialized Views.

Initial Build of 
Events mvs

- Obsolete in Release 7.

Replaced by BIM: Initial Build of Events Materialized Views.

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)
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Initial Build of 
Funds mvs

- Obsolete in Release 7.

Replaced by BIM: Initial Build of Budgets Materialized Views.

Load 
Geographic 
Hierarchies

Yes This program must be run each time that the geographies are changed.

Marketing 
Facts Load

- Obsolete in Release 7.

Replaced by BIM: Load Marketing Facts for the First Time.

Marketing 
Materialized 
views prebuilt 
tables (AMS)

- Obsolete in Release 7.

Replaced by BIM: Initial Build of Materialized Views

Marketing 
Materialized 
views Refresh 
(AMS)

- Obsolete in Release 7.

Replaced by BIM: Refresh Materialized Views

Payables 
Open 
Interface 
Import - 
Oracle 
Payables

Yes Payables open interface import is an Oracle Payables concurrent program used to 
create invoices in payables. It has to be run for the batch source defined in system 
parameters since all the claims settlement for payables get created with that batch 
source. For more information on parameters and options see the Oracle Payables 
Implementation Guide.

Refresh of 
Campaigns 
mvs

- Obsolete in Release 7.

Replaced by BIM: Refresh Campaigns Materialized Views.

Refresh of 
Events mvs

- Obsolete in Release 7.

Replaced by BIM: Refresh Events Materialized Views.

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)
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Refresh of 
Funds mvs

- Obsolete in Release 7.

Replaced by BIM: Refresh Budgets Materialized Views.

Workflow 
Background 
Process

Required The System Administrator must run this program. 

For lists purposes, this background process makes a list active. It populates List 
generation and target group generation data. For list generation, it requires the 
following parameters: 

■ Item Type: AMS List Generation   

■ Yes Process Timeout : yes

■ Process Stuck: yes 

■ Ignore Minimum and Maximum Thresholds

For data mining, this process must be run with the following parameters: 

■ Item Type: AMS Data Mining - Build/Score/Preview

■ Minimum Threshold: Leave blank.

■ Maximum Threshold: Leave blank.  

■ Process Deferred: Yes

■ Process Timeout: Yes

■ Process Stuck: Yes

For the Workflow daemon to monitor data mining workflow requests, a frequency 
of 30 minutes should be sufficient.

For budget approval purposes, the workflow background process must run with 
the following parameters: 

■ Set Item Type: AMS Marketing Approvals

■ Minimum Threshold: Leave blank.

■ Maximum Threshold: Leave blank.

■ Process Deferred: Yes

■ Process Timeout: Yes

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)
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Trigger 
Workflow 
Process

Yes The Trigger Workflow process is associated with an item type called OMO 
Triggers. This item type identifies all workflow processes that are needed to 
enable the Marketing Trigger functionality.

Currently there are four different processes in the OMO Triggers item type:

Trigger Process: The main process -- getting run as a subscription to the

Workflow Business Event OMO Trigger Event

(oracle.apps.ams.trigger.TriggerEvent). 

The following processes are sub flows of this main process flow.

– Perform All Actions

– Execute Schedule

– Schedule Approval

For more information see Oracle Marketing Release Note for Trigger Enhancement.

Table C–2 Oracle Marketing Concurrent Manager Programs (Cont.)
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D
Oracle Marketing List Import Field

Reference

This appendix provides tables of all of the List Import table fields used by Oracle 
Marketing. 

Topics include:

■ Section D.1, "B2B List Import Fields"

■ Section D.2, "B2C List Import Fields"

■ Section D.3, "Event List Import Fields"

■ Section D.4, "Lead List Import Fields" 
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D.1 B2B List Import Fields
The following sections describe the fields which can be used in list import. There 
are four sections B2B List Import, B2C List Import, Event Import and Lead Import.

Table D–1 B2B List Import Fields 

Field in Import File Data Type Table Name

Import 
Requires 
Entry Column Name

ADDRESS LINES 
PHONETIC

VARCHAR2(150) HZ_LOCATIONS No ADDRESS LINES 
PHONETIC

ADDRESS1 VARCHAR2(150) HZ_LOCATIONS No ADDRESS1

ADDRESS2 VARCHAR2(150) HZ_LOCATIONS No ADDRESS2

ADDRESS3 VARCHAR2(150) HZ_LOCATIONS No ADDRESS3

ADDRESS4 VARCHAR2(150) HZ_LOCATIONS No ADDRESS4

ANALYSIS_FY VARCHAR2 HZ_
ORGANIZATION
_PROFILES

No ANALYSIS_FY

CATEGORY CODE VARCHAR2 HZ_PARTIES No CATEGORY CODE

CEO NAME VARCHAR2(50) HZ_
ORGANIZATION
_PROFILES

No CEO NAME

CITY VARCHAR2(60) HZ_LOCATIONS No CITY

COUNTRY VARCHAR2(60) HZ_LOCATIONS No COUNTRY

COUNTY VARCHAR2(60) HZ_LOCATIONS No -

‘COUNTRY’ - - - -

CREATED BY NUMBER HZ_PARTIES No CREATED BY

CREATION DATE DATE HZ_PARTIES No CREATION DATE

CURR FY POTENTIAL 
REVENUE

NUMBER HZ_
ORGANIZATION
_PROFILES

No CURR FY POTENTIAL 
REVENUE

DECISION MAKER 
FLAG

VARCHAR2(1) HZ_ORG_
CONTACTS

No DECISION MAKER 
FLAG

DEDUPE KEY VARCHAR2(150) HZ_PARTIES No DEDUPE KEY
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DEPARTMENT VARCHAR2(60) HZ_ORG_
CONTACTS

No DEPARTMENT

DUNS NUMBER NUMBER HZ_
ORGANIZATION
_PROFILES

No DUNS NUMBER

EMAIL ADDRESS VARCHAR2(150) HZ_CONTACT_
POINTS

No EMAIL ADDRESS

EMPLOYEES TOTAL NUMBER HZ_
ORGANIZATION
_PROFILES

No EMPLOYEES TOTAL

FISCAL YEAREND 
MONTH

VARCHAR2(30) HZ_PARTIES No FISCAL YEAREND 
MONTH

FLOOR VARCHAR2 HZ_LOCATIONS No FLOOR

GSA INDICATOR FLAG VARCHAR2 HZ_PARTIES No GSA INDICATOR FLAG

HOUSE NUMBER VARCHAR2 HZ_LOCATIONS No HOUSE NUMBER

IMPORT LIST HEADER 
ID

NUMBER AMS_IMP_
SOURCE_LINES

No IMPORT LIST HEADER 
ID

IMPORT SOURCE LINE 
ID

NUMBER AMS_IMP_
SOURCE_LINES

No IMPORT SOURCE LINE 
ID

JGZZ FISCAL CODE VARCHAR2 HZ_PARTIES No JGZZ FISCAL CODE

JOB TITLE VARCHAR2(60) HZ_ORG_
CONTACTS

No JOB TITLE

LAST UPDATE DATE DATE AMS_IMP_
SOURCE_LINES

No LAST UPDATE DATE

LAST UPDATE LOGIN NUMBER AMS_IMP_
SOURCE_LINES

No LAST UPDATE LOGIN

LAST UPDATED BY NUMBER AMS_IMP_
SOURCE_LINES

No LAST UPDATED BY

LEGAL STATUS VARCHAR2(30) HZ_PARTIES No LEGAL STATUS

LINE OF BUSINESS VARCHAR2(30) HZ_PARTIES No LINE OF BUSINESS

MISSING STATEMENT VARCHAR2 HZ_PARTIES No MISSING STATEMENT

NEXT FY POTENTIAL 
REVENUE

NUMBER HZ_PARTIES No NEXT FY POTENTIAL 
REVENUE

Table D–1 B2B List Import Fields (Cont.)
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NOTES VARCHAR2(4000) AMS_IMP_
SOURCE_LINES

No NOTES

ORGANIZATION 
NAME PHONETIC

VARCHAR2 HZ_PARTIES No ORGANIZATION 
NAME PHONETIC

PARTY NAME VARCHAR2(150) HZ_PARTIES Yes PARTY NAME

PERSON FIRST NAME VARCHAR2(150) HZ_PARTIES No PERSON FIRST NAME

PERSON LAST NAME VARCHAR2(150) HZ_PARTIES No PERSON LAST NAME

PERSON MIDDLE 
NAME

VARCHAR2(60) HZ_PARTIES No PERSON MIDDLE 
NAME

PERSON NAME SUFFIX VARCHAR2(30) HZ_PARTIES No PERSON NAME SUFFIX

PERSON TITLE VARCHAR2(60) HZ_PARTIES No PERSON TITLE

PHONE AREA CODE VARCHAR2(10) HZ_CONTACT_
POINTS

No PHONE AREA CODE

PHONE COUNTRY 
CODE

VARCHAR2(10) HZ_CONTACT_
POINTS

No PHONE COUNTRY 
CODE

PHONE EXTENTION VARCHAR2(20) HZ_CONTACT_
POINTS

No PHONE EXTENTION

PHONE NUMBER VARCHAR2(40) HZ_CONTACT_
POINTS

No PHONE NUMBER

PO BOX NUMBER - HZ_LOCATIONS No PO BOX NUMBER

POSTAL CODE VARCHAR2(60) HZ_LOCATIONS No POSTAL CODE

POSTAL PLUS4 CODE - HZ_LOCATIONS No POSTAL PLUS4 CODE

PROVINCE VARCHAR2(60) HZ_LOCATIONS No PROVINCE

SALES AGENT LOGIN 
ID

VARCHAR2(2000) AMS_IMP_
SOURCE_LINES

No SALES AGENT LOGIN 
ID

SIC CODE VARCHAR2 HZ_
ORGANIZATION
_PROFILES

No SIC CODE

SIC CODE TYPE VARCHAR2 HZ_
ORGANIZATION
_PROFILES

No SIC CODE TYPE

SITE USE TYPE VARCHAR2 HZ_
ORGANIZATION
_PROFILES

No SITE USE TYPE

Table D–1 B2B List Import Fields (Cont.)
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STATE VARCHAR2(60) HZ_LOCATIONS No STATE

STATE

STREET VARCHAR2 HZ_LOCATIONS No STREET

STREET NUMBER VARCHAR2 HZ_LOCATIONS No STREET NUMBER

STREET SUFFIX VARCHAR2 HZ_LOCATIONS No STREET SUFFIX

SUITE VARCHAR2 HZ_LOCATIONS No SUITE

TAX REFERENCE VARCHAR2(50) HZ_PARTIES No TAX REFERENCE

VEHICLE REPONSE 
CODE

VARCHAR2(30) AMS_IMP_
SOURCE_LINES

No VEHICLE REPONSE 
CODE

YEAR ESTABLISHED NUMBER(4) HZ_PARTIES No YEAR ESTABLISHED

ADDRESS EFFECTIVE 
DATE 

DATE HZ_LOCATIONS - ADDRESS EFFECTIVE 
DATE 

ADDRESS EXPIRATION 
DATE 

DATE HZ_LOCATIONS -  ADDRESS EXPIRATION

 DATE 

 BRANCH FLAG VARCHAR HZ_
ORGANIZATION
_PROFILES

-  BRANCH FLAG 

BUSINESS LINE VARCHAR HZ_
ORGANIZATION
_PROFILES

-    BUSINESS LINE 

BUSINESS SCOPE VARCHAR HZ_
ORGANIZATION
_PROFILES

-    BUSINESS SCOPE 

CHIEF EXECUTIVE 
TITLE 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- CHIEF EXECUTIVE 
TITLE 

 CONGRESSIONAL 
DISTRICT CODE 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- CONGRESSIONAL 
DISTRICT CODE 

CONTROL YEAR NUMBER HZ_
ORGANIZATION
_PROFILES

- CONTROL YEAR 

CORPORATION CLASS VARCHAR HZ_
ORGANIZATION
_PROFILES

-  CORPORATION CLASS 

Table D–1 B2B List Import Fields (Cont.)
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 CREDIT SCORE VARCHAR HZ_
ORGANIZATION
_PROFILES

-  CREDIT SCORE 

CREDIT SCORE 
COMMENTARY 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- CREDIT SCORE 
COMMENTARY 

DB RATING VARCHAR HZ_
ORGANIZATION
_PROFILES

- DB RATING 

DATE OF BIRTH DATE HZ_PERSON_
PROFILES

- DATE OF BIRTH 

DATE OF DEATH DATE HZ_PERSON_
PROFILES

- DATE OF DEATH 

DEBARMENTS COUNT NUMBER HZ_
ORGANIZATION
_PROFILES

- DEBARMENTS COUNT 

   DEBARTMENTS 
DATE 

DATE HZ_
ORGANIZATION
_PROFILES

- DEBARTMENTS DATE 

   DECLARED 
ETHNICITY 

VARCHAR HZ_PERSON_
PROFILES

- DECLARED ETHNICITY 

DEBARTMENT 
INDICATOR 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- DEBARTMENT 
INDICATOR 

DESCRIPTION VARCHAR HZ_LOCATIONS - DESCRIPTION 

   DISADVANTAGED 
INDICATOR 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- DISADVANTAGED 
INDICATOR 

ENQUIRY DUNS VARCHAR HZ_
ORGANIZATION
_PROFILES

- ENQUIRY DUNS 

EXPORT INDICATOR VARCHAR HZ_
ORGANIZATION
_PROFILES

- EXPORT INDICATOR 

FAILURE SCORE VARCHAR HZ_
ORGANIZATION
_PROFILES

-  FAILURE SCORE 

Table D–1 B2B List Import Fields (Cont.)
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FAILURE SCORE 
COMMENTARY 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- FAILURE SCORE 
COMMENTARY 

FAILURE SCORE NATL 
PERCENTILE 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- FAILURE SCORE NATL 
PERCENTILE 

FAILURE SCORE 
OVERRIDE CODE 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- FAILURE SCORE 
OVERRIDE CODE 

FISCAL CODE VARCHAR HZ_PARTIES - FISCAL CODE 

GLOBAL FAILURE 
SCORE 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- GLOBAL FAILURE 
SCORE 

HEADQUARTER 
BRANCH INDICATOR 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- HEADQUARTER 
BRANCH INDICATOR 

HEAD OF 
HOUSEHOLD FLAG 

VARCHAR HZ_PERSON_
PROFILES

- HEAD OF HOUSEHOLD 
FLAG 

HOUSEHOLD SIZE VARCHAR HZ_PERSON_
PROFILES

- HOUSEHOLD SIZE 

IMPORT INDICATOR VARCHAR HZ_
ORGANIZATION
_PROFILES

- IMPORT INDICATOR 

ORGANIZATION 
KNOWN AS 

VARCHAR HZ_PARTIES - ORGANIZATION 
KNOWN AS 

ORGANIZATION 
KNOWN AS2 

VARCHAR HZ_PARTIES - ORGANIZATION 
KNOWN AS2 

ORGANIZATION 
KNOWN AS3 

VARCHAR HZ_PARTIES - ORGANIZATION 
KNOWN AS3 

ORGANIZATION 
KNOWN AS4 

VARCHAR HZ_PARTIES -    ORGANIZATION 
KNOWN AS4 

ORGANIZATION 
KNOWN AS5 

VARCHAR HZ_PARTIES - ORGANIZATION 
KNOWN AS5 

 PERSON KNOWN AS VARCHAR HZ_PARTIES - PERSON KNOWN AS 

PERSON KNOWN AS2 VARCHAR HZ_PARTIES - PERSON KNOWN AS2 

PERSON KNOWN AS3 VARCHAR HZ_PARTIES -  PERSON KNOWN AS3 

Table D–1 B2B List Import Fields (Cont.)
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PERSON KNOWN AS4 VARCHAR HZ_PARTIES -  PERSON KNOWN AS4 

PERSON KNOWN AS5 VARCHAR HZ_PARTIES -  PERSON KNOWN AS5 

LABOR SURPLUS 
INDICATOR 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- LABOR SURPLUS 
INDICATOR 

LOCAL ACTIVITY 
CODE 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- LOCAL ACTIVITY 
CODE 

LOCAL ACTIVITY 
CODE TYPE 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- LOCAL ACTIVITY 
CODE TYPE 

LOCATION 
DIRECTIONS 

VARCHAR HZ_LOCATIONS - LOCATION 
DIRECTIONS 

LOCATION STATUS VARCHAR HZ_LOCATIONS - LOCATION STATUS 

MARITAL STATUS VARCHAR HZ_PERSON_
PROFILES

- MARITAL STATUS 

MARITAL STATUS 
EFFECTIVE DATE 

DATE HZ_PERSON_
PROFILES

- MARITAL STATUS 
EFFECTIVE DATE 

MINORITY OWNED 
INDICATOR 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- MINORITY OWNED 
INDICATOR 

MINORITY OWNED 
TYPE 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- MINORITY OWNED 
TYPE 

ORGANIZATION 
ALIAS 

VARCHAR HZ_PARTIES - ORGANIZATION 
ALIAS 

ORGANIZATION TYPE VARCHAR HZ_PARTIES - ORGANIZATION TYPE 

ORGANIZATION URL VARCHAR HZ_PARTIES - ORGANIZATION URL 

OUT OF BUSINESS 
INDICATOR 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- OUT OF BUSINESS 
INDICATOR 

PERSONAL INCOME NUMBER HZ_PERSON_
PROFILES

- PERSONAL INCOME 

PERSON ACADEMIC 
TITLE 

VARCHAR HZ_PERSON_
PROFILES

- PERSON ACADEMIC 
TITLE 

Table D–1 B2B List Import Fields (Cont.)
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PERSON FIRST NAME 
PHONETIC 

VARCHAR HZ_PARTIES - PERSON FIRST NAME 
PHONETIC 

PERSON LAST NAME 
PHONETIC 

VARCHAR HZ_PARTIES - PERSON LAST NAME 
PHONETIC 

MIDDLE NAME 
PHONETIC 

VARCHAR HZ_PARTIES - MIDDLE NAME 
PHONETIC 

PERSON NAME 
PHONETIC 

VARCHAR HZ_PARTIES - PERSON NAME 
PHONETIC 

PERSON PREVIOUS 
TITLE NAME 

VARCHAR HZ_PARTIES - PERSON PREVIOUS 
TITLE NAME 

PLACE OF BIRTH VARCHAR HZ_PERSON_
PROFILES

- PLACE OF BIRTH 

PRINCIPAL NAME VARCHAR HZ_
ORGANIZATION
_PROFILES

- PRINCIPAL NAME 

PRINCIPAL TITLE VARCHAR HZ_
ORGANIZATION
_PROFILES

- PRINCIPAL TITLE 

PUBLIC PRIVATE 
OWNERSHIP FLAG 

VARCHAR HZ_
ORGANIZATION
_PROFILES

-  OWNERSHIP FLAG 

RENT OWNED 
INDICATOR 

VARCHAR HZ_PERSON_
PROFILES

- RENT OWNED 
INDICATOR 

SECOND TITLE VARCHAR HZ_PERSON_
PROFILES

- PERSON ACADEMIC 
TITLE

 SHORT DESCRIPTION VARCHAR HZ_LOCATIONS - SHORT DESCRIPTION 

SMALL BUSINESS 
INDICATOR 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- SMALL BUSINESS 
INDICATOR 

TAX ID VARCHAR HZ_PERSON_
PROFILES

- TAX REFERENCE

WOMAN OWNED 
INDICATOR 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- WOMAN OWNED 
INDICATOR 

ORGANIZATION 
ATTRIBUTE1 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE1

Table D–1 B2B List Import Fields (Cont.)
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ORGANIZATION 
ATTRIBUTE2 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE2

ORGANIZATION 
ATTRIBUTE3 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE3

ORGANIZATION 
ATTRIBUTE4 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE4

ORGANIZATION 
ATTRIBUTE5 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE5

ORGANIZATION 
ATTRIBUTE6 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE6

ORGANIZATION 
ATTRIBUTE7 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE7

ORGANIZATION 
ATTRIBUTE8 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE8

ORGANIZATION 
ATTRIBUTE9 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE9

ORGANIZATION 
ATTRIBUTE10 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE10

ORGANIZATION 
ATTRIBUTE11 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE11

ORGANIZATION 
ATTRIBUTE12 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE12

ORGANIZATION 
ATTRIBUTE13 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE13

ORGANIZATION 
ATTRIBUTE14 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE14
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ORGANIZATION 
ATTRIBUTE15 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ATTRIBUTE15

ORG CONTACT 
ATTRIBUTE1 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE1

ORG CONTACT 
ATTRIBUTE2 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE2

 ORG CONTACT 
ATTRIBUTE3 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE3

 ORG CONTACT 
ATTRIBUTE4 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE4

ORG CONTACT 
ATTRIBUTE5 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE5

ORG CONTACT 
ATTRIBUTE6 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE6

ORG CONTACT 
ATTRIBUTE7 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE7

ORG CONTACT 
ATTRIBUTE8 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE8

ORG CONTACT 
ATTRIBUTE9 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE9

ORG CONTACT 
ATTRIBUTE10 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE10

ORG CONTACT 
ATTRIBUTE11 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE11

ORG CONTACT 
ATTRIBUTE12 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE12

 ORG CONTACT 
ATTRIBUTE13 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE13

ORG CONTACT 
ATTRIBUTE14 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE14

ORG CONTACT 
ATTRIBUTE15 

VARCHAR HZ_ORG_
CONTACTS

- ATTRIBUTE15

ADDRESS ATTRIBUTE1 VARCHAR HZ_LOCATIONS - ATTRIBUTE1

ADDRESS ATTRIBUTE2 VARCHAR HZ_LOCATIONS - ATTRIBUTE2

Table D–1 B2B List Import Fields (Cont.)
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ADDRESS ATTRIBUTE3 VARCHAR HZ_LOCATIONS - ATTRIBUTE3

ADDRESS ATTRIBUTE4 VARCHAR HZ_LOCATIONS - ATTRIBUTE4

ADDRESS ATTRIBUTE5 VARCHAR HZ_LOCATIONS - ATTRIBUTE5

 ADDRESS 
ATTRIBUTE6 

VARCHAR HZ_LOCATIONS - ATTRIBUTE6

ADDRESS ATTRIBUTE7 VARCHAR HZ_LOCATIONS - ATTRIBUTE7

ADDRESS ATTRIBUTE8 VARCHAR HZ_LOCATIONS - ATTRIBUTE8

ADDRESS ATTRIBUTE9 VARCHAR HZ_LOCATIONS - ATTRIBUTE9

ADDRESS 
ATTRIBUTE10 

VARCHAR HZ_LOCATIONS - ATTRIBUTE10

ADDRESS 
ATTRIBUTE11 

VARCHAR HZ_LOCATIONS - ATTRIBUTE11

ADDRESS 
ATTRIBUTE12 

VARCHAR HZ_LOCATIONS - ATTRIBUTE12

ADDRESS 
ATTRIBUTE13 

VARCHAR HZ_LOCATIONS - ATTRIBUTE13

ADDRESS 
ATTRIBUTE14 

VARCHAR HZ_LOCATIONS - ATTRIBUTE14

ADDRESS 
ATTRIBUTE15 

VARCHAR HZ_LOCATIONS - ATTRIBUTE15

FAX COUNTRY CODE VARCHAR HZ_CONTACT_
POINTS

- FAX COUNTRY CODE 

FAX AREA CODE VARCHAR HZ_CONTACT_
POINTS

- FAX AREA CODE 

FAX NUMBER VARCHAR HZ_CONTACT_
POINTS

- FAX NUMBER 

ORG ATTRIBUTE 
CATEGORY 

VARCHAR HZ_
ORGANIZATION
_PROFILES

- ORG ATTRIBUTE 

CATEGORY 

ORG CONTACT 
ATTRIBUTE 
CATEGORY 

VARCHAR HZ_ORG_
CONTACTS

- ORG CONTACT 

ATTRIBUTE CATEGORY 

Table D–1 B2B List Import Fields (Cont.)
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D.2 B2C List Import Fields
The following table indicates B2C List Import Fields.   
 

ADDRESS ATTRIBUTE 
CATEGORY 

VARCHAR HZ_LOCATIONS - ADDRESS ATTRIBUTE 

CATEGORY 

PARTY SITE USE VARCHAR HZ_PARTY_SITE_
USES

- PARTY SITE USE 

ORIGINAL SYSTEM 
REFERENCE

VARCHAR HZ_PARTIES - ORIG SYSTEM 

REFERENCE

Table D–2 B2C List Import Fields 

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments

ADDRESS_LINES_
PHONETIC

VARCHAR2 No No - -

ADDRESS1 VARCHAR2(150) No No - Required every 
time if address is 
required.

ADDRESS2 VARCHAR2(150) No No - -

ADDRESS3 VARCHAR2 No No - -

ADDRESS4 VARCHAR2 No No - -

CITY VARCHAR2(60) No No Select distinct 
location_segment_
description, 
location_segment_
user_value from ar_
location_values 
where location_
segment_qualifier = 

‘CITY’

-

Table D–1 B2B List Import Fields (Cont.)
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COUNTRY VARCHAR2(60) No No Select territory_
short_name, 
territory_code, 
description from 
fnd_territories_vl

Required only if 
any of address 
columns are 
provided in the 
data file.

COUNTY VARCHAR2(60) No No Select distinct 
location_segment_
description, 
location_segment_
user_value from ar_
location_values 
where location_
segment_qualifier = 

‘COUNTRY’

-

CREATED_BY NUMBER Yes No - Populated by the 
list import 
program.

CREATION_DATE DATE Yes No - Populated by the 
list import 
program.

DEDUPE_KEY VARCHAR2(150) No No - Populated by the 
list import 
program.

EMAIL_ADDRESS VARCHAR2(150) No No - -

FLOOR No No - -

GENDER VARCHAR2(30) No No - -

HOUSE_NUMBER No No - -

HOUSEHOLD_
INCOME

NUMBER No No - -

IMPORT_LIST_
HEADER_ID

NUMBER Yes No - Auto Generated

IMPORT_SOURCE_
LINE_ID

NUMBER Yes No - Auto Generated

IMPORT_
SUCCESSFUL_FLAG

VARCHAR2(1) No No -

Table D–2 B2C List Import Fields (Cont.)

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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LAST_UPDATE_DATE DATE Yes No - Populated by the 
list import 
program.

LAST_UPDATE_LOGIN NUMBER Yes No - Populated by the 
list import 
program. 

LAST_UPDATED_BY NUMBER Yes No - Populated by the 
list import 
program.

NOTES VARCHAR2(400
0)

No No - -

OBJECT_VERSION_
NUMBER

NUMBER Yes No - Populated by the 
list import 
program.

PERSON_FIRST_NAME VARCHAR2(150) No Yes - This is a required 
column in the 
data file for B2C 
type of data 

PERSON_LAST_NAME VARCHAR2(150) No Yes - This is a required 
column in the 
data file for B2C 
type of data

PERSON_MIDDLE_
NAME

VARCHAR2(60) No No - -

PERSON_NAME_
SUFFIX

VARCHAR2(30) No No - -

PERSON_PRE_NAME_
ADJUNCT

No No - -

PERSON_TITLE VARCHAR2(60) No No - -

PHONE_AREA_CODE VARCHAR2(10) No No - -

PHONE_COUNTRY_
CODE

VARCHAR2(10) No No - -

PHONE_EXTENTION VARCHAR2(20) No No - -

Table D–2 B2C List Import Fields (Cont.)

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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PHONE_NUMBER VARCHAR2(40) No No - Required if any 
of the phone 
information is 
provided.

PO_BOX_NUMBER VARCHAR2 No No - -

POSTAL_CODE VARCHAR2(60) No No Select min(p.from_
postal_code), 

Max(p.to_postal_
code) from

Ar_postal_code_
ranges_v p,

Ar_location_values 
a where

p.location_segment_
id = a.location_
segment_id and 
a.location_segment_
qualifier

= ‘CITY’ and 
a.location_segment_
value like ‘X%’

-

POSTAL_PLUS4_CODE No No - -

PROVINCE VARCHAR2(60) No No Select distinct 
location_segment_
description, 
location_segment_
user_value from ar_
location_values 
where location_
segment_qualifier = 

‘PROVINCE’

-

SALES_AGENT_
LOGIN_ID

VARCHAR2(200
0)

No No - -

SALUTATION VARCHAR2 No No - -

SITE_USE_TYPE VARCHAR2 No No - -

Table D–2 B2C List Import Fields (Cont.)

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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D.3 Event List Import Fields
Following table shows the mapping for Event registration import. Note that only 
Event Source code is a required field. But many other fields are conditionally 
required. 

1. If the Party ID and Contact ID are provided in the csv file, the import will not 
create party but will use the ids provided in the csv and register them. 

2. If the Party ID and Contact ID are not provided, then registrant first name, last 
name and email address are required as the import program will use those 
fields to create the party and register them. If the Attendant first name, last 
name and email address are not provided in the csv file, the import program 
will use the details from the registrant fields for attendant information. 

STATE VARCHAR2(60) No No Select distinct 
location_segment_
description, 
location_segment_
user_value from ar_
location_values 
where location_
segment_qualifier = 

‘STATE’

-

STREET VARCHAR2 No No - -

STREET_NUMBER VARCHAR2 No No - -

STREET_SUFFIX VARCHAR2 No No - -

SUITE VARCHAR2 No No - -

VEHICLE_RESPONSE_
CODE

VARCHAR2(30) No No - Based on lookup 
AMS_Vehicle_
Response_Code

Table D–2 B2C List Import Fields (Cont.)

Table Column / Field in 
Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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Table D–3 Event List Import Fields 

Table Column / Field 
in Import File Data Type Valid Values Comments

Table 
Name Column Name

EVENT_SOURCE_
CODE/ Event Source 
Code

Table Entry Required: 
Yes

Import Entry 
Required: Yes

VARCHAR2 
(100)

Source code for 
Event - how the 
Event being 
registered for is 
identified.

ams_
Event_
registration
s

SOURCE_CODE

REGISTRATION_
SOURCE_TYPE/ 
Registration Source 
Type

VARCHAR2(30
)

Lookup 
AMS_
EVENT_
REG_
SOURCE

How the party 
registered for the 
Event (Web, 
phone, etc.).

ams_
Event_
registration
s

REG_SOURCE_
TYPE_CODE

ATTENDANCE_
FLAG/ Attendance 
Flag

VARCHAR2(1) Y/N Whether or not the 
party has attended 
the Event.

ams_
Event_
registration
s

ATTENDED_
FLAG

WAITLISTED_
FLAG/ Waitlisted 
Flag

VARCHAR2(1) Y/N Whether or not to 
force the system to 
waitlist the party 
or not waitlist the 
party. If null, the 
system will 
waitlist if 
registrations are 
full.

ams_
Event_
registration
s

SYSTEM_
STATUS_CODE (If 
the waitlisted_flag 
is "Y" then 
registration status 
will be Waitlisted).

CANCELLATION_
FLAG/ Cancellation 
Flag

VARCHAR2(1) Y/N Whether or not to 
cancel the party’s 
registration.

ams_
Event_
registration
s

SYSTEM_
STATUS_CODE (If 
the cancellation 
flag is "Y" then 
registration status 
will be cancelled).

CANCELLATION 
REASON_CODE/ 
Cancellation Reason

VARCHAR2(30
)

Lookup 
AMS_
EVNT_
REG_
CANCEL_
REASON

The reason for 
cancellation.

ams_
Event_
registration
s

CANCELLATION
_REASON_CODE
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CONFIRMATION_
CODE/ Confirmation 
Code

VARCHAR2(30
)

- This code will 
uniquely identify 
any registration.

ams_
Event_
registration
s

CONFIRMATION
_CODE

ORIGINAL_
SYSTEM_
REFERENCE/ 
Original System 
Reference

VARCHAR2 
(240)

- The original 
system reference 
of the registration

hz_parties ORG_SYSTEM_
REFERENCE

REG_PARTY_ID/ 
Registrant Party ID

Table Entry Required: 
Yes

NUMBER - The party id 
corresponding to 
the registrant 
(B2C) or the 
registrant’s 
company (B2B).

hz_parties PARTY_ID

REG_PARTY_TYPE/ 
Registrant Party Type

VARCHAR2(30
)

Fnd_
Lookups_
Party_Type

The Party Type of 
the registrant’s 
company

hz_parties PARTY_TYPE

REG_CONTACT_
ID/ Registrant 
Contact ID

Table Entry Required: 
Yes

NUMBER - The party ID 
corresponding to 
the registrant

hz_parties PARTY_ID

REG_PARTY_
NAME/ Registrant 
Party Name

VARCHAR2 
(360)

- The name of the 
registrant’s 
company (forces 
B2B).

hz_parties PARTY_NAME

REG_TITLE/ 
Registrant Title

VARCHAR2(30
)

- Title (Mr. Ms.) of 
the registrant

hz_org_
contacts

TITLE

REG_FIRST_NAME/ 
Registrant First Name

Table Entry Required: 
Yes

VARCHAR2 
(150)

- First Name of 
registrant

hz_parties PERSON_FIRST_
NAME

REG_MIDDLE_
NAME/ Registrant 
Middle Name

VARCHAR2(60
)

- Middle name of 
registrant

hz_parties PERSON_
MIDDLE NAME

Table D–3 Event List Import Fields (Cont.)

Table Column / Field 
in Import File Data Type Valid Values Comments

Table 
Name Column Name
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REG_LAST_NAME/ 
Registrant Last Name

Table Entry Required: 
Yes

VARCHAR2 
(150)

- Last Name of 
registrant

hz_parties PERSON_LAST_
NAME

REG_ADDRESS1/ 
Registrant Address1

VARCHAR2 
(240)F

- Address (first line) 
of the registrant

hz_parties ADDRESS1

REG_ADDRESS2/ 
Registrant Address1

VARCHAR2 
(240)F

- Address (second 
line) of the 
registrant

hz_parties ADDRESS2

REG_ADDRESS3/ 
Registrant Address1

VARCHAR2 
(240)F

- Address (third 
line) of the 
registrant

hz_parties ADDRESS3

REG_ADDRESS4/ 
Registrant Address1

VARCHAR2 
(240)F

- Address (fourth 
line) of the 
registrant

hz_parties ADDRESS4

REG_GENDER/ 
Registrant Gender

VARCHAR2(30
)

- Gender of the 
registrant

hz_person_
profiles

GENDER

REG_ADDRESS_
LINE_PHONETIC/ 
Registrant Address 
Line Phonetic

VARCHAR2 
(360)

- Phonetic address 
of the registrant

hz_
locations

ADDRESS_
LINES_
PHONETIC

REG_ANALYSIS_
FY/ Registrant 
Analysis FY

VARCHAR2(5) - FY analysis for the 
registrant

hz_parties ANALYSIS _FY

REG_APT_FLAG/ 
Registrant Apt Flag

VARCHAR2(1) - Whether or not the 
registrant’s 
address is an 
apartment

hz_
locations

APARTMENT_
FLAG

REG_BEST_TIME_
CONTACT_BEGIN/ 
Registrant Best Time 
Contact Begin

DATE - Best time to begin 
contacting the 
registrant

hz_person_
profiles

BEST_TIME_
CONTACT_
BEGIN

REG_BEST_TIME_
CONTACT_END

Registrant Best Time 
Contact End

DATE - Best time to stop 
contacting the 
registrant

hz_person_
profiles

BEST_TIME_
CONTACT_END

Table D–3 Event List Import Fields (Cont.)

Table Column / Field 
in Import File Data Type Valid Values Comments

Table 
Name Column Name
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REG_CATEGORY_
CODE/ Registrant 
Category Code

VARCHAR2(30
)

- Category code of 
the registrant

hz_parties CATEGORY_
CODE

REG_CEO_NAME/ 
Registrant CEO 
Name

VARCHAR2 
(360)

- CEO of the 
registrant’s 
company

hz_
organizatio
n_profiles

CEO_NAME

REG_CITY/ 
Registrant City

VARCHAR2(60
)

- City of the 
Registrant’s 
Address

hz_parties CITY

REG_CONTACT_
ME_FLAG/ 
Registrant Contact 
Me Flag

VARCHAR2(1) Y/N Whether or not it 
is OK to contact 
the registrant (Do 
or Do Not 
Contact)

hz_
contact_
preferences

PREFERENCE_
CODE (if Contact_
Type is ALL)

REG_COUNTRY/ 
Registrant Country

VARCHAR2(60
)

- Country of the 
registrant’s 
address

hz_parties COUNTRY

REG_COUNTY/ 
Registrant County

VARCHAR2(60
)

- County of the 
registrant’s 
address

hz_parties COUNTY

REG_CURRENT_FY_
POTENTIAL_REV/ 
Registrant Current FY 
Potential Revenue

NUMBER - Current fiscal year 
potential revenue 
of the registrant’s 
company

hz_parties CURR_FY_
POTENTIAL_
REVENUE

REG_NEXT_FY_
POTANTIAL_REV/ 
Registrant Next FY 
Potential Revenue

NUMBER - Next fiscal year 
potential revenue 
of the registrant’s 
company

hz_parties NEXT_FY_
POTENTIAL_
REVENUE

REG_HOUSEHOLD_
INCOME/ Registrant 
Household Income

NUMBER - Household income 
of the registrant

hz_person_
profiles

HOUSEHOLD_
INCOME

REG_DECISION_
MAKER_FLAG/ 
Registrant Decision 
Maker Flag

VARCHAR2(1) Y/N Whether or not the 
registrant is a 
decision maker

hz_org_
contacts

DECISION_
MAKER_FLAG

Table D–3 Event List Import Fields (Cont.)

Table Column / Field 
in Import File Data Type Valid Values Comments

Table 
Name Column Name
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REG_
DEPARTMENT/ 
Registrant 
Department

VARCHAR2 
(360)

- The registrant’s 
company 
department

hz_org_
contacts

DEPARTMENT

REG_DUN_NO_C/ 
Registrant Dun No.

VARCHAR2(30
)

- The Duns Number 
of the registrant’s 
company

hz_parties DUNS_NUMBER

REG_EMAIL_
ADDRESS/ 
Registrant email 
address

Table Entry Required: 
Yes

VARCHAR2 
(2000)

- Email address of 
the registrant

hz_parties EMAIL_ADDRESS

REG_EMAIL_OK_
FLAG/ Registrant 
Email OK Flag

VARCHAR2(1) Y/N Whether or not it 
is OK to email the 
registrant

hz_
contact_
preferences

PREFERENCE_
CODE (if Contact_
Type is EMAIL)

REG_EMPLOYEE_
TOTAL/ Registrant 
Employee Total

NUMBER - Employee total of 
the registrant’s 
company

hz_parties EMPLOYEES_
TOTAL

REG_FY_END_
MONTH/ Registrant 
FY End Month

VARCHAR2(30
)

- The month in 
which the 
registrant’s 
company’s fiscal 
year ends

hz_parties FISCAL_
YEAREND_
MONTH

REG_FLOOR/ 
Registrant’s Floor

VARCHAR2(50
)

- The floor (address) 
of the registrant

hz_
locations

FLOOR

REG_GSA_
INDICATOR_FLAG/ 
Registrant GSA 
Indicator Flag

VARCHAR2(30
)

- The GSA Indicator 
Flag of the 
registrant’s 
company

hz_parties GSA_
INDICATOR_
FLAG

REG_HOUSE_
NUMBER/ 
Registrant House 
Number

NUMBER - The house number 
of the registrant’s 
address

hz_
locations

HOUSE_
NUMBER

REG_IDENTIFYING_
ADDRESS_FLAG/ 
Registrant Identifying 
Address Flag

VARCHAR2(1) Y/N Whether or not 
this is the 
registrant’s 
primary address

hz_party_
sites

IDENTIFYING_
ADDRESS_FLAG

Table D–3 Event List Import Fields (Cont.)

Table Column / Field 
in Import File Data Type Valid Values Comments

Table 
Name Column Name
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REG_JGZZ_FISCAL_
CODE/ Registrant 
JGZZ FISCAL Code

VARCHAR2(20
)

- The JGZZ Fiscal 
Code of the 
registrant’s 
company

hz_parties JGZZ_FISCAL_
CODE

REG_JOB_TITLE/ 
Registrant Job Title

VARCHAR2 
(100)

- The job title of the 
registrant

hz_org_
contacts

JOB_TITLE

REG_LAST_ORDER_
DATE/ Registrant 
Last Order Date

DATE - Deprecated hz_parties LAST_ORDERED_
DATE

REG_ORG_LEGAL_
STATUS/ Registrant 
Org Legal Status

VARCHAR2(30
)

- The legal status of 
the registrant’s 
company

hz_
organizatio
n_profiles

LEGAL_STATUS

REG_LINE_OF_
BUSINESS/ 
Registrant Line of 
Business

VARCHAR2 
(240)

- The line of 
business with 
which the 
registrant is 
associated

hz_
organizatio
n_profiles

LINE_OF_
BUSINESS

REG_MISSION_
STATEMENT/ 
Registrant Mission 
Statement

VARCHAR2 
(2000)

- The mission 
statement for the 
registrant’s 
company

hz_parties MISSION_
STATEMENT

REG_ORG_NAME_
PHONETIC/ 
Registrant Org Name 
Phonetic

VARCHAR2 
(320)

- The phonetic 
name of the 
registrant’s 
company

hz_parties ORGANIZATION
_NAME_
PHONETIC

REG_OVERSEAS_
ADDRESS_FLAG/ 
Registrant Overseas 
Address Flag

VARCHAR2(1) Y/N Whether or not the 
address is overseas

hz_
locations

OVERSEAS_
ADDRESS_FLAG

REG_NAME_
SUFFIX/ Registrant 
Name Suffix

VARCHAR2(30
)

- The suffix of the 
registrant (Jr., 
M.D., etc.)

hz_parties PERSON_NAME_
SUFFIIX

REG_PHONE_
AREA_CODE/ 
Registrant Phone 
Area Code

VARCHAR2(10
)

- The area code of 
the registrant’s 
phone number

hz_
contact_
points

PHONE_AREA_
CODE

Table D–3 Event List Import Fields (Cont.)

Table Column / Field 
in Import File Data Type Valid Values Comments

Table 
Name Column Name
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REG_PHONE_
COUNTRY_CODE/ 
Registrant Phone 
Country Code

VARCHAR2(10
)

- The country code 
of the registrant’s 
phone number

hz_
contact_
points

PHONE_
COUNTRY_CODE

REG_PHONE_
EXTENSION/ 
Registrant Phone 
Extension

VARCHAR2(20
)

- The extension of 
the registrant’s 
phone number

hz_
contact_
points

PHONE_
EXTENSION

REG_PHONE_
NUMBER/ 
Registrant Phone 
Number

VARCHAR2(40
)

- The registrant’s 
phone number

hz_
contact_
points

PHONE_
NUMBER

REG_POSTAL_
CODE/ Registrant 
Postal Code

VARCHAR2(60
)

- The postal code of 
the registrant’s 
address

hz_parties POSTAL_CODE

REG_POSTAL_
PLUS4_CODE/ 
Registrant Postal 
plus4 Code

VARCHAR2(4) - The postal 
plus-four code of 
the registrant’s 
address

hz_
locations

POSTAL_PLUS4_
CODE

REG_PO_BOX_NO/ 
Registrant PO Box No

VARCHAR2(50
)

- The PO Box 
number of the 
registrant’s 
address

hz_
locations

PO_BOX_
NUMBER

REG_PROVINCE/ 
Registrant Province

VARCHAR2(60
)

- The province of 
the registrant’s 
address

hz_
locations, 
hz_parties

PROVINCE

REG_RURAL_
ROUTE_NO/ 
Registrant Rural 
Route No

VARCHAR2(50
)

- The rural route 
number of the 
registrant’s 
address

hz_
locations

RURAL_ROUTE_
NUMBER

REG_RURAL_
ROUTE_TYPE / 
Registrant Rural 
Route Type

VARCHAR2(30
)

- The rural route 
type of the 
registrant’s 
address

hz_
locations

RURTAL_
ROUTE_TYPE

REG_SECONDARY_
SUFFIX_ELEMENT/ 
Registrant Secondary 
Suffix Element

VARCHAR2(30
)

- The secondary 
suffix (such as Jr. 
or M.D.) of the 
registrant

hz_
locations

SECONDARY_
SUFFIX_
ELEMENT

Table D–3 Event List Import Fields (Cont.)

Table Column / Field 
in Import File Data Type Valid Values Comments

Table 
Name Column Name
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REG_SIC_CODE/ 
Registrant SIC Code

VARCHAR2(30
)

- The SIC Code of 
the registrant’s 
company

hz_parties SIC_CODE

REG_SIC_CODE_
TYPE/ Registrant SIC 
Code Type

VARCHAR2(30
)

- The SIC Code 
Type of the 
registrant’s 
company

hz_parties SIC_CODE_TYPE

REG_SITE_USE_
CODE/ Registrant 
Site Use Code

VARCHAR2(30
)

- The site use code 
of the registrant’s 
address

Not Used Not Used

REG_STATE/ 
Registrant State

VARCHAR2(60
)

- The state of the 
registrant’s 
address

hz_
locations, 
hz_parties

STATE

REG_STREET/ 
Registrant Street

VARCHAR2(50
)

- The street of the 
registrant’s 
address

hz_
locations

STREET

REG_STREET_
NUMBER/ 
Registrant Street 
Number

VARCHAR2(50
)

- The street number 
of the registrant’s 
address

hz_
locations

STREET_
NUMBER

REG_STREET_
SUFFIX/ Registrant 
Street Suffix

VARCHAR2(50
)

- The street suffix of 
the registrant’s 
address

hz_
locations

STREET_SUFFIX

REG_SUITE/ 
Registrant Suite

VARCHAR2(50
)

- The suite of the 
registrant’s 
address

hz_
locations

SUITE

REG_TAX_NAME/ 
Registrant Tax Name

VARCHAR2(30
)

- The tax name of 
the registrant’s 
company

hz_parties TAX_NAME

REG_TAX_
REFERENCE/ 
Registrant Tax 
Reference

VARCHAR2(50
)

- The tax reference 
of the registrant’s 
company

hz_parties TAX_REFERENCE

REG_TIME_ZONE/ 
Registrant Time Zone

NUMBER - The timezone of 
the registrant’s 
address

hz_
locations

TIME_ZONE

Table D–3 Event List Import Fields (Cont.)
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REG_TOTAL_NO_
OF_ORDER/ 
Registrant Total 
Number of Orders

NUMBER - Deprecated hz_parties TOTAL_NUM_
OF_ORDERS

REG_TOTAL_
ORDER_AMOUNT/ 
Registrant Total 
Order Amount

NUMBER - Deprecated hz_parties TOTAL_
ORDERED_
AMOUNT

REG_YEAR_
ESTABLISHED/ 
Registrant Year 
Established

NUMBER - The year the 
registrant’s 
company was 
established

hz_parties YEAR_
ESTABLISHED

REG_URL/ 
Registrant URL

VARCHAR2 
(2000)

- The URL of the 
registrant’s 
company

hz_
contact_
points, hz_
parties

URL

ATT_PARTY_ID/ 
attendant Party ID

Table Entry Required: 
Yes

NUMBER - The party id 
corresponding to 
the attendant 
(B2C) or the 
attendant’s 
company (B2B).

hz_parties PARTY_ID

ATT_PARTY_TYPE/ 
Attendant Party Type

VARCHAR2(30
)

- The Party Type of 
the attendant’s 
company

hz_parties PARTY_TYPE

ATT_CONTACT_ID/ 
Attendant Contact ID

Table Entry Required: 
Yes

NUMBER - The party ID 
corresponding to 
the attendant

hz_parties PARTY_ID

ATT_PARTY_
NAME/ Attendant 
Party Name

VARCHAR2 
(360)

- The name of the 
attendant’s 
company (forces 
B2B).

hz_parties PARTY_NAME

ATT_TITLE/ 
Attendant Title

VARCHAR2(30
)

- Title (Mr. Ms.) of 
the attendant

hz_org_
contacts

TITLE

Table D–3 Event List Import Fields (Cont.)
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ATT_FIRST_NAME/ 
Attendant First Name

Table Entry Required: 
Yes

VARCHAR2 
(150)

- First Name of 
attendant

hz_parties PERSON_FIRST_
NAME

ATT_MIDDLE_
NAME/ Attendant 
Middle Name

VARCHAR2(60
)

- Middle name of 
attendant

hz_parties PERSON_
MIDDLE NAME

ATT_LAST_NAME/ 
Attendant Last Name

Table Entry Required: 
Yes

VARCHAR2 
(150)

- Last Name of 
attendant

hz_parties PERSON_LAST_
NAME

ATT_ADDRESS1/ 
Attendant Address1

VARCHAR2 
(240)F

- Address (first line) 
of the attendant

hz_parties ADDRESS1

ATT_ADDRESS2/ 
Attendant Address1

VARCHAR2 
(240)F

- Address (second 
line) of the 
attendant

hz_parties ADDRESS2

ATT_ADDRESS3/ 
Attendant Address1

VARCHAR2 
(240)F

- Address (third 
line) of the 
attendant

hz_parties ADDRESS3

ATT_ADDRESS4/ 
Attendant Address1

VARCHAR2 
(240)F

- Address (fourth 
line) of the 
attendant

hz_parties ADDRESS4

ATT_GENDER/ 
Attendant Gender

VARCHAR2(30
)

- Gender of the 
attendant

hz_person_
profiles

GENDER

ATT_ADDRESS_
LINE_PHONETIC/ 
Attendant Address 
Line Phonetic

VARCHAR2 
(360)

- Phonetic address 
of the attendant

hz_
locations

ADDRESS_
LINES_
PHONETIC

ATT_ANALYSIS_
FY/ Attendant 
Analysis FY

VARCHAR2(5) - FY analysis for the 
attendant

hz_parties ANALYSIS _FY

ATT_APT_FLAG/ 
Attendant Apt Flag

VARCHAR2(1) Y/N Whether or not the 
attendant’s 
address is an 
apartment

hz_
locations

APARTMENT_
FLAG
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ATT_BEST_TIME_
CONTACT_BEGIN/ 
Attendant Best Time 
Contact Begin

DATE - Best time to begin 
contacting the 
attendant

hz_person_
profiles

BEST_TIME_
CONTACT_
BEGIN

ATT_BEST_TIME_
CONTACT_END

Attendant Best Time 
Contact End

DATE - Best time to stop 
contacting the 
attendant

hz_person_
profiles

BEST_TIME_
CONTACT_END

ATT_CATEGORY_
CODE/ Attendant 
Category Code

VARCHAR2(30
)

- Category code of 
the attendant

hz_parties CATEGORY_
CODE

ATT_CEO_NAME/ 
Attendant CEO 
Name

VARCHAR2 
(360)

- CEO of the 
attendant’s 
company

hz_
organizatio
n_profiles

CEO_NAME

ATT_CITY/ 
Attendant City

VARCHAR2(60
)

- City of the 
attendant’s 
Address

hz_parties CITY

ATT_CONTACT_
ME_FLAG/ 
Attendant Contact 
Me Flag

VARCHAR2(1) Y/N Whether or not it 
is OK to contact 
the attendant (Do 
or Do Not 
Contact)

hz_
contact_
preferences

PREFERENCE_
CODE (if Contact_
Type is ALL)

ATT_COUNTRY/ 
Attendant Country

VARCHAR2(60
)

- Country of the 
attendant’s 
address

hz_parties COUNTRY

ATT_COUNTY/ 
Attendant County

VARCHAR2(60
)

- County of the 
attendant’s 
address

hz_parties COUNTY

ATT_CURRENT_FY_
POTENTIAL_REV/ 
Attendant Current FY 
Potential Revenue

NUMBER - Current fiscal year 
potential revenue 
of the attendant’s 
company

hz_parties CURR_FY_
POTENTIAL_
REVENUE

ATT_NEXT_FY_
POTANTIAL_REV/ 
Attendant Next FY 
Potential Revenue

NUMBER - Next fiscal year 
potential revenue 
of the attendant’s 
company

hz_parties NEXT_FY_
POTENTIAL_
REVENUE

Table D–3 Event List Import Fields (Cont.)
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ATT_HOUSEHOLD_
INCOME/ Attendant 
Household Income

NUMBER Household income 
of the attendant

hz_person_
profiles

HOUSEHOLD_
INCOME

ATT_DECISION_
MAKER_FLAG/ 
Attendant Decision 
Maker Flag

VARCHAR2(1) Y/N Whether or not the 
attendant is a 
decision maker

hz_org_
contacts

DECISION_
MAKER_FLAG

ATT_
DEPARTMENT/ 
Attendant 
Department

VARCHAR2 
(360)

- The attendant’s 
company 
department

hz_org_
contacts

DEPARTMENT

ATT_DUN_NO_C/ 
Attendant Dun No.

VARCHAR2(30
)

- The Duns Number 
of the attendant’s 
company

hz_parties DUNS_NUMBER

ATT_EMAIL_
ADDRESS/ 
Attendant email 
address

Table Entry Required: 
Yes

VARCHAR2 
(2000)

- Email address of 
the attendant

hz_parties EMAIL_ADDRESS

ATT_EMAIL_OK_
FLAG/ Attendant 
Email OK Flag

VARCHAR2(1) Y/N Whether or not it 
is OK to email the 
attendant

hz_
contact_
preferences

PREFERENCE_
CODE (if Contact_
Type is EMAIL)

ATT_EMPLOYEE_
TOTAL/ Attendant 
Employee Total

NUMBER - Employee total of 
the attendant’s 
company

hz_parties EMPLOYEES_
TOTAL

ATT_FY_END_
MONTH/ Attendant 
FY End Month

VARCHAR2(30
)

- The month in 
which the 
attendant’s 
company’s fiscal 
year ends

hz_parties FISCAL_
YEAREND_
MONTH

ATT_FLOOR/ 
Attendant’s Floor

VARCHAR2(50
)

- The floor (address) 
of the attendant

hz_
locations

FLOOR

ATT_GSA_
INDICATOR_FLAG/ 
Attendant GSA 
Indicator Flag

VARCHAR2(30
)

- The GSA Indicator 
Flag of the 
attendant’s 
company

hz_parties GSA_
INDICATOR_
FLAG
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ATT_HOUSE_
NUMBER/ 
Attendant House 
Number

NUMBER - The house number 
of the attendant’s 
address

hz_
locations

HOUSE_
NUMBER

ATT_IDENTIFYING_
ADDRESS_FLAG/ 
Attendant Identifying 
Address Flag

VARCHAR2(1) Y/N Whether or not 
this is the 
attendant’s 
primary address

hz_party_
sites

IDENTIFYING_
ADDRESS_FLAG

ATT_JGZZ_FISCAL_
CODE/ Attendant 
JGZZ FISCAL Code

VARCHAR2(20
)

- The JGZZ Fiscal 
Code of the 
attendant’s 
company

hz_parties JGZZ_FISCAL_
CODE

ATT_JOB_TITLE/ 
Attendant Job Title

VARCHAR2 
(100)

- The job title of the 
attendant

hz_org_
contacts

JOB_TITLE

ATT_LAST_ORDER_
DATE/ Attendant 
Last Order Date

DATE - Deprecated hz_parties LAST_ORDERED_
DATE

ATT_ORG_LEGAL_
STATUS/ Attendant 
Org Legal Status

VARCHAR2(30
)

- The legal status of 
the attendant’s 
company

hz_
organizatio
n_profiles

LEGAL_STATUS

ATT_LINE_OF_
BUSINESS/ 
Attendant Line of 
Business

VARCHAR2 
(240)

- The line of 
business with 
which the 
attendant is 
associated

hz_
organizatio
n_profiles

LINE_OF_
BUSINESS

ATT_MISSION_
STATEMENT/ 
Attendant Mission 
Statement

VARCHAR2 
(2000)

- The mission 
statement for the 
attendant’s 
company

hz_parties MISSION_
STATEMENT

ATT_ORG_NAME_
PHONETIC/ 
Attendant Org Name 
Phonetic

VARCHAR2 
(320)

- The phonetic 
name of the 
attendant’s 
company

hz_parties ORGANIZATION
_NAME_
PHONETIC

ATT_OVERSEAS_
ADDRESS_FLAG/ 
Attendant Overseas 
Address Flag

VARCHAR2(1) Y/N Whether or not the 
address is overseas

hz_
locations

OVERSEAS_
ADDRESS_FLAG
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ATT_NAME_
SUFFIX/ Attendant 
Name Suffix

VARCHAR2(30
)

- The suffix of the 
attendant (Jr., 
M.D., etc.)

hz_parties PERSON_NAME_
SUFFIIX

ATT_PHONE_
AREA_CODE/ 
Attendant Phone 
Area Code

VARCHAR2(10
)

- The area code of 
the attendant’s 
phone number

hz_
contact_
points

PHONE_AREA_
CODE

ATT_PHONE_
COUNTRY_CODE/ 
Attendant Phone 
Country Code

VARCHAR2(10
)

- The country code 
of the attendant’s 
phone number

hz_
contact_
points

PHONE_
COUNTRY_CODE

ATT_PHONE_
EXTENSION/ 
Attendant Phone 
Extension

VARCHAR2(20
)

- The extension of 
the attendant’s 
phone number

hz_
contact_
points

PHONE_
EXTENSION

ATT_PHONE_
NUMBER/ 
Attendant Phone 
Number

VARCHAR2(40
)

- The attendant’s 
phone number

hz_
contact_
points

PHONE_
NUMBER

ATT_POSTAL_
CODE/ Attendant 
Postal Code

VARCHAR2(60
)

- The postal code of 
the attendant’s 
address

hz_parties POSTAL_CODE

ATT_POSTAL_
PLUS4_CODE/ 
Attendant Postal 
plus4 Code

VARCHAR2(4) - The postal 
plus-four code of 
the attendant’s 
address

hz_
locations

POSTAL_PLUS4_
CODE

ATT_PO_BOX_NO/ 
Attendant PO Box No

VARCHAR2(50
)

- The PO Box 
number of the 
attendant’s 
address

hz_
locations

PO_BOX_
NUMBER

ATT_PROVINCE/ 
Attendant Province

VARCHAR2(60
)

- The province of 
the attendant’s 
address

hz_
locations, 
hz_parties

PROVINCE

ATT_RURAL_
ROUTE_NO/ 
Attendant Rural 
Route Number

VARCHAR2(50
)

- The rural route 
number of the 
attendant’s 
address

hz_
locations

RURAL_ROUTE_
NUMBER

Table D–3 Event List Import Fields (Cont.)
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ATT_RURAL_
ROUTE_TYPE/ 
Attendant Rural 
Route Type

VARCHAR2(30
)

- The rural route 
type of the 
attendant’s 
address

hz_
locations

RURTAL_
ROUTE_TYPE

ATT_SECONDARY_
SUFFIX_ELEMENT/ 
Attendant Secondary 
Suffix Element

VARCHAR2(30
)

- The secondary 
suffix (such as Jr. 
or M.D.) of the 
attendant

hz_
locations

SECONDARY_
SUFFIX_
ELEMENT

ATT_SIC_CODE/ 
Attendant SIC Code

VARCHAR2(30
)

- The SIC Code of 
the attendant’s 
company

hz_parties SIC_CODE

ATT_SIC_CODE_
TYPE/ Attendant SIC 
Code Type

VARCHAR2(30
)

- The SIC Code 
Type of the 
attendant’s 
company

hz_parties SIC_CODE_TYPE

ATT_SITE_USE_
CODE/ Attendant 
Site Use Code

VARCHAR2(30
)

- The site use code 
of the attendant’s 
address

Not Used Not Used

ATT_STATE/ 
Attendant State

VARCHAR2(60
)

- The state of the 
attendant’s 
address

hz_
locations, 
hz_parties

STATE

ATT_STREET/ 
Attendant Street

VARCHAR2(50
)

- The street of the 
attendant’s 
address

hz_
locations

STREET

ATT_STREET_
NUMBER/ 
Attendant Street 
Number

VARCHAR2(50
)

- The street number 
of the attendant’s 
address

hz_
locations

STREET_
NUMBER

ATT_STREET_
SUFFIX/ Attendant 
Street Suffix

VARCHAR2(50
)

- The street suffix of 
the attendant’s 
address

hz_
locations

STREET_SUFFIX

ATT_SUITE/ 
Attendant Suite

VARCHAR2(50
)

- The suite of the 
attendant’s 
address

hz_
locations

SUITE

ATT_TAX_NAME/ 
Attendant Tax Name

VARCHAR2(30
)

- The tax name of 
the attendant’s 
company

hz_parties TAX_NAME
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D.4 Lead List Import Fields
The following field is new:

■ PERSON_INITIALS

Obsolete columns:

■ CUSTOMER_KEY

■ ADDRESS_KEY

■ CONTACT_KEY

ATT_TAX_
REFERENCE/ 
Attendant Tax 
Reference

VARCHAR2(50
)

- The tax reference 
of the attendant’s 
company

hz_parties TAX_REFERENCE

ATT_TIME_ZONE/ 
Attendant Time Zone

NUMBER - The timezone of 
the attendant’s 
address

hz_
locations

TIME_ZONE

ATT_TOTAL_NO_
OF_ORDER/ 
Attendant Total 
Number of Orders

NUMBER - Deprecated hz_parties TOTAL_NUM_
OF_ORDERS

ATT_TOTAL_
ORDER_AMOUNT/ 
Attendant Total 
Order Amount

NUMBER - Deprecated hz_parties TOTAL_
ORDERED_
AMOUNT

ATT_YEAR_
ESTABLISHED/ 
Attendant Year 
Established

NUMBER - The year the 
attendant’s 
company was 
established

hz_parties YEAR_
ESTABLISHED

ATT_URL/ 
Attendant URL

VARCHAR2 
(2000)

- The URL of the 
attendant’s 
company

hz_
contact_
points, hz_
parties

URL
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Table D–4 Event List Import Fields 

Table Column / Field 
in Import File Data Type

Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments

ACCEPT_FLAG - - - - -

ACTIVE_FLAG VARCHAR2(1) - - - -

ADDRESS_
EFFECTIVE_DATE

VARCHAR2 - - - -

ADDRESS_KEY VARCHAR2 - - - Stores the Address Key 
generated

ADDRESS_LINES_
PHONETIC

VARCHAR2 - - - -

ADDRESS_STYLE VARCHAR2 - - - -

ADDRESSEE VARCHAR2 - - - -

ASSIGN_DATE VARCHAR2 - - - -

ASSIGN_SALES_
GROUP_ID

VARCHAR2 - - - -

ASSIGN_TO_PERSON_
ID

VARCHAR2 - - - -

ASSIGN_TO_
SALESFORCE_ID

VARCHAR2 - - - -

ATTENDANCE_
FAILURE_REASON

VARCHAR2(30
)

- - AMS_EVENT_
ATTENDANC
E_FAILURE_
CODE 
LOOKUP

-

ATTENDANCE_
RESULT_CODE

VARCHAR2(30
)

- - - -

ATTENDANT_
ACCOUNT_ID

NUMBER - - CUSTOMER_
ACCOUNT_ID

-

ATTENDANT_
CONTACT_ID

NUMBER Yes CONTACT_ID -

ATTENDANT_
LANGUAGE

VARCHAR2(30
)

- - - -

ATTENDANT_
PARTY_ID

NUMBER - - PARTY_ID -
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ATTENDED_FLAG VARCHAR2(1) - - - -

ATTRIBUTE_
CATEGORY

VARCHAR2(30
)

- - - -

ATTRIBUTE1 VARCHAR2(15
0)

- - - -

ATTRIBUTE10 VARCHAR2(15
0)

- - - -

ATTRIBUTE11 VARCHAR2(15
0)

- - - -

ATTRIBUTE12 VARCHAR2(15
0)

- - - -

ATTRIBUTE13 VARCHAR2(15
0)

- - - -

ATTRIBUTE14 VARCHAR2(15
0)

- - - -

ATTRIBUTE15 VARCHAR2(15
0)

- - - -

ATTRIBUTE2 VARCHAR2(15
0)

- - - -

ATTRIBUTE3 VARCHAR2(15
0)

- - - -

ATTRIBUTE4 VARCHAR2(15
0)

- - - -

ATTRIBUTE5 VARCHAR2(15
0)

- - - -

ATTRIBUTE6 VARCHAR2(15
0)

- - - -

ATTRIBUTE7 VARCHAR2(15
0)

- - - -

ATTRIBUTE8 VARCHAR2(15
0)

- - - -
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ATTRIBUTE9 VARCHAR2(15
0)

- - - -

AUTO_ASSIGNMENT_
TYPE

VARCHAR2 - - - -

AUTO_REGISTER_
FLAG

VARCHAR2(1) - - - -

BUDGET_AMOUNT NUMBER - - - -

BUDGET_AMOUNT_1 NUMBER - - - -

BUDGET_AMOUNT_2 NUMBER - - - -

BUDGET_AMOUNT_3 NUMBER - - - -

BUDGET_AMOUNT_4 NUMBER - - - -

BUDGET_AMOUNT_5 NUMBER - - - -

BUDGET_STATUS_
CODE

VARCHAR2 - - - -

CANCELLATION_
CODE

NUMBER - - - -

CANCELLATION_
REASON_CODE

VARCHAR2(30
)

- - AMS_EVENT_
REG_
CANCEL_
REASON 
LOOKUP

-

CHANNEL_CODE VARCHAR2 - - - -

CLOSE_REASON VARCHAR2 - - - -

CNT_PNT_CONTENT_
SOURCE_TYPE

VARCHAR2 - - - This is a mandatory 
column in HZ_
CONTACT_POINTS, 
but if not given, default 
it to ‘USER_ENTERED’

CNT_PNT_TIME_
ZONE

VARCHAR2 - - - -

CONFIRMED_FLAG VARCHAR2(1) - - - -

Table D–4 Event List Import Fields (Cont.)
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CONTACT_KEY VARCHAR2 - - - Stores the Contact Key 
generated

CONTACT_NUMBER VARCHAR2 - - - -

CONTACT_PARTY_ID NUMBER - - - -

CONTACT_ROLE_
CODE

VARCHAR2 - - - -

CONTENT_SOURCE_
TYPE

VARCHAR2 - - - This is a mandatory 
column in HZ_
LOCATIONS, but if 
not given, default it to 
‘USER_ENTERED’

CREATED_BY NUMBER Yes - - Populated by the list 
import program.

CREATION_DATE DATE Yes - - Populated by the list 
import program.

CURRENCY_CODE VARCHAR2 - - - -

CUSTOMER_KEY VARCHAR2 - - - Stores the customer 
Key generated

DATE_
REGISTRATION_
PLACED

DATE - - - -

DECISION_MAKER_
FLAG

VARCHAR2 - - - -

DECISION_
TIMEFRAME_CODE

VARCHAR2 - - - -

DELETED_FLAG VARCHAR2 - - - -

DEPARTMENT VARCHAR2 - - - -

DEPARTMENT_CODE VARCHAR2 - - - -

DESCRIPTION VARCHAR2 - - - -

DESCRIPTION VARCHAR2 - - - -

DO_NOT_EMAIL_
FLAG

VARCHAR2 - - - If 'Y' then no emails 
sent to Contact.
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DO_NOT_FAX_FLAG VARCHAR2 - - - If 'Y' then no fax sent to 
Contact.

DO_NOT_PHONE_
FLAG

VARCHAR2 - - - If 'Y' then no phone 
calls to Contact.

DUNS_NUMBER VARCHAR2 - - - -

EMAIL_FORMAT VARCHAR2 - - - -

EVALUATED_FLAG VARCHAR2(1) - - - -

EVENT_OFFER_ID NUMBER - Yes AMS_EVENT_
OFFERS_ALL_
B

-

FA_LOCATION_ID NUMBER - - - -

FAX_AREA_CODE VARCHAR2 - - - -

FAX_COUNTRY_
CODE

VARCHAR2 - - - -

FAX_EXTENSION VARCHAR2 - - - -

FAX_NUMBER VARCHAR2 - - - -

FLOOR VARCHAR2 - - - -

GROUP_TYPE VARCHAR2 - - - -

GSA_INDICATOR_
FLAG

VARCHAR2 - - - -

HOUSE_NUMBER VARCHAR2 - - - -

HQ_BRANCH_IND NUMBER - - - -

IMPORT_FLAG NUMBER - - - -

IMPORT_LIST_
HEADER_ID

NUMBER Yes - - Auto Generated 

IMPORT_SOURCE_
LINE_ID

NUMBER Yes - - Auto Generated

IMPORT_
SUCCESSFUL_FLAG

VARCHAR2(1) - - - Populated by the list 
import program.
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INBOUND_
CHANNEL_ID

NUMBER - - - -

INBOUND_MEDIA_ID NUMBER - - - -

INCUMBENT_
PARTNER_PARTY_ID

NUMBER - - - Partner specific 

INCUMBENT_
PARTNER_
RESOURCE_ID

NUMBER - - - Partner specific 

INTEREST_TYPE_ID_1 NUMBER - - - -

INTEREST_TYPE_ID_2 NUMBER - - - -

INTEREST_TYPE_ID_3 NUMBER - - - -

INTEREST_TYPE_ID_4 NUMBER - - - -

INTEREST_TYPE_ID_5 NUMBER - - - -

INVENTORY_ITEM_
ID_1

NUMBER - - - -

INVENTORY_ITEM_
ID_2

NUMBER - - - -

INVENTORY_ITEM_
ID_3

NUMBER - - - -

INVENTORY_ITEM_
ID_4

NUMBER - - - -

INVENTORY_ITEM_
ID_5

NUMBER - - - -

INVITE_ONLY_
OVERRIDE_FLAG

VARCHAR2(1) - - - -

JGZZ_FISCAL_CODE VARCHAR2 - - - -

JOB_TITLE_CODE VARCHAR2 - - - Stores the job title code

KEEP_FLAG VARCHAR2 - - - -

KNOWN_AS VARCHAR2 - - - -

KNOWN_AS2 VARCHAR2 - - - -

Table D–4 Event List Import Fields (Cont.)
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Table 
Requires 
Entry

Import 
Requires 
Entry Valid Values Comments
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KNOWN_AS3 VARCHAR2 - - - -

KNOWN_AS4 VARCHAR2 - - - -

KNOWN_AS5 VARCHAR2 - - - -

LANGUAGE VARCHAR2 - - - -

LANGUAGE_NAME VARCHAR2 - - - -

LAST_ORDERED_
DATE

VARCHAR2 - - - -

LAST_REG_STATUS_
DATE

DATE - - Date when the 
registration 
closed.

-

LAST_UPDATE_
LOGIN

NUMBER Yes - - Populated by the list 
import program.

LAST_UPDATED_BY NUMBER Yes - - Populated by the list 
import program.

LEAD_DATE DATE - - - -

LEAD_NUMBER VARCHAR2 - - - -

LEAD_RANK_ID NUMBER - - - Stores the sales lead 
rank id.   Need not 
supply if supplied will 
get validated

LOAD_ERROR_
MESSAGE

VARCHAR2 - - - Currently, not used. To 
find the error 
messages, query from 
ams_errors

LOC_DESCRIPTION VARCHAR2 - - - -

LOC_HIERARCHY_ID NUMBER - - - -

LOC_VALIDATED_
FLAG

VARCHAR2 - - - -

LOCATION_
DIRECTIONS

VARCHAR2 - - - -

LOCATION_ID NUMBER - - - Location Id to which 
address info is mapped

Table D–4 Event List Import Fields (Cont.)
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Import 
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MAIL_STOP VARCHAR2 - - - -

MAILSTOP VARCHAR2 - - - -

MARKETING_SCORE NUMBER - - - -

MAX_ATTENDEE_
OVERRIDE_FLAG

VARCHAR2(1) - - - -

MIDDLE_INITIAL VARCHAR2 - - - -

MISSION_
STATEMENT

VARCHAR2 - - - -

NET_WORTH VARCHAR2 - - - free text format

NEW_CON_FLAG VARCHAR2 - - - << DO NOT 
POPULATE >>  if 1 - 
new contact, 0- existing 
Contact

NEW_LOC_FLAG VARCHAR2 - - - << DO NOT 
POPULATE >>  if 1 - 
this is a new location. If 
0- this is already 
existing.

NEW_PARTY_FLAG VARCHAR2 - - - << DO NOT 
POPULATE >>  If 1 - 
party is newly created. 
If 0, existing party is 
used.

NEW_PS_FLAG VARCHAR2 - - - << DO NOT 
POPULATE >>  if 1 - 
new PS, if 0 - PS 
already existing

NEW_REL_FLAG VARCHAR2 - - - << DO NOT 
POPULATE >>  if 1 - 
new relationship, 0- 
existing Rel

OBJECT_VERSION_
NUMBER

NUMBER Yes - - Populated by the list 
import program.

OFFER_ID NUMBER - - - -

Table D–4 Event List Import Fields (Cont.)

Table Column / Field 
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OFFER_ID_1 NUMBER - - - -

OFFER_ID_2 NUMBER - - - -

OFFER_ID_3 NUMBER - - - -

OFFER_ID_4 NUMBER - - - -

OFFER_ID_5 NUMBER - - - -

ORDER_HEADER_ID NUMBER - - - -

ORDER_LINE_ID NUMBER - - - -

ORG_CNT_
COMMENTS

VARCHAR2 - - - -

ORG_CNT_TITLE VARCHAR2 - - - -

ORGANIZATION_ID_
1

NUMBER - - - -

ORGANIZATION_ID_
2

NUMBER - - - -

ORGANIZATION_ID_
3

NUMBER - - - -

ORGANIZATION_ID_
4

NUMBER - - - -

ORGANIZATION_ID_
5

NUMBER - - - -

ORGANIZATION_
NAME_PHONETIC

VARCHAR2 - - - -

ORIG_SYSTEM_CODE VARCHAR2 - - - Source application 
code where the lead 
originated example 
OTN

ORIG_SYSTEM_
REFERENCE

VARCHAR2 - - - May be populated as 
<orig_system_code > 
<identifier> example 
OTN10100

Table D–4 Event List Import Fields (Cont.)

Table Column / Field 
in Import File Data Type
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ORIGINAL_
REGISTRANT_
CONTACT_ID

NUMBER - Yes - -

OWNER_USER_ID NUMBER - Yes - -

PARENT_PROJECT VARCHAR2 - - - -

PARTIES_
VALIDATED_FLAG

VARCHAR2 - - - -

PARTY_ID NUMBER - - - Party Id to which the 
customer info is 
mapped

PARTY_NUMBER VARCHAR2 - - - -

PARTY_REFERENCE_
USE_FLAG

VARCHAR2 - - - -

PARTY_SITE_ID NUMBER - - - Party Site Id to which 
the party and location 
info is mapped

PARTY_SITE_NAME VARCHAR2 - - - -

PARTY_SITE_
NUMBER

VARCHAR2 - - - Can be populated 
ONLY when profile 
"HZ Generate Party 
Number" set to 'N'

PARTY_TYPE VARCHAR2 - - - -

PAYMENT_STATUS_
CODE

VARCHAR2(30
)

- - - -

PERSON_FIRST_
NAME_PHONETIC

VARCHAR2 - - - -

PERSON_IDEN_TYPE VARCHAR2 - - - -

PERSON_IDENTIFIER VARCHAR2 - - - -

PERSON_LAST_
NAME_PHONETIC

VARCHAR2 - - - -

PERSON_NAME_
SUFFIX

VARCHAR2 - - - -

Table D–4 Event List Import Fields (Cont.)
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PERSON_PREVIOUS_
LAST_NAME

VARCHAR2 - - - -

PHONE_CALLING_
CALENDAR

VARCHAR2 - - - -

PHONE_COUNTRY_
CODE

VARCHAR2 - - - -

PHONE_ID NUMBER - - - DO NOT POPULATE

PO_BOX_NUMBER VARCHAR2 - - - -

LOCATION_
POSITION

- - - -

POSTAL_PLUS4_
CODE

VARCHAR2 - - - -

PRIMARY_CONTACT_
FLAG

VARCHAR2 - - - -

PRIMARY_CONTACT_
PER_ROLE_TYPE

VARCHAR2 - - - 'Y' or 'N' 

PRIMARY_INTEREST_
CODE_ID_1

NUMBER - - - -

PRIMARY_INTEREST_
CODE_ID_2

NUMBER - - - -

PRIMARY_INTEREST_
CODE_ID_3

NUMBER - - - -

PRIMARY_INTEREST_
CODE_ID_4

NUMBER - - - -

PRIMARY_INTEREST_
CODE_ID_5

NUMBER - - - -

PRIMARY_PER_TYPE VARCHAR2 - - - 'Y' or 'N'

PRM_ASSIGNMENT_
TYPE

VARCHAR2 - - - -

PRM_EXEC_
SPONSOR_FLAG

VARCHAR2 - - - Partner specific 

Table D–4 Event List Import Fields (Cont.)

Table Column / Field 
in Import File Data Type
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Import 
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Entry Valid Values Comments
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PRM_IND_
CLASSIFICATION_
CODE

VARCHAR2 - - - Partner specific

PRM_PRJ_LEAD_IN_
PLACE_FLAG

VARCHAR2 - - - Partner specific 

PRM_SALES_LEAD_
TYPE

VARCHAR2 - - - Partner specific

PROGRAM_
APPLICATION_ID

NUMBER - - - -

PROGRAM_
APPLICATION_ID

NUMBER - - - ] DO NOT POPULATE

PROGRAM_ID NUMBER - - - -

PROGRAM_ID - - - ] Concurrent process 
generated

PROGRAM_UPDATE_
DATE

DATE - - - -

PROGRAM_UPDATE_
DATE

DATE - - - -

PROMOTION_CODE VARCHAR2 - - - If given and 
promotion_id is not 
provided, then this will 
be transferred to 
promotion_id.

PROMOTION_ID NUMBER - - - If given, this is used for 
creating the sales lead 
header.

PROSPECT_FLAG VARCHAR2(1) - - - -

PS_USES_COMMENTS VARCHAR2 - - - -

QUALIFIED_FLAG VARCHAR2 - - - -

QUANTITY_1 NUMBER - - - -

QUANTITY_2 NUMBER - - - -

QUANTITY_3 NUMBER - - - -

Table D–4 Event List Import Fields (Cont.)
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in Import File Data Type
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QUANTITY_4 NUMBER - - - -

QUANTITY_5 NUMBER - - - -

RANK VARCHAR2 - - - -

RAW_PHONE_
NUMBER

VARCHAR2 - - - -

REG_SOURCE_TYPE_
CODE

VARCHAR2(30
)

- - AMS_EVENT_
REG_SOURCE_
TYPE LOOKUP

-

REGISTRANT_
ACCOUNT_ID

NUMBER - Yes CUSTOMER_
ACCOUNT_ID

-

REGISTRANT_
CONTACT_ID

NUMBER - Yes CONTACT_ID -

REGISTRANT_
PARTY_ID

NUMBER - Yes PARTY_ID -

REGISTRATION_
GROUP_ID

NUMBER - Yes - -

REGISTRATION_
SOURCE_ID

NUMBER - - - -

REJECT_REASON_
CODE

VARCHAR2 - - - -

REL_PARTY_ID NUMBER - - - Relationship’s party ID 
to which the 
relationship is mapped.

REQUEST_ID NUMBER - - - -

REQUEST_ID NUMBER - - - -

ROLE_LEVEL VARCHAR2 - - - -

SALES_LEAD_ID NUMBER - - - << DO NOT 
POPULATE >> Sales 
Lead ID to which the 
sales lead info is 
mapped.

SALES_TAX_
GEOCODE

VARCHAR2 - - - -

Table D–4 Event List Import Fields (Cont.)
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SALES_TAX_INSIDE_
CITY_LIMITS

VARCHAR2 - - - -

SALESREP_ID NUMBER - - - -

SCORECARD_ID NUMBER - - - -

SECONDARY_
INTEREST_CODE_ID_
1

NUMBER - - - -

SECONDARY_
INTEREST_CODE_ID_
2

NUMBER - - - -

SECONDARY_
INTEREST_CODE_ID_
3

NUMBER - - - -

SECONDARY_
INTEREST_CODE_ID_
4

NUMBER - - - -

SECONDARY_
INTEREST_CODE_ID_
5

NUMBER - - - -

SECURITY_GROUP_ID NUMBER - - - -

SECURITY_GROUP_ID NUMBER - - - -

SHORT_DESCRIPTION VARCHAR2 - - - -

SIC_CODE_TYPE VARCHAR2 - - - -

SITE_USE_TYPE VARCHAR2 - - - This is a mandatory 
column for HZ_
PARTY_SITE_USES. 
But if not given, it will 
be defaulted to ‘BILL_
TO’

SOURCE_CODE VARCHAR2(30
)

- Yes AMS_EVENT_
OFFERS_ALL_
B

-

SOURCE_
PROMOTION_ID_1

NUMBER - - - -

Table D–4 Event List Import Fields (Cont.)
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SOURCE_
PROMOTION_ID_2

NUMBER - - - -

SOURCE_
PROMOTION_ID_3

NUMBER - - - -

SOURCE_
PROMOTION_ID_4

NUMBER - - - -

SOURCE_
PROMOTION_ID_5

NUMBER - - - -

STREET VARCHAR2 - - - -

STREET_NUMBER VARCHAR2 - - - -

STREET_SUFFIX VARCHAR2 - - - -

SUITE VARCHAR2 - - - -

SYSTEM_STATUS_
CODE

VARCHAR2(30
)

- - AMS_EVENT_
REG_STATUS 
LOOKUP

-

TARGET_LIST_ID NUMBER - - - -

TAX_NAME VARCHAR2 - - - -

TIME_ZONE VARCHAR2 - - - -

TOTAL_NUM_OF_
ORDERS

NUMBER - - - -

TOTAL_ORDERED_
AMOUNT

NUMBER - - - -

UOM_CODE_1 NUMBER - - - -

UOM_CODE_2 NUMBER - - - -

UOM_CODE_3 NUMBER - - - -

UOM_CODE_4 NUMBER - - - -

UOM_CODE_5 NUMBER - - - -

URGENT_FLAG VARCHAR2 - - - -

Table D–4 Event List Import Fields (Cont.)

Table Column / Field 
in Import File Data Type

Table 
Requires 
Entry
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USER_STATUS_ID NUMBER - Yes AMS_USER_
STATUS 
LOOKUP

-

VEHICLE_RESPONSE_
CODE

VARCHAR2 - - - -

WAITLISTED_
PRIORITY

VARCHAR2(30
)

- - - -

Table D–4 Event List Import Fields (Cont.)
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E
Seeded User Statuses

This appendix describes the various seeded user statuses found in Oracle 
Marketing. 

Topics include: 

■ Section E.1, "User Status Overview"

■ Section E.2, "Seeded User Statuses"
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E.1 User Status Overview
User statuses can be created across the application for a combination of activity and 
status. Oracle Marketing is seeded with the following user statuses. These user 
statuses can be modified or extended to meet an organization’s business rules. 

It is important to note that the addition of a high number of user statuses would 
mean that the number of values seen in the drop-down list for an object’s status will 
also increase.

E.2 Seeded User Statuses
The seeded user status values are as follows:

Table E–1 Seeded User Statuses 

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name

Budget Sourcing Status APPROVED Approved Approved

Budget Sourcing Status CLOSED Closed Accounting Closed

Budget Sourcing Status NEW Planning Planning

Budget Sourcing Status PENDING Pending Pending Approval

Budget Sourcing Status REJECTED Rejected Rejected by Approver

Budget Status ACTIVE Active Active

Budget Status ARCHIVED Archived Archived

Budget Status CANCELLED Cancelled Cancelled

Budget Status CLOSED Closed Closed

Budget Status DRAFT Draft Draft

Budget Status ON_HOLD On Hold On Hold

Budget Status PENDING Pending Approval Pending Approval

Budget Status REJECTED Rejected Rejected

Campaign Schedule Status ACTIVE Active Active

Campaign Schedule Status ARCHIVED Archived Archived

Campaign Schedule Status AVAILABLE Available Available

Campaign Schedule Status CANCELLED Cancelled Cancelled

Campaign Schedule Status CLOSED Closed Closed

Campaign Schedule Status COMPLETED Completed Completed
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Campaign Schedule Status DENIED_BA Budget Rejected Denied Budget Approval

Campaign Schedule Status NEW New New

Campaign Schedule Status ON_HOLD Active Locked On Hold

Campaign Schedule Status SUBMITTED_BA Pending Budget Approval Pending Budget Approval

Campaign Status ACTIVE Active Active

Campaign Status ARCHIVED Archived Archived

Campaign Status AVAILABLE Available Available

Campaign Status CANCELLED Cancelled Cancelled

Campaign Status CLOSED Closed Closed

Campaign Status COMPLETED Completed Completed

Campaign Status DENIED_BA Denied - Budget Approval Budget Denied

Campaign Status DENIED_TA Denied - Theme Approval Theme Denied

Campaign Status NEW New New

Campaign Status ON_HOLD On-hold On Hold

Campaign Status PLANNING Planning Planned

Campaign Status SUBMITTED_BA Submitted - Budget 
Approval

Pending Budget approval

Campaign Status SUBMITTED_TA Submitted - Theme 
Approval

Pending Theme approval

Claim Status APPROVED Approved Approved

Claim Status CANCELLED Cancelled Cancelled

Claim Status CLOSED Closed Closed

Claim Status COMPLETE Complete Complete

Claim Status DUPLICATE Duplicate Duplicate

Claim Status NEW New New

Claim Status OPEN Open Open

Claim Status PENDING Pending Pending

Claim Status PENDING_
APPROVAL

Pending Approval Pending Approval

Claim Status PENDING_CLOSE Pending Close Pending Close

Table E–1 Seeded User Statuses (Cont.)

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
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Claim Status REJECTED Rejected Rejected

Deliverable Status ARCHIVED Archived Archived

Deliverable Status AVAILABLE Available Final Loaded

Deliverable Status BUDGET_APPR Budget Approved Budget Approval

Deliverable Status CANCELLED Cancelled Cancelled

Deliverable Status DENIED_BA Denied - Budget Approval Budget Denied

Deliverable Status DENIED_TA Denied - Concept Approval Denied Concept Approval

Deliverable Status EXPIRED Expired Expired

Deliverable Status NEW New New

Deliverable Status SUBMITTED_BA Submitted - Budget 
Approval

Pending Budget approval

Deliverable Status SUBMITTED_TA Submitted - Concept 
Approval

Pending Concept Approval

Deliverable Status SUPERCEDED Superceded Superceded

List Import Status COMPLETED Completed Completed

List Import Status ERROR Error Error

List Import Status NEW New New

List Import Status PURGED Purged Purged

List Import Status SCHEDULED Scheduled Scheduled

List Import Status STAGED Staged Staged

List Status ARCHIVED Archived Archived

List Status AVAILABLE Available Available

List Status CANCELLED Cancelled Cancelled

List Status DRAFT Draft Draft

List Status EXECUTED Executed Executed

List Status EXECUTING Executing Executing

List Status GENERATING Generating Generating

List Status LOCKED Locked Locked

List Status SCHEDULED Scheduled Scheduled

List Status VALIDATED Validated Validated

Table E–1 Seeded User Statuses (Cont.)

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
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List Status VALIDATING Validating Validating

Marketing Event Agenda 
Status

CONFIRMED Confirmed Confirmed

Marketing Event Agenda 
Status

UNCONFIRMED Unconfirmed Unconfirmed

Marketing Event Registration 
Status

CANCELLED Cancelled Cancelled

Marketing Event Registration 
Status

ENROLLED Enrolled Enrolled

Marketing Event Registration 
Status

REGISTERED Registered Registered

Marketing Event Registration 
Status

TARGETED Targeted Targeted

Marketing Event Registration 
Status

WAITLISTED Waitlisted Waitlisted

Marketing Event Speaker 
Status

BOOKED Booked Booked

Marketing Event Speaker 
Status

CANCELLED Cancelled Cancelled

Marketing Event Speaker 
Status

CONFIRMED Confirmed Confirmed

Marketing Event Speaker 
Status

SCHEDULED Scheduled Scheduled

Marketing Event Status ACTIVE Active Active

Marketing Event Status ARCHIVED Archived Archived

Marketing Event Status AVAILABLE Available Available

Marketing Event Status CANCELLED Cancelled Cancelled

Marketing Event Status CLOSED Closed Closed

Marketing Event Status COMPLETED Completed Completed

Marketing Event Status DENIED_BA Denied Budget Approval Budget Denied

Marketing Event Status DENIED_TA Denied Theme Approval Theme Denied

Marketing Event Status NEW New New

Marketing Event Status ON_HOLD On Hold On Hold

Marketing Event Status PLANNING Planning Planned

Table E–1 Seeded User Statuses (Cont.)

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
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Marketing Event Status SUBMITTED_BA Submitted Budget 
Approval

Pending Budget approval

Marketing Event Status SUBMITTED_TA Submitted Theme Approval Pending Theme approval

Model Status ARCHIVED Archived Archived

Model Status AVAILABLE Available Available

Model Status BUILDING Building Building

Model Status CUSTOM Custom Custom

Model Status DRAFT Draft Draft

Model Status EXPIRED Expired Expired

Model Status QUEUED Queued Queued

Model Status SCHEDULED Scheduled Scheduled

Model Status SCORING Scoring Scoring

Offer Status ACTIVE Active Active

Offer Status ARCHIVED Archived Archived

Offer Status CANCELLED Cancelled Cancelled

Offer Status CLOSED Closed Closed

Offer Status COMPLETED Completed Completed

Offer Status DRAFT Draft Draft

Offer Status ONHOLD On Hold On-Hold

Offer Status PENDING Pending Budget Approval Submitted - Budget Approval

Offer Status PENDING_ACTIVE Pending Active Pending Active

Offer Status REJECTED Budget Rejected Rejected - Budget Approval

Offer Status TERMINATED Terminated Terminated

Price List Statuses ACTIVE Active Active

Price List Statuses CANCELLED Cancelled Cancelled

Price List Statuses DRAFT Draft Draft

Price List Statuses PENDING Submitted For Approval Submitted For Approval

Price List Statuses REJECTED Rejected Rejected

Program Status ACTIVE Active Active

Table E–1 Seeded User Statuses (Cont.)

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
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Program Status ARCHIVED Archived Archived

Program Status CANCELLED Cancelled Cancelled

Program Status COMPLETED Completed Completed

Program Status NEW Draft Draft

Program Status ON_HOLD On Hold On Hold

Score status ARCHIVED Archived Archived

Score status COMPLETED Completed Completed

Score status DRAFT Draft Draft

Score status QUEUED Queued Queued

Score status SCHEDULED Scheduled Scheduled

Score status SCORING Scoring Running

Segment Status ARCHIVED Archived Archived

Segment Status AVAILABLE Available Available

Segment Status CANCELLED Cancelled Cancelled

Segment Status DRAFT Draft Draft

Segment Status EXPIRED Expired Expired

Table E–1 Seeded User Statuses (Cont.)

User Status For SYSTEM_STATUS SYSTEM_NAME User Status Name
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F
Seeded Data Source and Data Source

Attribute Reference

This appendix describes seeded data sources and data source attributes used for 
Oracle Marketing list generation and data mining functionality. 

Topics include:

■ Section F.1, "Seeded Data Sources"

■ Section F.2, "Seeded Data Source Parent-Child Relationships"

■ Section F.3, "Data Source Attribute Reference"
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F.1 Seeded Data Sources
The following parent data sources are seeded for release 11.5.10:

■ Person: Represents Business to Consumer (B2C) customer attributes such as 
first name, last name, marital status, household income, etc. 

■ Organization Contacts: Represents Business to Business (B2B) attributes such as 
first name, last name, job title, work e-mail address, etc.

■ Organization: Represents organization attributes such as company name, 
business type, revenue, etc. 

F.2 Seeded Data Source Parent-Child Relationships
The following table describes parent-child relationships for each of the seeded data 
sources.

Table F–1 Seeded Data Source Parent-Child Relationships

Parent Data Source  Child Data Sources

Persons ■ Person Profile

■ Person Interest

■ Person Accounts

■ Person Education

■ Employment History

■ Phone1 – 6 (11.5.9)

■ Fax (11.5.9)

■ System Reference

■ Interactions

■ Leads

■ Order Detail

■ Install Base Details

■ Sales Access

■ Data Mining Aggregates

■ Data Mining Scores

■ Party Profitability
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Organization Contacts ■ Organizations

■ Organization Profiles

■ Organization Accounts

■ Phone1 – 6 (11.5.9)

■ Fax (11.5.9)

■ System Reference

■ Interactions

■ Leads

■ Order Detail

■ Install Base Details

■ Sales Access

■ Data Mining Aggregates

■ Data Mining Score 

■ Party Profitability 

■ Person Profile 

■ Person Interest 

■ Person Education

■ Employment History

Organization ■ Organization Profiles

■ Organization Accounts

■ System Reference

■ Order Detail

■ Install Base Details

■ Sales Access

■ Data Mining Aggregates

■ Data Mining Scores

■ Party Profitability

Table F–1 Seeded Data Source Parent-Child Relationships

Parent Data Source  Child Data Sources
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F.3 Data Source Attribute Reference
The following table lists seeded data source attributes, the tables or logic from 
which attribute values are derived, and the name of the data source(s) that use the 
attribute.

Table F–2 Data Source Attributes 

Attribute Source Data Source Name(s)

ACCOUNT_ACTIVATION_DATE HZ_CUST_ACCOUNTS Account

ACCOUNT_ESTABLISHED_DATE HZ_CUST_ACCOUNTS Account

ACCOUNT_LIABLE_FLAG HZ_CUST_ACCOUNTS Account

ACCOUNT_NAME HZ_CUST_ACCOUNTS Account

ACCOUNT_NUMBER HZ_CUST_ACCOUNTS Account

ACCOUNT_TERMINATION_DATE HZ_CUST_ACCOUNTS Account

ACCT_LIFE_CYCLE_STATUS HZ_CUST_ACCOUNTS Account

AUTOPAY_FLAG HZ_CUST_ACCOUNTS Account

COMPETITOR_TYPE HZ_CUST_ACCOUNTS Account

COTERMINATE_DAY_MONTH HZ_CUST_ACCOUNTS Account

CREDIT_CLASSIFICATION_CODE HZ_CUST_ACCOUNTS Account

CURRENT_BALANCE HZ_CUST_ACCOUNTS Account

CUST_ACCOUNT_ID HZ_CUST_ACCOUNTS Account

CUSTOMER_CLASS_CODE HZ_CUST_ACCOUNTS Account

CUSTOMER_TYPE HZ_CUST_ACCOUNTS Account

DATE_TYPE_PREFERENCE HZ_CUST_ACCOUNTS Account

DATES_NEGATIVE_TOLERANCE HZ_CUST_ACCOUNTS Account

DATES_POSITIVE_TOLERANCE HZ_CUST_ACCOUNTS Account

DEPARTMENT HZ_CUST_ACCOUNTS Account

DEPOSIT_REFUND_METHOD HZ_CUST_ACCOUNTS Account

DORMANT_ACCOUNT_FLAG HZ_CUST_ACCOUNTS Account

FOB_POINT HZ_CUST_ACCOUNTS Account

FREIGHT_TERM HZ_CUST_ACCOUNTS Account
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HELD_BILL_EXPIRATION_DATE HZ_CUST_ACCOUNTS Account

HIGH_PRIORITY_INDICATOR HZ_CUST_ACCOUNTS Account

HOLD_BILL_FLAG HZ_CUST_ACCOUNTS Account

HOTWATCH_SERVICE_FLAG HZ_CUST_ACCOUNTS Account

HOTWATCH_SVC_BAL_IND HZ_CUST_ACCOUNTS Account

ITEM_CROSS_REF_PREF HZ_CUST_ACCOUNTS Account

MAJOR_ACCOUNT_NUMBER HZ_CUST_ACCOUNTS Account

NOTIFY_FLAG HZ_CUST_ACCOUNTS Account

NPA_NUMBER HZ_CUST_ACCOUNTS Account

ORIG_SYSTEM_REFERENCE HZ_CUST_ACCOUNTS Account

OVER_RETURN_TOLERANCE HZ_CUST_ACCOUNTS Account

OVER_SHIPMENT_TOLERANCE HZ_CUST_ACCOUNTS Account

PAYMENT_TERM_ID HZ_CUST_ACCOUNTS Account

PERSON_NAME_SUFFIX HZ_CUST_ACCOUNTS Account

PO_EFFECTIVE_DATE HZ_CUST_ACCOUNTS Account

PO_EXPIRATION_DATE HZ_CUST_ACCOUNTS Account

POSTAL_CODE HZ_CUST_ACCOUNTS Account

PRICING_EVENT HZ_CUST_ACCOUNTS Account

PRIMARY_SALESREP_ID HZ_CUST_ACCOUNTS Account

PRIMARY_SPECIALIST_ID HZ_CUST_ACCOUNTS Account

REALTIME_RATE_FLAG HZ_CUST_ACCOUNTS Account

RESTRICTION_LIMIT_AMOUNT HZ_CUST_ACCOUNTS Account

SALES_CHANNEL_CODE HZ_CUST_ACCOUNTS Account

SECONDARY_SPECIALIST_ID HZ_CUST_ACCOUNTS Account

SHIP_PARTIAL HZ_CUST_ACCOUNTS Account

SHIP_VIA HZ_CUST_ACCOUNTS Account

SINGLE_USER_FLAG HZ_CUST_ACCOUNTS Account
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SOURCE_CODE HZ_CUST_ACCOUNTS Account

STATUS HZ_CUST_ACCOUNTS Account

STATUS_UPDATE_DATE HZ_CUST_ACCOUNTS Account

SUSPENSION_DATE HZ_CUST_ACCOUNTS Account

TAX_CODE HZ_CUST_ACCOUNTS Account

TAX_HEADER_LEVEL_FLAG HZ_CUST_ACCOUNTS Account

TAX_ROUNDING_RULE HZ_CUST_ACCOUNTS Account

UNDER_RETURN_TOLERANCE HZ_CUST_ACCOUNTS Account

UNDER_SHIPMENT_TOLERANCE HZ_CUST_ACCOUNTS Account

WATCH_ACCOUNT_FLAG HZ_CUST_ACCOUNTS Account

WATCH_BALANCE_INDICATOR HZ_CUST_ACCOUNTS Account

WRITE_OFF_ADJUSTMENT_AMOUNT HZ_CUST_ACCOUNTS Account

WRITE_OFF_AMOUNT HZ_CUST_ACCOUNTS Account

WRITE_OFF_PAYMENT_AMOUNT HZ_CUST_ACCOUNTS Account

ACCOUNT_RECEIVABLE HZ_FINANCIAL_NUMBERS. 
(FINANCIAL_NUMBER and 
FINANCIAL_NUMBER_CURRENCY 
where FINANCIAL_NUMBER_NAME 
= ‘ACCOUNTS_RECEIVABLE’)

Data Mining 
Aggregates

AVG_CALL_LENGTH BIC_PARTY_SUMM Data Mining 
Aggregates

AVG_CLOSED_SRS BIC_PARTY_SUMM Data Mining 
Aggregates

AVG_COMPLAINTS BIC_PARTY_SUMM Data Mining 
Aggregates

AVG_DISC_OFFERED Derived using AMS_ACT_OFFERS and 
AMS_CAMPAIGN_SCHEDULES_VL 
fields

Data Mining 
Aggregates

AVG_HOLD_TIME BIC_PARTY_SUMM Data Mining 
Aggregates

AVG_LEN_OF_EMP BIC_PARTY_SUMM Data Mining 
Aggregates

Table F–2 Data Source Attributes (Cont.)

Attribute Source Data Source Name(s)



Data Source Attribute Reference

      Seeded Data Source and Data Source Attribute Reference F-7

AVG_ORDER_AMOUNT BIC_PARTY_SUMM. ORDER_AMT 
divided by ORDER_NUM

Data Mining 
Aggregates

AVG_RESOLVE_DAYS_1_MONTH BIC_PARTY_SUMM.AVG_SR_RESL_
TIME

Data Mining 
Aggregates

AVG_RESOLVE_DAYS_3_MONTHS BIC_PARTY_SUMM. AVG_SR_RESL_
TIME over the last 3 months

Data Mining 
Aggregates

AVG_RESOLVE_DAYS_6_MONTHS BIC_PARTY_SUMM. AVG_SR_RESL_
TIME over the last 6 months

Data Mining 
Aggregates

AVG_RESOLVE_DAYS_YEAR BIC_PARTY_SUMM. AVG_SR_RESL_
TIME over the past year

Data Mining 
Aggregates

AVG_TALK_TIME BIC_PARTY_SUMM. AVG_TALK_
TIME

Data Mining 
Aggregates

AVG_TRANSFERS_PER_SR BIC_PARTY_SUMM Data Mining 
Aggregates

AVG_UNITS_PER_ORDER BIC_PARTY_SUMM. ORDER_QTY 
divided by ORDER_NUM

Data Mining 
Aggregates

AVG_WORKLOAD BIC_PARTY_SUMM Data Mining 
Aggregates

CAPITAL_AMOUNT "HZ_FINANCIAL_
NUMBERS.[FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME IN (‘ISSUED_
CAPITAL’, ‘PAID_IN_CAPITAL’  
‘NOMINAL_CAPITAL’, 
‘AUTHORIZED_CAPITAL’)]"

Data Mining 
Aggregates

CAPITAL_TYPE_INDICATOR HZ_FINANCIAL_
NUMBERS.FINANCIAL_NUMBER_
NAME (where FINANCIAL_NUMBER_
NAME in (‘ISSUED_CAPITAL’ , ‘PAID_
IN_CAPITAL’, ‘NOMINAL_CAPITAL’, 
‘AUTHORIZED_CAPITAL’))

Data Mining 
Aggregates

CLOSED_SRS BIC_PARTY_SUMM Data Mining 
Aggregates

COGS BIC_PARTY_SUMM Data Mining 
Aggregates
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CONTRACT_AMT BIC_PARTY_SUMM Data Mining 
Aggregates

CONTRACT_DURATION BIC_PARTY_SUMM Data Mining 
Aggregates

CONTRACTS_CUML BIC_PARTY_SUMM Data Mining 
Aggregates

CURRENT_ASSETS HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME = ‘TOTAL_
CURRENT_ASSETS’)

Data Mining 
Aggregates

CURRENT_LIABILITIES HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME = ‘TOTAL_CURR_
LIABILITIES’)

Data Mining 
Aggregates

DAYS_SINCE_FIRST_CONTACT Derived using MIN (AMS_LIST_
HEADERS_VL. SENT_OUT_DATE) 
where SENT_OUT_DATE is not Null 
and AMS_LIST_ENTRIES fields

Data Mining 
Aggregates

DAYS_SINCE_LAST_EVENT MAX (AMS_EVENT_OFFERS_
VL.EVENT_START_DATE) where 
PARTY_ID in (AMS_EVENT_
REGISTRATIONS.ATTENDANT_
PARTY_ID)

Data Mining 
Aggregates

DAYS_SINCE_LAST_TARGETED Derived using MAX (AMS_LIST_
HEADERS_VL. SENT_OUT_DATE) 
where party in AMS_LIST_ENTRIES. 
PARTY_ID

Data Mining 
Aggregates

DEBT_TO_INCOME_RATIO HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY Where FINANCIAL_
NUMBER_NAME = ‘LONG_TERM_
DEBT’)

Data Mining 
Aggregates

ESCALATED_SRS BIC_PARTY_SUMM Data Mining 
Aggregates

Table F–2 Data Source Attributes (Cont.)

Attribute Source Data Source Name(s)



Data Source Attribute Reference

      Seeded Data Source and Data Source Attribute Reference F-9

FIRST_CALL_CL_RATE BIC_PARTY_SUMM Data Mining 
Aggregates

GROSS_ANNUAL_INCOME HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME = ‘GROSS_
INCOME’)

Data Mining 
Aggregates

GROSS_ANNUAL_SALES HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME = ‘SALES’)

Data Mining 
Aggregates 

HZ_PARTY_SITE_USES.BEGIN_DATE 
and END_DATE for SITE_USE_TYPE = 
RESIDES_AT

 HZ_PARTY_SITE_USES Data Mining 
Aggregates

INACTIVE_CONTRACTS BIC_PARTY_SUMM Data Mining 
Aggregates

LAST_TARGETED_CHANNEL_CODE Derived using AMS_CAMPAIGN_
SCHEDULES_VL AMS_LIST_
HEADERS_VL and AMS_LIST_
ENTRIES fields

Data Mining 
Aggregates

NET_PROFIT HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME=‘PROFIT_BEFORE_
TAX’)

Data Mining 
Aggregates

NET_WORTH HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME = ‘NET_WORTH’)

Data Mining 
Aggregates

NEW_CONTRACTS BIC_PARTY_SUMM Data Mining 
Aggregates

NUM_OF_COMPLAINTS BIC_PARTY_SUMM Data Mining 
Aggregates

NUM_OF_INTERACTIONS BIC_PARTY_SUMM Data Mining 
Aggregates

Table F–2 Data Source Attributes (Cont.)

Attribute Source Data Source Name(s)



Data Source Attribute Reference

F-10 Oracle Marketing Implementation and Administration Guide    

NUM_OF_SR_1_MONTH BIC_PARTY_SUMM. SRS_LOGGED Data Mining 
Aggregates

NUM_OF_SR_3_MONTHS SUM (BIC_PARTY_SUMM. SRS_
LOGGED) over the last 3 months

Data Mining 
Aggregates

NUM_OF_SR_6_MONTHS SUM (BIC_PARTY_SUMM. SRS_
LOGGED) over the last 6 months

Data Mining 
Aggregates

NUM_OF_SR_YEAR SUM (BIC_PARTY_SUMM. SRS_
LOGGED) over the past year

Data Mining 
Aggregates

NUM_OF_TRANSFERS BIC_PARTY_SUMM Data Mining 
Aggregates

NUM_TGT_BY_OFFR_TYP1 Derived using AMS_LIST_ENTRIES 
AMS_LIST_HEADERS_ALL AMS_
CAMPAIGN_SCHEDULES_B AMS_
ACT_OFFERS

Data Mining 
Aggregates

NUM_TGT_BY_OFFR_TYP2 Derived using AMS_LIST_ENTRIES 
AMS_LIST_HEADERS_ALL AMS_
CAMPAIGN_SCHEDULES_B AMS_
ACT_OFFERS

Data Mining 
Aggregates

NUM_TGT_BY_OFFR_TYP3 Derived using AMS_LIST_ENTRIES 
AMS_LIST_HEADERS_ALL AMS_
CAMPAIGN_SCHEDULES_B AMS_
ACT_OFFERS

Data Mining 
Aggregates

NUM_TGT_BY_OFFR_TYP4 Derived using AMS_LIST_ENTRIES 
AMS_LIST_HEADERS_ALL AMS_
CAMPAIGN_SCHEDULES_B AMS_
ACT_OFFERS

Data Mining 
Aggregates

NUM_TIMES_TARGETED AMS_LIST_HEADERS_VL.SENT_OUT_
DATE is not Null AND party is in AMS_
LIST_ENTRIES. PARTY_ID

Data Mining 
Aggregates

NUM_TIMES_TARGETED_DIRECT Derived using AMS_LIST_ENTRIES 
AMS_LIST_HEADERS_ALL AMS_
CAMPAIGN_SCHEDULES_B AMS_
MEDIA_VL

Data Mining 
Aggregates

NUM_TIMES_TARGETED_EMAIL Derived using AMS_LIST_ENTRIES 
AMS_LIST_HEADERS_ALL AMS_
CAMPAIGN_SCHEDULES_B AMS_
MEDIA_VL

Data Mining 
Aggregates

Table F–2 Data Source Attributes (Cont.)

Attribute Source Data Source Name(s)



Data Source Attribute Reference

      Seeded Data Source and Data Source Attribute Reference F-11

NUM_TIMES_TARGETED_TELEMKT Derived using AMS_LIST_ENTRIES 
AMS_LIST_HEADERS_ALL AMS_
CAMPAIGN_SCHEDULES_B AMS_
MEDIA_VL

Data Mining 
Aggregates

NUM_TYPES_DISC_OFFERED Derived using AMS_ACT_OFFERS And 
AMS_CAMPAIGN_SCHEDULES_VL 
fields

Data Mining 
Aggregates

ONTIME_PAYMENTS BIC_PARTY_SUMM Data Mining 
Aggregates

ONTIME_SHIP_PCT BIC_PARTY_SUMM Data Mining 
Aggregates

OPEN_CONTRACTS BIC_PARTY_SUMM Data Mining 
Aggregates

OPEN_SRS BIC_PARTY_SUMM Data Mining 
Aggregates

ORDER_LINES_DELIVERED BIC_PARTY_SUMM Data Mining 
Aggregates

ORDER_LINES_ONTIME BIC_PARTY_SUMM Data Mining 
Aggregates

ORDER_QTY_CUML BIC_PARTY_SUMM Data Mining 
Aggregates

ORDER_RECENCY BIC_PARTY_SUMM Data Mining 
Aggregates

PARTY_ID -- Data Mining 
Aggregates

PAYMENTS BIC_PARTY_SUMM Data Mining 
Aggregates

PERCT_CALL_REWORK BIC_PARTY_SUMM Data Mining 
Aggregates

PRODUCTS BIC_PARTY_SUMM Data Mining 
Aggregates

REFERALS BIC_PARTY_SUMM Data Mining 
Aggregates

RENEWED_CONTRACTS BIC_PARTY_SUMM Data Mining 
Aggregates

Table F–2 Data Source Attributes (Cont.)

Attribute Source Data Source Name(s)



Data Source Attribute Reference

F-12 Oracle Marketing Implementation and Administration Guide    

REOPENED_SRS BIC_PARTY_SUMM Data Mining 
Aggregates

RETAINED_EARNINGS HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME = ‘RETAINED_
EARNINGS’)

Data Mining 
Aggregates

RETURN_BY_VALUE BIC_PARTY_SUMM Data Mining 
Aggregates

RETURN_BY_VALUE_PCT BIC_PARTY_SUMM Data Mining 
Aggregates

RETURNS BIC_PARTY_SUMM Data Mining 
Aggregates

SALES BIC_PARTY_SUMM Data Mining 
Aggregates

TIMES_TARGETED_12_MONTH Derived using AMS_LIST_HEADERS_
VL. SENT_OUT_DATE (if not Null) and 
party in AMS_LIST_ENTRIES. PARTY_
ID for last year

Data Mining 
Aggregates

TIMES_TARGETED_3_MONTH Derived using AMS_LIST_HEADERS_
VL. SENT_OUT_DATE (if not Null) and 
party in AMS_LIST_ENTRIES. PARTY_
ID for last 3 months

Data Mining 
Aggregates

TIMES_TARGETED_6_MONTH Derived using AMS_LIST_HEADERS_
VL. SENT_OUT_DATE (if not Null) and 
party in AMS_LIST_ENTRIES. PARTY_
ID for last 6 months

Data Mining 
Aggregates

TIMES_TARGETED_9_MONTH Derived using AMS_LIST_HEADERS_
VL. SENT_OUT_DATE (if not Null) and 
party in AMS_LIST_ENTRIES. PARTY_
ID for last 9 months

Data Mining 
Aggregates

TIMES_TARGETED_MONTH Derived using AMS_LIST_HEADERS_
VL. SENT_OUT_DATE (if not Null) and 
party in AMS_LIST_ENTRIES. PARTY_
ID for last month

Data Mining 
Aggregates

TOT_CALLS BIC_PARTY_SUMM Data Mining 
Aggregates
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TOT_NUM_ORDER_3_MONTHS SUM (BIC_PARTY_SUMM.ORDER_
QTY) over the past 3 months

Data Mining 
Aggregates

TOT_NUM_ORDER_6_MONTHS SUM (BIC_PARTY_SUMM.ORDER_
QTY) over the past 6 months

Data Mining 
Aggregates

TOT_NUM_ORDER_9_MONTHS SUM (BIC_PARTY_SUMM.ORDER_
QTY) over the past 9 months

Data Mining 
Aggregates

TOT_NUM_ORDER_YEAR SUM (BIC_PARTY_SUMM.ORDER_
QTY) over the past year

Data Mining 
Aggregates

TOT_ORDER_AMOUNT_3_MONTHS SUM (BIC_PARTY_SUMM.ORDER_
AMT) over the past 3 months

Data Mining 
Aggregates

TOT_ORDER_AMOUNT_6_MONTHS SUM (BIC_PARTY_SUMM.ORDER_
AMT) over the past 6 months

Data Mining 
Aggregates

TOT_ORDER_AMOUNT_9_MONTHS SUM (BIC_PARTY_SUMM.ORDER_
AMT) over the past 9 months

Data Mining 
Aggregates

TOT_ORDER_AMOUNT_YEAR SUM (BIC_PARTY_SUMM.ORDER_
AMT) over the past year

Data Mining 
Aggregates

TOTAL_ASSETS HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME = ‘TOTAL_ASSETS’)

Data Mining 
Aggregates

TOTAL_DEBT_OUTSTANDING HZ_FINANCIAL_
NUMBERS.(FINANCIAL_NUMBER 
and FINANCIAL_NUMBER_
CURRENCY where FINANCIAL_
NUMBER_NAME = ‘LONG_TERM_
DEBT’)

Data Mining 
Aggregates

TOTAL_SR_RESPONSE_TIME BIC_PARTY_SUMM Data Mining 
Aggregates

ARC_USED_FOR_OBJECT AMS_DM_SOURCE Data Mining Scores

CONTINUOUS_SCORE AMS_DM_SOURCE Data Mining Scores

CREATED_BY ams_dm_scores_all_b Data Mining Scores

CREATION_DATE ams_dm_scores_all_b Data Mining Scores

DECILE AMS_DM_SOURCE Data Mining Scores
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LAST_UPDATE_DATE ams_dm_scores_all_b Data Mining Scores

LAST_UPDATE_LOGIN ams_dm_scores_all_b Data Mining Scores

LAST_UPDATED_BY ams_dm_scores_all_b Data Mining Scores

MODEL_ID ams_dm_scores_all_b Data Mining Scores

MODEL_NAME ams_dm_models_all_tl Data Mining Scores

MODEL_TYPE ams_dm_scores_all_tl Data Mining Scores

PARTY_ID AMS_DM_SOURCE Data Mining Scores

SCORE_ID ams_dm_scores_all_b Data Mining Scores

SCORE_NAME ams_dm_scores_all_tl Data Mining Scores

USED_FOR_OBJECT_ID AMS_DM_SOURCE Data Mining Scores

BEGIN_DATE HZ_EMPLOYMENT_HISTORY Employment History

BRANCH HZ_EMPLOYMENT_HISTORY Employment History

EMPLOYED_AS_TITLE HZ_EMPLOYMENT_HISTORY Employment History

EMPLOYED_BY_DIVISION_NAME HZ_EMPLOYMENT_HISTORY Employment History

EMPLOYED_BY_NAME_COMPANY HZ_EMPLOYMENT_HISTORY Employment History

EMPLOYMENT_HISTORY_ID HZ_EMPLOYMENT_HISTORY Employment History

END_DATE HZ_EMPLOYMENT_HISTORY Employment History

MILITARY_RANK HZ_EMPLOYMENT_HISTORY Employment History

PARTY_ID HZ_EMPLOYMENT_HISTORY Employment History

RESPONSIBILITY HZ_EMPLOYMENT_HISTORY Employment History

SERVED HZ_EMPLOYMENT_HISTORY Employment History

STATION HZ_EMPLOYMENT_HISTORY Employment History

SUPERVISOR_NAME HZ_EMPLOYMENT_HISTORY Employment History

ACTIVE_END_DATE CSI_ITEM_INSTANCES Install Base Details

ACTIVE_START_DATE CSI_ITEM_INSTANCES Install Base Details

ACTUAL_RETURN_DATE CSI_ITEM_INSTANCES Install Base Details

CATEGORY_DESC CSI_ITEM_INSTANCES Install Base Details
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CITY CSI_ITEM_INSTANCES Install Base Details

COMPLETENESS_FLAG CSI_ITEM_INSTANCES Install Base Details

CONCAT_CAT_PARENTAGE CSI_ITEM_INSTANCES Install Base Details

CONCATENATED_SEGMENTS CSI_ITEM_INSTANCES Install Base Details

CONTEXT CSI_ITEM_INSTANCES Install Base Details

COUNTRY CSI_ITEM_INSTANCES Install Base Details

COUNTY CSI_ITEM_INSTANCES Install Base Details

CREATED_BY CSI_ITEM_INSTANCES Install Base Details

CREATION_COMPLETE_FLAG CSI_ITEM_INSTANCES Install Base Details

CREATION_DATE CSI_ITEM_INSTANCES Install Base Details

DESCRIPTION CSI_ITEM_INSTANCES Install Base Details

INSTALL_DATE CSI_ITEM_INSTANCES Install Base Details

INSTANCE_DESCRIPTION CSI_ITEM_INSTANCES Install Base Details

INSTANCE_ID CSI_ITEM_INSTANCES Install Base Details

INSTANCE_NUMBER CSI_ITEM_INSTANCES Install Base Details

INSTANCE_STATUS_ID CSI_ITEM_INSTANCES Install Base Details

INSTANCE_USAGE_MEANING CSI_ITEM_INSTANCES Install Base Details

INV_MASTER_ORGANIZATION_ID CSI_ITEM_INSTANCES Install Base Details

INV_ORGANIZATION_ID CSI_ITEM_INSTANCES Install Base Details

INVENTORY_ITEM_ID CSI_ITEM_INSTANCES Install Base Details

ITEM_DESCRIPTION CSI_ITEM_INSTANCES Install Base Details

ITEM_TYPE CSI_ITEM_INSTANCES Install Base Details

LAST_CUST_PO_NUMBER CSI_ITEM_INSTANCES Install Base Details

LAST_HEADER_ID CSI_ITEM_INSTANCES Install Base Details

LAST_LINE_ID CSI_ITEM_INSTANCES Install Base Details

LAST_LINE_NUMBER CSI_ITEM_INSTANCES Install Base Details

LAST_OE_ORDER_LINE_ID CSI_ITEM_INSTANCES Install Base Details
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LAST_ORDER_NUMBER CSI_ITEM_INSTANCES Install Base Details

LOCATION_ID CSI_ITEM_INSTANCES Install Base Details

LOCATION_TYPE_CODE CSI_ITEM_INSTANCES Install Base Details

LOT_CONTROL_CODE CSI_ITEM_INSTANCES Install Base Details

MANUALLY_CREATED_FLAG CSI_ITEM_INSTANCES Install Base Details

NAME CSI_ITEM_INSTANCES Install Base Details

OWNER_PARTY_ACCOUNT_ID CSI_ITEM_INSTANCES Install Base Details

OWNER_PARTY_ID CSI_ITEM_INSTANCES Install Base Details

PADDED_CONCATENATED_
SEGMENTS

CSI_ITEM_INSTANCES Install Base Details

POSTAL_CODE CSI_ITEM_INSTANCES Install Base Details

PROVINCE CSI_ITEM_INSTANCES Install Base Details

QUANTITY CSI_ITEM_INSTANCES Install Base Details

RETURN_BY_DATE CSI_ITEM_INSTANCES Install Base Details

SERIAL_NUMBER_CONTROL_CODE CSI_ITEM_INSTANCES Install Base Details

SHIPPED_DATE CSI_ITEM_INSTANCES Install Base Details

STATE CSI_ITEM_INSTANCES Install Base Details

TERMINATED_FLAG CSI_ITEM_INSTANCES Install Base Details

UNIT_OF_MEASURE CSI_ITEM_INSTANCES Install Base Details

ACTION JTF_IH_ACTIONS_TL Interactions

ACTION_ID JTF_IH_ACTIVITIES Interactions

ACTION_ITEM JTF_IH_ACTION_ITEMS_TL Interactions

ACTION_ITEM_ID JTF_IH_ACTIVITIES Interactions

ACTIVE JTF_IH_ACTIVITIES Interactions

ACTIVITY JTF_IH_ACTION_ITEMS_TL Interactions

ACTIVITY_ID JTF_IH_ACTIVITIES Interactions

CREATION_DATE JTF_IH_ACTIVITIES Interactions

CUST_ACCOUNT_ID JTF_IH_INTERACTIONS Interactions
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DIRECTION JTF_IH_ACTIVITIES Interactions

DOC_ID JTF_IH_MEDIA_ITEMS Interactions

DOC_REF JTF_IH_ACTIVITIES Interactions

END_DATE_TIME JTF_IH_ACTIVITIES Interactions

HANDLER_ID JTF_IH_ACTIVITIES Interactions

INTERACTION_ID JTF_IH_INTERACTIONS Interactions

MEDIA_ID JTF_IH_ACTIVITIES Interactions

MEDIA_ITEM_TYPE JTF_IH_ACTIVITIES Interactions

OBJECT_ID JTF_IH_MEDIA_ITEMS Interactions

OUTCOME_CODE JTF_IH_ACTIVITIES Interactions

OUTCOME_DESCRIPTION JTF_IH_OUTCOMES_TL Interactions

OUTCOME_ID JTF_IH_ACTIVITIES Interactions

PARTY_ID JTF_IH_INTERACTIONS Interactions

POSITIVE_RESPONSE_FLAG JTF_IH_RESULTS_TL Interactions

REASON_CODE JTF_IH_REASONS_TL Interactions

REASON_DESCRIPTION JTF_IH_ACTIVITIES Interactions

REASON_ID JTF_IH_INTERACTIONS Interactions

RESOURCE_ID JTF_IH_RESULTS_TL Interactions

RESULT_CODE JTF_IH_ACTIVITIES Interactions

RESULT_DESCRIPTION JTF_IH_ACTIVITIES Interactions

RESULT_ID JTF_IH_OUTCOMES_TL Interactions

SCRIPT_ID JTF_IH_REASONS_TL Interactions

SCRIPT_TRANS_ID JTF_IH_RESULTS_TL Interactions

SOURCE_CODE JTF_IH_ACTIVITIES Interactions

SOURCE_CODE_ID JTF_IH_ACTIVITIES Interactions

START_DATE_TIME JTF_IH_ACTIVITIES Interactions
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PARTY_NAME HZ_PARTIES Interactions, 
Organization, and 
Person

ACCEPT_FLAG AS_SALES_LEADS Leads

ADDRESS_ID AS_SALES_LEADS Leads

ASSIGN_SALES_GROUP_ID AS_SALES_LEADS Leads

ASSIGN_TO_PERSON_ID AS_SALES_LEADS Leads

ASSIGN_TO_SALESFORCE_ID AS_SALES_LEADS Leads

BUDGET_AMOUNT AS_SALES_LEADS Leads

BUDGET_STATUS AS_LOOKUPS Leads

BUDGET_STATUS_CODE AS_SALES_LEADS Leads

CATEGORY_ID AS_SALES_LEAD_LINES Leads

CATEGORY_SET_ID AS_SALES_LEAD_LINES Leads

CHANNEL_CODE AS_SALES_LEADS Leads

CLOSE_REASON AS_SALES_LEADS Leads

CONTACT_ROLE_CODE AS_SALES_LEADS Leads

CREATION_DATE AS_SALES_LEADS Leads

CURRENCY_CODE AS_SALES_LEADS Leads

CUSTOMER_ID AS_SALES_LEADS Leads

DECISION_TIMEFRAME_CODE AS_SALES_LEADS Leads

DESCRIPTION AS_SALES_LEADS Leads

GROUP_NAME AS_LOOKUPS Leads

INVENTORY_ITEM_ID AS_SALES_LEAD_LINES Leads

LAST_UPDATE_DATE AS_SALES_LEADS Leads

LEAD_NUMBER AS_SALES_LEADS Leads

LEAD_RANK_CODE AS_SALES_LEADS Leads

LEAD_RANK_ID AS_SALES_LEADS Leads

LEAD_STATUS AS_STATUSES_TL Leads
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ORGANIZATION_ID AS_SALES_LEAD_LINES Leads

ORIG_SYSTEM_REFERENCE AS_SALES_LEADS Leads

PRIMARY_CNT_PERSON_PARTY_ID AS_SALES_LEADS Leads

PRIMARY_CONTACT_PARTY_ID AS_SALES_LEADS Leads

PRIMARY_CONTACT_PHONE_ID AS_SALES_LEADS Leads

QUALIFIED_FLAG AS_SALES_LEADS Leads

QUANTITY AS_SALES_LEAD_LINES Leads

RANK AS_SALES_LEAD_RANKS_TL Leads

SALES_CHANNEL ASO_I_SALES_CHANNELS_V Leads

SALES_LEAD_ID AS_SALES_LEADS Leads

SOURCE_PROMOTION_CODE AMS_P_SOURCE_CODES_V Leads

SOURCE_PROMOTION_ID AS_SALES_LEADS Leads

SOURCE_PROMOTION_NAME AMS_P_SOURCE_CODES_V Leads

STATUS_CODE AS_SALES_LEADS Leads

TIME_FRAME AS_SALES_LEADS Leads

UNIT_OF_MEASURE_TL MTL_UNITS_OF_MEASURE Leads

UOM_CODE AS_SALES_LEAD_LINES Leads

URGENT_FLAG AS_SALES_LEADS Leads

VEH_RESP_CODE_MEANING AS_LOOKUPS Leads

VEHICLE_RESPONSE_CODE AS_SALES_LEADS Leads

CONCAT_CAT_PARENTAGE ENI_PROD_DEN_HRCHY_PARENTS_
V

Leads and Order 
Details

CONCATENATED_SEGMENTS MTL_SYSTEM_ITEMS_VL Leads and Order 
Details

ITEM_DESCRIPTION MTL_SYSTEM_ITEMS_VL Leads and Order 
Details

CATEGORY_DESC ENI_PROD_DEN_HRCHY_PARENTS_
V

Leads and Order 
Details

RESOURCE_NAME JTF_RS_RESOURCE_EXTNS Leads and Sales Access
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ACTUAL_ARRIVAL_DATE OE_ORDER_LINES_ALL Order Details

ACTUAL_SHIPMENT_DATE OE_ORDER_LINES_ALL Order Details

ATO_LINE_ID OE_ORDER_LINES_ALL Order Details

BOOKED_DATE OE_ORDER_HEADERS_ALL Order Details

BOOKED_FLAG OE_ORDER_LINES_ALL Order Details

CANCELLED_FLAG OE_ORDER_LINES_ALL Order Details

CANCELLED_QUANTITY OE_ORDER_LINES_ALL Order Details

CREATION_DATE OE_ORDER_LINES_ALL Order Details

EXTENDED_PRICE NVL(OL.UNIT_SELLING_PRICE,0)*( 
NVL(OL.ORDERED_QUANTITY,0) - 
NVL(OL.CANCELLED_QUANTITY,0) )

Order Details

FULFILLED_QUANTITY OE_ORDER_LINES_ALL Order Details

HEADER_ID OE_ORDER_LINES_ALL Order Details

INVENTORY_ITEM_ID MTL_SYSTEM_ITEMS_VL Order Details

INVOICE_TO_ORG_ID OE_ORDER_LINES_ALL Order Details

ITEM_NUMBER MTL_SYSTEM_ITEMS_VL Order Details

LAST_UPDATE_DATE OE_ORDER_LINES_ALL Order Details

LINE_CATEGORY_CODE OE_ORDER_LINES_ALL Order Details

LINE_ID OE_ORDER_LINES_ALL Order Details

LINE_NUMBER OE_ORDER_LINES_ALL Order Details

LINE_TYPE_ID OE_ORDER_LINES_ALL Order Details

MARKETING_SOURCE_CODE_ID OE_ORDER_HEADERS_ALL Order Details

OPEN_FLAG OE_ORDER_LINES_ALL Order Details

OPTION_NUMBER OE_ORDER_LINES_ALL Order Details

ORDER_QUANTITY_UOM OE_ORDER_LINES_ALL Order Details

ORDER_SOURCE_ID OE_ORDER_LINES_ALL Order Details

ORDERED_DATE OE_ORDER_HEADERS_ALL Order Details

ORDERED_QUANTITY OE_ORDER_LINES_ALL Order Details

Table F–2 Data Source Attributes (Cont.)

Attribute Source Data Source Name(s)



Data Source Attribute Reference

      Seeded Data Source and Data Source Attribute Reference F-21

ORG_ID OE_ORDER_HEADERS_ALL Order Details

PARTY_ID HZ_CUST_ACCOUNTS Order Details

PRICING_QUANTITY OE_ORDER_LINES_ALL Order Details

PRICING_QUANTITY_UOM OE_ORDER_LINES_ALL Order Details

PROMISE_DATE OE_ORDER_LINES_ALL Order Details

REQUEST_DATE OE_ORDER_LINES_ALL Order Details

SALES_CHANNEL_CODE OE_ORDER_HEADERS_ALL Order Details

SCHEDULE_ARRIVAL_DATE OE_ORDER_LINES_ALL Order Details

SCHEDULE_SHIP_DATE OE_ORDER_LINES_ALL Order Details

SHIP_TO_CONTACT_ID OE_ORDER_LINES_ALL Order Details

SHIP_TO_ORG_ID OE_ORDER_LINES_ALL Order Details

SHIPMENT_PRIORITY_CODE OE_ORDER_LINES_ALL Order Details

SHIPPED_QUANTITY OE_ORDER_LINES_ALL Order Details

SHIPPING_METHOD_CODE OE_ORDER_LINES_ALL Order Details

SHIPPING_QUANTITY OE_ORDER_LINES_ALL Order Details

SHIPPING_QUANTITY_UOM OE_ORDER_LINES_ALL Order Details

SOLD_FROM_ORG_ID OE_ORDER_HEADERS_ALL Order Details

SOLD_TO_ORG_ID OE_ORDER_HEADERS_ALL Order Details

TRANSACTIONAL_CURR_CODE OE_ORDER_HEADERS_ALL Order Details

UNIT_LIST_PRICE OE_ORDER_LINES_ALL Order Details

UNIT_SELLING_PRICE OE_ORDER_LINES_ALL Order Details

ANALYSIS_FY HZ_ORGANIZATION_PROFILES Organization

AVG_HIGH_CREDIT HZ_ORGANIZATION_PROFILES Organization

BRANCH_FLAG HZ_ORGANIZATION_PROFILES Organization

CEO_NAME HZ_ORGANIZATION_PROFILES Organization

CEO_TITLE HZ_ORGANIZATION_PROFILES Organization

CONG_DIST_CODE HZ_ORGANIZATION_PROFILES Organization
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CONTROL_YR HZ_ORGANIZATION_PROFILES Organization

CORPORATION_CLASS HZ_ORGANIZATION_PROFILES Organization

CREDIT_SCORE HZ_ORGANIZATION_PROFILES Organization

CURR_FY_POTENTIAL_REVENUE HZ_ORGANIZATION_PROFILES Organization

CUSTOMER_KEY HZ_PARTIES Organization

DB_RATING HZ_ORGANIZATION_PROFILES Organization

DISADV_8A_IND HZ_ORGANIZATION_PROFILES Organization

EFFECTIVE_END_DATE HZ_ORGANIZATION_PROFILES Organization

EFFECTIVE_START_DATE HZ_ORGANIZATION_PROFILES Organization

EMP_AT_PRIMARY_ADR HZ_ORGANIZATION_PROFILES Organization

EMPLOYEES_TOTAL HZ_ORGANIZATION_PROFILES Organization

EXPORT_IND HZ_ORGANIZATION_PROFILES Organization

FAILURE_SCORE HZ_ORGANIZATION_PROFILES Organization

FAILURE_SCORE_NATL_PERCENTILE HZ_ORGANIZATION_PROFILES Organization

FISCAL_YEAREND_MONTH HZ_ORGANIZATION_PROFILES Organization

GLOBAL_FAILURE_SCORE HZ_ORGANIZATION_PROFILES Organization

GSA_INDICATOR_FLAG HZ_PARTIES Organization

HIGH_CREDIT HZ_ORGANIZATION_PROFILES Organization

HQ_BRANCH_IND HZ_ORGANIZATION_PROFILES Organization

IMPORT_IND HZ_ORGANIZATION_PROFILES Organization

INCORP_YEAR HZ_ORGANIZATION_PROFILES Organization

INTERNAL_FLAG HZ_ORGANIZATION_PROFILES Organization

LANGUAGE_NAME HZ_PARTIES Organization

LEGAL_STATUS HZ_ORGANIZATION_PROFILES Organization

LINE_OF_BUSINESS HZ_ORGANIZATION_PROFILES Organization

LOCAL_BUS_IDEN_TYPE HZ_ORGANIZATION_PROFILES Organization

LOCAL_BUS_IDENTIFIER HZ_ORGANIZATION_PROFILES Organization
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PRIMARY_CONTACT_ID HZ_ORGANIZATION_PROFILES Organization

STATUS HZ_PARTIES Organization

TOTAL_EMPLOYEES_IND HZ_ORGANIZATION_PROFILES Organization

VALIDATED_FLAG HZ_PARTIES Organization

PARTY_TYPE HZ_PARTIES Organization and 
Organization Contact

GROUP_TYPE HZ_PARTIES Organization and 
Organization Contact

NEXT_FY_POTENTIAL_REVENUE HZ_ORGANIZATION_PROFILES Organization and 
Organization Contact

ORIG_SYSTEM_REFERENCE HZ_PARTIES Organization and 
Organization Contact

PUBLIC_PRIVATE_OWNERSHIP_FLAG HZ_ORGANIZATION_PROFILES Organization and 
Organization Contact

TAX_NAME HZ_PARTIES Organization and 
Organization Contact

OOB_IND HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

ORGANIZATION_NAME HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

ORGANIZATION_TYPE HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

PARENT_SUB_IND HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

PAYDEX_NORM HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

PAYDEX_SCORE HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

PAYDEX_THREE_MONTHS_AGO HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

PREF_FUNCTIONAL_CURRENCY HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile
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REGISTRATION_TYPE HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

SIC_CODE HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

SIC_CODE_TYPE HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

SMALL_BUS_IND HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

TOTAL_EMP_EST_IND HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

TOTAL_EMP_MIN_IND HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

TOTAL_NUM_OF_ORDERS HZ_PARTIES Organization and 
Organization Profile

TOTAL_ORDERED_AMOUNT HZ_PARTIES Organization and 
Organization Profile

TOTAL_PAYMENTS HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

WOMAN_OWNED_IND HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

YEAR_ESTABLISHED HZ_ORGANIZATION_PROFILES Organization and 
Organization Profile

LAST_ORDERED_DATE HZ_PARTIES Organization and 
Person

PARTY_NUMBER HZ_PARTIES Organization and 
Person

SALUTATION HZ_PARTIES Organization and 
Person

CONTACT_ID HZ_PARTIES Organization Contact

CONTACT_NUMBER HZ_ORG_CONTACTS Organization Contact

CUSTOMER_KEY HZ_PARTIES Organization Contact

DECISION_MAKER_FLAG HZ_ORG_CONTACTS Organization Contact

DEPARTMENT HZ_ORG_CONTACTS Organization Contact
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DEPARTMENT_CODE HZ_ORG_CONTACTS Organization Contact

GENDER HZ_PARTIES Organization Contact

HQ_BRANCH_IND HZ_PARTIES Organization Contact

JOB_TITLE HZ_ORG_CONTACTS Organization Contact

JOB_TITLE_CODE HZ_ORG_CONTACTS Organization Contact

MANAGED_BY HZ_ORG_CONTACTS Organization Contact

NATIVE_LANGUAGE HZ_ORG_CONTACTS Organization Contact

ORGANIZATION_ID HZ_PARTIES Organization Contact

ORGANIZATION_PARTY_NAME HZ_PARTIES Organization Contact

PARTY_CONTACT_NAME HZ_ORG_CONTACTS Organization Contact

PERSON_ACADEMIC_TITLE HZ_PARTIES Organization Contact

PERSON_PREVIOUS_LAST_NAME HZ_PARTIES Organization Contact

PHONE_COUNTRY_CODE HZ_PARTIES Organization Contact

PHONE_EXTENSION HZ_PARTIES Organization Contact

PHONE_NUMBER HZ_PARTIES Organization Contact

RANK HZ_ORG_CONTACTS Organization Contact

RELATIONSHIP_CODE HZ_RELATIONSHIPS Organization Contact

ROLE_TYPE HZ_PARTIES Organization Contact

SIC_CODE HZ_PARTIES Organization Contact

SIC_CODE_TYPE HZ_PARTIES Organization Contact

TITLE HZ_PARTIES Organization Contact

VALIDATED_FLAG HZ_PARTIES Organization Contact

EMAIL_ADDRESS HZ_PARTIES Organization Contact 
and Person

MAIL_STOP HZ_ORG_CONTACTS Organization Contact 
and Person

PARTY_SITE_ID HZ_PARTIES Organization Contact 
and Person
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PERSON_FIRST_NAME HZ_PARTIES Organization Contact 
and Person

PERSON_LAST_NAME HZ_PARTIES Organization Contact 
and Person

PERSON_MIDDLE_NAME HZ_PARTIES Organization Contact 
and Person

PERSON_NAME_SUFFIX HZ_PARTIES Organization Contact 
and Person

PERSON_PRE_NAME_ADJUNCT HZ_PARTIES Organization Contact 
and Person

PHONE_AREA_CODE HZ_PARTIES Organization Contact 
and Person

PERSON_IDENTIFIER HZ_PARTIES Organization Contact 
and Person Profile

MINORITY_OWNED_IND HZ_ORGANIZATION_PROFILES Organization Profile

MINORITY_OWNED_TYPE HZ_ORGANIZATION_PROFILES Organization Profile

PARTY_ID HZ_ORGANIZATION_PROFILES Organization Profile

TAX_NAME HZ_ORGANIZATION_PROFILES Organization Profile

TAX_REFERENCE HZ_ORGANIZATION_PROFILES Organization Profile

TOTAL_EMPLOYEES_TEXT HZ_ORGANIZATION_PROFILES Organization Profile

ADDRESS4 HZ_PARTIES Organization and 
Organization Contact

DUNS_NUMBER HZ_PARTIES Organization and 
Organization Contact

POSTAL_CODE HZ_PARTIES Organization and 
Organization Contact

PROVINCE HZ_PARTIES Organization and 
Organization Contact

REFERENCE_USE_FLAG HZ_PARTIES Organization, 
Organization Contact, 
and Person
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COUNTY HZ_PARTIES Organization, 
Organization Contact, 
and Person  

KNOWN_AS HZ_PARTIES Organization, 
Organization Contact, 
and Person Profile

TAX_REFERENCE HZ_PARTIES Organization, 
Organization Contact, 
Person

ADDRESS1 HZ_PARTIES Organization, 
Organization Contact, 
Person, and Account 

ADDRESS2 HZ_PARTIES Organization, 
Organization Contact, 
Person, and Account 

ADDRESS3 HZ_PARTIES Organization, 
Organization Contact, 
Person, and Account 

CITY HZ_PARTIES Organization, 
Organization Contact, 
Person, and Account 

COUNTRY HZ_PARTIES Organization, 
Organization Contact, 
Person, and Account 

STATE HZ_PARTIES Organization, 
Organization Contact, 
Person, and Account

URL HZ_PARTIES Organization, 
Organization Contact, 
Person, and Account

JGZZ_FISCAL_CODE HZ_PARTIES Organization, 
Organization Contact, 
Person, Person Profile

RENT_OWN_IND HZ_ORGANIZATION_PROFILES Organization, 
Organization Contact, 
Person, Person Profile
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PARTY_ID HZ_PARTIES Organization, Person, 
and Organization 
Contact

BEST_TIME_CONTACT_BEGIN HZ_ORGANIZATION_PROFILES Organization, Person, 
and Person Profile

BEST_TIME_CONTACT_END HZ_ORGANIZATION_PROFILES Organization, Person, 
and Person Profile

CUSTOMER_KEY HZ_PARTIES Person

LANGUAGE HZ_PARTY_SITES Person

LAST_ORDERED_DATE HZ_PARTIES Person

PARTY_SITE_NAME HZ_PARTY_SITES Person

PHONE_COUNTRY_CODE HZ_CONTACT_POINTS Person

PHONE_EXTENSION HZ_CONTACT_POINTS Person

PHONE_NUMBER HZ_CONTACT_POINTS Person

AGE trunc(months_between(sysdate date_of_
birth) / 12,0)

Person and Person 
Profile

DATE_OF_BIRTH HZ_PERSON_PROFILES Person and Person 
Profile

DATE_OF_DEATH HZ_PERSON_PROFILES Person and Person 
Profile

DECLARED_ETHNICITY HZ_PERSON_PROFILES Person and Person 
Profile

GENDER HZ_PERSON_PROFILES Person and Person 
Profile

HEAD_OF_HOUSEHOLD_FLAG HZ_PERSON_PROFILES Person and Person 
Profile

HOUSEHOLD_INCOME HZ_PERSON_PROFILES Person and Person 
Profile

HOUSEHOLD_SIZE HZ_PERSON_PROFILES Person and Person 
Profile

INTERNAL_FLAG HZ_PERSON_PROFILES Person and Person 
Profile
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MARITAL_STATUS HZ_PERSON_PROFILES Person and Person 
Profile

MARITAL_STATUS_EFFECTIVE_DATE HZ_PERSON_PROFILES Person and Person 
Profile

PERSON_NAME HZ_PERSON_PROFILES Person and Person 
Profile

PERSONAL_INCOME HZ_PERSON_PROFILES Person and Person 
Profile

PLACE_OF_BIRTH HZ_PERSON_PROFILES Person and Person 
Profile

COURSE_MAJOR HZ_EDUCATION Person Education

DEGREE_RECEIVED HZ_EDUCATION Person Education

EDUCATION_ID HZ_EDUCATION Person Education

LAST_DATE_ATTENDED HZ_EDUCATION Person Education

PARTY_ID HZ_EDUCATION Person Education

SCHOOL_ATTENDED_NAME HZ_EDUCATION Person Education

START_DATE_ATTENDED HZ_EDUCATION Person Education

TYPE_OF_SCHOOL HZ_EDUCATION Person Education

INTEREST_NAME HZ_PERSON_INTEREST Person Interest

INTEREST_TYPE_CODE HZ_PERSON_INTEREST Person Interest

LEVEL_OF_INTEREST HZ_PERSON_INTEREST Person Interest

LEVEL_OF_PARTICIPATION HZ_PERSON_INTEREST Person Interest

PARTY_ID HZ_PERSON_INTEREST Person Interest

PERSON_INTEREST_ID HZ_PERSON_INTEREST Person Interest

SINCE HZ_PERSON_INTEREST Person Interest

SUB_INTEREST_TYPE_CODE HZ_PERSON_INTEREST Person Interest

TEAM HZ_PERSON_INTEREST Person Interest

AMS_PERSON_PROFILE_ID HZ_PERSON_PROFILES Person Profile

CONTENT_SOURCE_TYPE HZ_PERSON_PROFILES Person Profile
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DECLARED_ETHNICITY HZ_PERSON_PROFILES Person Profile

PARTY_ID HZ_PERSON_PROFILES Person Profile

PERSON_IDEN_TYPE HZ_PERSON_PROFILES Person Profile

PERSON_PERVIOUS_LAST_NAME HZ_PERSON_PROFILES Person Profile

TAX_REFERENCE HZ_PERSON_PROFILES Person Profile

ACCOUNTS1 FEM_PARTY_PROFITABILITY Profitability

ACCOUNTS2 FEM_PARTY_PROFITABILITY Profitability

ACCOUNTS3 FEM_PARTY_PROFITABILITY Profitability

ACCOUNTS4 FEM_PARTY_PROFITABILITY Profitability

ACCOUNTS5 FEM_PARTY_PROFITABILITY Profitability

BALANCE1 FEM_PARTY_PROFITABILITY Profitability

BALANCE2 FEM_PARTY_PROFITABILITY Profitability

BALANCE3 FEM_PARTY_PROFITABILITY Profitability

BALANCE4 FEM_PARTY_PROFITABILITY Profitability

BALANCE5 FEM_PARTY_PROFITABILITY Profitability

CACC_TOTAL FEM_PARTY_PROFITABILITY Profitability

CACC1 FEM_PARTY_PROFITABILITY Profitability

CACC2 FEM_PARTY_PROFITABILITY Profitability

CACC3 FEM_PARTY_PROFITABILITY Profitability

CACC4 FEM_PARTY_PROFITABILITY Profitability

CACC5 FEM_PARTY_PROFITABILITY Profitability

CONTRIB_AFTER_CPTL_CHG FEM_PARTY_PROFITABILITY Profitability

EXPENSE_TOTAL FEM_PARTY_PROFITABILITY Profitability

EXPENSE1 FEM_PARTY_PROFITABILITY Profitability

EXPENSE2 FEM_PARTY_PROFITABILITY Profitability

EXPENSE3 FEM_PARTY_PROFITABILITY Profitability

EXPENSE4 FEM_PARTY_PROFITABILITY Profitability
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EXPENSE5 FEM_PARTY_PROFITABILITY Profitability

ISO_CURRENCY_CD FEM_PARTY_PROFITABILITY Profitability

LTD1 FEM_PARTY_PROFITABILITY Profitability

LTD2 FEM_PARTY_PROFITABILITY Profitability

LTD3 FEM_PARTY_PROFITABILITY Profitability

LTD4 FEM_PARTY_PROFITABILITY Profitability

LTD5 FEM_PARTY_PROFITABILITY Profitability

PARTNER_VALUE_INDEX FEM_PARTY_PROFITABILITY Profitability

PARTY_ID FEM_PARTY_PROFITABILITY Profitability

PROFIT FEM_PARTY_PROFITABILITY Profitability

PROFIT_PCT FEM_PARTY_PROFITABILITY Profitability

PROFIT_TOTAL FEM_PARTY_PROFITABILITY Profitability

PROFIT1 FEM_PARTY_PROFITABILITY Profitability

PROFIT2 FEM_PARTY_PROFITABILITY Profitability

PROFIT3 FEM_PARTY_PROFITABILITY Profitability

PROFIT4 FEM_PARTY_PROFITABILITY Profitability

PROFIT5 FEM_PARTY_PROFITABILITY Profitability

RATIO1 FEM_PARTY_PROFITABILITY Profitability

RATIO2 FEM_PARTY_PROFITABILITY Profitability

RATIO3 FEM_PARTY_PROFITABILITY Profitability

RATIO4 FEM_PARTY_PROFITABILITY Profitability

RATIO5 FEM_PARTY_PROFITABILITY Profitability

RELATIONSHIP_EXPENSE FEM_PARTY_PROFITABILITY Profitability

REVENUE_TOTAL FEM_PARTY_PROFITABILITY Profitability

REVENUE1 FEM_PARTY_PROFITABILITY Profitability

REVENUE2 FEM_PARTY_PROFITABILITY Profitability

REVENUE3 FEM_PARTY_PROFITABILITY Profitability
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REVENUE4 FEM_PARTY_PROFITABILITY Profitability

REVENUE5 FEM_PARTY_PROFITABILITY Profitability

TOTAL_EQUITY FEM_PARTY_PROFITABILITY Profitability

TOTAL_GROSS_CONTRIB FEM_PARTY_PROFITABILITY Profitability

TOTAL_ROE FEM_PARTY_PROFITABILITY Profitability

TRANSACTION1 FEM_PARTY_PROFITABILITY Profitability

TRANSACTION2 FEM_PARTY_PROFITABILITY Profitability

TRANSACTION3 FEM_PARTY_PROFITABILITY Profitability

TRANSACTION4 FEM_PARTY_PROFITABILITY Profitability

TRANSACTION5 FEM_PARTY_PROFITABILITY Profitability

VALUE1 FEM_PARTY_PROFITABILITY Profitability

VALUE2 FEM_PARTY_PROFITABILITY Profitability

VALUE3 FEM_PARTY_PROFITABILITY Profitability

VALUE4 FEM_PARTY_PROFITABILITY Profitability

VALUE5 FEM_PARTY_PROFITABILITY Profitability

YTD1 FEM_PARTY_PROFITABILITY Profitability

YTD2 FEM_PARTY_PROFITABILITY Profitability

YTD3 FEM_PARTY_PROFITABILITY Profitability

YTD4 FEM_PARTY_PROFITABILITY Profitability

YTD5 FEM_PARTY_PROFITABILITY Profitability

CUSTOMER_ID AS_ACCESSES_ALL Sales Access

GROUP_ID JTF_RS_GROUPS_VL Sales Access

GROUP_NAME JTF_RS_GROUPS_VL Sales Access

RESOURCE_ID JTF_RS_RESOURCE_EXTNS Sales Access

SALESFORCE_ID AS_ACCESSES_ALL Sales Access

ORIG_SYSTEM HZ_ORIG_SYS_REFERENCES System Reference

ORIG_SYSTEM_REFERENCE HZ_ORIG_SYS_REFERENCES System Reference
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OWNER_TABLE_ID HZ_ORIG_SYS_REFERENCES System Reference

OWNER_TABLE_NAME HZ_ORIG_SYS_REFERENCES System Reference

STATUS HZ_ORIG_SYS_REFERENCES System Reference
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implementing, 4-7
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setting up, 3-46
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implementing for UWQ, 6-38
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marketing intelligence
defining exchange rates, 11-5
initial build of materialized views, 11-7
loading marketing facts, 11-5
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setting up, 2-7
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